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Welcome

The Buzzsaw on-demand collaborative project management solution helps your
organization centralize building design and construction-related documents, simplify
communication, and streamline collaboration so you can successfully execute projects
based on timely decision and accurate information.

The Buzzsaw application runs in a web browser or as a stand-alone executable. Once
you've downloaded the software, it's easy to create, organize, and access projects
from anywhere in the world. You can communicate and collaborate with all members
of your extended project team, whether they're architects, engineers, consultants,
contractors, owners, or other industry professionals.

Buzzsaw Standard is available in the following languages: English, French, German,
Italian, Japanese, Korean, Spanish, and Simplified Chinese. You can also access your
site without having to download any software. For more information see Accessing
Your Site (page 5).

Accessing Your Site (page 5)

Read Me (page 7)

Getting Started (page 13)

Navigating the Workspace (page 29)

Site and Project Administration (page 41)

Creating a New Member (page 89)

Information Pages (page 151)

Adding a New Folder (page 159)

Adding a File (page 176)

Buzzsaw Professional (page 255)

ProductVersion What s Newew

ProductVersion FAQAQ
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ProductVersion Discussion Boardrd
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Accessing Your Site

There are two ways in which you can access your Buzzsaw site: by downloading the
Buzzsaw software or through Buzzsaw Web Access.

Software

The Buzzsaw software gives you access to the following functionality:
■ Site and project administrative functions, such as creating a new member and viewing

activity logs.

■ What's New

■ Find

■ Mail

■ Recycle Bin

Buzzsaw Web Access

Buzzsaw Web Access enables you to access your site directly through the internet without
having to download any software.

The advantage of using Buzzsaw Web Access is that you can access your site from any computer
that has an internet connection. Using Buzzsaw Web Access you have full access to project
data without having to download any software.

You can upload and download files, view dashboards, reports, and forms. Forms are only
available if you have Buzzsaw professional.

To access your site using Buzzsaw Web Access, remove the word “client” from your site name.
For example, https://projectpoint.buzzsaw.com/client/mysite becomes
https://projectpoint.buzzsaw.com
/mysite.
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Read Me

This document includes the most recent information supplementing the Buzzsaw
documentation.

Installation Notes

Getting Started (page 13)

Installing the Software

The Buzzsaw client software downloads and installs automatically when you navigate to a
Buzzsaw site with your browser. The time needed to install Buzzsaw depends on the speed of
your Internet connection. Even on the slowest connections, the entire install process should
take less than 20 minutes.

An alternative to the automatic download is to specifically download and execute the installer,
ProjectPoint-BZ-EN.exe, from the Buzzsaw web server.

To install Buzzsaw, enter the site provided in the email notification sent by your Site
Administrator. Please follow ALL instructions during the install. Some users may need to
restart their machines before completing the install. If you are not sure of your site URL or
user login information, contact your Site Administrator.

Uninstalling the Software

You can uninstall Buzzsaw using the Control Panel's Add/Remove Programs feature. The
program name in the uninstall dialog is Autodesk Buzzsaw.

Installation Problems

If Buzzsaw downloads but does not install and does not bring up the installation dialogs,
check that you have sufficient disk space (approximately 20 MB).

If you are having trouble with the automatic download and install, manually download
ProjectPoint-BZ-EN.exe and launch the installer. This often resolves the issue.

3
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Verifying your Install

Once the automatic installation has completed, the Buzzsaw login prompt should display.
Enter the username and password assigned by the Site Administrator to login to your site.
If you are unable to install or login please contact your Site Administrator or Buzzsaw
Support.

Version Information

You can always determine which version you have running on your computer by viewing
the About Box from the Buzzsaw help menu.

Operational Notes

Internet Explorer Settings

If after installing Buzzsaw you change the default settings for Microsoft's Internet Explorer,
you may have difficulties logging into Buzzsaw sites. In particular, the “Do not save encrypted
pages to disk” option must be unchecked. To verify this is not checked:

1 Open IE's Internet Options control panel from IE's Tools menu.

2 Select the Advanced Tab.

3 Scroll down and find the “Do not save encrypted pages to disk” option.

4 Verify that it is NOT checked. If this option is checked, some Buzzsaw features will
not work.

Internet Explorer must be set to allow ActiveX controls to run. Specifically, the following
security levels must be set in the IE's Internet Options control panel:

1 Download Signed ActiveX control = Set to Prompt or Enable.

2 Run ActiveX controls and plug-ins = Set to Prompt or Enable.

3 File Download = Set to Enable.

When using Internet Explorer with Buzzsaw, it is important to remember that the browser
will retrieve files from its browser cache when possible. Thus, if problems arise where the
latest version of a file will not download, clear your browser cache (including offline content).
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Viewing Microsoft Excel Files

Microsoft Excel does not allow you to open two documents with the same name, even if
they are in different folders. For example:

1 Select an Excel file in the tree view and click the View tab. The file is displayed in the
details pane.

2 Right-click the same file in the tree view and select View in Window from the menu.
This produces an error.

This behavior is a limitation of Microsoft Excel.

An error occurred in the secure channel support

Information on the cause of this problem and how to fix this it are available here:
http://support.microsoft.com/support/kb/articles/q177/3/01.asp. This error is usually caused by
installing Service Pack 3 after you install Internet Explorer. Microsoft recommends:

1 Click Start, and then click Run.

2 In the Open box, type regsvr32 rsabase.dll , and then click OK.

We recommend upgrading to the latest version of Microsoft Internet Explorer.

Based on the interaction among certain versions of Internet Explorer, Microsoft Project,
and Buzzsaw, viewing Microsoft Project files in Buzzsaw can be difficult. Users must start
Microsoft Project prior to navigating to the View tab for an MPP file stored in Buzzsaw.
Invoking Microsoft Project without opening an MPP is sufficient to do the trick.

Session

If the Buzzsaw Login dialog box appears while you are working with Buzzsaw, enter your
site URL address, and then click OK. If the Login dialog box immediately reappears, enter
your Buzzsaw User Name, Password, and site URL (should still be there), and then click OK.

If your Buzzsaw session times out or an external viewer starts its own session you may get
a network login prompt with a resource name of Buzzsaw.com. Reenter your login and
password to open your site.

XREF Upload Wizard

Buzzsaw cannot locate XREF'd files that are specified in AutoCAD drawings using URL-based
path names. UNC names are handled, but if the user opts to preserve the directory structure,
they must be a site administrator for the operation to succeed.

Read Me | 9
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Uploading fonts

When uploading .dwg files Buzzsaw only finds fonts in the AutoCAD font directory.

Microsoft Office XP and AutoCAD 2002

If you are using Office XP and AutoCAD 2002 (or earlier) you can not access your Buzzsaw
site through Network places due to an Office XP related problem.

Cimmetry Systems AutoVue

Buzzsaw includes the integration of Cimmetry Systems AutoVue product. AutoVue is a view
and mark up tool for DGN files and over 200 other file formats. The following known issues
exist regarding the operation of the AutoVue product within Buzzsaw:
■ Buzzsaw is unable disable the markup capability of AutoVue. As a result, Buzzsaw users

who are limited to "View" access are still able to invoke AutoVue markup tools. They are
unable to save anything to Buzzsaw.

■ AutoVue remains in the Pan or Magnifying Glass state when creating markup entities.

■ Marking up of icon files causes AutoVue to crash. Buzzsaw has disabled the markup
feature for icon files.

■ Using the AutoVue OLE Object tool within Buzzsaw can cause Buzzsaw to crash. The
problem has been reported to Cimmetry Systems. Manipulating OLE objects is not
recommended at this time.

■ Changing the background color of an AutoCAD drawing does not persist from Buzzsaw
session to session. Users must set the desired background color, if different from what
is contained in the DWG, with each viewing.

■ Tool tips for AutoVue do not operate when AutoVue is running inside Buzzsaw.

■ For users of the demonstration copy of AutoVue Professional, a patch is available from
the support console that addresses items related to file mark up. These problems are not
present in a purchased copy of AutoVue Professional.

Directory Path Length Limit

Due to a Windows limitation the full directory path of a file can not exceed 238 characters.
This number includes all the characters in your site name, project name, sub-folder name
(if any), and file name. If the total number of characters exceeds 238 you will not be able
to drag and drop the file. Bear this limitation in mind when naming files.
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Proxy Settings

Some proxies may not be configured to allow the Buzzsaw client to communicate with its
server resulting in login failures. Configuring your proxy with Buzzsaw's address usually
fixes this problem. Buzzsaw uses the standard HTTP and HTTPS ports for communication.
If you continue to have problems logging into your Buzzsaw site through your proxy, please
contact your Site Administrator or Buzzsaw Support.

Users can also try to configure Internet Explorer to bypass the proxy server in Internet
Explorer 6.x:

1 Open the Tools Menu and select Internet Options.

2 Click the Connections Tab.

3 Click the LAN Settings button.

4 If "Use a Proxy Server for your LAN" is checked, click the Advanced button.

5 In the "Do not use proxy server for addresses beginning with:" field, add
projectpoint.buzzsaw.* and folders.buzzsaw.*.

6 Click OK.

Limitations with Multibyte Languages

Microsoft Web Folders is not supported for multibyte languages.

Sorting of multibyte characters is based on the first character's initial single byte value and
can be different from Windows true multibyte character sorting.
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Getting Started

System Requirements

There are several different categories of users that work with Buzzsaw. This
section defines those categories and provides recommendations for system
specifications based on what activities a member needs to accomplish during
the member’s daily activities. These specifications are recommended starting
points for all levels of users: adjust them according to your needs.

These recommendations are assuming a fresh reboot with no other products
running. Running other products uses system RAM. You may need to increase
your RAM in order to use multiple products at once. The bandwidth of the
internet connection directly affects file transfer and log in speeds. Initial login
to the Buzzsaw software client takes the longest due to the caching of data that
takes place. Subsequent logins take less time as Buzzsaw only updates the
differences since the last login. Initial login times are affected by the size of the
site being accessed. Your level of permission on the site you are accessing does
not change the amount of data that is gathered during initial login.

Buzzsaw is available in the following languages: English, French, German, Italian,
Japanese, Korean, Spanish, and Simplified Chinese.

File Transfer Only

Buzzsaw System Requirements
■ Intel® Pentium®-based PC or compatible, 1-GHz processor (or higher)

■ Microsoft® Windows® XP Professional or Windows 2000

■ 256 MB RAM

■ VGA video display of 1024x768 (or higher)

■ Microsoft Internet Explorer 6.0 (or higher)
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■ Broadband Internet connection (DSL, cable, or equivalent)

Software Access System Requirements

To make use of the Windows-based Buzzsaw client for the most basic
file-transfer capabilities. Specifically if you would like the Windows-based
application feel and are only transferring files.
■ Intel® Pentium®-based PC or compatible, 1-GHz processor (or higher)

■ Microsoft® Windows® XP Professional or Windows 2000

■ 256 MB RAM

■ 35 MB free disk space (or higher)

■ VGA video display of 1024x768 (or higher)

■ Microsoft Internet Explorer 6.0 (or higher)

■ Broadband Internet connection (DSL, cable, or equivalent)

Design File Viewing and Markup

Software Access System Requirements

In order to view specific files like DWF or DWG files from within Buzzsaw you
are required to install the appropriate viewers and in turn meet their minimum
system requirements in addition to the Buzzsaw requirements.
■ Intel® Pentium®-based PC or compatible, 2-GHz processor (or higher)

■ Microsoft® Windows® XP Professional or Windows 2000

■ 512 MB RAM—1 GB (or higher)

■ 35 MB free disk space (or higher)

■ VGA video display of 1024x768 (or higher)

■ Microsoft Internet Explorer 6.0 (or higher)

■ Broadband Internet connection (DSL, cable, or equivalent)

Site Administration

Software Access System Requirements

System administration includes tasks such as creating and maintaining users,
groups, projects, and managing permissions. The software client is required
for these actions.
■ Intel® Pentium®-based PC or compatible, 2-GHz processor (or higher)

■ Microsoft® Windows® XP Professional or Windows 2000
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■ VGA video display of 1024x768 (or higher)

■ Microsoft Internet Explorer 6.0 (or higher)

■ Broadband Internet connection (DSL, cable, or equivalent)

See also:

Viewers and Markups (page 241)

Logging In, Logging Out

Overview

Access to files on a site requires a username and password. The login
information verifies your identity within the system and maintains the security
of your project files.

If you share a computer with another Buzzsaw user, it is recommended that
you log in and out for each session. To access your site without having to
download the software, use Buzzsaw Web Access (page 5).

The link in the welcome email directs you to the Buzzsaw Welcome page. On
the Welcome page you create a password, select a security question and answer,
and enter your contact information. Next, select an access method: software
access or Buzzsaw Web Access. If the software has previously been installed
on your machine then the Buzzsaw software launches automatically and you
do not select an access method.

Only you know your password. If you forget it, use the I forgot my
password button in the Login dialog box for assistance. If this button is not
available then ask your site administrator to reset your password. In order to
use password assistance you must create a security question and answer in the
Changing Your Member Information (page 17) dialog box.

NOTE Your site administrator may require you to create a strong password. See
Password Requirements (page 443) for more information. If your site administrator
does not require you to create a strong password then your new password must
start with a letter, be at least eight characters long, and contain at least one capital
letter and one number. For example, Changeme1.

After a period of inactivity you will automatically be logged out depending
on the Security Tab (page 79) specified by the site administrator.
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Logging Out

To log out of your Buzzsaw session, click the Logout button on the title bar
menu. (It is to the right of your member name.)

Or, place your mouse pointer anywhere in the tree view, details view, or
shortcut bar. Right-click and choose Logout.

Logging In

The Login option in the right-click menu enables you to access other sites
that you are a member of.

1 With your mouse pointer in the tree view, details view, or shortcut bar,
right-click and select Login from the menu.

2 Enter the username and password for the site.

Password expiration

Depending on how the site administrator has configured the Security Tab
(page 79), your password may expire after a specified amount of time.

If you attempt to log in and your password has expired, you must create a
new password. Your site administrator may require you to create a strong
password. The criteria your password must meet are listed in the dialog box.

If your site administrator does not require you to create a strong password
then your new password must start with a letter, be at least eight characters
long, and contain at least one capital letter and one number. For example,
Changeme1.

Session time out

If your site administrator configured the Session time out option in the
Security Tab (page 79), then you are automatically logged out of a session
after the amount of time specified by the site administrator. Log back in to
the site to start a new session.

Disabled due to inactivity

If your site administrator configured the Member inactivity option in the
Security Tab (page 79), then you will be automatically disabled after the
number of days specified by the site administrator, if you have not logged
into the site. Contact your site administrator to enable your member profile.
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You cannot access the site until the site administrator enables your member
profile.

See also:

Changing Your Member Information (page 17)

Accessing Your Site (page 5)

Changing Your Member Information

Use the Member Information dialog box to change your password and contact
information, and create a security question for password assistance. You can
modify your personal information at any time.

1 Click the Personal Information toolbar button,  .

2 Choose from the following tabs to complete your changes:

General: Change your company name, address, and phone/fax/email
information. It is helpful to enter as much information about yourself
as possible. Then, when other members are looking at a list of members
they can easily see your contact information. If you do not enter any
contact information then other members can only contact you through
email.

Security: Change your password. Your site administrator may require
you to create a strong password. The criteria your password must meet
are listed in the Personal Information dialog box. For more
information about creating a strong password see Password Requirements
(page 443).

If your site administrator does not require you to create a strong password
then your new password must be at least eight characters long and must
contain at least one uppercase character and one number. Example:
Changeme1. If you forget your password you can request assistance to
reset it. Enter a security question and answer in the fields provided. Select
a question from the options provided, or create your own. Select a
question and answer that other people are unlikely to guess. If you do
not select a question and answer then you cannot request password
assistance.

3 Click OK.
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See also:

Logging In, Logging Out (page 15)

Using the Member List (page 18)

Setting Preferences (page 19)

Using the Member List

The Member List provides a consolidated list of site and project member
information for those projects that you are working on. The toolbar buttons
are available to you according to your permission level. All functionality
available through the toolbars are also available through the right-click menu.

To view the Member List:

1 Click the Member List toolbar button,  , to display the Member
List window.

2 You can view members for an entire site or for an individual project by
using the project selection bar:

■ To see all the members on the site, click the arrow to the right and select
the site icon.

■ To see the members of a specific project, click the arrow to the right and
click Browse. Then select a project from the list and click OK.

NOTE Remember (even when you choose from the site level), you will only see
the Member List for the projects you have permissions to.

To use the Member List:

In the Member List window, select a member and then do any of the following:
■ Create and send an email to the selected members. In the toolbar, click

the Send Mail toolbar button,  . For detailed instructions, see Creating
a New Message (page 425).

■ Update the Member List. Click the Refresh toolbar button,  .

18 | Chapter 4   Getting Started



NOTE As Site or Project Administrators add new members or new member
information, the information in the Member List is updated to reflect the latest
additions or changes. If you have been working in Buzzsaw for a while, click
the Refresh button to see the most current member list data.

■ Use the Options button to Manage Columns Dialog Box (page 423).

To use administrator tasks:

■ Edit and delete members using the toolbar buttons.

■ Enable and disable members using the toolbar buttons.

■ Send welcome email. Select a member and right-click. Choose Send
Welcome Email from the menu. Administrators can only send welcome
emails to members who are enabled, have a valid email address and have
never logged in to the site.

■ Reset a member's password using the Reset Password toolbar button, 
. Administrators can only reset the password of members who are enabled,
have a valid email address and have previously logged in to the site.

■ Use the right-click menu to edit and remove members and groups.
(Administrators only). Project administrators with New Member privileges
can delete project level groups. Project administrators can delete a group
from the site if he or she owns the group.

■ Non-administrator group owners can edit and delete groups that they own.

See Filtering Options (page 424) for more information about how to customize
your view.

See also:

Changing Your Member Information (page 17)

Creating and Sending an Email Message (page 234)

Permissions Tab (page 71)

Setting Preferences

All members can select or change certain preferences including position of
the help display, the amount of time that passes before folders are
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automatically opened, when you drag and drop, and selection of a default
drawing viewer. You can also choose which viewer to use for specific file types.

Setting preferences can save time, depending on your work style and how
frequently you use drawing files. Preferences can be changed at any time.

General tab

1 From the Tools menu, choose Preferences. The Preferences dialog box is

displayed. 

2 In the General Tab choose from the following options as desired:

Keep help on top — If you want to keep the help displayed on top of
the browser window, select the Keep help on top check box. The
advantage to keeping the help display on top is that the help page doesn't
disappear behind the browser window, and you can easily reposition
and refer to it (side-by-side) as you work with Buzzsaw.

Drag and drop hover open time — When you drag a file to a folder
and hold it there, after the specified amount of time, the folder
automatically opens. This saves a step you don't have to end the drag
and drop, open a folder, and then drag the file over the folder. If you
want to change the amount of time that must pass before a folder
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automatically opens, enter the new time in the Drag and drop hover
open time field.

Project Creation — Select what you would like to happen after adding
a new project. That is, always start the Project Setup wizard; always ask
first if you want to go through the Project Setup Wizard; or never start
the Project Setup wizard. See Project Setup (page 259) for more
information. This option only affects Buzzsaw Professional Professional
users.

DWG Publishing — These options control when these alert messages
are displayed. The messages are displayed when you click the Markup
button or tab and either a DWF does not exist, or a newer DWG exists
that has not yet been published. Selecting these options means that the
alert message will not be displayed and a DWF is automatically published
when needed.

3 Click the OK button when you are finished, or click the File Types tab
to continue selecting your preferences.

File Types tab

1 From the Tools menu, choose Preferences. The Preferences dialog box is
displayed. Click the File Types tab.
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2 In this tab you can select which viewer you want to use to view various
file types. For example you can choose to view DWF files using Design
Review.

The different file types are listed at the top of the dialog box. Select a
file type and then select the viewer that you want to view that file type
with. You can add additional viewers by clicking the Add Viewers button.
You can download other viewers from the Autodesk website
http://www.autodesk.com/viewerinfo.

Viewing Autodesk Drawing Files (DWG, DXF) — Select Autodesk
Drawing Files at the top of the dialog box. In the View with drop-down
list, select a viewer to use when viewing AutoCAD drawings. When
Autodesk drawing files is selected at the top of the dialog box, the option,
Downloading, is displayed. Use the drop-down list box to select an option
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that determines whether or not external references will be scanned for
when downloading a drawing. Scanning files can be a time-consuming
process if the files are large and if you are downloading multiple files.
Thus, you have the option to choose when your drawings are scanned.

Viewing DWF Files — Select Published Drawings at the top of the
dialog box. In the View with drop-down list, select a viewer to use when
viewing DWF files. Buzzsaw defaults to the viewer that is installed on
your computer. That is, if you only have Autodesk Design Review
installed, then Buzzsaw automatically selects that option. The Design
Review is selected by default if installed on your computer. To add a new
viewer click the Add Viewers button.

Viewing Raster Files — Select Raster Files at the top of the dialog box.
In the View with drop-down list, select a viewer to use when viewing
raster files. By default, your current bitmap viewer is used (for example,
Internet Explorer). To use Design Review you must explicitly select that
option. In addition to viewing bitmap files you can also mark up bitmaps.
To add a new viewer click the Add Viewers button. For a list of supported
bitmap files, see Supported Bitmap Files (page 413).

External References — This option controls whether the "External
References Not Found" window is displayed when viewing a DWG file
that has missing XREFS. If you do not select the Do not list external
references option, then the other two options are disabled. If you do
select this option, then you have the choice of using local copies of
missing external references or not using any at all.

3 Click the OK button when you are finished.

Email

These options control when the email options dialogs are displayed and when
email notifications are sent. These options are only enabled for site
administrators and project administrators who have New Member privileges.

These options apply only to the email types listed in this tab. These options
(except Display Send Options) do not apply to any other emails that are sent
from within Buzzsaw, such as project size limit notifications or when existing
members are added to a new project.

1 From the Tools menu, choose Preferences. The Preferences dialog box is
displayed. Click the Email tab.
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2 For each type of email select the corresponding options (not all options
are available for all email types):
■ Display Send Options — if selected for a particular email the Send

Options Dialog Box (page 427) is displayed before the email is sent. If
in the Send Options dialog box you select the "...do not show send
options" then you can only turn that dialog back on by re-visiting
this tab and selecting the Display Send Options checkbox.

■ Display Language Options — if selected for a particular email,
the language options that are seen in this tab (Language Preference
and Encoding) are displayed before the email is sent.

■ Notify Administrator — if selected an email is sent to the
administrators associated with the project, stating that a welcome
email was sent to the users who were added to the project. If, as an
administrator, you do not want to receive these confirmation emails,
then do not select this option.

■ Notify Member — if selected an email is sent to the member
confirming that a project or group membership change has occurred.

3 Select the language and encoding that should be applied to welcome
and reset password emails:
■ Language Preferences — use this option to select which language

you want all welcome emails and reset password notification emails
to be sent in. You can change the language for each email if you
selected the option above, "Display Language Options". Then, each
time you send a welcome email you will have the chance to change
the language that the email is sent in. If you cleared this option, then
the welcome emails are automatically sent in the language that is
specified in this Preferences dialog box.

■ Encoding — use this option to select the encoding format that is
applied to all welcome emails and reset password notification emails.
You can choose between Unicode or Native Encoding (MBCS).

NOTE  Unicode enables text to be displayed correctly regardless of the
language the text was written in. However if the recipients email client
does not support UTF-8 encoding then the text is not displayed correctly.
By default, the email is sent in Native Encoding which means that the
subject and body can only be in one character set (that is, you can not
mix Japanese content with Korean content). If you send the welcome
email in Unicode, the subject and body can have mixed content (that
is, you can mix Japanese content with Korean content, Chinese content,
German content, etc.).
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See also:

Viewers and Markups (page 241)

Downloading External References (page 214)

Send Options Dialog Box (page 427)

Collaborative Work Environment

There are a myriad of project tracking tools that allow you to streamline project
processes throughout design and building cycles. You can publish drawings,
solicit and collect feedback, and track all revisions and file histories and follow
all project-related activities.

To make sure the exchange of information goes smoothly and to achieve your
project goals it's a good idea to establish some basic team communication
guidelines. Sharing project files and working collaboratively is most effective
if you decide how you want to work together as an extended team, set up the
ground rules, and then let all project members know the rules right from the
start. Here are some suggestions to consider as you set up project
communication guidelines:
■ If you want to work with a locked file, be sure to check with the person

who originally locked the file before you download the same locked file
to your local computer. That way, the person who originally locked the
file can let you know if it's OK for the file to be unlocked and that it's being
worked on. The person can also direct other team members not to work
with the same locked file while it's in use.

NOTE You must have Administrator or Edit permission to lock and unlock files.

■ Use the Discussion feature to let others know that you are downloading a
file for editing or to communicate about folders and files in general.

■ After you make changes to your version of the file, upload it to your site.
Then send an email or attach a discussion item to let others know about
the changes.

■ Assign one person primary responsibility for keeping edited files organized,
named, and backed up to a local computer.

See also:

Discussion Threads (page 200)

Copying a Project URL (page 26)

Start a Discussion Thread (page 201)
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Copying a Project URL

Rather than tell site and project members how to navigate to a specific project
folder or file you want them to see, you might want to use a simpler method:
the Copy URL command. You can use this feature to email a project URL to
members of your choosing, who can then click the link you provide to navigate
directly to the folder or file you specify.

You can also make project folders or files available to non-members. To
announce to anyone (not just site or project members) that a specific folder
or file is available for viewing, use the Copy Public URL function. By copying
the public URL for a folder or file and pasting it into an email message, you
allow anyone you choose to see project data that has been designated as
publicly accessible. People viewing this data need not provide a username or
password. The permissions to the file or folder is read-only.

NOTE Before using the Copy Public URL function, you first must grant access to
the selected folders and files through the public member function. To see how to
set up public access to project data, see Granting Anonymous Public Access (page
45).

To copy a project URL:

1 In the tree view or details view, select the file or folder you wish to tell
members about. Or use your mouse pointer to select the URL shown in
the browser's Address field.

2 Right-click and select Copy URL from the menu. Or, select Copy URL
from the Edit menu.

3 Create a new email message by clicking the Send Mail toolbar button,

 .

4 With your cursor in the body of the email, choose Paste from the Edit
menu in the Mail window.

You can now send the project URL to selected site or project members.

To copy a public URL:

1 In the tree view or details view, select the file or folder you wish to tell
people about — or use your mouse pointer to select the URL shown in
the browser's Address field.
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2 Right-click and select Copy Public URL from the menu. Or, select Copy
Public URL from the Edit menu.

3 Create a new email message by clicking the Mail icon on the toolbar or
by clicking the Mail button on the standard toolbar, then choosing Send
Email.

4 With your cursor in the body of the email, choose Edit, then Paste from
the Mail window drop-down menu.

You can now send the public project URL to anyone you wish.

NOTE When you circulate a public URL for a project folder or file, people clicking
the URL will be able to view the folder or file specified — and any other folder or
file that has been assigned public access.

See also:

Collaborative Work Environment (page 25)

Granting Anonymous Public Access (page 45)

Naming Restrictions

When naming a project, folder, file, form log, or form, it is important to note
that not all characters are allowed.

Valid Characters

■ alpha

a | b | c | d | e | f | g | h | i | j | k | l | m | n | o | p | q | r | s | t | u | v | w | x | y |
z | A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V |
W | X | Y Z

■ digit

0 | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9

Invalid Characters

? | < | > | " | % | # | { | } | | | \ | ^ | ~ | [ | ] | / | : | * | ` | @ | $ | & | !
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Web Folders

When naming objects (that is, a project, folder, file, or form log) bear in mind
that if users are using Web Folders, there are further naming restrictions. A
name that is acceptable in the thick client (that is, projectpoint.exe ) may not
be acceptable in Web Folders.

The thick client allows high bit ASCII characters that are not valid for Web
Folders. Because of this you may see some differences in how objects are
accessed. If an object contains characters that are invalid for Web Folders, the
object name is displayed correctly in the directory listing but you will not be
able to navigate further into subfolders. Also, you will not be able to access
the file.
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Navigating the
Workspace

Navigation Tools

It's easy to navigate throughout Buzzsaw. Features are organized in different
regions in the main window based on their purpose. You can navigate to any
component with a click of the mouse.

■ The title bar menu at the top of the details view allows you to create and
view project data, and team directories. If available, forms and reports can
also be accessed from this menu. Administrators can access administrative
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tasks from this menu. The menus only display information that you have
access to.

■ The Using the Project Selection Bar (page 36) provides a list of all projects
you have access to in your site. Use the Browse window to select the project
you want to work with.

■ The Buzzsaw bar provides a way to get to the tasks and activities you use
most often.

■ The tree view contains a hierarchical list of all the files in the site or the
currently selected project. Click + and - to show or hide the levels in the
tree. When you select a folder in the tree view, the folder's contents are
displayed in the details view.

■ The details view displays detailed information about the item that is
selected in the tree view hierarchy. Choose among the tabs located along
the top of the work area to specify the information you want to view and
work with.

■ The Using the Standard Toolbar (page 33) provides a shortcut to the
commands you use most often (Add, Edit, Update, and so on).

See also:

Using the Project Selection Bar (page 36)

Using Drag and Drop (page 32)

Using the Shortcut Bar (page 37)

Using the Standard Toolbar (page 33)

Using the Title Bar

The title bar is below the Buzzsaw toolbar. You can use this bar to navigate
through your site. The title bar is contextual for the site or project selected. If
a folder, file, note, link, or log is selected, then the menu for the parent project
is displayed. Your permission level also determines the menu content. That
is, whether you are an administrator or not.
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The title bar displays the site or project name above the folder tree. To the
right of the project or site name the menu items, Project Information, Reports,
Forms, Folders, and Project Setup are displayed.

Menus

The following menus are displayed in the Buzzsaw title bar:

Site Level:
■ Site Information — displays the Information Pages (page 151) that you

have access to at the site level.

■ Folders — switches to folder view. That is, in the details pane you see a
hierarchical list of folders instead of a dashboard.

■ Site Setup — only available if you are a site administrator. Displays the
Step 5: Manage Information Pages (page 269) window.

Project Level:
■ Project Information — displays the Information Pages (page 151) that

you have access to at the project level.

■ Folders — switches to the folder view. That is, in the details pane you see
a hierarchical list of folders instead of an information page.

■ Project Setup — only available if you are a site or project administrator.
From here you can add/delete members, change the Step 5: Manage
Information Pages (page 269) that are displayed for the project. You can
also edit Step 1: Define Project Data (page 260) or change Step 4: Business
Processes (page 263) parameters.

■ Member Name — displays the user name that you are logged in as. Click
your name to display the Member Information dialog box. Here, you can
change your password, your security question and answer, or your contact
information.

Buzzsaw Professional Menus

The following menus are displayed in the Buzzsaw Professional title bar:

Site Level:
■ Site Information — displays the Information Pages (page 151) that you

have access to at the site level.

■ Reports (page 337) — displays the report categories that you have access
to at the site level.

■ Folders — switches to file view. That is, in the details pane you see a
hierarchical list of folders instead of a dashboard.
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■ Site Setup — only available if you are a site administrator. Displays the
Step 5: Manage Information Pages (page 269) setup page.

Project Level:
■ Project Information — displays the Information Pages (page 151) that

you have access to at the project level.

■ Reports (page 337) — displays the reports that you have access to at the
project level.

■ Forms (page 312) — displays the forms that you have access to at the
project level.

■ Folders — switches to the folder view. That is, in the details pane you see
a hierarchical list of folders instead of an information page.

■ Project Setup — only available if you are a site or project administrator.
From here you can add/delete members, change the Step 5: Manage
Information Pages (page 269) that are displayed for the project. You can
also edit Step 1: Define Project Data (page 260) or change Step 4: Business
Processes (page 263) parameters.

■ Member Name — displays the user name that you are logged in as. Click
your name to display the Member Information dialog box, where you can
change your password, your security question and answer, or your contact
information.

See also:

Changing Your Member Information (page 17)

Using Drag and Drop

Drag-and-drop provides shortcut methods for performing common tasks such
as, uploading and downloading files between the server and your desktop.

For example, you can add new drawing or document files to a project by
dragging items from your desktop to your site, just as you do when using
Microsoft Windows.

To drag and drop:

1 Select the item that you want to add to your site. To select an item, move
your mouse pointer over it, then click your left mouse button.

2 Hold the left mouse button while you drag the item to its destination
folder in the hierarchical tree view. The drop target is highlighted.
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3 Release the mouse button to drop the item in place.

TIP Use the tree view to navigate through the project hierarchy. Click the + and
- to reveal subfolders contained within each parent folder (similar to the Windows
Explorer tree view)

NOTE New project files inherit their permission lists from the folder in which they
are stored. To learn more about permissions, see Permission Levels (page 130).

You can also drag items from your site to your desktop by selecting the item
in the tree view and dragging it on your desktop.

NOTE Drag and drop is not recommended for downloading drawings and their
external references. Rather, select a file in the tree view, right-click and choose
Download.

See also:

Using the Project Selection Bar (page 36)

Using the Shortcut Bar (page 37)

Using the Standard Toolbar (page 33)

Using the Standard Toolbar

The standard toolbar is located at the top of the window, just below the
browser controls, and provides a fast way to access the tasks and activities you
use most often. You can reposition this bar by tearing and docking it anywhere
within the window.
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Click the button on the toolbar that corresponds with the option that you
want to use. Buttons adjoined by downward-pointing arrows open a menu.
See the table below for more information about each button. The accessibility
of many of the toolbar options depend on the type of file you select and your
assigned permission level.

DescriptionToolbar Button

Allows you to move backwards to the previously view.

 Back

Allows you to move forwards through previous views.

 Forward

Allows you to move up one level in the tree hierarchy.

 Up in hierarchy

Allows you to add a drawing, file, note, link, folder, or project
to your site. Add

Downloads a file, folder, project, form, or form log to your hard
drive. Save As

Use this command if you want to change the contents of a file.
The file is locked so that no one else can make changes to the Edit
file while you are working on it. Opens the Save File to Edit As
dialog box. Save the file to a folder of your choice on your local
computer. This button is not available if you have only List or
View permission.

Opens the Update Project Documents wizard to update a file
that you previously locked and modified. Use this command to Update File
complete the editing process. As a result, a new version is stored
with your updates.

Clones a project to another location within the site. Cloning
replicated the attributes of the project. That is, the folder struc- Clone
ture and project members and their permissions. You can also
choose to clone file data. You must have administrator privileges
to clone a project.
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DescriptionToolbar Button

Copies the selected item to the clipboard. It is deleted from its
original location after you've pasted. Cut

Copies the selected item to the clipboard.

 Copy

Pastes the item from the clipboard.

 Paste

Deletes the selected item(s).

 Delete

Creates a comment which is attached to the selected file.

 Add Comment

Enter reply text to selected comment. Not available to those
with View or List permission. Reply to Com-

ment

Opens the dialog box to create a new subscription for a specific
file or project. New No-

tification

Opens the Notification Manager dialog box. From here you can
view all of your notifications for the site. Notification

Manager

Opens the New Message window. Use to address, compose and
send email messages. Mail

Displays the personal information dialog box and tabs. Allows
you to change your personal information at any time. Click this
button to change your password.

 Personal Informa-
tion

Displays a list of members for the site or project you are working
on. Member List
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DescriptionToolbar Button

Updates the project hierarchy. Use this command to make cer-
tain that the contents displayed are up to date with those stored Refresh
on the server. For example, if another member added a file to
the site after you logged in, that new file will not be listed in the
project files list until you refresh the hierarchy or log out and
log in again.

Refreshes the information page or report that you are viewing.
This command does not refresh the tree hierarchy. Refresh Report

Displays the properties for the selected item. Allows Administrat-
ors to view and modify the permission levels for individual folders
or project files.

 Properties

Saves information pages or reports to your hard drive.

 Save
Report

Sends the contents of the selected item (file, form, information
page or report) to your local printer. Print

Opens the help table of contents and related or context sensitive
help page. Help

See also:

Using the Project Selection Bar (page 36)

Using Drag and Drop (page 32)

Using the Shortcut Bar (page 37)

Using the Project Selection Bar

The Project Selection bar is located above the shortcut bar and provides a list
of all the projects in your site. You can only see the projects to which you
have permission. You can reposition this bar by tearing and docking it
anywhere within the window.
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1 Click the arrow to the right of the Project field and then click Browse to
open the Select Project window.

2 Select a project from the window and click OK.

The content of the project you select is displayed in the hierarchical tree view.

To see all the projects to which you have permission, click the arrow in the
Project Selection Bar and select the gray, site icon.

See also:

Using Drag and Drop (page 32)

Using the Shortcut Bar (page 37)

Using the Standard Toolbar (page 33)

Using the Shortcut Bar

The shortcut bar, located along the left side of the main window, provides
easy access to the tasks and activities you use most often.

When you click one of the icons, different options are displayed. Note that
the contents of the details view (located on the right side of the window)
change to display data and tabs according to the task you selected in the
shortcut bar. The currently selected task is depressed to show you what mode
you are in.

Right-click an icon to open a task, open a task in a new window, learn more
about the task, or to log in/out. You can also change the size of the icons.

Depending on your assigned permission level, you can access the following
activities:

DescriptionIcon

Available only to Site Administrators. Used to perform admin-
istrative functions including adding members and groups,
changing permissions, and accessing the Site Activity Log.
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DescriptionIcon

Gives the Project Administrator quick access to frequently
used administrative tasks and activities, including adding
members and groups to a project and accessing a log of all
project-related activities. Available to Site and Project Admin-
istrators.

Displays a hierarchical tree view and a details view (similar to
Windows Explorer) of all the folders and files in the project.
This is the main working area. Typically, you use this option
to add, view, edit, and update project files, as well as particip-
ate in discussions. Available to all project members.

Provides a list of all project files you have not viewed or read.
Available to all project members.

Allows you to locate files across the entire site or within indi-
vidual projects. You can limit or expand your search by includ-
ing search criteria such as text, author, date, subfolders, and
so on. Available to all project members.

Enables you to create, send, and manage your email messages.

Enables you to view folders and files that have been deleted
from a project.

See also:

Using Drag and Drop (page 32)

Navigation Tools (page 29)

Using the Standard Toolbar (page 33)
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Using the Project Team Directory

The Project Directory provides a complete list of all project members
(automatically updated as members are added) which is available to everyone
assigned to the project. You can view and sort directory information in a
number of different ways, including by last name, first name, company, work
city, and home city.

To access the Project Directory click the Project Information menu and then
select Project Directory.

You must be a Site or Project Administrator to change the content for the
Directory page. There are several ways to choose the information that is
displayed for example, you can create your own custom directory in HTML
format and then add a link to the Web page (content can include images or
HTML pages).

NOTE A custom directory page will not be updated automatically.

Use the drop-down box to sort project members. You can sort by first or last
name, company, administrators or groups.

You can also search the directory by using the CTRL+F keyboard shortcut.

See also:

Step 5: Manage Information Pages (page 269)

Information Pages (page 151)

Navigating the Workspace | 39



40



Site and Project
Administration

Archiving Site, Project, and Folder Contents

The ability to archive site, project, or folder contents provides administrators
with a convenient way to transfer a complete copy of files to a local computer
system. The Archive command is most often used when a project is closed out
or when there is a need to free space on your site.

When you archive contents, a copy of all the selected site, project, or folder
files, including all file versions and discussion and version comments, is copied
to your local computer. Version and discussion comments are converted to
HTML and are displayed in a list. All you have to do is select an item from the
list, and the built-in viewer loads and displays it in your browser.

Using Microsoft operating systems, the absolute limit on a file name, including
its path, is 256 characters. When an archive of your site is created on your local
computer, it must obey this limit. This means that if your site structure gets too
deep, the resulting path names on your local computer will be too long for the
archive command to work properly. Also note that Buzzsaw adds \Discussion
Comments\VC_XXXXX.htm or \Version Comments\VC_XXXXX.htm which
may push the archive command over the limit. If you are archiving to the
default destination, you also have \Program
files\ProjectPoint\Archive\projectpoint.Buzzsaw.com\ as part of the resulting
path. This means that for a successful archive to the default
destination, you must limit the path lengths on your site to no more
than 133 characters (including your site name).

After the contents have been copied, it's a good idea to verify that all the files
are in the specified target directory on your local computer. You can then safely
delete the items from your site as desired.
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NOTE When archiving a site, project or folder, any email associated with the
contents is not archived.

To archive site, project, or folder contents:

1 In the tree view, select the item you want to archive.

2 Right-click and choose Archive from the menu.

The Save As dialog box appears.

■ Use the Save in: field drop-down menu to select the target location
on your local computer for the selected content.

■ Use the File name: field to name the folder in which the file(s) will
be archived.

■ The Save as type: drop-down menu contains one choice (All Files),
which is already selected.

3 Click Save.

The selected contents are copied from your site to the folder you specified.

4 Verify that all the files are in the specified target directory on your local
computer.

You can safely delete the selected items from your site as needed.

Cloning a Project

Site and project administrators have the ability to clone projects (you must
have administrator permissions to the source project and the destination).
Cloning a project copies all the properties of the project, including members
and their permissions, all sub-projects and folders. Cloning is useful if you
have a project with a large number of users. It is time consuming to set-up
members and their permissions. Cloning enables you to set-up members and
their permissions once and then replicate them throughout the site. You can
clone projects, folders, and form logs. Markups, notes, and discussions can
also be cloned. Project information pages are also cloned as well as project
data. There are no restrictions on where a project can be cloned to.

By default the files and form logs in the existing project are not cloned. You
must specifically select the option in the clone dialog box to include files (and
thus also include markups, notes and discussions). Any "locked for editing"
files within the project are cloned as unlocked. A new copy of the file is created
and the lock removed.
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Cloning is different from copying in that cloning a project or folder replicates
the attributes of the project (the project members and their permissions).
Copying merely duplicates the data (the folder structure and files). With
cloning you can choose to clone the data, but the main purpose is to replicate
the attributes. Through cloning you can also save a form log configuration.
Cloning a form log saves the routing rules and who is able to participate in
the form log in the cloned project.

Cloning a project:

When cloning a project the following elements are cloned: Project Setup (Data,
Members, Roles and Information Pages) is cloned to the new project. The new,
cloned project will have the same Project Data, the same Members, the same
set of Roles and Role Members and the same set of Information Pages.

1 Select a project in the tree view and right-click. Choose Clone from the
menu. The Clone Project dialog box is displayed.

2 Enter a name for the new project in the Clone As field.

3 Select a destination for the new project in the To field. Click the arrow
on the right and then click Browse to select a different location.

4 To clone the files in the selected project select the Include Files check
box. This copies all the files into the new project.

5 To clone the groups that are associated with the project select the Include
Project Groups option. Selecting this option does not include the
members of the group; it only clones the name of the group and the
permission level that has been assigned to the group. If a group is marked
private then that setting is also retained in the cloned copy. To include
the members of the group in the cloned project, select the Include
members of Project Groups option.

6 Click OK when you are finished.

Cloning a project with a form log:

When cloning a project with form logs it is important to note what is cloned
when the Include Files option is selected.

If the Include Files check box option is not selected, a project is created with
the following attributes:
■ The name and location indicated in the Clone Project dialog box.

■ The same project members as in the original project.
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■ The same folders, logs, and sub-projects as in the original project, with the
same permissions, as the original project.

■ The same roles and workflow types associated with the original project,
with the same project members associated with each. Forms are not cloned.
Note that even though roles are cloned, specific member assignment to
those roles are not. For example, if Sue is assigned the role of Lead-Engineer
in the source project, the destination project will not receive Sue. The role,
Lead-Engineer will be cloned, but it will not contain any members.

If the Include Files option is selected, a project is created with all of the above
attributes, as well as all of the files of the original project, with the following
attributes:
■ Files have the same permissions associated with them as the original files

and forms.

■ Files only contain their most recent version.

■ Files maintain their discussions.

■ Drawings maintain their markups.

Cloning and permissions

When a project is cloned to a subfolder, all users belonging to the cloned
project are granted list permissions to the top level (or parent) folder, and all
subfolders down to the cloned project. This is because the destination folder
may be a location that users do not have permission to view. By granting users
list permissions to the parent folder, users can access the cloned project. For
example:

In the following picture Construction Drawings has been cloned to a subfolder
of Proj3. Before Construction Drawings is cloned, you have edit permissions
to Construction Drawings, but not to Proj1, Proj2, and Proj3. After the clone,
you still have edit permissions to Construction Drawings, as well as list
permissions to Proj1, Proj2, and Proj3.

A project that has a locked permission set can be cloned and the permission
set will remain locked in the clone.
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See also:

Project Setup (page 259)

Step 1: Define Project Data (page 260)

Locking and Unlocking Permission Sets (page 138)

Granting Anonymous Public Access

Through the public-access feature, Administrators can permit anyone to view
certain folders and files within a project. This allows you to share information
without requiring that the intended readers supply a username and password.
In addition, people with which you wish to share project details need not be
Buzzsaw users. If you provide them the URL for public project data, they can
view it with their Web browser.

For more information on making project information public, see To copy a
public URL: (page 26)

How Public Access Works

When a new site is created, a public member is also created — denoted in the
Members list as (public). To see it, click Site Administration, then click the
Members tab.

By assigning the member (public) to a project, you allow anyone to log in to
your project and exercise the permissions you have assigned to (public). For
example, if you assign View permission to the member (public) for a subfolder
of Project X, anyone who logs in as (public) will be able to view only the
contents of that subfolder.

NOTE  If the member (public) is not created when your site is established, only
Site Administrators — or Project Administrators that have been granted the ability
to create site members — can create this member.
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Once (public) is assigned to a project, people can access that project by taking
the following steps:
■ Click the public URL received in an email from another project member

or Administrator.

■ Enter (public) in the Username field of the Login dialog box (no password
is needed).

■ Add ?public to the end of the project URL in the Address field of a Web
browser; for example,
http://projectpoint.buzzsaw.com/client/yoursitename/foldername?public.

For information about how to add (public) or other members to a site, project,
or group, see Creating a New Member (page 89).

For information about assigning permission levels, see Permissions (page 130).

Limiting Access

The permission level you assign to the (public) member at the project level is
inherited by all subordinate project folders unless explicitly assigned otherwise.

NOTE Assigning varying public access permissions within a project could make
permissions for that project difficult for you to track.

To limit access to folders or files:

1 In the tree view, right-click the folder or file and choose Properties from
the menu.

The Properties dialog box for that folder or file will appear.

1 Select the Members tab, then choose (public) from the members list.

2 In the Permissions drop-down menu, select from the following access
levels: No Access, List, View, Review, and Edit.

NOTE The List permissions option is available only for folders.

Optional: If you want to block public access to the folder or file, select (public)
from the members list in the Members tab, then select No Access from the
drop-down list beneath the members list.

Public access to the folder or file will now be limited according to the
parameters you set.
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Administrators: It's a good idea to group your public project data into one
folder. For example, if you wish for people to have access to only one file but
you have assigned (public) to the project folder containing that file, people
logging in as (public) — or adding ?public to your project URL in their Web
browser — will be able to see other files in the folder, depending on the
permission level you assign to (public).

It is not recommended that Administrators encourage non-members to
bookmark a page with a public URL. When such a page is bookmarked by a
Web browser, the browser does not include the ?public tag in the page
reference. Anyone wishing to return to this page must add the ?public string
to the end of the URL in the browser's Address field, or they will be prompted
for a username and password.

Public Access Restrictions

■ In addition to having project access restricted to select folders and files,
public members cannot see the contents of other folders not designated
as publicly accessible.

■ Public visitors also cannot view a list of project or site members.

■ Site Administrators can disable public members in the same way as other
site members. In the Buzzsaw bar, click Site Administration, then select
the Members tab. In the members list, select (public), and click the Disable
toolbar button.

■ Project Administrators cannot disable public members; instead, you must
restrict the public member's permissions or remove (public) from the
project. To remove (public), in the shortcut bar, click Project
Administration, then select the Members tab. In the members list, select
(public), then click the Remove button.

■ A file locked by a public member can be unlocked by any other person
who accesses the project as (public). See Locking and Unlocking a File (page
187) for more information.

■ Public members can see the Site Information page only if they have access
to a project on the site. If No Access permission has been assigned or if the
public member has been disabled, the Site Info page will be concealed from
view.

■ For security reasons, the (public) member may not be added to a group.

See also:

Adding a Member to a Project (page 97)
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Copying a Project URL (page 26)

Permissions (page 130)

Converting Project and Standard Folders

Overview

Site Administrators can save time by converting standard folders to project
folders and vice versa at any level of the tree view hierarchy. For example, if
the contents in a standard folder have grown to a point that it's difficult to
manage, you may want to convert the standard folder to a project folder and
then rename it as needed.

Conversely, it may be that you started with one project folder but the
organization of the project has changed and grown. All you need to do is
convert the project folder to a standard folder and then create a new project
folder and as many standard folders as you need to support the new
organization of your project.

Either way, the ability to convert folders allows you to manage project and
standard folders and quickly reflect the changes and growth of projects in
your organization.

There are a couple of differences between project and standard folders:
■ Project folders come with two separate HTML page options. Administrators

can customize what appears in the Project Info and Directory tabs simply
by assigning the desired URL address. Standard folders do not come with
HTML page options.

■ The project folder right-click menu allows Administrators the option to
notify members by email as changes are made to project assignments or
in the event that members permissions have changed. The standard folder
right-click menu does not offer this administrative option.

NOTE  Keep in mind that project and standard folders are automatically sorted
and placed in alphabetical order in the tree view. If you want to reposition a
converted folder, you must rename it alphabetically (first letter of new folder name)
for it to appear where you want it in the hierarchical tree view.

To convert standard and project folders:

1 Use the Project Selection menu to select a project.

2 In the shortcut bar, click Project Files.
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3 In the tree view, select the project or folder you want to convert.

4 Right-click and then select Convert to Project or Convert to Folder from
the menu.

5 The converted folder or project appears in the hierarchical tree view.
The converted item is automatically selected.

6 Rename the folder as desired.

See also:

About Project Files (page 171)

Folders (page 157)

Project Properties

The Properties command for a project accesses the same administrative tasks
that are available through the Project Administration icon in the Buzzsaw bar.
Select a project, right-click and choose Properties from the menu.

The properties window is displayed.
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■ General tab — see General Tab (page 56) for more information.

■ Members tab — see Members Tab (page 58) for more information.

■ Groups tab — see Groups Tab (page 110).

■ Companies tab — see Companies Tab (page 113).

■ Attributes tab — see for Attributes Tab (page 67) more information.

■ Permissions tab — see Permissions Tab (page 71) for more information.

■ Form Links tab — see Using the Form Links Tab (page 176) for more
information.

■ Activity Log tab — see Activity Tab (page 74) for more information.

■ Statistics tab — see Statistics Tab (page 75) for more information.

For information about the properties available to a folder, file, form log, form,
link, or note, see Using Properties (page 168).

See also:

About Project Administration (page 103)
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Ownership of a Project, Folder, or File

Available only to administrators.

When a project member creates a folder or adds a file to the project, that
member automatically has ownership of that item. This applies even if an
administrator changes that member's permission level to view access. That is,
the member can still edit that item. Administrators, however can change the
ownership of an item.

1 Use the Project Selection menu to select a project, folder or file.

2 Right-click and choose Properties.

3 Click the General tab.

4 Click the Ownership button. The Owner dialog box displays. The name
of the folder and file display at the top of the box. The current owner is
also displayed.

5 Select the member whom you now want to be the owner.

Replace owner on subfolders and file. Selecting this option means that the
member will have full access rights to all the folders and files below the item
listed at the top of the dialog box. Not selecting this option means that if the
member has view access to the sub-directories and files, that permission level
remains in place — ownership only applies to the item listed at the top of the
dialog box.

You can also assign and preserve a different permission level for a project
member at the folder of file level. All you need to do is lock the permission
set for that particular folder or file. Then, even if permission levels change
elsewhere in the project, the locked item is skipped, and the permission set
remains unchanged.

See also:

Ownership Dialog Box (page 407)

Project Properties (page 49)

Working with Site and Project Statistics

The Statistics tab is a useful maintenance tool for Site and Project
Administrators. You can quickly view important statistics for all the projects
on your site (or those for which you have Project Administrator permission).
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The statistical data that is available to you provides a convenient way to
perform regular project maintenance.

For example, if you find that deleted projects, folders, or files appear in the
statistics list, you can quickly select the name of the item, right-click, and
then choose to permanently delete it, thus reducing your storage. The statistics
tab can be an invaluable took in evaluating how your site storage is being
used.

How to access the Statistics tab:

1 Select the site or a project in the tree view.

2 In the Buzzsaw bar, click the Site Administration or Project
Administration icon.

3 Click the Statistics tab.

How to use the statistics tab:

On the statistics tab you can see:
■ Name(s) of existing project(s)

NOTE Deleted projects that appear in the statistics list continue to use storage
space until they are permanently purged from the system. If you want to
permanently delete a project from the statistics list (and system), hold down
the SHIFT key, right-click, and then choose Delete from the list.

■ Project size limit

■ Warning size limit

■ Available storage

■ Current size of project(s) currently on the site (Note that the number in
this field includes multiple file versions or discussions)

■ Number of project(s)

■ Number of folders contained in the selected project(s)

■ Number of files contained in the selected project(s)

■ Number of versions contained in the selected project(s)

■ Number of markups contained in the selected project(s)

■ Number of comments in the selected project(s)

■ Number of members in the selected project(s)

■ Version limit in the selected project(s)
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■ Administrator username(s) assigned to the selected project(s). The username
is the same as the login name.

NOTE Information on the contents of your Recycle Bin is also included in the
Statistics tab view.

How to save site or project statistics to a file:

1 In the Statistics tab view, click the Save Statistics button.

To choose the location on your computer where the statistics will be
saved, click the Browse button and navigate to the desired directory.

2 When you are finished, click OK.

How to use the right-click menu:

There is a right-click menu available on the Statistics tab which makes it
possible to take care of maintenance tasks such as converting files to folders,
renaming items, and restoring deleted items.

In the Name column of the Statistics tab, select the item that you want to
work with, click the right mouse button, and make a choice from the menu.

NOTE Right-click menu choices are different for deleted items. All right-click menu
options, including those for deleted items, are included in the following table.

What it doesCommand

Prints all contents in the Statistics tab view.Print

Print statistics for only the folder you have selected.Print Selected

Converts a project folder and all of its contents to a standard folder.Convert to Folder

Allows you to save the selected item to a local computer and under
a new name, if necessary.

Archive

Downloads the selected item to a local computer.Download
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What it doesCommand

Removes the selected item from the list (item is placed in the Recycle
Bin and flagged with a trash can icon). You can permanently remove
it from the system from the Recycle Bin.

Delete

If you want to permanently remove items from the system directly
from the Statistics list, hold down the SHIFT key, right-click, and then
choose Delete.
A confirmation dialog box is displayed before deleting the file from
the server. If you change your mind, it is possible to recover files and
folders.
See Recovering a Folder  (page 162).

Allows you to rename the selected item.Rename

Marks the files as read.Mark as Read

Use this command to manually lock a file so other members can't
change it. Use the Unlock command to release a lock that you previ-
ously put on a file.

Lock/Unlock All

Locks or unlocks the selected project, folder, or file permission list.Lock/Unlock Per-
missions

Displays the properties for the selected item. Allows Administrators
to modify the access rights for individual folders or project files.

Properties

Use this command to log in to another site.Login

Use this command to log out of the site.Logout

See also:

General Tab (page 56)

Groups Tab (page 61)

Members Tab (page 58)
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Site Administrator Tasks

About Site Administration

Overview

When a site is created it is assigned one administrator. This administrator can
add project members, who can also function as administrators if they are given
the proper permissions.

If you are the administrator, log into your site using the username and
password supplied to you. Once you are logged in, you can add site members
and projects. It is easier to add all members at the site level first and then
create the projects. After you create a project, you can assign the site members
to it, giving them the permissions they need to participate in the project.

Project members see only the project(s) to which they belong. If a user is not
assigned to any project, they will not see any projects when they log in. This
gives you complete control of security for any sensitive material.

NOTE Assign permissions carefully. Once users have Edit permission for a project,
they have the ability to overwrite files.

Many project members need just read-only (View or List) permission. Note
that a user can have View permission for one project and Edit permission for
another project. It is up to you as the administrator to decide who gets which
permissions for each project.

The Site Administrator icon is how you get to administrative tasks, including:
■ Adding members and groups

■ Changing permissions

■ Viewing a list of all the activities within the site (such as, who logged in,
which file was read and downloaded)

The administration tabs appear in the details view to the right of the shortcut
bar.

See also:

Creating a New Member (page 89)

Creating a Group (page 102)
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Permissions (page 130)

General Tab

To view the General tab, click the Site Administration icon in the shortcut
bar; the General tab is the first tab. Use the Site Administration General Tab
to view the following aspects of your site:

Site Properties

View site properties such as:
■ Site name

■ Site URL address

■ Date the site was originally created

Users

View the number of users in the site who are enabled, disabled and the
maximum number of enabled users in the site.

Storage

View the amount of space being used by files, the recycle bin, and mail. This
allows administrators to see how their site space is being used. Currently Site
Administrators cannot reclaim space associated with stored mail, only
individual users can delete their email. To see the amount of mail being stored
by an individual user, look at the Members Tab (page 58).

If you anticipate that your site will continue to grow in size beyond its current
storage space limit, please contact your Site Administrator or
bcs.support@autodesk.com to request a space increase.

Content

This section lists the total number of items that are in a site. Items include,
files, folders, projects, form logs, forms, edit locks and permission locks.

Site maintenance

The site maintenance area enables you set maintain the recycle bin.
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Click the Empty Recycle Bin button to purge any files that you have deleted
from your site.

Specify who can empty the Recycle Bin (thus permanently deleting files from
the site). By default all users can permanently delete files that they own or
have administrator permissions to. As a Site Administrator, you can specify if
all users, site administrators, or project administrators can permanently delete
files. If project members are restricted from emptying the Recycle Bin, then
deleting a file functions as a "soft" delete. That is, the file is sent to the Recycle
Bin where an Administrator can later delete it from the site.

Client Upgrade Management

This section enables you to specify the minimum version that you want site
members to use. This is useful if you do not want to require members to
upgrade to the latest version. If members are using a version that is older than
what you have specified as the minimum, then the next time they login to
the site they will be required to download the latest version. This may be a
more recent version than what you have specified. With this functionality
upgrading is only required if you set the Site Administrator's Required Version
to equal the latest version released by Autodesk.

Following is a description of the values in this section:

Current Version — the version that you are using. This refers only to you,
not to other site members.

Minimum Required Version — the minimum version that Autodesk
requires all site members to be using. This value is set by Autodesk and cannot
be changed by you. It is okay for members to use a more recent version than
what is required but not an older version.

Most Recent Version Available — the latest version available from
Autodesk. This version may not be the same as the Minimum Required Version.
For example, the minimum client version may be 7.0.10, but the most recent
version available is 7.1.25. Unless Autodesk has specified that you use 7.1.25,
upgrading is optional.

Your Site's Administrator Required Version — this is the minimum
version that you, as site administrator, require all site members to use. By
setting this value you can control whether members are required to upgrade
to the latest version. As long as you set this value to something less than the
most recent version, members do not have to upgrade. Or, you can require
all members to upgrade by setting this value to the latest released version.
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Following is an example of how this might work: Autodesk has set the
minimum client version to 7.0.10, but the last released version is 7.1.25. You
can set the minimum version to 7.1.25, 7.0.10, or something in-between.

When members do upgrade they will receive the latest version that Autodesk
has released. This may be a newer version than what you have specified as
the minimum. This is okay — members can use a version that is newer than
what you have required, but they cannot use a version that is older.

Upgrade Now button — click this button to upgrade to the latest version.
This initiates the downloading of the latest version. By clicking this button
you are only upgrading the client on the computer that you are using, not all
site members.

Edit Site Minimum Required Version — click this button to change the
minimum version number that you want to require for all site members. This
opens the Site Administrator's Minimum Required Version Dialog Box (page
429). This button is disabled if the Autodesk Most Recent Version and the
Autodesk Minimum Required Version are the same.

Currency

Use this option to set the currency format for the site. That is, if you want all
monetary values to display in US currency then make that selection here. Note
that this setting does not affect the actual formatting of the value. Each user's
system locale setting determines how the currency is formatted.

For example, if the site administrator has set the currency to USD (United
States Dollars) then a user in Germany would see 1,000.00. The value of this
money is still in US dollars but formatted according to local convention.

See also:

Groups Tab (page 61)

Members Tab (page 58)

Security Tab (page 79)

Members Tab

The Members tab is used by Site Administrators to:
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Create a new member

Create a new member if you have New Member privileges. See Creating a New
Member (page 89) for more information.

Edit a member

Click the Edit toolbar button,  . See Editing a Member (page 94) for more
information.

Delete a member

Click the Delete toolbar button,  , to delete the member from the site.

Add a member to a company

1 Select a member and right-click. Choose Add to Company. The Select
Company dialog box is displayed.

2 Select a company and click OK.

Import/Export users

Click the Import/Export toolbar button,  . See Importing and Exporting
Members (page 100) for more information.

See Filtering Options (page 424) for more information about how to customize
your view of this window.

Copy a member

Select an existing user and click the Copy toolbar button to use an existing
member as a template for a new user. That is, a member exists who belongs
to the same projects and has the permissions that you want the new member
to have. This is useful if you are adding a number of members to the same
projects and want to grant similar permissions and project memberships to
all the members.

Enable/Disable a member

Click the Disable toolbar button,  , if you want to restrict a user's activities
rather than delete their records or alter their permissions settings. A disabled
member cannot log into the site. Disabling a member is useful, if for example,
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an employee leaves your company. Disabling the member prevents him or
her from being added to projects but the member can still be searched on in
the Find window. If you need to find files that this member added or updated,
you will be able to do so if the membership is disabled. If the membership is
deleted you can not search for these items using the members name. Disabled
users do not count toward the site's maximum number of users.

To enable a disabled member, click the Enable toolbar button,  .

Note that there are three ways to disable a member within Buzzsaw:

1 Through the Site Administration Members tab.

2 When a member surpasses the allowable time for inactivity as specified
in the Member Inactivity section of the Security Tab (page 79).

3 When a member surpasses the allowable number of login attempts as
specified in the Login section of the Security Tab (page 79).

Reset member password

1 Select a member and click the Reset Password toolbar button,  .

2 In the Send Options dialog box select the options for sending the email.
You can choose to send the email immediately or edit the email before
sending. You can also select a language for the email text and how it
should be encoded.

3 Click OK.

NOTE Administrators can only reset the password of members who are enabled,
have a valid email address, and have previously logged in to the site.

Send welcome email

Click the Send Welcome email toolbar button,  . This email contains the
member's user name, password and a link to the project.

Welcome emails can only be sent to members who are enabled, have a valid
email address, and have never logged in to the site.
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Notify members of a change to their membership

To notify a member that they have been added or removed from a project, or
that their permission level has changed, click the Send Email toolbar button,

 .

See also:

Creating a New Member (page 89)

Editing a Member (page 94)

Importing and Exporting Members (page 100)

Groups Tab

The Groups tab is used by site and project administrators to add, edit, or delete
groups. Site Administrators and Project Administrators, who have the ability
to create members, can create site or project level groups. Groups can be created
a the site or project level. Site level groups can be added to any project within
the site. A project level group is created for a specific project and can only be
added to projects that the creator has administrator rights to.

By using groups to assign members, you treat many individuals as a single
entity, allowing you to manage dozens of individuals at once rather than one
at a time. For example, if there are many project members who require Review
permission, you might create a reviewers group, add all the appropriate
members to it, and then add that group to the project.

See Filtering Options (page 424) for more information about how to customize
your view.

Overview

Creating a group is an effective way to manage project members. Once a group
is created and added to various projects, then new members can be added to
projects via the group. Because the group is already a member of various
projects, the new member automatically has access to all the projects that the
group has access to.

Permissions are assigned at a group level. When a new member is added to
an existing group, that member has access to all projects, folders, or files where
the group is assigned. That is, everyone within the group has the same
permission. Individuals in that group can then work within the project at the
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assigned permission level. The default permission is View. For more
information see Permissions (page 130).

Once a site level group has been created the group can be added to any project.
Project level groups can only be added to the project that the creator has
administrator rights to.

When creating groups, it helps to keep the following thoughts in mind:
■ Private and hidden groups are effective ways to maintain confidentiality.

Members of a private or hidden group cannot be seen by other group and
project members. This is desirable if you want members to be able to update
project files but you don't want them to see who else is updating
documents. For more information see Private and Hidden Groups (page
128).

■ A group owner does not have to be a project administrator. It is possible
for an administrator to initially create a group and then transfer ownership
to a non-administrator. The group owner can then edit the group through
the Using the Member List (page 18).

■ You may add up to 500 members to a group at a time. To create groups
larger than 500 members, simply perform more than one add operation.

■ Review the organization of your project before creating groups. For example,
it's a good idea to organize and create separate groups according to job
function (owners, architects, general contractors, and so on). Then you
can apply the group to the appropriate projects.

Create a group

Click the New button to start the Creating a Group (page 102).

Edit a group

Click the Edit button. Follow the directions for Editing a Group (page 128).

You can also edit groups in the Using the Member List (page 18). Click the

Member List toolbar button,  . Right-click a group and choose Edit.

Delete a group

Site administrators can delete a site and project level groups; project
administrators can only delete project level groups. Group owners can delete
site and project level groups (but they cannot add groups to different projects).
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NOTE When a project level group is deleted from a project it is also deleted from
the site.

These steps will remove a group from the site.

1 In the Buzzsaw bar, click the Site Administration icon.

2 Click the Groups tab and select a group.

3 Right-click and choose Delete Group.

To remove a group from a project go through Project Administration  ➤ Project
Members. Right-click a group and choose Remove.

Permissions

A member can have multiple permission levels if he or she is given access to
an item as an individual and as a group member. The highest permission that
has been assigned to the member, regardless of whether it was assigned at the
group or individual level is, is how the member accesses an item.

For example, Jane Smith is a member of Group 1. Jane and Group 1 have
access to Project A. Jane had access to Project A, with View permission, before
she was added to Group 1. Group 1 has the permission of Edit to Project A.
Because Edit is a higher level of access than View, that is the level at which
Jane Smith accesses Project A.

The exception to this rule is if a member is assigned No Access as an individual
or as a group member. No Access overrides all other permission levels. Thus,
in the example above, if Jane was assigned View as an individual and No
Access as a group member, she would not be able to access Project A.

Site administrators can delete a site and project level groups; project
administrators can only delete project level groups. Group owners can delete
site and project level groups (but they cannot add groups to different projects).

NOTE When a project level group is deleted from a project it is also deleted from
the site.

These steps will remove a group from the site.

1 In the Buzzsaw bar, click the Site Administration icon.

2 Click the Groups tab and select a group.

3 Right-click and choose Delete Group.
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To remove a group from a project go through Project Administration
 ➤ Members. Right-click a group and choose Remove.

See also:

Editing a Group (page 128)

Creating a Group (page 102)

Private and Hidden Groups (page 128)

Companies Tab

The Companies tab is accessed through Site Administration. It displays a list
of companies that have been added to the site, the date the company
information was last updated and by whom.

Adding companies to your site enables you to associate a member with a
company. By doing so you can then easily organize members according to
the companies that they are associated with, or see all the members who are
associated with the company.

Create a new company

1 Click the New toolbar button. The New Company dialog box is displayed.

2 Enter the company information.

3 Select an attribute value for each attribute. The available attributes come
from the Attributes tab. The attributes that can be applied to a company
are: Company Type, Rating, Trade, MWDBE, Project Type, and Service.
You can edit the names and the values of these attributes. For more
information see Attributes Tab (page 67).

4 Enter the contact information for the company.

5 Click Create to create the company.

6 Click the Members tab to add members with the company, or click Close.

Companies created through Site Administration are not associated with projects
until a member who is associated with the company is added to the project.

64 | Chapter 6    Site and Project Administration



Add members to a company

Once a company has been created you can associate members with that
company. This is helpful if you want to organize members by company.

1 Select a company and right-click. Choose Add Members from the menu.

2 Select the members in the Available list and click Add.

3 To remove a member from the company, select the member in the
Selected list and click Remove.

4 If the member you want to add to the project does not exist, click the
Add New Member button. See Creating a New Member (page 89) for
more information.

When member is added to a project, the company that the member is
associated with is automatically added to the project.

Edit a company

1 Select a company and right-click. Choose Edit from the menu. The Edit
Company dialog box is displayed.

2 Click the Company Information to change attributes for the company
or the contact information.

3 Click the Company Members tab to add or remove members that are
associated with the company.

Delete a company

Select a company in the list and click the Delete Company toolbar button.
The company is deleted from the site.

NOTE You cannot delete a company that has any associated members. If the
company you want to delete has associated members then you must first reassign
the members to a different company, or choose to not associate the members
with a company at all.

Import companies

You can import companies instead of entering them manually. When
importing it is important to note that the file you import must be in the
following format.
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The file must be a CSV (comma separated value) file with one header line (the
contents of which are ignored) and must be UTF-8 encoded. Columns should
be separated by a comma and column headers should be in double-quotes.
Here is an example of what a CSV file looks like prior to import:

These column headers correspond to the fields in the Company Information
tab in the New/Edit Company dialog box. After importing your CSV file, it is
these fields that will be populated. Not all fields will be applicable to your
business needs. Use the fields that are appropriate for your business. When
importing, the columns should be in the following order using the same
column names.

NOTE All columns can be empty but they do have to be in the order outlined
below.

■ "Company Name"

■ "Vendor ID" — if the Vendor ID exists in the site then it is updated upon
import.

■ "Company Type"

■ "Rating"

■ "Trade (Primary)"

■ "Trade"

■ "Services"

■ "Project Types"

■ "MWDBE"

■ "Contract Limit"

■ "Contract Limit Money Type"

■ "Sales Tax Rate"

■ "Sales Tax Exempt No"

■ "Address1"
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■ "Address2"

■ "City"

■ "County"

■ "State"

■ "Postal Code"

■ "Country"

■ "Toll Free"

■ "Main Telephone"

■ "Main Fax"

■ "Website"

■ "Comment"

Export companies

You can export the companies and the associated information to a CSV file.

1 To export a company, select a company in the list and click the Export
toolbar button.

2 Click the Browse button and select a file on your hard drive.

3 Click Save.

4 Click OK.

The companies are exported to the file you specified.

See also:

Groups Tab (page 61)

Attributes Tab (page 67)

Members Tab (page 58)

Attributes Tab

The Attributes tab is accessed through Site Administration. Attributes are used
to define and categorize members and companies. Use the default attributes
or edit them to suit your business needs. The attributes are listed in the
Attributes tab, along with the last modified date and by whom the attribute
was edited.
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The available attributes can be applied to members (page 89) or companies
(page 64), although not all attributes can be applied to both companies and
members. The attributes, Company Type, Rating, Trade, MWDBE, Project
Type, and Service can be applied to companies. The attributes, Preferred
Contact Method, Rating and Trade, can be applied to members.

Buzzsaw comes with default attributes that cannot be deleted. These attributes
can be renamed but you cannot add new attributes.

Example of how attributes work

Attributes provide a powerful way to organize and categorize members,
companies, and even files. For example:

First, add the values Electrical, Plumbing, and Concrete to the attribute called
Trade. Now that the Trade attribute is defined you can apply that attribute to
members and companies. If you apply the Trade attribute to members, for
each member you can select a value such as Electrical or Plumbing. Now, you
have set the foundation to search for members who are of the Electrical trade.

Second, rename an attribute to be Region. Add the values Northern California,
Southern California, and Gulf Coast, to the Region attribute. Now you can
search for members that are of the Electrical Trade and are from Southern
California.

Edit attributes

Changes that you make in this tab are reflected in the companies (page 64)
and the Member Profile tab of the members (page 89).

1 In the Attributes tab, select an attribute and click the Edit toolbar button.
The Edit Attribute dialog box is displayed.

2 Edit the attribute label.

Next, you can add new values to the attribute, import or export values, or
hide values. See the remaining sections in this topic for details on how to
complete these tasks.

Add values to an attribute

You can add values to an attribute.

1 In the Attributes tab, select an attribute and click the Edit toolbar button.

2 Click the Add toolbar button.

3 Enter a name for the value and click OK.
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Hide/Display attribute values

To hide values:

Right-click a value and choose Hide. Use the SHIFT or CTRL key to make
multiple selections.

Hiding a value prevents it from being seen when creating or editing a member
or a company. The values available when completing those tasks is dependent
on which values you choose to hide or not hide. Hidden values cannot be
applied to Creating a New Member (page 89) or Companies Tab (page 113).

To display values:

Right-click a value and choose Display. Use the SHIFT or CTRL key to make
multiple selections.

Import attribute values

You can import attribute values instead of entering them manually. When
importing it is important to note that the file you import must be in the
following format:

The file must be a CSV (comma separated value) file with one header line (the
contents of which are ignored) and must be UTF-8 encoded. Columns should
be separated by a comma and column headers should be in double-quotes.
The columns should be in the same order as you see in the Attribute dialog
box. Following is an example of what a CSV file looks like prior to import.
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1 Right-click an attribute and select Edit.

2 In the Edit Attribute dialog box click the Import toolbar button.

3 Click the Browse button to select a file.

4 Click OK.

The attribute values are imported.

Export attributes and values

You can export attributes or attribute values to a CSV file.

To export attributes:

1 To export an attribute, select an attribute in the list and click the Export
toolbar button.

2 Click the Browse button and select a file on your hard drive.

3 Click Save.

4 Click OK. The attributes are exported to the file you specified.

NOTE When exporting attributes, values associated with that attribute are not
also exported. To export the values follow the next set of steps.
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To export attribute values:

1 Select an attribute in the list and click the Edit toolbar button. The Edit
Attribute dialog box is displayed.

2 Click the Export toolbar button.

3 Click the Browse button and select a file on your hard drive.

4 Click Save.

5 Click OK. The values are exported to the file you specified.

See also:

Companies Tab (page 64)

Members Tab (page 58)

Permissions Tab

The permissions tab is accessed through Site and Project Administration. The
matrix allows administrators to view and edit members and their permissions
in one window. You can view all the members in a site or project, which
project they belong to, and what their permission is for that project.

Navigating the matrix

In the Permissions Matrix window you can filter the list by project or by
members. You can further narrow this view by looking at one project or at
one group of people. For example, you can view just project administrators.

Use the Project drop-down list to see the users for a specific project. Regardless
of whether you are viewing the matrix by user or by project, you can
double-click a project to see sub-projects or folders.

Use the toolbar buttons at the top of the matrix to move up one level in the
project tree, send an email, refresh the matrix, or view contact information
for a user.

Export the data from the permissions matrix to a Comma Separated Value
(CSV) file. Click the Export button in the bottom left corner. The CSV file
contains the data in the current matrix. A CSV file is a file in which each piece
of data is separated by a comma.
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View Projects and Administrators

The Projects and Administrators view displays all Site and Project
Administrators and the projects for which they administer.

Projects for Project Administrators are listed in the Project column. Individual
projects are not listed for Site Administrators since they have permission to
all projects. Instead, the word "All" is listed in the projects column.

Click the user icon on the far left to sort members grouped according to their
user status: Site Administrator or Project Administrator. Users are differentiated
by their icon.

View by project

In this view, projects (and subfolders) are listed in the left pane. The members
are listed vertically in the right pane, with their permissions code displayed
underneath. Use the Project drop-down to navigate to a different project.

Double-click a folder in the left pane to reach sub-projects or folders.

View by member

In this view, the members are listed in the left pane and the projects are listed
vertically in the right pane. A user icon is displayed to the left of the user
name, distinguishing administrators from members.

To highlight a user and the projects he or she belongs to, select the user in
the left pane. That user's permissions are highlighted.

NOTE Members who have been added to a project may not display in the matrix
until he or she has logged into Buzzsaw. Also, if the user is added to the project
while the permission lock is set for a file, then the appropriate icon will not display
in the matrix.

Change permissions

There are multiple ways that you can change permissions. You can change
the permissions for one user in one project, one user in multiple projects,
many users in one project, or many users in multiple projects.

All of these changes are accomplished by selecting a row of users, a row of
projects or by pressing the SHIFT key and selecting individual permission
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codes. Once you have selected a member and project, right-click and select a
new permission:

These changes are not applied until you click the Apply button. Then, a
confirmation dialog box is displayed. To let members know that you have
changed their permission, select the Notify affected members by email check
box in the Verify Change Permissions window.

Change all member's permission for one project

To change permissions for all the members in one project, select the project
row and right-click. Choose the permission level that you want all the members
to have. Remember, by doing this, you are granting the same permission to
all of the project members.

You can also select multiple projects and change all the project member's
permissions at once. Select a project and hold the SHIFT key while selecting
a second project. Then, on a permissions code right-click and choose a new
permission level. For example:
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See also:

Groups Tab (page 61)

Members Tab (page 58)

Security Tab (page 79)

Activity Tab

The Activity Log tab is used to filter and view site or project data. The Activity
Log is available only to site administrators.

You can control what is listed by choosing from a series of "filters" that show
or hide information according to what you want to view. For example, you
can view a broad array of all site information or narrow the information by
restricting the Date, Users, Actions, or Types fields.

See also:

Working with Site and Project Statistics (page 51)

Site Administrator Tasks (page 55)
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Using the Activity Log (page 145)

Statistics Tab

The Statistics tab is a useful maintenance tool for Site and Project
Administrators. You can quickly view important statistics for all the projects
on your site (or those for which you have Project Administrator permission).
The statistical data that is available to you provides a convenient way to
perform regular project maintenance.

For example, if you find that deleted projects, folders, or files appear in the
statistics list, you can quickly select the name of the item, right-click, and
then choose to permanently delete it, thus reducing your storage. The statistics
tab can be an invaluable took in evaluating how your site storage is being
used.

How to access the Statistics tab:

1 Select the site or a project in the tree view.

2 In the Buzzsaw bar, click the Site Administration or Project
Administration icon.

3 Click the Statistics tab.

How to use the statistics tab:

On the statistics tab you can see:
■ Name(s) of existing project(s)

NOTE Deleted projects that appear in the statistics list continue to use storage
space until they are permanently purged from the system. If you want to
permanently delete a project from the statistics list (and system), hold down
the SHIFT key, right-click, and then choose Delete from the list.

■ Project size limit

■ Warning size limit

■ Available storage

■ Current size of project(s) currently on the site (Note that the number in
this field includes multiple file versions or discussions)

■ Number of project(s)

■ Number of folders contained in the selected project(s)
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■ Number of files contained in the selected project(s)

■ Number of versions contained in the selected project(s)

■ Number of markups contained in the selected project(s)

■ Number of comments in the selected project(s)

■ Number of members in the selected project(s)

■ Version limit in the selected project(s)

■ Administrator username(s) assigned to the selected project(s). The username
is the same as the login name.

NOTE Information on the contents of your Recycle Bin is also included in the
Statistics tab view.

How to save site or project statistics to a file:

1 In the Statistics tab view, click the Save Statistics button.

2 To choose the location on your computer where the statistics will be
saved, click the Browse button and navigate to the desired directory.

3 When you are finished, click OK.

See also:

Activity Tab (page 74)

Members Tab (page 58)

Security Tab (page 79)

Limits Tab

Use the Limits tab to set size limits for projects. A default limit can be set for
all projects and can then be edited at any time on a project by project basis.
You can also set a warning size limit so that an email is sent to project and
site administrators with a warning that the project is approaching its size limit.

Size limits are optional. You do not have to set limits on any of the projects
in your site, or you can set a limit for only one or two projects.

The Limits tab gives you an overview of your total site storage, the available
storage and the current storage being used. Items in the Recycle Bin count
toward the total project size limit. Thus, if the project has exceeded its limit,
you may be able to gain space by deleting the recycle bin.
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Project administrators can view the limit for a specific project by looking at
the General Tab (page 104) for a specific project.

To edit default settings for all projects:

To set the default size limits for all projects within a site, click the Edit Defaults
button.

Changing the default size limits affects all projects created after changing this
setting. Once the default limits have been changed all projects created after
have the new size limit. Existing projects are not affected by the new size limit
defaults.

Project size limit:

Choose a specific size limit for your project, or leave it at unlimited. Note that
no site has unlimited space. The "unlimited" option means that the users can
continue adding files to this project until the size limit for the site is reached.

Size limit notifications:

If you choose a size limit for the project then the notification options are
enabled. You can send an email notification to site administrators, project
administrators, or site members.

To send an warning email, select the Send warning notification... option. You
must also specify at when the warning email should be sent. For example, if
the total project size is limited to 500 MB, you can specify that the warning
notification is sent when the project reaches 450 MB.

If the warning notification is not selected, then a notification is only sent
when the project reaches it's limit.

Select which members should receive the email notifications: site
administrators, project administrators or individual site members. Note that
even though you can send the notification to site members and project
administrators, only site administrators have the ability to increase a project's
size.

Upon receiving the notification, members can delete files to increase the
project's available space.

To edit limits for multiple projects:

The Edit Limits dialog box has the same options as the Edit Defaults dialog
box. The difference is that the Edit Limits dialog box options are for changing
the limits for one or more projects. Whereas the Edit Defaults dialog box is
for changing the size limits for all new projects within the site.
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Project Size limit:

To change the size limit for a project select Unlimited or enter a new number.

Size limit notifications:

Choose who should receive a warning notification and/or a notification when
the project has exceeded its size limit. The recipient can be site administrators,
project administrators, or project members.

NOTE You can use this option to edit the size limit for multiple projects by selecting
multiple projects in the existing projects list.

To preview the email notification:

You can preview the email that is sent to administrators, warning them that
the project is approaching its size limit, or has exceeded its limit.

Click the Preview button to see the text that will be emailed to the selected
recipients. This text is not editable.

NOTE The settings you define in the welcome email options dialog box are not
applied to warning notification emails.

To save limits information to your hard drive and to print:

You can save the information in the Limits tab to your hard drive as a .TXT
file. This file can be saved in one of three formats: comma separated, tab
separated, or vertical tab separated.

1 Select the rows of information that you want to save.

2 Click the Save Limits button. If no rows are selected then only the general
information at the top of the window is saved to the .txt file.

3 To choose the location on your computer where the limits file will be
saved, click the Browse button and navigate to the desired directory.

4 In the Field Delimiter drop-down list, select how you want the
information separated. For example, if you choose comma, the
information displays as: Project A, 83.98 MB, 125 MB, 100 MB, All Site
Administrators.

5 Selecting Use Quoted Strings inserts quotes between each of the values.
For example, "Project A", "83.98 MB", "125 MB", "100 MB", "All Site
Administrators".

6 When you are finished, click OK.
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After you have saved the Limits tab information to your hard drive you can

print the file. You can also print by clicking the Print toolbar button, 
, while viewing the Limits tab window. Only selected rows are printed. If you
have not selected any rows, then nothing is printed.

NOTE Your printer settings may need to be adjusted in order to fit all the
information onto one page.

See also:

Activity Tab (page 74)

Security Tab (page 79)

Statistics Tab (page 75)

Security Tab

The security tab is accessed through Site Administration.

Password Age

Password age enables you to set the number of days that a password is valid.
After that time members need to create a new password. This setting is optional
and applies to members using the Buzzsaw software or PRODNAME Web
Access (page 5)ss.

1 Select Password Age on the left.

2 Select the option requiring members to change their password after a
set number of days.

3 Enter the number of days a password is valid. After this number of days
has passed members must change their password. The minimum number
allowed is one day; the maximum number allowed is 999 days. For
example if you set the number of days to 90, then on day 91 a member
has to change his or her password upon login.

4 If selected you can exempt individual members from the password age
restriction. Click the Select button. The Select Exempted Members dialog
box is displayed.

5 Select members in the Available list and click Add.

6 Click OK and you are returned to the Security tab.
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Password Requirements

This section enables to you require members to create strong passwords. This
means that passwords must adhere to certain rules. Requiring members to
create strong passwords increases site security. These restrictions are optional
and apply to members using the Buzzsaw software or PRODNAME Web Access
(page 5)ss.

NOTE If you do not select any of the options in the Password Requirements section
then the following criteria apply to password creation: passwords must be at least
eight characters long and must contain at least one uppercase character and one
number. For example: Changeme1.

1 Select Password Requirements on the left.

2 Select the option, Enable Strong Passwords to require members to create
a password that must adhere to specific criteria. Selecting this option is
a quick way to require members create a password that meets the Strong
Password requirements. See Password Requirements (page 443) for more
information.

3 If Enable Strong Passwords is selected then you can customize the criteria
for creating a more secure password. Select from the following options:

Contain a special character — passwords must contain at least one
special character. Special characters are: ({}[],<>;:’”?/|\`~!@#$%^&*()_-+=).

Cannot contain any words four characters long — passwords
cannot contain words found in a standard English dictionary that are
four characters long or greater.

Cannot contain first, last or user name of member — passwords
cannot contain the member's first name, last name or user name.

Must be different from previous passwords — use these two
options to specify that a password must be different from past passwords;
and differ from passwords used in the specified number of past months.
These two options can be used together or separately.

4 Select one of the enforcement options:
■ Immediately — all members must change their password to meet

the criteria you selected, the next time they log in

■ Upon password creation — members are required to change their
password when their current password expires or when creating a
new password. Until either of those events occur their current
password will work.

80 | Chapter 6    Site and Project Administration



Login

Select Login on the left. The following options are available:

Enable Automated Password Assistance

This option only applies to members using the Buzzsaw software.

Select this option if you want site members to receive password assistance.
That is, members can set-up a security question that allows them to request
a new password. This works in the following sequence:

1 Member forgets password and clicks the I forgot my password button
in the login dialog box.

2 Member enters identifying information: site name, user name or, email
address associated with user profile. An email is sent to the member
containing a link.

3 Member clicks the link in the email which takes him or her to a dialog
box containing their security question.

4 Member answers security question. The member has 5 attempts to answer
the security question correctly. If they do not answer correctly the Site
Administrator must reset the password.

If the member answers the security question correctly then he or she is allowed
to create a new password.

Selecting this option means that members will be able to go through the
previous steps in order to create a new password. If you do not select this
option then only you, the Site Administrator, can reset passwords.

Disable Member

This option applies to members using the Buzzsaw software or PRODNAME
Web Access (page 5)ss. The following options are available:

Disable member after... — Select this option if you want to disable a
member after a specified number of failed login attempts. Do not select this
option if you do not want to restrict how often a member can attempt to
login.

If selected, you then have the option to re-enable the member after a specified
period of time.
■ Under Automatically re-enable members, select a period of time after which

members should be enabled.
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■ Or, select the option that requires members to be re-enabled by a site
administrator (page 107).

Enable Remember this Password

This option only applies to members using the Buzzsaw software.

Selecting this option enables members to select the option, Remember this
Password in the Log In Dialog Box (page 398). If you do not select this option
then members will have to enter their password every time they log in.

Session Time Outs

Session time outs enable you to specify the amount of time a member can be
inactive before the session times out. For example, if a member is inactive for
two hours he or she is automatically logged out. These settings are optional
and apply to members using the Buzzsaw software or PRODNAME Web Access
(page 5)ss.

1 Select Session Time Outs on the left.

2 Select the period of time a member using the Buzzsaw software needs to
be inactive before it times out.

3 Select the period of time a member using Buzzsaw Web Access needs to
be inactive before it times out.

Member Inactivity

Member inactivity enables you to specify the amount of time a member can
be inactive (in terms of days) before he or she is disabled. This setting is
different from session time outs because it calculates a member's inactivity in
two ways:

1 By the date and time a member logs into the site. That is, if you specify
that members are to be disabled after five days of inactivity then the five
days are calculated from the last date and time that the member logged
in.

2 When the site administrator enables a member. That is, if you specify
that members are to be disabled after five days of inactivity then the five
days are calculated from the date and time that the site administrator
enables the member, not from the last time the member logged in.
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Session time outs differ because that feature monitors a member's activity
once the member has logged in. The member inactivity option monitors
members who have not logged in to the site.

This setting is optional and applies to members using the Buzzsaw software
or PRODNAME Web Access (page 5)ss.

1 Select Member Inactivity on the left.

2 Select the number of days after which a member should be disabled.

3 If exemptions are selected you can exempt individual members from
being disabled regardless of how many days they are inactive. Click the
Select button. The Select Exempted Members dialog box is displayed.

4 Select members in the Available list and click Add.

5 Click OK and you are returned to the Security tab.

IP Restrictions

IP restrictions enable you to allow access to your site based on IP address. This
setting is optional and applies to members using the Buzzsaw software or
PRODNAME Web Access (page 5)ss.

Grant/Deny Access

1 Select IP Restrictions on the left.

2 Select the option to Restrict or grant access based on IP address.

3 Select one of the following options:
■ all computers except the following — if selected then any

computer will be able to access your site except for the IP addresses.
You are denying access if you select this option.

■ no computers except the following — if selected then only the
IP address listed will be able to access your site. You are granting
access if you select this option.

Edit IP Addresses

1 Click the Add button. Depending on which option you selected in step
3 the Deny or Grant Access dialog box is displayed.

2 Select an option and enter the appropriate IP address, or a range of
addresses.

3 Click OK. You are returned to the Security tab. The IP addresses you
entered are listed in the IP address list.
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4 Select an IP address in the list and click the Edit button.

5 Edit the address or select a different option.

6 Click OK.

Remove IP Addresses

Select an IP address in the list and click the Remove button.

File Transfers

Select File Transfers on the left.
■ If security or privacy is not an issue, select the Allow non-secure file

transfers option.

■ If security or privacy is an issue, clear the Allow non-secure file transfers
option.

Use this option to specify whether to transport files between your site and the
server using the HTTP or HTTPS protocol. HTTPS provides a secure method
of transferring files through a Secure Socket Layer (SSL). The tradeoff is that
it takes longer to encrypt the file, thus the overhead processing takes longer.

NOTE All other communications between your site and server are performed using
HTTPS. Passwords and other site information are never transferred between the
client and server without using SSL.

NOTE  If you want to load files from your site into AutoCAD, you must select the
Allow non-secure file transfers check box. If you do not, you may experience
unpredictable system results.

Changes made in this tab are applied when you click the Apply button. If you
navigate away from this window without clicking Apply, an alert is displayed
asking to you apply or cancel the changes. Clicking the Reset button clears
your selections and reinstates your previous selections. For example, the
password age is set to 90 days. You change it to 60 days and then click the
Reset button. The option reverts to 90 days.

See also:

Activity Tab (page 74)

Limits Tab (page 76)

Members Tab (page 58)
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Welcome Email Options

Only available to site administrators.

This dialog box is accessible through the Tools menu  ➤ Welcome Email
Options and from the Import Wizard — Send Email step. If you are using the
ProjectPoint client embedded in Internet Explorer, then access this dialog box
through the ProjectPoint menu.

You can configure the welcome email to determine what is contained in the
email. The welcome email includes the new member's user name, links to the
support center, contact information, and attachments that you can specify.

Site administrators, and project administrators with the ability to create new
members, have the option to further edit the welcome email by selecting the
"Display Send Options..." option in the Preferences dialog box Email tab. As
long as this option is selected then you will always be able to further edit the
welcome email before it is sent.

The Welcome Email Options dialog box is divided into two tabs:

Subject and Body

In Subject and Body tab you can create a customized welcome email for your
users. You can enter your own text for the body of the message. You can also
set the priority that all welcome emails should be sent with and whether the
email should be flagged for follow-up.

NOTE The text you enter for the subject and body will not be translated by
Buzzsaw. Therefore if you are typing text in German, English users will see German
text. By default, the email is sent in Native Encoding which means that the subject
and body can only be in one character set (that is, you can not mix Japanese
content with Korean content). If you choose to send the welcome email in Unicode,
the subject and body can have mixed content (that is, you can mix Japanese
content with Korean content, Chinese content, German content, etc.).

Priority — Select the priority level that all welcome emails should be sent
with: Normal, High, or Low.

Flag for Follow-up — Select a flag that you want displayed on all welcome
emails. The default is Do not Flag. You can choose from a variety of flags such
as Do not Forward. The selected flag is displayed in the email above the To
field. Click the Preview button to see what this looks like in the email.

Subject — Enter the text that you want to be displayed in the subject of the
email.
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Message — Enter the text that you want to be displayed in the body of the
email.

Use Default Subject and Message — Select this option to populate the
Subject and Message fields with the default text. This option is selected by
default. To customize the message, de-select the option.

Advanced Options

In the Advanced Options tab you can select to have links to various support
elements, contact information and add attachments.

The following options are available:

Links to the Support Center — select this option to include links to the
support center, training information, and system requirements.

Contact information — use these options to include a site member's contact
information. The contact information can be for the administrator who creates
the new member, administrators of all the projects to which the member has
access to, or site members who are not administrators. Including contact
information is useful to provide in case the new member loses his or her
password or needs to request access to a project or file.

Attachments — select the Attachment option to add a file to every outgoing
welcome email. After selecting the option click the Select button to browse
to the attachment on your hard drive, or within your Buzzsaw site.

After you have made your selections, you can preview the email to see what
it will look like when new members receive it.

Preview the email

Click the Preview button to see the changes that you made. You will see the
text that you entered, plus the options that you chose to include in the body
of the email.

When you are working in either of the two tabs, the buttons OK, Cancel and
Restore Defaults, are available.
■ OK — Click this button to save your changes.

■ Cancel — Click to close the window without saving your changes. Note
that the default text is not restored when the Cancel button is clicked.

■ Restore Defaults — Click to cancel any changes that you made and to
restore the default text and options. Note that this option restores the
default settings on all tabs, not just to the current tab in focus.
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See also:

Setting Preferences (page 19)

Members Tab (page 58)

Managing Site Information Pages

Available to Site Administrators only.

Information pages refer to dashboards as well as the page called "information
page." All the pages that are listed in the Project Information menu are called
Information pages. You can edit, add, remove, control access to, and control
the display order, in Site Setup. Actions relating to project information pages
are tracked in the Activity log.

You can select a custom information page to display for the site. Buzzsaw
comes with default information pages. By default projects display the
automatically generated pages.

Information pages can be configured at any point for the site. An information
page can be an HTML file or an image file (e.g., gif, bmp).

1 Click the Site Setup menu and then Information pages.

2 To add a new page click the Add Page button. The Add Information
page is displayed.

3 Enter a name for the page in the Page Name field. You can accept the
default name or enter a different name.

4 Select a page by clicking the Select Source drop-down list. From this
menu you can select one of the automatically generated pages, or browse
the files in your site or on your computer for a new page.

5 Select which members can view this page: all project members or selected
individuals.

Controlling who can view the informatoin page

As an administrator you can control which members view each page. If a
member is not given the ability to view an information page, then the page
is not displayed in the Project Information menu. By default, all project
members who have view access or greater can view all information pages with
the exception of the Executive Summary. The Executive Summary's initial list
access includes administrators only.
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If a member is given access to view an information page but does not have
sufficient permission to see the page, then an error message will display when
the member tries to view the page.

If a project member does not have access to view any information pages, then
the Project Information menu does not display in the title bar.

You can control who has access to the information page, and when they view
it.

NOTE This is a powerful option. You can choose to restrict a member from seeing
a dashboard. Beware that doing so may prevent the member from viewing assigned
items.

Changing the page order

As an administrator, you can control the user's experience of what he or she
sees and in what order.

If you want the information pages to display in a different order, select a page
and use the Move Up or Move Down buttons.

You can also specify which page the user sees upon login for each session. To
do this:

1 Select a page from the list.

2 Select one of the following options:
■ First information page the user has access to view - if selected

the member will see this view when he or she initially logs into the
site.

■ Files view - if selected the member will see the tree view in the
details pane.

■ Last page viewed by the user - the last page the member viewed
will be the first page the member sees the next time he or she logs
in.

These settings apply to the members specified in the Add Information Page
(page 438) dialog box. That is, either all project members or specific individuals.

Removing an information page

Select a page and click the Remove button.
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Tracking Project Information pages in the Activity Log

All actions pertaining to the management of Project Information pages are
tracked in the Activity Log. These actions include:

Project Setup - Information Pages

■ Add page

■ Edit page

■ Change name

■ Change file

■ Remove page

■ Change page order

■ Change access list

Project Setup - Initial View

■ Change initial view for site

■ Change initial view for project

See also:

Step 5: Manage Information Pages (page 269)

Using the Activity Log (page 145)

Information Pages (page 151)

Creating a New Member

Before a member can participate in a project, a member must be created. Then,
the member can be added to projects and groups. Site Administrators can
create, edit, and remove members, and manage member access to projects
and groups. This dialog box can be accessed through the member management
windows:

Site Administration  ➤ Members tab

Project Administration  ➤ Members tab Member List

Project Properties  ➤ Members tab
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Click the Members tab and then click the New toolbar button. Use the
following four tabs to create the new member's profile:

General

1 From within the New Member dialog box click the General tab.

2 In the Identification section, enter a user name, first name, last name
and email address for the new member.

A password is automatically assigned to the member. When the member
logs in for the first time, when a password has been reset, or if the
password has expired, the member is required to create a new password.
Site administrators can require members to create strong passwords. See
Security Tab (page 79) and Password Requirements (page 443) for more
information.

If a strong password is not required then passwords must start with a
letter, be 8 characters long, and contain at least one capital letter and
one number.

3 Enter a comment if desired. Comments can only be seen by site
administrators.

4 To not associate the member with a company, select the Do Not
Associate member with a company option.

or

5 To associate the member with an existing company, select the Select
from existing companies option.

6 Click the magnifying glass to open the Select Company dialog box.

7 Select a company from the list and click OK.

8 To create a new company select the Enter Company Name option
and enter a name in the Company Name field.

9 Click the Create Company button and complete the required fields.

10 Click the Create button to return to the New Member dialog.

11 Enter contact information as desired, or, select the option, Use Company's
contact information for this member. The company contact information
is displayed in the contact fields.

NOTE In order for certain information to display in the Members tab (page
58) and the Member List (page 18) window, you must fill out the contact
information. For example, if you want to be able to sort the site members
by city, then you need to fill in the City field.
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12 If you are finished creating the member click the Create button,
otherwise click the Project Memberships or Groups Memberships tab to
add the member to a project or a group.

Member Profile

In this tab you select the attributes that you want to be associated with the
member. The attributes displayed in this dialog box come from the Attributes
Tab (page 67). By applying attributes to a member you are categorizing the
member, thus making it easier to search for the member by attribute name.
The attributes that can be applied to a member are: Preferred Contact Method,
Rating and Trade.

1 Click the drop-down arrow for the available attributes and select a value.

2 Click Create.

Project Memberships

1 From within the New Member dialog box click the Project
Memberships tab. In this tab you can add or remove members from a
project, set their permission level and set their administrative rights.

2 Set the administrative rights for the member.
■ Site Administrator — Grants the user access to all files and data

on the site, as well as full control to make changes to permission
settings and project and group membership.

When you select this option a warning dialog box is displayed,
reminding you of a Site Administrator's ability to affect site and
project administration. This is a powerful permission setting, assign
it carefully!

■ Add New Member/Edit Member — Enables the member to create
new site members and site level groups. You will also need to give
the member the permission of administrator to at least one project.
This option is not necessary to create a project administrator.

3 Click the Add to Project toolbar button. The Add to Project dialog box
is displayed. Select a project and a permission level and click OK. The
project is displayed in the project list along with the member's permission
level for that project.
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NOTE Use the tree view toggle to view the projects in a hierarchical list.
This makes it easier to see where the project is in relation to the hierarchy.
If you are changing a member's permission for a specific project it is helpful
to see what sub-projects or folders are affected by the permission change.

4 Use the Membership column to see how the member was added to a
project. That is, as an individual member or as part of a group.

5 To remove a member from a project select the project in the list and
click the Remove toolbar button.

6 If you are finished creating the member click the Create button,
otherwise click the Group Memberships tab to add the member to a
group.

Group Memberships

1 From within the New Member dialog box click the Group
Memberships tab.

2 Click the Add toolbar button. The Select Group Dialog Box (page 434) is
displayed. Select a group and click OK.

3 To remove a member from a group select the group in the list and click
the Remove button.

4 To view the members of a group click the plus sign to the left of the
group name.

When finished click the Create button. If the Send Options Dialog Box (page
427) is displayed, select the options that you want. The new site member appears
in the Members list.

NOTE To create multiple site members without leaving the window, click Create
as you complete an individual's record. The new record is completed, and you
can continue to add additional members without leaving the Site Administration
window. To close the window and accept changes you have made since the last
time you clicked Create, click Close.

Assigned permission versus actual access

A member can have multiple permissions to one project (or folder or file) if
he or she is given access to an item as an individual and as a group member.
This can occur if the member is given permission to the project as an individual
with one permission level, and as a member of a group that has a different
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permission level. This results in members having “assigned” permission and
“actual” access to a project.
■ Assigned permission — refers to the permission level that was assigned

to a member as an individual member.

■ Actual access — refers to the highest permission by which the member
can access an item (file, folder, or project). This permission can be derived
from either a group membership, or an individual project membership.

The highest permission that has been assigned to the member, regardless of
whether it was assigned at the group or individual level, is how the member
accesses an item.

For example, Jane Smith is a member of Group 1. Jane and Group 1 have
access to Project A. Jane had access to Project A, with View permission before
she was added to Group 1. Group 1 has the permission of Edit to Project A.
Because Edit is a higher level of access than View, Jane can now access Project
A with Edit permission.

The exception to this rule is if a member is assigned No Access as an individual
or as a group member. No Access overrides all other permission levels. Thus,
in the example above, if Jane was assigned View as an individual and No
Access as a group member, she would not be able to access Project A.

To view a member's assigned or actual permission level in the New Member
dialog box:

2 Within the New Member dialog box click the Project Memberships
tab.

3 Select either display option, Assigned Permissions or Actual Access. The
values in the Permission column may change depending on how the
member is able to access the project.

NOTE The Membership column lists all of the ways a member can access a
project. It lists access via individual membership and group memberships.
The method by which the member's actual access is derived from appears
first in the Membership column. Thus, if a member's actual access is Edit
through a group membership, then the group name is listed first, followed
by the project membership.

When finished, click the Create button. If the Send Options dialog box is
displayed, select the options that you want. The new site member appears in
the Members list.
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NOTE To create multiple site members without leaving the window, click Create
as you complete an individual's record. The new record is completed, and you
can continue to add additional members without leaving the Site Administration
window. To close the window and accept changes you have made since the last
time you clicked Create, click Close.

See also:

Editing a Member (page 94)

Permissions (page 130)

Members Tab (page 58)

Editing a Member

Site Administrators can make changes to site member information over the
life of a project. (Project administrators can only remove members from a
project that they administer, and create or edit members if they have New
member privileges.) Site administrators can also disable a user, which restricts
that member's access to the project or site without requiring a change to the
member's permissions.

If the member has never logged in, then the Send Welcome Email button is
enabled. If the member has previously logged in then the Reset Password
button is enabled.

To edit a member's information:

1 In a member management window select a member, right-click and
choose Edit.

2 Click the General tab make changes as needed to the Identification,
Company or Contact information.

3 Click OK.

To add a member to a project:

1 In a member management window select a member, right-click and
choose Edit.

2 Click the Project Memberships tab.
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3 Edit the Administrative rights if necessary. Choose an option to make
the member a site administrator or to allow a project administrator to
create members and groups.

4 Click the Add to Project button.

5 Select a project from the list and click OK.

6 Select a permission level. Members added to a project for the first time
are automatically assigned view permission. You can select a different
permission from the Permission drop-down list.

7 Use the tree view toggle to view the projects in a hierarchical list. This
makes it easier to see where the project is in relation to the hierarchy. If
you are changing a member's permission for a specific project it is helpful
to see what sub-projects or folders are affected by the permission change.

8 Use the Membership column to see how the member accesses the project.
That is, as an individual member or via a group membership. The method
by which the member's actual access is derived from appears first in the
Membership column. Thus, if a member's actual access is Edit through
a group membership, then the group name is listed first, followed by
the project membership.

9 Click OK.

Depending on the options you have selected in the Preferences dialog box,
the project members may be notified that they have been added to the project.
To change when members are notified of a membership change, go to the
Setting Preferences (page 19) and make your selections.

To add a member to a group:

1 In a member management window select a member, right-click and
choose Edit.

2 Click the Group Memberships tab.

3 Click the Add toolbar button. The Select Group dialog box is displayed.

4 Select a group and click OK.

5 Depending on the options you have selected in the Preferences dialog
box, the project members may be notified that they have been added to
the group. To change when members are notified of a membership
change, go to the Email tab of the Preferences dialog box and make
your selections.
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To remove a member from a project or group:

1 In a member management window select a member, right-click and
choose Edit.

2 In the Project Memberships or Group Memberships tab, select a project
or a group and click the Remove toolbar button.

To edit a member's attributes:

1 In a member management window select a member, right-click and
choose Edit.

2 Click the Member Profile tab.

3 Select the attribute values that you want applied to this member.

4 Click OK.

To edit multiple members:

You can edit the contact information for multiple members at one time.

1 In a member management window select two or more members using
the SHIFT and CTRL keys.

2 Right-click and choose Edit.

3 Modify the fields as necessary.

4 Click OK.

To view a member's assigned permission or actual access:

A member can have multiple permissions to one project (or folder or file) if
he or she is given access to an item as an individual and as a group member.
This can occur if the member is given permission to the project as an individual
with one permission level, and as a member of a group that has a different
permission level. This results in members having “assigned” permission and
“actual” access to a project.
■ Assigned permission — refers to the permission level that was assigned

to a member as an individual member.

■ Actual access — refers to the highest permission by which the member
can access an item (file, folder, or project). This permission can be derived
from either a group membership, or an individual project membership.
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The highest permission that has been assigned to the member, regardless of
whether it was assigned at the group or individual level, is how the member
accesses an item.

For example, Jane Smith is a member of Group 1. Jane and Group 1 have
access to Project A. Jane had access to Project A, with View permission before
she was added to Group 1. Group 1 has the permission of Edit to Project A.
Because Edit is a higher level of access than View, Jane can now access Project
A with Edit permission.

The exception to this rule is if a member is assigned No Access as an individual
or as a group member. No Access overrides all other permission levels. Thus,
in the example above, if Jane was assigned View as an individual and No
Access as a group member, she would not be able to access Project A.

You can view a member's assigned or actual permission level in the Edit
Member dialog box:

2 Within the Edit Member dialog box click the Project Memberships
tab.

3 Select either display option, Assigned Permissions or Actual Access. The
values in the Permission column may change depending on how the
member is able to access the project.

NOTE The Membership column lists all of the ways a member can access a
project. It lists access via individual membership and group memberships.
The method by which the member's actual access is derived from appears
first in the Membership column. Thus, if a member's actual access is Edit
through a group membership, then the group name is listed first, followed
by the project membership.

See also:

Adding a Member to a Project (page 97)

Creating a New Member (page 89)

Permissions (page 130)

Adding a Member to a Project

Once a project is created, administrators can add members. Until a member
is explicitly added to a project, he or she can not access the data within the
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project. The tasks and activities available to members depends on their assigned
permission levels.

Project Administrators can also add existing members to one or more projects
(Project administrators must have administrator permission for each project
they wish to add members to). They can create site level groups if they have
been given the permission to create new members and groups.

NOTE If you would like to add a person to a site or project but cannot find that
person's name in the list of available members, the Site Administrator must first
add the person as a site member — or give you permission to create new site
members. Contact your Site Administrator to make a request.

To add a member to a project:

1 In the project tree view, select a project.

2 In the shortcut bar click the Project Administration icon.

3 Click the Members tab.

4 Click the Add toolbar button to display the Add Project Members dialog
box.

5 In the Available members list, select a member's name and then click
the Add button.

Use the SHIFT and CTRL keys to add multiple members.

NOTE If you would like to add a person to a site or project but cannot find
that person's name in the list of available members, the Site Administrator
must first add the person as a site member — or give you permission to
create new site members. Contact your Site Administrator to make a request.

6 The member's name is displayed in the Selected section in the lower
pane of the window.

7 From the Permission drop-down list, choose a permission level for the
member(s). The same permission is applied to all the members being
added. Members permissions can be changed in the Members tab. See
Permissions (page 130) for more information.

By default, all new members to the project are assigned view permission.
Use the Permission drop-down list to change the permission level.
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8 Click OK to add the member to the Project Members list. If you selected
the option on the Members tab to notify members by email that they
have been added to a project or their permission level has changed, the
email is sent now.

See also:

Creating a New Member (page 89)

Creating a Group (page 102)

Private and Hidden Groups (page 128)
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Importing and Exporting Members

Site Administrators can save time by using the Import/Export feature when
adding members to a site.

For example, when you import user information from your Microsoft Outlook
account list (a multi-step process), the specified information is automatically
copied to a new member record in Buzzsaw. Once the imported information
is in Buzzsaw, all you have to do is add the desired site- or project-specific
information to the new member's record.

Import user information

1 In the shortcut bar, click Site Administration.

2 Select the Members tab and click the Import/Export toolbar button,

 .

The Import Export Members Wizard appears.

3 In the Action section, click Import.

4 In the File Name section, click Browse and navigate to the file you
want.

5 Use the File type drop-down menu to choose the file type you want.
Choices include: All files [*.*], Comma Separated Variable Files [*.csv],
or Tab Delimited Files [*.txt].

6 Click Open.

7 Use the Delimiter field to indicate what separator appears between
imported or exported fields of information. Options include Comma,
Tab, or Other.

NOTE When you choose Other, an additional Edit field appears. Use the
Edit field to enter the delimiter character or string you want to use.

8 Click Next.

9 Use the Import/Export mapping list and fields to match the column
heading to the selected information.

Optional: If you want to preview and confirm column heading and
information choices as they will appear after they are imported or
exported, click the Preview button.

10 Click Next.

The Select Members window is displayed.
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11 In the Select Members list, select the member names you want to add
to your site.

To add all members to the Select Members list (even if some are not
selected) click Select All. To remove all the members from the Select
Members list, click Clear All.

NOTE Members names are not added if a duplicate name already exists or
if a new name does not have an email address attached to it. Member Name
and Email Address are required columns. Member names that are not added
will remain in the Select Members list with a highlighted user icon.

12 Click Next.

13 Select when to send the email.

14 Select a language for the email.

15 Select an encoding code. See Welcome Email Options (page 85) for more
information about the options in this step.

16 Click Finish.

Imported information appears in the Members tab.

Newly imported members receive an automatically generated email
message that contains the following information:

■ URL to the site

■ User name

■ Password (randomly generated)

■ Project information (if you added the new member to a project at
the same time). If a new site member is added to a project at a later
time, they receive a separate email with project-specific information
when they are added to a project.

Export user information

1 In the shortcut bar, click Site Administration.

2 Select the Members tab and click the Import/Export toolbar button,

 .

The Import/Export Members Wizard appears.

3 In the Action section, click Export.

4 Click Browse to select a target location for the exported information
file and confirm or rename the selected file. Click Save.
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5 Use the Delimiter field to indicate what separator appears between
imported or exported fields of information. Choices include Comma,
Tab, or Other.

NOTE When you choose Other, an additional Edit field appears. Use the
Edit field to enter the delimiter character or string you want to use.

6 Click Next.

The Export Fields window is displayed.

7 Use the Select Fields list to select the fields to be included in the exported
file.

Or, click the Use Standard fields button and then use the drop-down
menu to choose the type you want.

NOTE If you are using Microsoft Outlook, choose the Microsoft Outlook
comma-separated value type. This selection ensures that column headings
are selected and organized so Microsoft Outlook recognizes them. When
you choose the comma-separated value, fewer column headings are selected.

8 Click Next.

The Select Members window is displayed.

9 In the Select Members list, select the member names you want to include
in the exported information file.

To add all members to the Select Members list (even if some are not
selected), click Select All. To remove all the members from the Select
Members list, click Clear All.

10 Click Finish.

Exported information file appears in the file location you specified.

See also:

Import/Export Members Wizard (page 441)

Import/Export Members - Import Field Mapping Step (page 439)

Import/Export - Select Members Step (page 440)

Creating a Group

Only available to site administrators and project administrators who can create
new members.
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This wizard is accessed through Site Administration  ➤ Groups tab  ➤ New,
or Project Administration  ➤ Groups tab  ➤ New.

1 Enter a name for the group.

NOTE Group names can contain up to 64 characters and spaces.

2 If needed, select a different owner for the group. By default the owner
of the group is the creator. If you want a different member to be the
owner, click the Select button. The Owner dialog box is displayed. Select
a name and click the OK button. You are returned to the Group Properties
dialog box.

3 Select whether the group should be created at the site level (and thus
available to be added to any project) or only at the project level. If
creating a project level group click the Browse button. Only the projects
to which you have administrator rights are displayed.

4 For either a site or project level group, the group can be private. That is,
the member names of the group are visible only to site administrators
(if a site level group) or to project administrators (if a project level group)
and the group owner. See Private and Hidden Groups (page 128) for more
information.

5 Click Next to go to step 2 of the wizard.

See also:

New Group Wizard: Step 2 Select Members (page 432)

New Group Wizard: Step 3 Project Memberships (page 433)

Private and Hidden Groups (page 128)

Groups Tab (page 61)

Project Administration Tasks

About Project Administration

About Project Administration

The Project Administration feature gives the Project Administrator access to
frequently used administrative tasks and activities. You can name the project,
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indicate a "not to exceed" version limit for the files in the project, add members
and groups, change permissions, and access a log of all project activities.

The administration tabs appear in the details view to the right of the shortcut
bar.

See also:

General Tab (page 104)

Members Tab (page 106)

Activity Log Tab (page 118)

General Tab

The Project Administration General tab is used by Project or Site Administrators
to:

■ View the date the project was originally created and URL.

■ View the size limit, warning size limit, available storage, and current size.

■ View the total number of items that are in a project. Items include files,
folders, projects, form logs, forms, edit locks and permission locks.

Change ownership of a project:

When a project member creates a folder or adds a file to the project, that
member automatically has ownership of that item. This applies even if an
administrator changes that member's permission level to view access. That is,
the member can still edit that item. For more information see Ownership of
a Project, Folder, or File (page 51).

1 Use the Project Selection bar to select a project.

2 Select a folder or file in the tree, right-click and choose Properties.

3 Click the General tab.

4 Click the Ownership button. The Owner dialog box is displayed. The
name of the folder and file display at the top of the box. The current
owner is also displayed.
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5 Select the member whom you now want to be the owner.

Replace owner on subfolders and file - Selecting this option means that the
member will have full access rights to all the folders and files below the item
listed at the top of the dialog box. Not selecting this option means that if the
member has view access to the sub-directories and files, that permission level
remains in place — ownership only applies to the item listed at the top of the
dialog box.

You can also assign and preserve a different permission level for a project
member at the folder of file level. All you need to do is lock the permission
set for that particular folder or file. Then, even if permission levels change
elsewhere in the project, the locked item is skipped, and the permission set
remains unchanged.

Lock a permission set:

Click this button to lock the permission set for this project. For more
information about what locking a permission set means, see Locking and
Unlocking Permission Sets (page 138).

Specify the number of file versions saved:

1 Click the Versions button. The Versions dialog box opens.

2 If you want to save an unlimited number of versions, select Save all.

3 If you want to save a limited number of versions, select Limit to, and
then enter the maximum number of file versions to be saved.

NOTE Once you limit the number of saved versions, each time a version is
saved the most recent version is increased by one to the next number. Once
the version limit is reached, saving a new version deletes the oldest version.

4 Click OK.
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See also:

Locking and Unlocking Permission Sets (page 138)

Activity Log Tab (page 118)

Members Tab (page 106)

Members Tab

The Members tab is used by Site or Project Administrators to manage project
members. This tab is accessible through the Project Administration icon, or
through right-clicking a project, folder, or file in the tree view and choosing
Properties.

See Filtering Options (page 424) for more information about how to customize
your view of this window.

Add members to a project

1 Click the Add toolbar button,  . The Add Project Members Dialog
Box (page 434) dialog box is displayed.

2 Select a member, click Add and then click OK.

You can not add a member to a project if the permission set for the project is
locked.

Remove members from a project

Select a member in the list and click the Remove toolbar button,  .

The member can no longer access this project.

Create a new member

Click the New toolbar button,  , if you have New Member privileges. See
Creating a New Member (page 89) for more information.
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Edit a member

Click the Edit toolbar button,  . See Editing a Member (page 94) for more
information. This option is only available to project administrators with New
Member privileges.

Delete a member

Click the Delete toolbar button,  , to delete the member from the site.

NOTE Project administrators can only delete members from the site if they have
New Member privileges.

Add a member to a company

■ Select a member and right-click. Choose Add to Company. The Select
Company dialog box is displayed.

■ Select a company and click OK.

Import/Export users

Click the Import/Export toolbar button,  . See Importing and Exporting
Members (page 100) for more information.

Copy a member

You can use an existing member as a template for a new user. Select an existing

user and click the Copy toolbar button,  .

This is useful if a member exists who belongs to the same projects and has
the permissions that you want the new member to have. This is useful if you
are adding a number of members to the same projects and want to grant
similar permissions and project memberships to all the members.

Enable/Disable a Member

Click the Disable toolbar button,  , if you want to restrict a user's
activities rather than delete their records or alter their permissions settings. A
disabled member cannot log into the site. Disabling a member is useful, if for
example, an employee leaves your company. Disabling the member prevents
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him or her from being added to projects but the member can still be searched
on in the Find window. If you need to find files that this member added or
updated, you will be able to do so if the membership is disabled. If the
membership is deleted you can not search for these items using the members
name. Disabled users do not count toward the site's maximum number of
users.

To enable a disabled member, click the Enable toolbar button,  .

Reset member password

1 Select a member and click the Reset Password toolbar button,  .

2 In the Send Options dialog box select the options for sending the email.
You can choose to send the email immediately or edit the email before
sending. You can also select a language for the email text and how it
should be encoded.

3 Click OK.

NOTE Administrators can only reset the password of members who are enabled,
have a valid email address and have previously logged in to the site.

Change member permission levels

1 Select a member from the list. The current assigned permission level for
the selected member appears in the Permission field.

2 Use the drop-down menu to select the new permission level for the
selected member.

Notify members of a change to their membership

To notify a member that they have been added or removed from a project, or
that their permission level has changed, click the Send Email toolbar button,

 .

View and edit group members

To view the members of a group, select the group name in the list and then
click the View Group Members toolbar button. The Group Members dialog
box is displayed.
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You can view the members of a group if

a) the group is a non-private (expandable) group, or

b) you are a Site Administrator or the owner of the group.

If you are a Site Administrator or the group's owner, you can edit a group by
clicking the Edit button in the Group Members dialog box.

To view a member's assigned permission or actual access:

A member can have multiple permissions to one project (or folder or file) if
he or she is given access to an item as an individual and as a group member.
This can occur if the member is given permission to the project as an individual
with one permission level, and as a member of a group that has a different
permission level. This results in members having “assigned” permission and
“actual” access to a project.
■ Assigned permission — refers to the permission level that was assigned

to a member as an individual member.

■ Actual access — refers to the highest permission by which the member
can access an item (file, folder, or project). This permission can be derived
from either a group membership, or an individual project membership.

The highest permission that has been assigned to the member, regardless of
whether it was assigned at the group or individual level, is how the member
accesses an item.

For example, Jane Smith is a member of Group 1. Jane and Group 1 have
access to Project A. Jane had access to Project A, with View permission before
she was added to Group 1. Group 1 has the permission of Edit to Project A.
Because Edit is a higher level of access than View, Jane can now access Project
A with Edit permission.

The exception to this rule is if a member is assigned No Access as an individual
or as a group member. No Access overrides all other permission levels. Thus,
in the example above, if Jane was assigned View as an individual and No
Access as a group member, she would not be able to access Project A.

See also:

Adding a Member to a Project (page 97)

Creating a Group (page 102)

Permission Levels (page 130)
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Groups Tab

The Groups tab is used by site and project administrators to add, edit, or delete
groups. Site Administrators and Project Administrators, who have the ability
to create members, can create site or project level groups. Groups can be created
a the site or project level. Site level groups can be added to any project within
the site. A project level group is created for a specific project and can only be
added to projects that the creator has administrator rights to.

By using groups to assign members, you treat many individuals as a single
entity, allowing you to manage dozens of individuals at once rather than one
at a time. For example, if there are many project members who require Review
permission, you might create a reviewers group, add all the appropriate
members to it, and then add that group to the project.

See Filtering Options (page 424) for more information about how to customize
your view.

Overview

Creating a group is an effective way to manage project members. Once a group
is created and added to various projects, then new members can be added to
projects via the group. Because the group is already a member of various
projects, the new member automatically has access to all the projects that the
group has access to.

Permissions are assigned at a group level. When a new member is added to
an existing group, that member has access to all projects, folders, or files where
the group is assigned. That is, everyone within the group has the same
permission. Individuals in that group can then work within the project at the
assigned permission level. The default permission is View. For more
information see Permissions (page 130).

Once a site level group has been created the group can be added to any project.
Project level groups can only be added to the project that the creator has
administrator rights to.

When creating groups, it helps to keep the following thoughts in mind:
■ Using private and hidden groups is an effective way to maintain

confidentiality. Members of a private group cannot be seen by other group
and project members. This is desirable if you want members to be able to
update project files but you don't want them to see who else is updating
documents. For more information see Private and Hidden Groups (page
128).
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■ A group owner does not have to be a project administrator. It is possible
for an administrator to initially create a group and then transfer ownership
to a non-administrator. The group owner can then edit the group through
the Using the Member List (page 18).

■ You may add up to 500 members to a group at a time. To create groups
larger than 500 members, simply perform more than one add operation.

■ Review the organization of your project before creating groups. For example,
it's a good idea to organize and create separate groups according to job
function (owners, architects, general contractors, and so on). Then you
can apply the group to the appropriate projects.

Create a group

Click the New button to start the Creating a Group (page 102).

Edit a group

Click the Edit button. Follow the directions for Editing a Group (page 128).

You can also edit groups in the Using the Member List (page 18). Click the

Member List toolbar button,  . Right-click a group and choose Edit.

Delete a group

Site administrators can delete a site and project level groups; project
administrators can only delete project level groups. Group owners can delete
site and project level groups (but they cannot add groups to different projects).

NOTE When a project level group is deleted from a project it is also deleted from
the site.

These steps will remove a group from the site.

1 In the Buzzsaw bar, click the Site Administration icon.

2 Click the Groups tab and select a group.

3 Right-click and choose Delete Group.

To remove a group from a project go through Project Administration  ➤ ;
Members. Right-click a group and choose Remove.
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Permissions

A member can have multiple permissions to one project (or folder or file) if
he or she is given access to an item as an individual and as a group member.
This can occur if the member is given permission to the project as an individual
with one permission level, and as a member of a group that has a different
permission level. This results in members having “assigned” permission and
“actual” access to a project.
■ Assigned permission — refers to the permission level that was assigned

to a member as an individual member.

■ Actual access — refers to the highest permission by which the member
can access an item (file, folder, or project). This permission can be derived
from either a group membership, or an individual project membership.

The highest permission that has been assigned to the member, regardless of
whether it was assigned at the group or individual level, is how the member
accesses an item.

For example, Jane Smith is a member of Group 1. Jane and Group 1 have
access to Project A. Jane had access to Project A, with View permission before
she was added to Group 1. Group 1 has the permission of Edit to Project A.
Because Edit is a higher level of access than View, Jane can now access Project
A with Edit permission.

The exception to this rule is if a member is assigned No Access as an individual
or as a group member. No Access overrides all other permission levels. Thus,
in the example above, if Jane was assigned View as an individual and No
Access as a group member, she would not be able to access Project A.

You can view a member's assigned or actual permission level in the Project
Administration Members tab:

1 Select a project in the tree view. Right-click and choose Properties.

2 Click the Members tab.

3 Select either display option, Assigned Permissions or Actual Access. The
values in the Permission column may change depending on how the
member is able to access the project.

NOTE The Membership column lists all of the ways a member can access a
project. It lists access via individual membership and group memberships.
The method by which the member's actual access is derived from appears
first in the Membership column. Thus, if a member's actual access is Edit
through a group membership, then the group name is listed first, followed
by the project membership.
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4 Click OK.

See also:

Editing a Group (page 128)

Creating a Group (page 102)

Private and Hidden Groups (page 128)

Companies Tab

Use the Companies tab to manage the companies associated with a project.
Companies exist at the site level. If you edit company information, add or
remove associated members, those changes are made at the site level.

A company is automatically added to a project when a member, who is
associated with that company, is added to the project. Or, you can create a
new company. If you are looking for a company that you know exists but it
is not displayed in the Project Administration Companies tab, you can add
the company to the project by associating a project member with that
company.

Add a site company

1 In the Companies tab right-click and select Add Site Company. The
New Company dialog box is displayed.

2 Enter the company information.

3 Select an attribute value for each attribute. The attributes available are
based on the attributes that are in the Attributes tab.

4 Enter the contact information for the company.

5 Click Create to create the company.

6 Click the Company Members tab to add members with the company,
or click Close.

Add members to a company

1 Select a company and right-click.

2 Choose Add Members from the menu. The Select Members dialog box
(page 434) is displayed.

3 Select a member from the list of available project members.
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4 Select a member from the list and click Add.

5 Click Save. You are returned to the Companies tab.

Edit a company

1 Select a company and right-click. Choose Edit from the menu. The Edit
Company dialog box is displayed.

2 Click the Company Information to change attributes for the company
or the contact information.

3 Click the Company Members tab to add or remove members that are
associated with the company.

Export companies

You can export the companies and the associated information to a CSV file.

1 Select a company in the list and click the Export toolbar button.

2 Click the Browse button and select a file on your hard drive.

3 Click Save.

4 Click OK.

The attributes are exported to the file you specified.

See also:

Groups Tab (page 61)

General Tab (page 104)

Members Tab (page 106)

Permissions Tab

The permissions tab is accessed through Site and Project Administration. The
matrix allows administrators to view and edit members and their permissions
in one window. You can view all the members in a site or project, which
project they belong to, and what their permission is for that project.
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Navigating the matrix

In the Permissions Matrix window you can filter the list by project or by
members. You can further narrow this view by looking at one project or at
one group of people. For example, you can view just project administrators.

Use the Project drop-down list to see the users for a specific project. Regardless
of whether you are viewing the matrix by user or by project, you can
double-click a project to see sub-projects or folders.

Use the toolbar buttons at the top of the matrix to move up one level in the
project tree, send an email, refresh the matrix, or view contact information
for a user.

Export the data from the permissions matrix to a Comma Separated Value
(CSV) file. Click the Export button in the bottom left corner. The CSV file
contains the data in the current matrix. A CSV file is a file in which each piece
of data is separated by a comma.

View Projects and Administrators

The Projects and Administrators view displays all Site and Project
Administrators and the projects for which they administer.

Projects for Project Administrators are listed in the Project column. Individual
projects are not listed for Site Administrators since they have permission to
all projects. Instead, the word "All" is listed in the projects column.

Click the user icon on the far left to sort members grouped according to their
user status: Site Administrator or Project Administrator. Users are differentiated
by their icon.

View by project

In this view, projects (and subfolders) are listed in the left pane. The members
are listed vertically in the right pane, with their permissions code displayed
underneath. Use the Project drop-down to navigate to a different project.

Double-click a folder in the left pane to reach sub-projects or folders.
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View by member

In this view, the members are listed in the left pane and the projects are listed
vertically in the right pane. A user icon is displayed to the left of the user
name, distinguishing administrators from members.

To highlight a user and the projects he or she belongs to, select the user in
the left pane. That user's permissions are highlighted.

NOTE Members who have been added to a project may not display in the matrix
until he or she has logged into Buzzsaw. Also, if the user is added to the project
while the permission lock is set for a file, then the appropriate icon will not display
in the matrix.

Change permissions

There are multiple ways that you can change permissions. You can change
the permissions for one user in one project, one user in multiple projects,
many users in one project, or many users in multiple projects.

All of these changes are accomplished by selecting a row of users, a row of
projects or by pressing the SHIFT key and selecting individual permission
codes. Once you have selected a member and project, right-click and select a
new permission. For example:
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These changes are not applied until you click the Apply button. Then, a
confirmation dialog box is displayed. To let members know that you have
changed their permission, select the Notify affected members by email check
box in the Verify Change Permissions window.

Change all member's permission for one project

To change permissions for all the members in one project, select the project
row and right-click. Choose the permission level that you want all the members
to have. Remember, by doing this, you are granting the same permission to
all of the project members.

You can also select multiple projects and change all the project member's
permissions at once. Select a project and hold the SHIFT key while selecting
a second project. Then, on a permissions code right-click and choose a new
permission level. For example:
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See also:

Working with Site and Project Statistics (page 51)

Members Tab (page 58)

Security Tab (page 79)

Activity Log Tab

The Project Administration Activity Log tab is used to filter and view project
use patterns. The Project Administration Activity Log is available only to those
with Site or Project Administrator permission.

You can change the information that is displayed by using the filters. For
example, you can view a broad or specific amount of usage information by
restricting the Date, Users, Actions, or Types fields.

See also:

Overview (page 143)

Using the Activity Log (page 145)
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Printing Activity Log Information (page 148)

Statistics Tab

The Statistics tab is a useful maintenance tool for Site and Project
Administrators. You can quickly view important statistics for all the projects
on your site (or those for which you have Project Administrator permission).
The statistical data that is available to you provides a convenient way to
perform regular project maintenance.

For example, if you find that deleted projects, folders, or files appear in the
statistics list, you can quickly select the name of the item, right-click, and
then choose to permanently delete it, thus reducing your storage. The statistics
tab can be an invaluable took in evaluating how your site storage is being
used.

How to access the Statistics tab:

1 Select the site or a project in the tree view.

2 In the Buzzsaw bar, click the Site Administration or Project
Administration icon.

3 Click the Statistics tab.

How to use the statistics tab:

On the statistics tab you can see:
■ Name(s) of existing project(s)

NOTE Deleted projects that appear in the statistics list continue to use storage
space until they are permanently purged from the system. If you want to
permanently delete a project from the statistics list (and system), hold down
the SHIFT key, right-click, and then choose Delete from the list.

■ Project size limit

■ Warning size limit

■ Available storage

■ Current size of project(s) currently on the site (Note that the number in
this field includes multiple file versions or discussions)

■ Number of project(s)

■ Number of folders contained in the selected project(s)
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■ Number of files contained in the selected project(s)

■ Number of versions contained in the selected project(s)

■ Number of markups contained in the selected project(s)

■ Number of comments in the selected project(s)

■ Number of members in the selected project(s)

■ Version limit in the selected project(s)

■ Administrator username(s) assigned to the selected project(s). The username
is the same as the login name.

NOTE Information on the contents of your Recycle Bin is also included in the
Statistics tab view.

How to save site or project statistics to a file:

1 In the Statistics tab view, click the Save Statistics button.

To choose the location on your computer where the statistics will be
saved, click the Browse button and navigate to the desired directory.

2 When you are finished, click OK.

How to use the right-click menu:

There is a right-click menu available on the Statistics tab which makes it
possible to take care of maintenance tasks such as converting files to folders,
renaming items, and restoring deleted items.

In the Name column of the Statistics tab, select the item that you want to
work with, click the right mouse button, and make a choice from the menu.

NOTE Right-click menu choices are different for deleted items. All right-click menu
options, including those for deleted items, are included in the following table.

What it doesCom-
mand

Prints all contents in
the Statistics tab view.

Print
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What it doesCom-
mand

Print statistics for only
the folder you have
selected.

Print
Selec-
ted

Converts a project
folder and all of its

Con-
vert to
Folder contents to a standard

folder.

Allows you to save the
selected item to a local

Archive

computer and under a
new name, if neces-
sary.

Downloads the selec-
ted item to a local
computer.

Down-
load

Removes the selected
item from the list

Delete

(item is placed in the
Recycle Bin and
flagged with a trash
can icon). You can
permanently remove
it from the system
from the Recycle Bin.
If you want to perman-
ently remove items
from the system dir-
ectly from the Statist-
ics list, hold down the
SHIFT key, right-click,
and then choose De-
lete.
A confirmation dialog
box is displayed before
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What it doesCom-
mand

deleting the file from
the server. If you
change your mind, it
is possible to recover
files and folders.
See Recovering a
Folder  (page 162).

Allows you to rename
the selected item.

Re-
name

Marks the files as read.Mark
as Read

Use this command to
manually lock a file so

Lock/Un-
lock All

other members can't
change it. Use the Un-
lock command to re-
lease a lock that you
previously put on a
file.

Locks or unlocks the
selected project,

Lock/Un-
lock

folder, or file permis-
sion list.

Permis-
sions

Displays the properties
for the selected item.

Proper-
ties

Allows Administrators
to modify the access
rights for individual
folders or project files.

Use this command to
log in to another site.

Login
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What it doesCom-
mand

Use this command to
log out of the site.

Logout

See also:

Activity Tab (page 74)

Members Tab (page 58)

Security Tab (page 79)

Adding a Member to a Project

Once a project is created, administrators can add members. Until a member
is explicitly added to a project, he or she can not access the data within the
project. The tasks and activities available to members depends on their assigned
permission levels.

Project Administrators can also add existing members to one or more projects
(Project administrators must have administrator permission for each project
they wish to add members to). They can create site level groups if they have
been given the permission to create new members and groups.

NOTE If you would like to add a person to a site or project but cannot find that
person's name in the list of available members, the Site Administrator must first
add the person as a site member — or give you permission to create new site
members. Contact your Site Administrator to make a request.

To add a member to a project:

1 In the project tree view, select a project.

2 In the shortcut bar click the Project Administration icon.

3 Click the Members tab.

4 Click the Add toolbar button to display the Add Project Members
dialog box.

5 In the Available members list, select a member's name and then click
the Add button.

Use the SHIFT and CTRL keys to add multiple members.
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NOTE  If you would like to add a person to a site or project but cannot find
that person's name in the list of available members, the Site Administrator
must first add the person as a site member — or give you permission to
create new site members. Contact your Site Administrator to make a request.

6 The member's name is displayed in the Selected section in the lower
pane of the window.

7 From the Permission drop-down list, choose a permission level for the
member(s). The same permission is applied to all the members being
added. Members permissions can be changed in the Members tab. See
Permissions (page 130) for more information.

By default, all new members to the project are assigned view permission.
Use the Permission drop-down list to change the permission level.
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8 Click OK to add the member to the Project Members list. If you selected
the option on the Members tab to notify members by email that they
have been added to a project or their permission level has changed, the
email is sent now.

See also:

Creating a New Member (page 89)

Creating a Group (page 102)

Private and Hidden Groups (page 128)

Site and Project Administration | 125



Editing Members of a Project

Project Administrators can make changes to project member information,
including changing their permission and removing the member from a project.

To edit a member's permission:

1 In the Buzzsaw bar, click the Project Administration icon.

2 Click the Members tab and select a member from the list.

3 Select a new permission from the Permission drop-down list at the bottom
of the window.

To remove a member from a project:

1 In the Buzzsaw bar, click the Project Administration icon.

2 Click the Members tab and select a member from the list. Use the filter
above the member list if needed, to view all project members.

3 Right-click and choose Remove.

NOTE  Removing a member from a project prevents the selected member
from accessing the project.

4 Click Yes to confirm removal of the member from the project.

See also:

Adding a Member to a Project (page 97)

Groups

Creating a Group: New Group Wizard Step 1
Group Properties

Only available to site administrators and project administrators who can create
new members.
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This wizard is accessed through Site Administration  ➤ Groups tab  ➤ New,
or Project Administration  ➤ Groups tab  ➤ New.

1 Enter a name for the group.

NOTE Group names can contain up to 64 characters and spaces.

2 If needed, select a different owner for the group. By default the owner
of the group is the creator. If you want a different member to be the
owner, click the Select button. The Owner dialog box is displayed. Select
a name and click the OK button. You are returned to the Group
properties dialog box.

3 Select whether the group should be created at the site level (and thus
available to be added to any project) or only at the project level. If
creating a project level group click the Browse button. Only the projects
to which you have administrator rights are displayed.

4 Select a privacy type for the group:

Open Group — the group and its members can be seen by everyone
who has access to the same projects.

Private Group — the group can be seen by everyone. However the
members of the group can only be seen by site administrators, the group
owner, and project administrators associated with that project (if a project
level group). See Private and Hidden Groups (page 128) for more
information.

Hidden Group — the group and its members cannot be seen by anyone
except site administrators, the group owner, and project administrators
associated with that project (if a project level group). See Private and
Hidden Groups (page 128) for more information.

5 Click Next to go to step 2 of the wizard.

See also:

New Group Wizard: Step 2 Select Members (page 432)

New Group Wizard: Step 3 Project Memberships (page 433)

Private and Hidden Groups (page 128)

Groups Tab (page 61)
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Editing a Group

Only available to site administrators and project administrators who can create
new members.

Access this dialog through Site Administration  ➤ Groups tab  ➤ Edit, or Project
Administration  ➤ Groups tab  ➤ Edit. Use this dialog box to edit an existing
group.

1 In the Group Name field, enter a name.

NOTE Group names can contain up to 64 characters and spaces.

2 If needed, select a different owner for the group. By default the owner
of the group is the creator. If you want a different member to be the
owner, click the Ownership button. The Owner dialog box is displayed.
Select a name and click the OK button. You are returned to the Group
Properties dialog box.

3 Select the Private or Hidden options as necessary. See Private and Hidden
Groups (page 128) for more information.

4 Click the Add Members button to select a member to add to the group.

5 To remove a member from a group select the name in the Group
Members List and click the Remove button.

6 Click the Add to Project button to add the group to a project.

7 Click the Remove button to remove the group from a project.

8 Select a group and then choose a permission from the Permission
drop-down list box to change the permission of the group.

9 Click OK. This group will now display in the Site Administration Groups
tab, and the Member List directory.

See also:

Creating a Group (page 102)

Private and Hidden Groups (page 128)

Groups Tab (page 61)

Private and Hidden Groups

Private and hidden groups are an effective way to maintain confidentiality.
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In a site level, private or hidden group the members can only be seen by site
administrators and the owner of the group. In a project level private or hidden
group the members can be seen by the site administrators, groups owners,
and project administrators with access to that project. Private and hidden
groups are distinguished from general groups by a different icon. A private or
hidden group cannot be expanded unless you are the owner of the group or
are a site administrator. For more limitations to using a private or hidden
group, see Limitations of Using Private and Hidden Groups (page 130).

Open group — the group and its members can be seen by everyone
who has access to the same projects.

Private group — the group can be seen by everyone. However the
members of the group can only be seen by site administrators, the group
owner, and project administrators associated with that project (if a project
level group).

 Hidden group — the group and its members cannot be seen by anyone
except site administrators, the group owner, and project administrators
associated with that project (if a project level group).

In a private or hidden group, members of the group cannot see each other's
name or contact information. Private and hidden groups can be created by
site administrators and project administrators (who have the privilege to create
members and groups). Project administrators can edit and delete groups that
have been defined for thier project. Group owners can edit and delete groups
that they own. Site administrators can edit and delete all groups.

When used in conjunction with the deposit permission, a private or hidden
group is useful if you want members to be able to update project files but you
don't want them to see who else is updating documents. For example, if you
are asking members to bid on a project, you want them to be able to add a
document detailing their bid, but you don't want them to see who the other
bidders are, or their contact information. Thus, creating a private or hidden
group, used in conjunction with the deposit permission, allows you to do this.
Private or hidden group members can add a document to the project, but they
can't see other documents in the project nor can they see who the other
members in the group are. Note that they can still see other project members,
but not the other members of the private or hidden group. For more
information about how to create a private or hidden group, see Creating a
Group (page 102).

When sending email through Buzzsaw, a private or hidden group is
automatically placed in the BCC field. This prevents the names and email
addresses from being exposed to other mail recipients. It is not recommended
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that you assign a form to a private or hidden group. Doing so exposes the
names and email addresses of private or hidden group members in the routing
tab of forms and in various dashboards. When a private or hidden group is
added to a discussion only the group name is displayed in the participants
field.

Limitations of Using Private and Hidden Groups

While a private or hidden group can be an effective way of maintaining
confidentiality, there are limitations. The member names of a private or hidden
group do appear in certain places across the site (such as a document's author).
In order to maintain confidentiality within the private or hidden group, you
must give each member deposit permission. In this way, when a document
is added to a project, the private or hidden group members can not see the
document or the author. The author's name can be seen by members who are
not in the private or hidden group.

It is also recommended that you do not assign a form to a private or hidden
group. Doing so exposes the names and email addresses of private or hidden
group members in email notifications. Forms can only be assigned to hidden
groups by administrators of the project containing the form log.

See also:

Creating a Group (page 102)

Permissions (page 130)

Groups Tab (page 61)

Permissions

Permission Levels

An important feature of Buzzsaw is the capability to assign permission levels.
Permission to a project or individual file can be assigned to individual members
or more broadly through group membership. By thinking ahead about the
level of access project members should have to each project, folder, and file,
you can save time when making permission-level changes.
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High-level overview of the permissions
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De-
posit

ViewRe-
view

Up-
date

EditProject
Adminis-
trator

Site Ad-
minis-
trator

Permission Lev-
elList

X*XXXAdd/Edit/Delete
Files, Forms and
Folders

XXXXXUpdate/Respond
to Existing files
and forms
X**

XXXXXXAdd/Edit Notes,
Comments,
Markups, and
Links to Existing
Files

XXXXXXXView/Download
Files, subscribe to
notifications
X**

XXXXXXXView Information
pages
X***

Only View Folder
Structure (no files)
X

NOTE * The Deposit permission allows a project member to view or edit only
those files that the project member creates or that are assigned to the project
member. ** Project members with List permission can add, edit, and respond to
forms, and subscribe to a form log, only if the form log options have been
configured to allow these actions. *** Project members with List permission can
view information pages if the project administrator has specificed that all project
members are allowed to view information pages.
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Overview

Typically a members permission level is set on a project-by-project basis. This
can be accomplished through an individual project membership or group
membership. Once a member has permission to a project then he or she has
access to everything contained within that project, at that particular permission
level.

NOTE It is possible for members to have multiple permissions to the same project.
This can occur if the member is given permission to the project as an individual
and as a member of a group. It is important to understand how a member can
access a project when he or she has multiple permissions. If not paying attention,
you can mistakenly give a member access to a project at a level that you do not
want

Permissions in Buzzsaw are inherited. This means that if a member is granted
View permission to a project then that member will have View permission to
every subfolder, sub-project, and file added to the highest level project. When
new folders and project files are added, the member automatically has access
to the new item according to the permission level you assigned at the higher
level (this is true for every permission level except List, which does not inherit
downward through the project hierarchy). A member's level of access can be
changed at anytime to a particular item.

When used in conjunction with other features, permissions can be a powerful
tool. For example, if members of a private group are assigned the deposit
permission, members can add documents while maintaining confidentiality.
See Private and Hidden Groups (page 128) for more information.

You can lock the permissions for a project, folder or file. This prevents
permission levels from changing even if the permission levels are changed
elsewhere in the project. The locked item is skipped, and the permission set
remains unchanged. See Locking and Unlocking Permission Sets (page 138) for
more information.

Understanding Permission Level Definitions

Project members can be assigned different permission levels at the project,
folder, or file level.

DescriptionPermission Level

Project members can see a list of project folders but cannot view
contents or edit them. This permission level is assigned so

List
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DescriptionPermission Level

members have the ability to navigate through several levels
within a project and then view and interact with a single file.
When assigned to a folder, List permission does not inherit
downward throughout the project hierarchy.
Members with list permission can not view information pages.

NOTE When a member is assigned (with any permission) to a
subordinate folder in a project hierarchy, that member is auto-
matically assigned List permission in the highest folder within
the hierarchy.

The automatic assignment of list permission occurs only when
access is given to folders below the top level in the project
hierarchy.
If you attempt to assign to a folder a member that does not
have access to the "parent" project folder (the folder at the top
level of the project hierarchy in the tree view), you must select
the "Show all site members" check box in the Add Project
Members dialog box. Otherwise, the member will not appear
in the list of available members.

Project members can view a project and add a file to that project
but cannot see other files within that project.

Deposit

For Buzzsaw Professional users, this means that a member can
add a form to a log, but he or she can not see the responses,
or other forms in the log.
Members with deposit permission can not view information
pages unless the administrator has specified that all project
members are allowed to view information pages.
See Step 5: Manage Information Pages (page 269) for more in-
formation.

Project members can view information pages, project files and
subscribe to notifications but cannot add, edit, or delete files.

View

Project members can view information pages, all files in a project
and add or edit notes, comments, and links. Members can also

Review

subscribe to notifications. Members can not add, rename, or
delete files.
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DescriptionPermission Level

Project members can view information pages, edit, update and
rename existing files, and subscribe to notifications. Members
cannot add new files or delete existing files.

Update

Project members can add, edit, or delete files including forms.
These files include drawings, standard folders or subfolders (not

Edit

site- or project-level folders), notes, comments, links, and extern-
al files, such as images and Microsoft Word files. Members can
also subscribe to notifications and view information pages.

Project Administrators can create and convert folders for the
project(s) they can add and remove members from projects.

Project Adminis-
trator

They can also subscribe to notifications and clone projects.
Project administrators can automatically view executive summar-
ies for a project.
Project Administrators can add existing site members to a pro-
ject. They can only create new members and site level groups
if the "Can create members and groups" option was selected
when the member was created. Project Administrators can only
edit groups that they own and they can not delete groups. Only
Site Administrators can delete groups. For more information see
Groups (page 126).

NOTE Project Administrators cannot delete projects they did
not create. When attempting to delete a project, a Project Admin
will not be able to use the Delete option in the right-click menu
or the Delete button on the standard toolbar unless that Admin-
istrator created the project.

See the Glossary definition of Project Administrator (page 390)
for more details.

Site Administrators have full rights to a project or site, including
the ability to add or remove other project members, add, re-

Site Administrator

move, or edit groups (including private groups), add or remove
folders, assign permission levels, and delete projects, and sub-
scribe to notifications. They can also clone projects.
Site administrators can not delete mail storage for individual
users. When deleting a project member it is preferable to have
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DescriptionPermission Level

the member delete his or her email storage first, and then the
site administrator should delete the member.
Site administrators can view all information pages even if they
have not been explicitly added to the access list for an informa-
tion page. Site Administrators can only delete members from a
project if he or she has been specifically added to the same
project.
See the Glossary definition of Site Administrator (page 392) for
more details.

Viewing assigned permissions versus actual access

A member can have multiple permissions to one project (or folder or file) if
he or she is given access to an item as an individual and as a group member.
This can occur if the member is given permission to the project as an individual
with one permission level, and as a member of a group that has a different
permission level. This results in members having “assigned” permission and
“actual” access to a project.
■ Assigned permission — refers to the permission level that was assigned

to a member as an individual member.

■ Actual access — refers to the highest permission by which the member
can access an item (file, folder, or project). This permission can be derived
from either a group membership, or an individual project membership.

The highest permission that has been assigned to the member, regardless of
whether it was assigned at the group or individual level, is how the member
accesses an item.

For example, Jane Smith is a member of Group 1. Jane and Group 1 have
access to Project A. Jane had access to Project A, with View permission before
she was added to Group 1. Group 1 has the permission of Edit to Project A.
Because Edit is a higher level of access than View, Jane can now access Project
A with Edit permission.

The exception to this rule is if a member is assigned No Access as an individual
or as a group member. No Access overrides all other permission levels. Thus,
in the example above, if Jane was assigned View as an individual and No
Access as a group member, she would not be able to access Project A.
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You can view a member's assigned or actual permission level in the Project
Administration Member’s tab:

2 Select a project in the tree view. Right-click and choose Properties.

3 Click the Members tab.

4 Select either display option, Assigned Permissions or Actual Access. The
values in the Permission column may change depending on how the
member is able to access the project.

NOTE The Membership column lists all of the ways a member can access a
project. It lists access via individual membership and group memberships.
The method by which the member's actual access is derived from appears
first in the Membership column. Thus, if a member's actual access is Edit
through a group membership, then the group name is listed first, followed
by the project membership.

Setting permissions at the project level

Typically, a member's permission is set at the project level. This is the most
important level because permissions are inherited in subfolders. (This is true
of every permission level except List, which does not inherit downward.) Thus,
it is important to think about your project members and what level of access
they will need to all folders and files within the project.

NOTE Permissions that are assigned at the top level are not inherited if a folder
or file at a subordinate level has permissions locked. See Locking and Unlocking
Permission Sets (page 138) for more information.

1 In the tree view select a project.

2 Right-click and choose Properties.

3 Click the Members tab and select a member from the list.

4 From the Permission drop-down list box on the bottom left of the
window, select a new permission.

5 Click OK to apply the change.

6 If the Send Options dialog box is displayed choose whether to notify the
member, via email, of the permissions change.

Setting permissions at the folder or file level

You can change a member's permission at the folder or file level. For example,
giving a member No Access to a confidential budget document that is
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contained within a project to which the member has Edit access. Typically,
you would assign file-level permissions only when you want to override
permissions for a single user on a single file. Excessive use of file-level
permissions can make your site difficult to manage.

1 In the tree view select a folder or file.

2 Right-click and choose Properties.

3 Click the Members tab and select a member from the list.

4 From the Permission drop-down list box on the bottom left of the
window, select a new permission.

5 Click OK to apply the change.

6 If the Send Options dialog box is displayed choose whether to notify the
member, via email, of the permissions change.

See also:

Locking and Unlocking Permission Sets (page 138)

Private and Hidden Groups (page 128)

Setting permissions at the project level (page 137)

Locking and Unlocking Permission Sets

Administrators can lock the permission set of a project, folder, or file. This
prohibits the permissions for an item from being affected by changes made
to project wide permissions. (You cannot lock the permission set for a form
log or an individual form.)

NOTE Locking a permission set is different from locking a file to be edited. For
details on locking a file for editing purposes, see Locking and Unlocking a File
(page 187).

Though a file or folder may have its permission set locked, it is still possible
to unintentionally add a new member to the permission list. If you assign a
new member to a group that is included in a locked permission list, that new
member will receive access to the locked file or folder.

Adding new members to groups when a permission set is locked is not
recommended. It is further recommended that you do not assign groups to a
security-sensitive folder at all. Instead, add members individually to ensure
the security of a sensitive folder.
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Overview

Once an item's permission set is locked, only team members and groups
included in the permission list have access to the folder — and the permission
set for that folder will not be affected by any changes made to project-wide
permission lists.

This is useful if, for example, you want to limit member access to a project's
financial folder. You know there are only certain members who should have
access to this financial folder regardless of any changes that may be made to
the site or project. Locking the permission set prevents giving new members
access to this folder. Or, if permissions should be changed site or project-wide,
the permissions for this folder will not be affected.

When you lock a permission set, you are locking the entries you see in the
permission list. The term "locked" in this case means that new, individual
project members cannot be given access to a locked folder or file (except when
members are added to groups that have already been assigned to a folder or
file with a locked permission set). An administrator cannot change the
permissions of existing project members within a locked list. Nor can
administrators add a new project member to a project that has a locked
permission set.

It is possible to unintentionally grant new project members access to a locked
folder or file. A permission list may include a combination of individual
members and groups; if you lock a permission set and then add a new member
to a group that is in the locked permission list, the new member will have
access to the folder or file.

NOTE To control the security of locked folders and files, do not add new members
to groups when a permission set is locked.

A project that has a locked permission set can be cloned and the permission
set will remain locked in the clone.

To lock and unlock a permission set (folder or file)

1 In the tree view select a project, folder, or file.

2 Right-click, and choose either Lock Permission or Unlock Permission
from the menu.

See also:

Cloning a Project (page 42)

Permissions (page 130)
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Setting permissions at the project level (page 137)

Permissions Matrix

The permissions tab is accessed through Site and Project Administration. The
matrix allows administrators to view and edit members and their permissions
in one window. You can view all the members in a site or project, which
project they belong to, and what their permission is for that project.

Navigating the matrix

In the Permissions Matrix window you can filter the list by project or by
members. You can further narrow this view by looking at one project or at
one group of people. For example, you can view just project administrators.

Use the Project drop-down list to see the users for a specific project. Regardless
of whether you are viewing the matrix by user or by project, you can
double-click a project to see sub-projects or folders.

Use the toolbar buttons at the top of the matrix to move up one level in the
project tree, send an email, refresh the matrix, or view contact information
for a user.

Export the data from the permissions matrix to a Comma Separated Value
(CSV) file. Click the Export button in the bottom left corner. The CSV file
contains the data in the current matrix. A CSV file is a file in which each piece
of data is separated by a comma.

View Projects and Administrators

The Projects and Administrators view displays all Site and Project
Administrators and the projects for which they administer.

Projects for Project Administrators are listed in the Project column. Individual
projects are not listed for Site Administrators since they have permission to
all projects. Instead, the word "All" is listed in the projects column.

Click the user icon on the far left to sort members grouped according to their
user status: Site Administrator or Project Administrator. Users are differentiated
by their icon.
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View by project

In this view, projects (and subfolders) are listed in the left pane. The members
are listed vertically in the right pane, with their permissions code displayed
underneath. Use the Project drop-down to navigate to a different project.

Double-click a folder in the left pane to reach sub-projects or folders.

View by member

In this view, the members are listed in the left pane and the projects are listed
vertically in the right pane. A user icon is displayed to the left of the user
name, distinguishing administrators from members.

To highlight a user and the projects he or she belongs to, select the user in
the left pane. That user's permissions are highlighted.

NOTE Members who have been added to a project may not display in the matrix
until he or she has logged into Buzzsaw. Also, if the user is added to the project
while the permission lock is set for a file, then the appropriate icon will not display
in the matrix.

Change permissions

There are multiple ways that you can change permissions. You can change
the permissions for one user in one project, one user in multiple projects,
many users in one project, or many users in multiple projects.

All of these changes are accomplished by selecting a row of users, a row of
projects or by pressing the SHIFT key and selecting individual permission
codes. Once you have selected a member and project, right-click and select a
new permission:
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These changes are not applied until you click the Apply button. Then, a
confirmation dialog box is displayed. To let members know that you have
changed their permission, select the Notify affected members by email check
box in the Verify Change Permissions window.

Change all member's permission for one project

To change permissions for all the members in one project, select the project
row and right-click. Choose the permission level that you want all the members
to have. Remember, by doing this, you are granting the same permission to
all of the project members.

You can also select multiple projects and change all the project member's
permissions at once. Select a project and hold the SHIFT key while selecting
a second project. Then, on a permissions code right-click and choose a new
permission level. For example:
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See also:

Groups Tab (page 61)

Members Tab (page 58)

Security Tab (page 79)

Activity Logs

Overview

The Activity Log is only available to administrators.

The Activity Log enables administrators to view all the activity for a site,
project, or individual file. You can also view activities for a form log, form,
link and note.

Administrators can access activity logs through the Site or Project
Administration icons in the Buzzsaw bar. Or, through the Properties command
(available through the right-click menu).
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The Activity Log tab provides an automatic trail of all the actions that have
taken place at the site and file level. For example, if a file is placed on the site
and you want to see who has looked at the file since it was posted, use the
Activity Log to find this information. You can also track form log actions (edit,
assign, save to log, etc.), and actions pertaining to project information pages
(such as, add page, edit page, change page order, etc.).

The Activity Log tab displays a read-only list of information, including:
■ Date the file was created

■ Author

■ A list of all the actions (such as read, update, download, and so on) that
have taken place in the file

■ IP Address -- this column displays the IP address of a user. Note that if the
user has logged in, but not using the using the Buzzsaw 6.3 client, then
the IP address is displayed as "Unknown". Otherwise the IP address is
displayed as "Never Logged In" for users who have not logged in to the
site.

You can also customize and view data at the project level by choosing from
a series of "filters" that show or hide information according to date, users,
actions, or types. By using the Activity Log, you can view a broad array of
information or zero in on a very specific piece of data. For example, if you
want to see how often project members have downloaded files within the past
two weeks, you can enter the date range, check Download, and get the
information right away.

See also:

Printing Activity Log Information (page 148)

Using the Activity Log (page 145)
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Using the Activity Log

Overview

You can use the Activity Log to customize and view data by choosing from a
series of "filters" that show or hide information according to date, users, actions,
or types. By using the Activity Log, you can view a broad array of information
or zero in on a very specific piece of data. For example, if you want to see how
often project members have downloaded files within the past two weeks, you
can enter the date range, check Download, and get the information right
away.
■ If you have Site Administrator permission, you can access the Activity Log

tab from the Site or Project Administration icons or from the Properties
command (available on the standard toolbar or right-click menu).

■ If you have Project Administrator permission, you can access the Activity
Log tab from the Project Administration icon or from the Properties
command (available on the standard toolbar or right-click menu).

The Site Administration Activity Log provides information about the actions
of site members. You can customize the Activity Log by choosing among
activities such as login /logout, members added to the site, and so on. By
selecting the Include Project Level Activity option, you can also view all
project level activity without having to go to the project administration
log.

The Project Administration Activity Log provides information about all
tasks or activities (read, download, lock, edit, etc.) that have taken place
within the selected project.

■ In the Buzzsaw bar, click Site Administration or Project Administration,
then select the Activity Log tab.

The Activity Log tab contains seven options:

Dates: Allows you to view events according to date of occurrence.
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Include Project Level Activity: Allows site administrators to view project
level activity from the site administration log.

List Options: Allows you to customize the display of information according
to user(s), action(s) taken, or type(s). Type refers to the objects or items acted
upon, such as folder, group, mail, etc.

Refresh List: Allows you to view all actions that have taken place since the
last time you selected the Activity Log tab or the Refresh List button. Use the
refresh option when you have been logged in to your site for a long time.

Recover selected item: Allows you to restore deleted folders and files.

Save Log: Allows you to save the selected Activity Log information to disk.

Active Members: Allows you to see which members are currently logged in
to the site or project.

1 In the Dates field, choose from Between, After, Any Date, or Before, then
enter the date you want.

Optional: Click Refresh List to manually update all actions that have occurred
since the last time you selected the Activity Log tab or the Refresh List button.

NOTE You can sort information by Name, Date, Action, Type, or Item by clicking
the corresponding title bar located across the top of the Activity Log view.

To restrict the display of Activity Log information:

1 In the Activity Log tab, click List Options.

2 From the following options, select the check box(es) next to the type of
activity you wish to view:

Users: Specify the members to be included in your Activity Log view.

Actions: Specify actions or activities to be included in your Activity Log
view as follows:

■ If you are using the Site Administration Activity Log, indicate site
member actions, such as changing a password, updating a group,
removing a user, and so on.

■ If you are using the Project Administration Activity Log, indicate
task(s) or activities, such as read, delete, download, change permission,
and so on.

Item Types: Specify the type of file or activity (such as folder, project,
user, and so on) to be included in your Activity Log view. The types of
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files and activities that are available vary, depending on whether you
are using the Site or Project Administration Activity Log.

NOTE If you want to clear all the options in a list, click Clear. If you want to
select each item in a list, click Select All.

When you are finished, your List Options dialog box might look similar to
this:

To view the Activity Log for a single file:

1 Select a file in the tree view.

2 In the toolbar, click the Properties toolbar button,  , and then select
the Activity Log tab.

Or, right-click the file and choose Properties from the menu.

When you view the Activity Log for a single file, you cannot filter the data
that appears in the list. The log includes information such as name, date, and
action.

See also:

Activity Logs (page 143)

Printing Activity Log Information (page 148)
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Printing Activity Log Information

You can print the Activity Log information displayed on screen by saving it
to disk. Then, when it's convenient, import the file into Excel or another
spreadsheet and print the information.

NOTE Your printer settings may need to be adjusted in order to fit all the
information onto one page.

To save Activity Log information to disk:

1 In the Buzzsaw bar, click Site or Project Administration.

2 Click the Activity Log tab.

3 Click the Save Log button and do the following:

Enter the file name you wish to save records to or click Browse and
navigate to the desired destination file.

Use the Field Delimiter field to indicate what separator you want to
appear between exported fields of information in the printed Activity
Log report.

Select the Use Quoted Strings check box if you want to place quotes
around exported field information. With quoted strings, you can easily
distinguish between fields and actually include the separator character
within a given field.

Quotes appear around each exported field of information.

Here's an example of exported information fields using a comma field
delimiter and quote strings:

"John Doe","jdoe@kalamazooinc.com","Project Manager","415 555-1234"

If field delimiters and quote strings are not used, the exported fields of
information might look like this:
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John Doe,jdoe@kalamazooinc.com,Project Manager,415 555-1234

4 Click OK.

Now, import the file into a spreadsheet software program and print the
Activity Log information.

See also:

Activity Logs (page 143)

Using the Activity Log (page 145)
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Information Pages

Information Pages

Overview

Information pages are a way for administrators to communicate information
to all project members. Dashboards provide you with a personalized view of
your site and projects, enabling you to see assigned action items and when they
are due.

The default information pages are available to all members. There is an exception
to this rule: the default setting for the Site Executive Summary, Project Executive
Summary, and the Portfolio Information pages is: "Viewable by Selected Site
Members". When adding these pages the option, Viewable by Selected Site
Members, is the default. If members are not added to this list, then only
administrators can see these two pages.

Project members with No Access Permission can only see site level information
pages. An administrator can always see all information pages even when the
"viewable by" list does not explicitly list the administrator.

The default setting for the Site Executive Summary, Project Executive Summary,
and the Portfolio Information pages is: "Viewable by Selected Site Members".
When adding these pages the option, Viewable by Selected Site Members, is the
default. If members are not added to this list, then only administrators can see
theses two pages.

Administrators can add custom information pages to a site or project. While
any type of file can be selected as the source for an information page, web pages
(HTML files) are the best choice because a special application is not required to
view them. For example, a Microsoft Excel spreadsheet can be an information
page. However, only project members who have Excel can view the spreadsheet.

7
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Administrators can further customize the page by specifying a unique name
for the page. You can also re-name the default pages.

Available information pages:

Following is a list of default pages available in Buzzsaw:

Buzzsaw Profession-
al

BuzzsawInformation Page

XSite Executive Summary

XSite Personal Summary

XSite Details

XPortfolio (site)

XXSite Information

XProject Executive Summary

XProject Personal Summary

XProject Details

XProject Data

XXProject Directory

XXProject Information

To view a project information page:

1 Select a project in the tree view.

2 From the Project bar, select Project Information.
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The pages available for you to view are displayed in the drop-down menu.

If you receive an error message when attempting to view a page it means that
you do not have adequate permission to view the page. Contact your project
administrator to have your permission level changed.

To view the site information page:

1 Click the Site icon (the gray ball) in the tree view.

2 From the Project bar select Site Information.

3 The pages available for you to view are displayed in the drop-down menu.

If you receive an error message when attempting to view a page it means that
you do not have adequate permission to view the page. Contact your project
administrator to have your permission level changed.

The information page is displayed.

See also:

Dashboard Overview (page 275)

Step 5: Manage Information Pages (page 269)

Changing the Information Pages

As a site administrator you can select a custom information page to display
for your site and projects. Site administrators can control which information
pages are available at the site level. Project administrators can control which
information pages are available for a project.

Buzzsaw comes with default information pages. These default pages can be
removed and replaced with any number of custom information pages. While
any type of file can be selected as the source for an information page, web
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pages (HTML files) are the best choice because a special application is not
required to view them.

In addition to adding customized information pages, you can control which
members have access to an information page, and when they view that page.
For example, when the member first logs in to the site, you can specify that
the member sees a specific information page. However, if a member does not
have permission to view an information page, then the page is not displayed
in the member’s Site/Project Information menu. By default, all members can
view all information pages.

To select a site information page:

An information page can be an HTML file or other type of file (for example,
gif, bmp, doc, xls).

1 Select the site in the project tree.

2 In the navigation bar click Site Setup and then Information Pages.

3 The Information Pages window is displayed. The default pages are listed
in the window.

4 To add a new page click the Add Page button. The Add Information
page dialog box is displayed.

5 Enter a name for the page in the Page Name field. The name field can
contain any character including spaces. This field is required. To accept
a default name for an automatically generated page, go to step 6and
select a source. The name field is populated after you select the source.
If you are entering an external URL as the source, the name field is
required.

6 Select a page by clicking the Select Source drop-down list. From this
menu you can select one of the automatically generated pages. Or browse
the files in your site or on your computer for a new page. You can also
enter an URL to use an external web address as an information page.

7 Select which members can view this page: all site members or selected
individuals.

8 Click OK. Click Cancel if you do not want to add these pages to the
site.
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To select a project information page:

An information page can be an HTML file or other type of file (for example,
gif, bmp, doc, xls).

1 Select a project in the project tree.

2 In the navigation bar click Project Setup and then Information
Pages.

3 The Information Pages window is displayed. The default pages are listed
in the window.

4 To add a new page click the Add Page button. The Add Information
page dialog box is displayed.

5 Enter a name for the page in the Page Name field. The name field can
contain any character including spaces. This field is required.

To accept a default name for an automatically generated page, go to step
4 and select a source. The name field is populated after you select the
source.

If you are entering an external URL as the source, the name field is
required.

6 Select a page by clicking the Select Source drop-down list. From this
menu you can select one of the automatically generated pages, or browse
the files in your site or on your computer for a new page.

You can also enter an URL to use an external web address as an
information page.

7 Select which members can view this page: all project members or selected
individuals.

8 Click OK. Click Cancel if you do not want to add these pages to the
site.

To control who can view an information page:

You can control which members have access to an information page, and
when they view that page. For example, when the member first logs in to the
site, you can specify that the member sees a specific information page.

If a member is not given the ability to view an information page, then the
page is not displayed in that users Project Information menu. By default, all
project members can view all information pages. However, the default setting
does not apply to the Site Executive Summary, Project Executive Summary,
and the Portfolio Information pages. When adding these pages the option,
Viewable by Selected Site Members, is the default. If members are not
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added to this list, then only administrators can see the Site Executive, Portfolio
and Project Executive pages.

NOTE Controlling access to information pages is a powerful option. You can
choose to restrict members from seeing a dashboard. However, restricting access
can prevent members from viewing assigned items.

To change the page order:

As an administrator, you can control in what order the member sees the
information pages.

To display the information pages in a different order, select a page and use
the Move Up or Move Down buttons. Doing so changes how the pages are
displayed in the Site/Project Information menu in the navigation bar.

To change the initial view:

You can specify which page site and project members see upon login for each
session. This option can be set at the site level and the project level. The
following options apply to the information page that is set to display first in
the Site/Project Information menu.

For this section, Initial View for this site or project for each session,
select one of the following options:
■ First information page the user has access to view — If selected,

site and project members see an information page the first time they visit
this site or project after logging into the site.

■ Files view — If selected, site/project members will see the files view in
the details pane the first time they visit the site/project after logging into
the site.

■ Last page viewed by the user — the last page the member viewed will
be the first page the member sees the next time the member logs in.

These settings apply to all members who have access to the information page.

See also:

Step 5: Manage Information Pages (page 269)

Information Pages (page 151)
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Folders

Folders

A folder is a container for organizing project files and other folders. A folder is
used to store project files, drawings, form logs, links, and notes that are associated
with the project. You must have Administrator permission to create project
folders. Folders can be project folders or standard folders. A project folders is
orange and a standard folder is yellow. A project folder stores administrative
information and a standard folder stores data.

NOTE Project and standard folders can appear at any level in the hierarchical tree
view.

1 = Site level

2 = Project folder

3 = Standard folder

Converting Project and Standard Folders

If you have Administrator permission, you can convert standard folders to
project folders and vice versa — at any level of the tree view hierarchy. For
example, if the original standard folder (and all of the subfolders) has grown to
a point that it's difficult to manage, you may want to convert it to a project
folder and then rename it as needed.

8
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Both standard and project folders serve as containers for related subfolders.
The main difference between the folder types is that with project folders, you
can designate and change a project information URL. You are also able to
perform more administrative tasks by using the Project Administration tabs
(available only when you are working with a project folder).

Conversely, it may be that you started with one project folder, but the
organization of the project has changed and grown. In that case, all you need
to do is convert the project folder to a standard folder and then create a new
project folder and as many standard folders as you need to support the new
organization of your project.

NOTE Keep in mind that project and standard folders are automatically sorted
and placed in alphabetical order in the tree view. If you want to reposition a
converted folder, you must rename it alphabetically (first letter of new folder name)
for it to appear where you want it in the hierarchical tree view.

For more information see Converting Project and Standard Folders (page 48).

NOTE It's a good idea to confirm the permission list for a converted folder to make
sure that the list contains the correct individuals and groups, given the new position
of the converted folder in the tree view.

For more information about assigning permission at the project and folder
level, see Setting permissions at the folder or file level (page 137).

Standard Folders

You create and use standard folders and subfolders to organize and store project
information (text files, drawings, links, and notes) for your work environment.
You must have Administrator or Edit permission to create standard folders.
Standard folders and subfolders are yellow folders, so it is easy to distinguish
them from project folders.

If you have Administrator or Edit permission, you can move folders from
project to project. You can also drag files into a folder, create notes, or add
links within a folder.

For more information see Adding a File (page 176).

NOTE You cannot move folders or project files from one Buzzsaw site to another.
For example, you cannot open two browsers (and two separate sites) and then
drag files between the two sites.
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See also:

Adding a New Folder (page 159)

Deleting a Folder (page 160)

Adding a New Folder

Folders are used to organize all the files (including text files, drawings, links,
and notes) associated with a project. You must have Administrator or Edit
permission to add folders to a site.

NOTE Project Administrators can add project folders and standard folders, but
members with Edit permission can add only standard folders.

See Folders (page 157) for more information.

You can also convert folders to projects and vice versa at any level within the
tree view hierarchy. See Converting Project and Standard Folders (page 48)
for more information.

To add a new folder:

1 In the tree view select the folder where you want to add a subfolder.

2 Right-click the selected folder and choose Add Folder.

A new folder appears in the tree view.

3 Enter a name to replace the New Folder name default.

You can cut, copy, move, paste, and delete folders in the tree and detail views
just as you are able to do in Microsoft Windows Explorer.

If you have been assigned Administrator or Edit permission, you can also move
folders from project to project within a single site by dragging files to the
desired project folder.

See also:

Setting permissions at the folder or file level (page 137)

Converting Project and Standard Folders (page 48)

Deleting a Folder (page 160)
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Deleting a Folder

By default, all users can permanently delete folders that they own, or have
administrator or edit permissions to. Site Administrators can restrict who can
empty the Recycle Bin (thus permanently deleting the folder). If the default
is changed so that only Administrators can empty the Recycle Bin, then project
members can only "soft" delete files. That is, deleting a file sends it to the
Recycle Bin. The folder can then be recovered from the Recycle Bin unless an
Administrator permanently deletes it. To change who can empty the Recycle
Bin, click the Site Administration icon, and then click the General tab.

In the tree view, select the folder you want to delete and do one of the
following three actions:

■ In the toolbar, click the Delete button,  .

■ Right-click and choose Delete.

■ Press the DELETE key on your keyboard.

When an administrator deletes a folder, all contents (including subfolders)
are permanently deleted from the system.

See also:

Recycle Bin (page 237)

Using the Recycle Bin (page 238)

Working Folders

Working folders is the term used to describe the folders on your hard drive
that are used to store files when they are downloaded from Buzzsaw. A strong
relationship exists between the files and folders you store on your site and
those you download to your local computer. The first time you download and
update files and folders you identify a directory path for the selected folder(s),
which can include all of its subfolders and files. Then, each time you download
and edit items on your local computer or update them (which creates a new
version on your site), the default path is automatically used.

Other notes about how working folders work:
■ Although the system remembers the last directory path you specified, you

always have the choice to modify the path.
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■ Even if you download a folder that contains subfolders the first time, you
can download single subfolders or files from the folder at a later time, and
the system remembers the most recent directory path you provided.

■ If the local directory path changes, you can establish a new path the first
time you update items from your local computer. Just drag and drop the
items from your local computer to your site.

■ If you add new files to the folder that you've downloaded to your local
computer, they are automatically uploaded with the original content of
the folder when you update to your site.

See also:

Downloading a Folder (page 161)

Updating a Folder (page 163)

Downloading a Folder

You can easily download a project or standard folder and all of its contents
to your local computer, make changes to some (or all) of the downloaded files,
then upload the modified files by using the Update Project Documents wizard

(click the Update File toolbar button,  ).

NOTE All files are automatically compressed when they are moved to your local
computer or to the site. You do not need to compress (ZIP) files, subfolders, or
folders. The exception is when AutoCAD is used to load a file from your site. In
this case, the file is moved by AutoCAD, hence it is not compressed.

To download a folder:

1 In the tree view, select a folder.

2 Right-click and choose Download. The Select Download Destination
dialog box is displayed.

3 Click Browse and navigate to a destination on your local computer.

4 NOTE The directory path you choose now becomes the Working Folder.
The next time you download the same path address will automatically appear
in the To: field. You can change the working folder at any time.

5 To include all the subfolders within the selected folder, select the
Include subfolders option.
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6 Click OK.

See also:

Updating a Folder (page 163)

Working Folders Dialog Box (page 403)

Recovering a Folder

If you have Site Administrator or Project Administrator permission, you can
recover folder(s) or file(s) that have been permanently deleted from the system
as long as you do so within 30 days from the day the item(s) was deleted.

1 In the Buzzsaw bar, click Site or Project Administration.

2 Click the Activity Log tab.

3 In activity list select the item that was deleted. Deleted items are listed
by the action, "delete". Items in the Recycle Bin cannot be restored as
they have not been deleted yet.

4 Select the item and click the Recover Selected Item button. The Folder
Recover dialog box is displayed.

5 In the Destination field confirm the destination of the recovered folder.

6 Select the items you want to restore and a check mark is displayed to
the left.

7 TIP To save time, click Clear All if you want to clear all the files in the list.
If you want to select all the files, click Select All.

8 If you want the system to prompt you before recovering each file, click
the Prompt for Each File button. If you want to define the recovery
rules, click the Don't prompt, use Recovery Rules button.

9 Recovery Rules

If the file already exists, you can:

Skip Recovery — An S is displayed to the left of the file name in the
list. Existing files on your hard drive are not replaced.

Replace Existing File — Existing files on your hard drive are replaced
by the files you are downloading.

Add Recovered Version — Adds the recovered version(s) as new
version(s) to the existing file.
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10 Make a version restoration choice by clicking the Restore All Versions
or Restore most recent version button.

NOTE If you want to restore the original file(s) comments, select the Restore
Comments check box. If you want to restore the original file(s) markups,
select the Restore Markups check box.

11 When you're through, click OK.

See also:

Updating a Folder (page 163)

Working Folders Dialog Box (page 403)

Updating a Folder

You can update project and standard folders and their subfolders and files
after you are finished editing them. The updated version(s) is copied from
your local computer back to the Buzzsaw server by using the Update Project
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Documents wizard. The wizard automatically launches when you drag an item
to the target folder in Buzzsaw. It then walks you through uploading, starting
a discussion, and notifying key team members that a new item or version is
available.

NOTE The project that you are uploading files to may have a size limit in place.
If the size limit is reached an error message is displayed and you cannot upload
files until more space is available. To make more space available, delete items or
contact your project or site administrator to increase the size limit.

To update a folder or file:

1 In the tree view, select the target folder or file.

2 In the toolbar, click the Update File toolbar button,  . The Update
Project Documents wizard is displayed.

3 Select the folder(s) or file(s) you want to upload to the server. Click
Browse to choose files as needed, then click Next.

4 You can add a subject line and a comment, which becomes the first
discussion item for this document. Then click Next.

5 You can send an email notification about this file. To copy the subject
line and comment from the previous screen into the email, click Copy
comment. To select an email recipient from the list of project members,
click To.

6 To add the item, click Finish. This also adds the comment and sends
the email notification. (Click Finish at any time to copy the file to your
site without adding comments or email.)

NOTE You can use drag-and-drop or Cut/Copy/Paste to update a folder or file in
your site. If an item with the same name exists in the folder on the site it is assumed
that you want to update the existing item and you are prompted to update the
file (a new version is created), update all, skip, or skip all (which cancels the upload
process). When you use Cut/Copy/Paste to add or update documents they are
not locked.

When you save changes or add new information to files the new data is
uploaded to the Buzzsaw server. As you update files, you will see the updated
file name within your project folder in the tree view. As soon as the upload
process is completed, the file size changes from the number zero (0) to the
correct size.
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If you are in the midst of uploading files and click Cancel, a message is
displayed and asks if you to confirm the cancellation. If you choose Yes, the
procedure is cancelled without uploading the files.

All files are automatically compressed when they are moved to your local
computer or the server. You do not need to compress (zip) files, subfolders,
or folders.

The updated version of the folder, subfolder, or file becomes the new version
(appears in the Project Files/Versions tab list as version 2), the older version
is moved (appears in the same list as version 1), and the item is unlocked.

NOTE Be careful when updating files that you do not overwrite changes made
by another member who may have edited and the same file. For tips about sharing
project file information effectively, see Collaborative Work Environment (page 25).

See also:

Collaborative Work Environment (page 25)

Downloading a Folder (page 161)

Adding a Link to a Folder or File

A link is a shortcut to a file, form, form log, folder, project or web site. Links
are merely shortcuts to other places within a site. This is similar to creating a
shortcut on your desktop to a program that you use often. Navigating through
a large site can be time consuming and a link can help you reach a desired
location quickly.

Adding a link provides an easy way for others to view related information.
For example, you can add a link to a project to provide a quick way for project
members to get to the project from another location on your site without
actually having to navigate to that location.

NOTE Project members can only view linked items to which they have permission.
That is, if Sally does not have permission to Project B, she will not be able to follow
the link to Project B. If you want all members to be able to access the linked item,
ensure that they are members of the parent project.

To add a link:

1 Select the item that you want to link to in the Details view (right-hand
pane of the window).
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2 Press and hold the right mouse button while dragging the item to the
destination folder, or project, in the tree view.

3 Release the mouse button and choose Create Link Here from the

menu. 

The link is created and displays in the destination folder. Example.

To view a link, click it in the tree view, or double-click it in the details view.

You can also create a link using the Create Link wizard. This method allows
you to create a comment and send an email notification to other project
members. To use the wizard select the destination in the tree view and
right-click. Choose Add ➤ Link and follow the wizard instructions.

NOTE Using the wizard you can only link to a project, folder, or form log by typing
the path to the item in the Address field in the Create link window. You can not
select a project, folder, or form log using the browse window.
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To copy a link:

1 In the tree view select the desired link.

2 Right-click and choose Copy.

3 Select the target folder.

4 Right-click and choose Paste.

You can also drag and drop the link from the details view to a folder in the
tree view.

To delete a link:

Deleting a link does not delete the original file, just the link.

1 In the tree view, select the link.

2 Right-click and choose Delete.

You can also delete links using the View Links command. See the next section
for details.

To use the View Links command:

Once a link is created the View Links command on the right-click menu is
enabled for that item. This command opens a dialog box that displays all the
links to the selected project, folder or file. This dialog box does not show all
the links within a site, but merely the links for a selected folder or file.
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Using this dialog box is useful when moving or deleting files; you can view
all the related links in one location and update them as necessary.

To access the view links dialog box:

1 In the tree view, select the item that you want to see links for.

2 Right-click and choose View Links. The Link dialog box is displayed.
All the links that have been created for this item are listed. From here
you can delete, edit, or lock the link.

See also:

Adding a Link to a Note (page 185)

Using Properties

The Properties command provides information about the selected item. The
options available to you depend on your permission level and the file you
have selected.

The Properties tabs provide a way to change member and group permission
levels or display a list of all the actions (such as read, download, and so on)
that have taken place since the file was created.

Accessing properties:

To see the properties of a folder, file, form log, link, or note:

1 Select the item and right-click.

2 Choose Properties from the menu. You can also access this dialog box
by clicking the Properties toolbar button.

The following table describes the options available according to your access
level:

Available Tabs:Selected Item:

Administrator - General and Members tab.Folder
Non-administrator - General tab.

Administrator - General, Members, and Activity Log tab.File
Non-administrator - General tab.
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Available Tabs:Selected Item:

Administrator - General tab.Form log
Non-administrator - General tab.

Administrator - General, Members, and Activity Log tab.Link
Non-administrator - General tab.

Administrator - General, Members, and Activity Log tab.Note
Non-administrator - General tab.

Following is a description of each tab:
■ General tab — see Using the File Properties General Tab (page 405).

■ Members tab — Available only to administrators. See Members Tab (page
58) or Members Tab (page 106).

■ Form Links Tab — Available to administrators and members if there is
a link to the file from a form. See Linking Documents to a Form (page 317).

See also:

Folders (page 157)

Working Folders Dialog Box (page 403)
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Files

About Project Files

The Project Files function provides a hierarchical list (a tree view, similar to that
used in Windows Explorer) of all the folders and files in the project. To reveal
or hide levels, click the + and - symbols to the left of the folder in the list.

When you select an item in the tree view, the details (organized in multiple
tabs) appear in the details view to the right.

If a file has discussions associated with it, then the number of discussions is
displayed on the Discussions tab.

NOTE Right-click menu options are available at any time but change depending
on the active view and activity.

See also:

Using the Discussions Tab (page 172)

Using the File Properties General Tab (page 405)

Using the Markups Tab (page 174)

Using the Versions Tab (page 173)

Using the View Tab (page 172)
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Using the View Tab

The View tab is used to open and display the contents of a project file in the
Details view (located on the right side of the screen). You can also add lines
and text to a drawing file, save the file with the markups (redlines) as a DWF
file, and put it in the location of your choice on the site or your local computer.
The View tab is available to all project members except those with List or No
Access permission.
■ View in Window button — click to open the file in a new window.

■ Markup button — this button is displayed if you are viewing a .dwg file.
Clicking the button publishes the .dwg to .dwf if necessary, which enables
you to markup the file. The Markup tab opens and then, in the Markups
tab the newly published .dwf file is listed one level below the .dwg. Any
markups associated with that .dwf are listed one level below the .dwf.

■ Xrefs button — this button is displayed if Xrefs are missing and indicates
the number of missing button. Click the button to resolve xrefs.

See also:

Markups (Redlines) (page 248)

Viewing a File (page 180)

Using the Discussions Tab

The Discussions tab displays all the discussion threads that are attached to
the selected project file. Project members do not have to be active participants
in discussions to read them. The number of discussion threads for a file is
displayed on the Discussions tab.

You must have Administrator, Edit, or Review permission to participate in
discussion threads (e.g., start or reply to a comment). If you have View
permission, you can only read and print the information contained in
discussion threads. If you have List permission, you are not able to view the
Discussions tab.
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Discussions are especially useful if you want to link messages together to
exchange information and make decisions as a team. Discussion threads are
organized and stored along with the related file.

NOTE Discussion threads for markups are stored with a specific markup file. To
view the discussion threads for a particular markup you must open the markup in
a new window and then click the Discussions tab.

See also:

Delete a Discussion Thread (page 203)

Reply to a Discussion Thread (page 201)

Start a Discussion Thread (page 201)

Using the Versions Tab

The Versions tab provides a list of all versions of the currently selected file.
The Versions tab is used to:

Open and view any file version:

Click the Versions tab, select the version you want from the list, and then
click the View in Window button or click the View tab.

The contents of the selected file now appear in the View tab or in a separate
window.

Download the selected file version to your local computer:

Select the version you want, click the Download button, and select the target
location to save the selected file.

The file is copied to the location you specified.
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Review or edit comments that are attached to the selected file version:

In the Versions tab you can review the comments made by other members
about different versions of a document.

To review comments:

1 Click the Versions tab.

2 Select a version from the list.

3 The comment for that version (if one was made) is displayed in the lower
pane of the window.

The Edit Comment button is available after you upload a new version of a
document. You can only edit the comment for the version that you uploaded
-- you cannot edit the comments for versions that other members uploaded.
Once you have created a comment you cannot edit it.

To compare two versions of the same drawing:

1 Within the project tree select a drawing.

2 Navigate to the Versions tab.

3 Click the Compare DWFs button. The Compare DWFs dialog box is
displayed.

4 Under Version 1 select a version.

5 Select a sheet.

6 Under Version 2 select a second version and then select a sheet.

7 Click OK. The selected sheets are displayed in Autodesk Design Review
for comparison.

See also:

Versions (page 197)

Set the Version Limit (page 199)

View a Version (page 198)

Using the Markups Tab

The Markups tab is used to create, view, or edit markup (DWF only) files. You
can save markup files to a location of your choice, either on the site or your
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local computer. You must have Admin, Edit, or Review permission to create
markups.

The number of markups associated with the original drawing is noted on the
Markups tab. However, the number only refers to the markups that are
associated with the drawing. If you save a markup as a separate file (either to
your site or your local hard drive) that markup is not included in the number
on the markups tab.

To compare two drawings:

1 Within the project tree select one or more drawings.

2 Right-click and select Compare DWFs. The Compare DWFs dialog box
is displayed.

3 The name of the file you selected in the project tree is displayed in the
field, File 1. If you want to select a different file click the Browse button
and navigate to the desired file.

4 Select the sheet to be used in the comparison.

5 Under File 2, click the Browse button and select Browse project
folders to select a second file. Alternatively you can select Browse
local files to select a file for comparison from your local hard drive.

6 Select the sheet for to be used in the comparison.

7 Click OK. The selected sheets are displayed in Autodesk Design Review
for comparison.

To compare two versions of the same drawing:

1 Within the project tree select a drawing.

2 Navigate to the Versions tab.

3 Click the Compare DWFs button. The Compare DWFs dialog box is
displayed.

4 Under Version 1 select a version.

5 Select a sheet.

6 Under Version 2 select a second version and then select a sheet.

7 Click OK. The selected sheets are displayed in Autodesk Design Review
for comparison.
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See also:

Markups (Redlines) (page 248)

Viewing a Markup File (page 251)

Using the Form Links Tab

The Forms Links tab is used to view which forms are linked to this file. A link
is only displayed if this file is linked to a form. If you are going to move or
delete the file you can look here first to see which forms will be impacted.
You can access the form that this file is linked to by clicking the name of the
form in the Linked to By column.

See also:

Linking Documents to a Form (page 317)

Adding a Form (page 309)

Links Tab for Forms (page 319)

Adding a File

After you set up a new project you can add files to it. File types include
drawings, text files, links, and notes. Once you've added files to any project
folder you can share them with others and exchange ideas about the contents.
You can also allow project members to edit selected files.

When a file is added to your project it is copied from your local computer and
placed inside a project folder on your site. The file is stored on the Buzzsaw
server and is available to other project members, as determined by their
permission levels. The ability to view files in Buzzsaw depends on your browser
and the plug-ins that you have installed on it. By default, you can view HTML,
text, GIF, and JPEG files.
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AutoCAD drawing files (DWG, DWF, and DXF) can be viewed if you have
Autodesk True View, or AutoVue Professional installed.

To add a file:

1 In the Project Selection bar choose the project you want.

2 In the tree view select a target folder.

3 In the standard toolbar, click Add, then the file type (document, drawing,
etc.).

You can also drag the existing file(s) from your local computer to a
destination within your site.

The Add to Project wizard opens.

4 The Add to Project wizard will lead you through the remaining steps
and options, such as attaching a comment and sending email
notification. It is recommended that you add no more than 250 files at
a time. This limitation does not apply to adding files via the
drag-and-drop method.

5 Click Finish at any time to copy the file to the site without adding
comments or sending an email.

NOTE The project that you are adding a drawing to may have a size limit in place.
This means that if the size limit has been reached you will receive an error message
and you can not upload files until more space is available. To increase the available
space, items need to be deleted from the project or the size limit needs to be
increased. Contact your project or site administrator.

See also:

Versions (page 197)

Editing a File (page 177)

Viewing a File (page 180)

Editing a File

If you have Administrator or Edit permission, you can edit drawings,
documents, links, and notes from within your site.

When you click the Edit toolbar button,  , the selected file (stored on the
site) is locked so others cannot edit the file at the same time you are working
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with it. You then choose a target location to save the selected file on your
local computer.

After the file is downloaded, the application registered as the file type's editor
with Microsoft Windows opens the file on your computer (if a file is a link or
a note, it is edited within your site).

NOTE  All project members can download, view, and save a copy of a locked file
to their local computer. However, only those with Edit or Administrator permission
can update files (back to the site) once they have been edited.

When you have completed your editing session, click the Update toolbar

button,  to upload the file to your site. If you quit your editing session
before making any updates to the file, the file is unlocked. See Locking and
Unlocking a File (page 187) for more information.

Working In a Collaborative Environment:

To make sure the exchange of information goes smoothly—and that edited
files are not accidentally overwritten—you may want to establish some basic
communication guidelines. A collaborative work environment works most
effectively if you decide how you want to work together as a team, set up the
ground rules, and then let all project members know the rules right from the
start of the project.

To edit a file:

1 In the details view (or tree view), select the file you want to edit.

NOTE If you do not want to download the selected file, press the CTRL key
while you click the Edit icon and then choose No.

2 In the standard toolbar, click the Edit toolbar button.

When you've finished editing the file, it's a good idea to save the file to your
local computer. If the file is ready to be shared with other project members,
the updated version can be copied back to the site using the Update Projects
Document wizard (In the standard toolbar, click the Update File icon). The
current version of the file becomes the new version (2), the older version is
"bumped" (1), and the file is unlocked.

Otherwise, you can continue to edit the file until you are ready to share the
changes with others.
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Tips for updating files:

■ You can drag-and-drop or use Cut/Copy/Paste from your desktop to a file
within your site. If a file with the same name exists in the target folder it
is assumed that you want to update the existing file.

■ You can use the Cut/Copy/Paste method to add or update a file only if the
item is not locked.

■ Previous versions of your project files are stored on the site. For more
information about working with multiple versions, see Versions (page 197)
and View a Version (page 198).

■ When editing a Microsoft Word file, close any open sessions of Microsoft
Word first. Then, download the Word document from your site to your
local hard drive, make your edits and save the file. The Update Project
Documents wizard is displayed.

■ The project that you are uploading files to, may have a size limit in place.
This means that if the size limit has been reached you will receive an error
message and you can not upload files until more space is available. To
make more space available, either items need to be deleted or the size limit
needs to be increased. Contact your project or site administrator.

See also:

Adding a File (page 176)

Deleting a File (page 179)

Updating a File (page 192)

Deleting a File

Your permission level determines what type of file you can delete. If you have
Edit or Administrator permission you can delete all file types. If you have
Review permission you can only delete link and note files.

For non-administrators, deleting a file means sending it to the Recycle Bin.
Only Site and Project Administrators can permanently delete files from the
Recycle Bin. When used by non-administrators, the shortcut key, Shift+Delete
deletes the file to the Recycle Bin. When Admins use Shift+Delete , the file is
permanently deleted.
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NOTE  You cannot move or delete files that are locked (Exception: Administrators
can delete locked files). If you try to do this, an error message is displayed. For
example, if you try to delete a folder that contains a locked file, the error message
is displayed, the folder remains (with the single locked file in it), and all other
unlocked files are deleted from the server.

To delete a folder or file:

1 In the tree view select an item.

2 Click the Delete toolbar button,  .

3 A confirmation dialog box is displayed before deleting the file from the
server. Items in the Recycle Bin can be recovered.

4 The selected item is moved to the Recycle Bin.

See also:

Using the Recycle Bin (page 238)

Viewing a File

Buzzsaw uses the same plug-ins and ActiveX controls that your browser uses
to display files. Generally, you must install the appropriate application to view
a file. If you can't see the selected file when loading into your browser, you
will not be able to view it in your site. Once you've installed the application
that handles the file format you want to view, it automatically launches when
you open a file in Buzzsaw.

NOTE Buzzsaw does not automatically resize files (for example, .JPGs). When
viewing pictures this may cause you to scroll back and forth in order to see the
full picture. This is a known limitation.

To view a file:

1 In the tree view or details view, select the file you want.

2 In the details view, click the View tab.

3 The contents are displayed in the View tab window.

NOTE To make sure that external reference paths are found and loaded
(resolved), click the Check External References button.
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4 If you are viewing a drawing file, you can start the markup process by
clicking the Markup button.

To view a file in a new window:

1 Select a file in the project tree.

2 Click the View tab.

3 Click the View in Window button.

or

Select the file in the project tree and right-click. Choose View in
Window from the menu.

See also:

Adding a File (page 176)

Deleting a File (page 179)

Editing a File (page 177)

Adding a Note

Notes are text files that are created and stored in folders within a project.
When you create a note, you are creating a stand-alone file (similar to a Word
document) that can be edited or updated directly within your project site,
without requiring an additional application. There are some simple formatting
options (font, point size, etc.) available when you create a note, similar to the
way Microsoft Word works. You can also create a hyperlink in a note.

There are many useful ways to use notes. As an example, you can create a note
about the specifics of a folder or file, or, simply record your thoughts. Then,
as with any other file on your site, you can email the appropriate project
member(s) to let them know that the note has been posted.

NOTE The right-click menu options available to you within a note may vary. For
example, if the note has already been marked as read, the Mark as Read right-click
menu option for that note will not be available.

Each note is stored in the associated project folder. Unlike comments (and
discussion threads), you cannot chain notes together. If you want to create
and chain together messages to exchange information, see Start a Discussion
Thread (page 201).
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To add a note:

1 In the tree view, select the target folder or file.

2 Right-click and choose Add  ➤ Note from the menu.

3 In the Add to Project wizard window, enter your note and format it as
desired.

4 Click Next.

Or, you can initiate a threaded discussion by adding a comment, which
becomes the first discussion item for this file. Then click Next.

You can send email to notify team members that this file has been posted.
To copy the subject line and comment from the previous screen into
the email, click Paste comment. To select an email recipient from the
list of project members, click To.

5 Click Finish to add the note and send the email notification.

You can also create a hyperlink within the body of your note to connect
members to specific information on the Internet. To create a hyperlink,
highlight the text within the note that will become the hyperlink, click the
globe icon (located in the upper right corner), and enter the desired destination
URL in the address field.

See also:

Adding a Link to a Note (page 185)

Start a Discussion Thread (page 201)

Adding a Link to a Folder or File

A link is a shortcut to a file, form, form log, folder, project or web site. Links
are merely shortcuts to other places within a site. This is similar to creating a
shortcut on your desktop to a program that you use often. Navigating through
a large site can be time consuming and a link can help you reach a desired
location quickly.

Adding a link provides an easy way for others to view related information.
For example, you can add a link to a project to provide a quick way for project
members to get to the project from another location on your site without
actually having to navigate to that location.
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NOTE Project members can only view linked items to which they have permission.
That is, if Sally does not have permission to Project B, she will not be able to follow
the link to Project B. If you want all members to be able to access the linked item,
ensure that they are members of the parent project.

To add a link:

1 Select the item that you want to link to in the Details view (right-hand
pane of the window).

2 Press and hold the right mouse button while dragging the item to the
destination folder, or project, in the tree view.

3 Release the mouse button and choose Create Link Here from the

menu. 

The link is created and displays in the destination folder. Example.

To view a link, click it in the tree view, or double-click it in the details view.

You can also create a link using the Create Link wizard. This method allows
you to create a comment and send an email notification to other project
members. To use the wizard select the destination in the tree view and
right-click. Choose Add  ➤ Link and follow the wizard instructions.

NOTE Using the wizard you can only link to a project, folder, or form log by typing
the path to the item in the Address field in the Create link window. You can not
select a project, folder, or form log using the browse window.
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To copy a link:

1 In the tree view select the desired link.

2 Right-click and choose Copy .

3 Select the target folder.

4 Right-click and choose Paste from the menu.

You can also drag and drop the link from the details view to a folder in the
tree view.

To delete a link:

Deleting a link does not delete the original file, just the link.

1 In the tree view, select the link.

2 Right-click and then choose Delete from the menu.

You can also delete links using the View Links command. See the next section
for details.

To use the View Links command:

Once a link is created the View Links command on the right-click menu is
enabled for that item. This command opens a dialog box that displays all the
links to the selected project, folder or file. This dialog box does not show all
the links within a site, but merely the links for a selected folder or file.
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Using this dialog box is useful when moving or deleting files; you can view
all the related links in one location and update them as necessary.

To access the view links dialog box:

1 In the tree view, select the item that you want to see links for.

2 Right-click and choose View Links. The Link dialog box is displayed.
All the links that have been created for this item are listed. From here
you can delete, edit, or lock the link.

See also:

Adding a Link to a Note (page 185)

Adding a Link to a Note

Adding a link within the text body of a note provides an easy way for others
to view related or reference information. For example, you can send a note to
a project member and include a link to a vendor's Web site. It's convenient
for those who need the linked information and it's easy to do.

There are two ways of adding a link to a file or to a note. If you want to add
a link to a folder of file, see Add a Link to a Folder or File.

To add a link to a note:

1 Use the Project Selection menu to select the project you want.

2 In the shortcut bar, click Project Files and then select the folder or file
where you want the note and link.

3 Right-click and choose Add  ➤ Note.

4 Enter your note and format it as desired.

There are some simple formatting options (font, point size, etc.) available,
similar to the way Microsoft Outlook works.

5 Within the note, highlight the text that will become the hyperlink.

6 Click the globe icon (located in the upper right corner) and enter the
desired destination URL in the Address field.

You can also click the Browse folder to the right of the Address field to
select a folder or file from another location on your site. Remember, the
folders and files available to you are those that you have been given
permission to work on.
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7 Click OK.

8 Click Finish to add the link or click Next to add a comment or send
an email notification.

See also:

Adding a Note (page 181)

Adding a Link to a Folder or File (page 165)

Downloading a Folder or File

You can easily download a project or standard folder and all of its contents
to your local computer, make changes to some (or all) of the downloaded files,
then upload the modified files by using the Update Project Documents

wizard (click the Update File toolbar button,  ).

NOTE All files are automatically compressed when they are moved to your local
computer or to the site. You do not need to compress (ZIP) files, subfolders, or
folders. The exception is when AutoCAD is used to load a file from your site. In
this case, the file is moved by AutoCAD, hence it is not compressed.

To download a folder or file:

1 In the tree view, select the folder or file you want to download.

2 Right-click and then choose Download from the menu.

The Download dialog box appears.

In the To: field, enter the destination path for the downloaded item on
your local computer or click Browse and navigate to the correct
destination location on your local computer.

NOTE The directory path you choose now becomes the Working Folder.
This means that the next time you download the same path address will
automatically appear in the To: field. You can change the working folder at
any time.

3 If you are downloading a folder and want to include all the subfolders
within the selected folder, select the Include subfolders option.

4 Click Download.
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See also:

Updating a File (page 192)

Working Folders Dialog Box (page 403)

Locking and Unlocking a File

If you have Administrator or Edit permission, you can lock a file, preventing
other project members from editing the file. A locked file can still be
downloaded or viewed by other project members depending on the assigned
permission levels.

NOTE Those with Administrator and Edit permission can delete folders with locked
files in them, but they will not receive a warning message. If you have Review,
View, or List permission, you cannot move or delete files that are locked. If you
try to do this, an error message is displayed. For example, if you try to delete a
folder that contains a locked file, you see the error message, the folder remains
(with the single locked file in it), and all other unlocked files are deleted.

When you choose Lock, the file is locked but remains on the site. You can
wait until later to edit the locked file. Administrators can unlock a file at any
time even if they didn't originally lock the file.

To lock and download a file at the same time, Administrators and Editors can
choose Edit from the right-click menu. The selected file is downloaded to
their local computer and locked on your site. To see who locked a file, select
the file and click the General tab. The member’s name is listed next to Edit
Lock.

When cloning a project, any "locked for editing" files within the project are
cloned as unlocked. A new copy of the file is created and the lock removed.

To lock a file:

In the tree view, right-click the file you want to lock, and then choose Lock.
The lock symbol appears to the left of the item in the tree view.

NOTE Selecting a log in the tree view locks all the forms within that log. To lock
an individual form select it in the details view.

Once the file is locked it cannot be edited by others.

Files | 187



NOTE Choosing Edit automatically locks the files.

To unlock a file:

When you update the file to your site the locked file is automatically unlocked.
However, you can unlock a file without actually updating it. For example, you
can edit a file and unlock it without updating your changes to the site.

In the tree view, right-click the file and choose Unlock (the lock symbol
disappears).

Locked files and the recycle bin

When a locked file is put in the recycle bin, the lock is removed. If a file that
was previously locked file is restored from the recycle bin to a project, the file
is restored as unlocked.

See also:

Editing a File (page 177)

Updating a File (page 192)

Downloading a Folder or File (page 186)

Recovering a File

If you have Site Administrator or Project Administrator permission, you can
recover a file that has been permanently deleted from the system as long as
you do so within 30 days from the day the item was deleted.

1 In the shortcut bar, click Site or Project Administration.

2 Click the Activity Log tab.

3 In activity list select the deleted item. Deleted items are listed by the
action, "delete". Items in the Recycle Bin cannot be restored as they have
not been deleted yet.

4 Select the item and click the Recover Selected Item button. The Folder
Recover dialog box is displayed.

5 In the Destination field confirm the destination path of the recovered
file.

6 Select the items you want to restore and a check mark is displayed to
the left.
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7 TIP To save time, click Clear All if you want to clear all the files in the list.
If you want to select all the files, click Select All.

8 If you want the system to prompt you before recovering each file, click
the Prompt for Each File button. If you want to define the recovery
rules, click the Don't prompt, use Recovery Rules button.

9 Recovery Rules

If the file already exists, you can:

Skip Recovery — An S is displayed to the left of the file name in the
list. Existing files on your hard drive are not replaced.

Replace Existing File — Existing files on your hard drive are replaced
by the files you are downloading.

Add Recovered Version — Adds the recovered version(s) as new
version(s) to the existing file.

10 Make a version restoration choice by clicking the Restore All Versions
or Restore most recent version button.

NOTE If you want to restore the original file comments, select the Restore
Comments check box. If you want to restore the original file markups, select
the Restore Markups check box.
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11 When you are through, click OK.

12 In the Destination Path field of the File Recovery dialog box, confirm
the destination path of the recovered file. Click the Choose button to
edit the destination.

By default, the name of the deleted file is displayed. If the file's parent
doesn't exist then a folder named Recovered Files is created for you. You
can rename this folder.

13 Select the file, comment, and markup you want to recover from the list.
A check mark is diplayed.

If a file of the same name exists, the recovered version is added as the
most recent version.

14 Select the View in Window option to view the file in a separate
window. Select the Go to option to view a hierarchical tree view.

190 | Chapter 9   Files



15 When you're through, click OK.

See also:

Updating a Folder (page 163)

Working Folders Dialog Box (page 403)

Renaming a File

To rename a file:

1 In the tree view, right-click a file and then choose Rename.

2 Enter a new name.

Similar to the way Windows folders work, no two project files in the
same folder are allowed the same name. If a file is added to a folder and
a file of the same name already exists, you have two options:

Update - The file(s) is copied to the site and becomes the current version.

Skip - The procedure is canceled.

See also:

Versions (page 197)

Updating a File (page 192)

Editing a File (page 177)
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Updating a File

You can update project and standard folders and their subfolders and files
after you are finished editing them. The updated version is copied from your
local computer back to the Buzzsaw server by using the Update Project
Documents wizard. The wizard automatically launches when you drag an item
to the target folder in Buzzsaw. It then walks you through uploading, starting
a discussion, and notifying key team members that a new item or version is
available.

NOTE The project that you are uploading files to, may have a size limit in place.
This means that if the size limit has been reached you will receive an error message
and you can not upload files until more space is available. To make more space
available, either items need to be deleted or the size limit needs to be increased.
Contact your project or site administrator.

To update a file:

1 In the tree view, select the target folder or file.

2 In the toolbar, click the Update File toolbar button,  . The Update
Project Documents wizard is displayed.

3 Select the folder(s) or file(s) you want to upload to the server. Click
Browse to choose files as needed, then click Next

4 You can add a subject line and a comment, which becomes the first
discussion item for this document. Then click Next.

5 You can send an email notification about this file. To copy the subject
line and comment from the previous screen into the email, click Copy
comment. To select an email recipient from the list of project members,
click To.

6 To add the item, click Finish. This also adds the comment and sends the
email notification. (You can click Finish at any time to copy the file to
your site without adding comments or email.)

NOTE You can use drag-and-drop or Cut/Copy/Paste to update a folder or file in
your site. If an item with the same name exists in the folder on the site it is assumed
that you want to update the existing item and you are prompted to update the
file (a new version is created), update all, skip, or skip all (which cancels the upload
process). When you use Cut/Copy/Paste to add or update documents they are
not locked.
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When you save changes or add new information to files (you must have
Administrator or Edit permission; those with Review permission can add and
save comments only), the new data is uploaded to the Buzzsaw server. As you
update files, you will see the updated file name within your project folder in
the tree view. As soon as the upload process is completed, the file size changes
from the number zero (0) to the correct size.

If you are in the midst of uploading files to the server and click Cancel, a
message appears and asks if you really want to stop the data upload process.
If you choose Yes, the procedure is cancelled without transferring the file(s)
to the server.

All files are automatically compressed when they are moved to your local
computer or the server. You do not need to compress (zip) files, subfolders,
or folders.

The updated version of the file becomes the new version (is displayed in the
Project Files/Versions tab list as version 2), the older version is moved (appears
in the same list as version 1), and the item is unlocked.

NOTE Be careful when updating files that you do not overwrite changes made
by another member who may have edited and the same file. For tips about sharing
project file information effectively, see Collaborative Work Environment (page 25).

See also:

Collaborative Work Environment (page 25)

Download Folder Dialog box (page 405)

Working with Multiple Views

You can view two or more windows at once. This is helpful if you need to
work with several project files at the same time.

To view in window

Use this option to open a selected file in the details view (so you have access
to all the tabbed options) in a separate window. Because the selected file
information appears in a separate window, you can then view any number of
details about two files at the same time.

As an example, if you want to view a drawing but you also need to view the
related discussion thread, select the drawing file from the list in the tree view,
right-click, and then choose View in Window. The selected file appears in a
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separate window. You see the contents of the file (View tab) and you also have
access to all the other tabbed options (General, Discussion, and Activity Log).
Then, by navigating back to the first window and selecting the Discussion
tab, you can read the information in both the View and Discussion tabs as
needed.

To view file in a new window:

1 Select a file in the project tree.

2 Click the View tab.

3 Click the View in Window button.

Use this option as a convenient work tool to locate the task and activity options
you use most often (Site Administration, Project Files, What's New, etc.) in a
separate window from the main browser.

For example, if you are working in a particular file but want to reference the
Project Information page, right-click the Project Info task, click the View in
Window button, and select the Project Information tab. The project
information is displayed in a window separate from your browser, and you
haven't lost your place with the work you were doing originally.

NOTE To view multiple windows at the same time, use the mouse to resize and
position each separate window.

To open and view multiple project files:

1 In the tree view, select the file you want to view.

2 Click the View tab and then click the View in Window button.

3 This option opens the selected file in the details view (so you have access
to all the tabbed options) in a separate window. Because the selected file
information appears in a second window, you can view any number of
details about two files at the same time.
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To view multiple tools from the shortcut bar:

1 In the shortcut bar, select the desired tool.

2 Right-click and then choose Open in New Window.

This option works as a convenient work tool to open the task and activity
options you use most often (Site Administration, Project Files, What's
New, etc.) in a separate window.

3 Repeat steps 1 and 2 until you have opened all the tasks or project files
you want to view.

To view multiple windows at the same time, use the mouse to resize and
position each separate window.

See also:

Editing a File (page 177)

Using the View Tab (page 172)

View a Version (page 198)
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Using Properties

The Properties command provides information about the selected item. The
options available to you depend on your permission level and the file you
have selected.

The Properties tabs provide a way to change member and group permission
levels or display a list of all the actions (such as read, download, and so on)
that have taken place since the file was created.

Accessing properties:

To see the properties of a folder, file, form log, link, or note:

1 Select the item and right-click.

2 Choose Properties from the menu. You can also access this dialog box
by clicking the Properties toolbar button.

The following table describes the options available according to your
access level:

Available Tabs:Selected
Item:

Administrator - General and Members
tab.

Folder

Non-administrator - General tab.

Administrator - General, Members,
and Activity Log tab.

File

Non-administrator - General tab.

Administrator - General tab.Form
log Non-administrator - General tab.

Administrator - General, Members,
and Activity Log tab.

Link

Non-administrator - General tab.

Administrator - General, Members,
and Activity Log tab.

Note

Non-administrator - General tab.
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Following is a description of each tab:
■ General tab — see Using the File Properties General Tab (page 405).

■ Members tab — Available only to administrators. See Members Tab (page
106).

■ Activity Log tab — Available only to administrators and only when a
file is selected.

The Activity Log tab displays a list of all the actions (such as read,
download, change permission, and so on) that have taken place at the file
level since the item was created. You can also see the date the file was
originally created, and the author's name.

If you are viewing the activity log for a form, you can see which project
members assigned and responded to an item.

Use the filters to show or hide information according to Date, Users,
Actions, or Types. For detailed procedures, see Using the Activity Log (page
145).

■ Form Links Tab — Available to administrators and members if there is
a link to the file from a form. See Linking Documents to a Form (page 317).

See also:

Using the Activity Log (page 145)

Members Tab (page 58)

Using the Folder Properties General Tab (page 401)

Versions

Versions Overview

When you create a new file version, you post an updated version of a file that
already exists on the site. The new version should be added to a folder in the
project where an older version with the same name exists. The updated version
of the file becomes the new version (version 2), and the existing file becomes
the previous version (version 1).

To create a new version:

1 Drag the desired file from your local computer to the appropriate project
location in your site. The Update Project Documents wizard appears.
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NOTE The Update button on the standard toolbar can be used to update
a file only when you have downloaded the file to your local computer.

2 Select the file (from your local computer) that you want to update. Click
Browse to navigate and select the desired file. Click Next to accept the
file information as it appears.

You can add a subject line and a comment, which becomes the first
discussion item for this document. Then click Next.

You can send an email notification about this file. To copy the subject
line and comment from the previous screen into the email, click Copy
comment. To select an email recipient from the list of project members,
click To.

3 To update the file, click Finish. This also adds the comment and sends
the email notification.

NOTE You can click Finish at any time without adding comments or email.

See also:

Set the Version Limit (page 199)

View a Version (page 198)

View a Version

To view a version:

1 In the tree view, select a file.

2 In the details view, click the Versions tab.

3 Select the version you want and then choose from the following options:

Download: The selected file is downloaded from your site to your local
computer. When you download a file, the result is the same as copy/paste.

View in Window: The selected file is opened in the details view in a separate
window. You also have access to all the tabbed options (in case you want to
select from the other tabs). Then you can navigate to your site, open any other
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file, and use the tabbed options to view a variety of details about the second
file. You can view information about both files at the same time.

See also:

Versions (page 197)

Set the Version Limit (page 199)

Set the Version Limit

You may want to give some thought to the number of file versions that are
saved in your project. You can choose between saving all versions or limiting
the number of versions.

For example, if you have large numbers of files—and if the file sizes are also
large—you may want to limit the number of saved versions (according to
available space on your site). If file size is not an issue, you can save all versions.

To set the version limit:

1 In the shortcut bar, click the Project Administration icon and then
click the General tab.

2 Click the Versions button. The Versions dialog box opens.

3 If you want to save an unlimited number of files, click Save all.

4 If you want to save a limited number of versions, click Limit to and then
use the arrows to indicate the maximum number of file versions to be
saved —or type in the desired value.

NOTE Once you limit the number of saved versions, each time a version is
saved, the oldest version is bumped up to the next number. If you limit the
number of versions and then save over the limit number, the file versions
beyond the limit are deleted.

5 Click OK.
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See also:

Versions (page 197)

View a Version (page 198)

Discussion Threads

Discussion Threads Overview

You can add and chain together messages to exchange information and make
decisions as a team. Discussion threads are organized and linked to a specific
file (drawing, document, note, or link). Discussions can be read by members
with Admin, Edit, View, or Review permission. Project members do not have
to be active participants in discussions to read them.

For example, if you want to copy a drawing file to a Review folder on your
site, it is a good idea to start a discussion thread at the same time, letting the
appropriate team members know of any additional details about the file.
Because you have started a discussion, it's easy for reviewers to reply by adding
additional comments as they work with the file. Those with Review, View,
and Edit permission can follow along without adding or replying, as the
discussion evolves.

When adding a discussion thread you can also send an email to project
members, notifying them of the new thread. This is similar to sending an
email notification when uploading a file.

Discussion threads cannot be deleted unless the associated file is deleted.
When the file is deleted, all the connected discussion threads are permanently
removed from the system.

There is a separate discussions tab for forms. For more information see
Discussions Tab for Forms (page 321).

See also:

Delete a Discussion Thread (page 203)

Reply to a Discussion Thread (page 201)

Start a Discussion Thread (page 201)
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Start a Discussion Thread

You can start and chain together messages to exchange information and make
decisions as a team. Discussion threads are initiated, organized, and linked to
a specific file (drawing, document, note or link). Discussions can be read by
members with Edit, View, or Review permission. You can also send email
notifications to project members when starting or adding a thread.

To start a discussion thread:

1 In the tree view, select the desired file.

When you select a file, you also identify the item with which the
discussion thread will be stored.

2 In the details view, click the Discussions tab.

3 Right-click and choose Add  ➤ Comment from the menu.

The Text Editor dialog box opens.

4 Enter a title in the Subject line.

5 Position the cursor in the text box and enter your comments.

6 Click Next. The Send Email Notification dialog box appears. Sending
an email is optional. If you do not wish to send an email, click the Finish
button. To send an email, continue with the following steps.

7 Click the To button to select recipients. Note that you can only select
recipients who have already been added to the project.

8 Enter a subject and a message.

9 Click Finish.

The thread is added to the Discussions tab and the email is sent.

See also:

Discussion Threads (page 200)

Delete a Discussion Thread (page 203)

Reply to a Discussion Thread (page 201)

Reply to a Discussion Thread

You can reply to a comment as a way to keep a discussion going, exchange
information, and make decisions as a team. Project members do not have to
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be active participants in discussions to review the information contained in
them.

To reply to a discussion thread:

1 In the tree view, select the desired file.

2 In the details view, select the Discussion tab.

3 Select the comment you want to respond to, right-click, and then choose
Reply to Comment from the menu.

The Text Editor dialog box opens.

4 Enter the reply text in the comment region and click OK.

Your reply appears beneath the original comment in the details view.

See also:

Discussion Threads (page 200)

Delete a Discussion Thread (page 203)

Start a Discussion Thread (page 201)
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Delete a Discussion Thread

Discussion threads cannot be deleted unless the associated file is deleted.
When the file is deleted, all the connected discussion threads are permanently
removed from the system.

1 In the details view (or tree view), select the file you want to delete.

2 In the standard toolbar, click the Delete button.

A confirmation message is displayed before deleting the file from the server.
Note that if you change your mind, there is no Undo command. Delete with
care!

See also:

Discussion Threads (page 200)

Reply to a Discussion Thread (page 201)

Start a Discussion Thread (page 201)

Drawings

Drawings Overview

For optimum use, it's best to install the appropriate viewer to open and view
drawing files. Buzzsaw uses the same plug-ins and ActiveX controls that your
browser uses to display files, so if you can't see the drawing files (DWG , DWF,
or DXF) when you load them into your browser, you will not be able to view
them in Buzzsaw.

Buzzsaw is fully integrated with the Autodesk family of viewers. The drawing
file formats that you are able to view depend on the viewer that is installed
on your computer. For more information see Available Viewers (page 241).

NOTE Whichever viewer you choose, the viewer may not always render selected
files with complete accuracy. This is a function of the viewer's ability to approximate
the selected image or information as created by the file's native application and
is not related to the performance or capabilities of Buzzsaw.
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Drawing File Format Options

Following is a description of the drawing file formats:
■ DWG — the standard format for saving vector graphics from within

AutoCAD

■ DWF/DWFx — a highly compressed format created from a DWG file

■ DXF — an ASCII or binary version of an AutoCAD file

■ IPT, IAM, IDW — Autodesk Inventor

■ Bitmap files — For a complete listing of bitmap file types that can be
viewed and marked up, see Supported Bitmap Files (page 413).

See also:

Add/Update to Project - Select Drawings Wizard (page 417)

Viewers and Markups (page 241)

Edit an Existing Drawing (page 209)

Add a New Drawing

You can add drawing files to any project folder and then collaborate and
exchange ideas about the contents — or allow team members to edit drawing
files. Buzzsaw recognizes .dwg and .dwf drawing file types.

When you add a drawing file to your project, the file you select from your
local computer is uploaded and placed inside a project folder within your site.
The file is stored on the site and is available to other project members (level
of interaction depends on the assigned permission).

NOTE You can launch the Add Drawing wizard from the ProjectPoint.exe or
AutoCAD. You do not have to open a browser in order to add drawings to your
site.

To add a new drawing:

1 In the tree view (or details view), select the destination folder for the
drawing file.

2 Right-click and choose Add  ➤ Drawing from the menu. The Add to
Project wizard opens.

204 | Chapter 9   Files



3 In the first screen, click Browse. Use the File Open dialog box to select
the desired file, and then click Open.

4 Click Next. Add a subject line and a comment, which becomes the first
discussion item for this file.

5 Click Next.

6 You can send an email notification about this file. Click the Copy
Comment button to copy the subject line and comment from the
previous screen into the email. To select an email recipient from the list
of project members, click To.

7 To add the file, click Finish. This also adds the comment and sends the
email notification. You can click Finish at any time without adding
comments or sending an email.

You can also use drag-and-drop or Cut/Copy/Paste from the Microsoft Windows
desktop to add a drawing to your site. If a drawing with the same name exists
in the target folder, it is assumed that you want to update the existing drawing,
not create a different drawing.

NOTE The project that you are adding a drawing to may have a size limit in place.
This means that if the size limit has been reached you will receive an error message
and you can not upload files until more space is available. To increase the available
space, items need to be deleted from the project or the size limit needs to be
increased. Contact your project or site administrator.

See also:

View a Drawing (page 205)

Update a Drawing (page 208)

Edit an Existing Drawing (page 209)

View a Drawing

Buzzsaw uses the same plug-ins and ActiveX controls that your browser uses
to display files. It's best to install the appropriate viewer to open and view
drawing files. If you can't see the drawing files (DWG, DWF, or DXF) when
you load them into your browser, you will not be able to view them using
Buzzsaw.
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To view a drawing:

1 In the tree view (or details view), select the drawing file you want to
view.

2 In the details view, click the View tab.

NOTE To make sure that external reference paths are resolved, click the Check
External References button.

If the selected drawing(s) are not on your site, they may still be found on your
local file system depending on how your Xrefs were assembled. If Xrefs can't
be found using the path information provided but they reside in the same
directory, they are located and loaded (resolved). This is consistent with the
way AutoCAD works. The External References button displays information
about files that have been uploaded to your site only.

To view a versioned drawing:

1 In the tree view, select the file you want to view. The file information is
displayed in the details view.

2 At the top of the details view, click the Versions tab.

3 Right-click a version choose View.

NOTE When you click View in Window, the selected file information is displayed
in the details view in a separate window. You also have access to all the tabbed
options in case you want to select from the other tabbed information. You can
then navigate to your site, open any other file, and view a variety of details about
two files at the same time.

To view a drawing in a separate window:

1 Select a drawing in the project tree.

2 Click the View tab.

3 Click the View in Window button.
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To compare two versions of a drawing:

1 Select a drawing in the project tree.

2 Click the Versions tab.

3 Click the Compare DWFs button.

See also:

Add/Update to Project - Select Drawings Wizard (page 417)

Viewers and Markups (page 241)

Edit an Existing Drawing (page 209)

Compare Drawings

You can compare two drawings to see changes that have occured. You can
compare drawings in three ways: both drawings are within Buzzsaw, one
drawing is in Buzzsaw and the second is on your local hard drive, or compare
two versions of the same drawing.

To compare two drawings:

1 Within the project tree select one or more drawings.

2 Right-click and select Compare DWFs. The Compare DWFs dialog box
is displayed.

3 The name of the file you selected in the project tree is displayed in the
field, File 1. If you want to select a different file click the Browse button
and navigate to the desired file.

4 Select the sheet to be used in the comparison.

5 Under File 2, click the Browse button and select Browse project
folders to select a second file. Alternatively you can select Browse
local files to select a file for comparison from your local hard drive.

6 Select the sheet for to be used in the comparison.

7 Click OK. The selected sheets are displayed in Autodesk Design Review
for comparison.

To compare two versions of the same drawing:

1 Within the project tree select a drawing.
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2 Navigate to the Versions tab.

3 Click the Compare DWFs button. The Compare DWFs dialog box is
displayed.

4 Under Version 1 select a version.

5 Select a sheet.

6 Under Version 2 select a second version and then select a sheet.

7 Click OK. The selected sheets are displayed in Autodesk Design Review
for comparison.

See also:

Add a New Drawing (page 204)

View a Drawing (page 205)

Edit an Existing Drawing (page 209)

Update a Drawing

You can easily update a drawing after you are finished editing it. The updated
version is moved from your local computer back to your site by using the
Update Drawing wizard. The current version of the file is replaced by the
updated version, and the file is unlocked.

To update a drawing:

1 Click the Update File toolbar button,  .

The Update Project Documents wizard is displayed.

2 Select the (updated) file(s) you want to update to your site. Click Browse
to choose files as needed and then click Next.

You can add a subject line and a comment, which becomes the first
discussion item for this document. Then click Next.

You can send an email notification about this file. To copy the subject
line and comment from the previous screen into the email, click Copy
comment. To select an email recipient from the list of project members,
click To.

3 To add the file, click Finish. This also adds the comment and sends the
email notification. You can click Finish at any time without adding
comments or email.
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You can also use drag-and-drop or Cut/Copy/Paste from the Microsoft Windows
desktop to update a file. If a file with the same name exists in the folder where
information is moved to, it is assumed that you want to update the existing
file.

When you use the Cut/Copy/Paste method to add or update a file, the item
is not locked.

Previous versions of project files are maintained on your site.

NOTE The project that you are adding a drawing to, may have a size limit in place.
This means that if the size limit has been reached you will receive an error message
and you can not upload files until more space is available. To make more space
available, either items need to be deleted or the size limit needs to be increased.
Contact your project or site administrator.

See also:

Add a New Drawing (page 204)

View a Drawing (page 205)

Edit an Existing Drawing (page 209)

Edit an Existing Drawing

You can edit drawing files from within your site. This means that changes
made to the file are made on the server that stores your site. The changes are
not made on your local hard drive.

When you click Edit, the selected drawing file is locked so others cannot edit
the file at the same time you are working with it. A locked file can still be
viewed.

To edit a drawing:

1 In the details view, select the drawing file you want to edit.

2 Right-click and choose Edit from the menu.

After you complete an editing session, it is recommended that you save the
drawing to your local computer. If the file is ready to be shared with other
project members the updated version can be copied back to the server using
the Update Project Documents wizard (in the toolbar, click the Update File
toolbar button). The current version of the file is replaced by the updated

Files | 209



version, and the file is unlocked. Otherwise, you can continue to edit the file
until you are ready to share the changes with others.

You can also use drag-and-drop or Cut/Copy/Paste from the Microsoft Windows
desktop to update a drawing in your site. If a drawing file with the same name
exists in the target folder, it is assumed that you want to update the existing
drawing file. When you use the Cut/Copy/Paste method to add or update a
drawing, the item is not locked.

The server maintains previous versions of drawings.

NOTE The project that you are adding a drawing to, may have a size limit in place.
This means that if the size limit has been reached you will receive an error message
and you can not upload files until more space is available. To make more space
available, either items need to be deleted or the size limit needs to be increased.
Contact your project or site administrator.

To edit a locked drawing:

If you have Administrator or Edit permission and attempt to download or edit
a locked file, a message appears to let you know about the existing lock and
asks if you still want to continue the operation. If you continue, the file is
downloaded and saved to your computer but will remain lockded by the editor
who locked the file to start with.

NOTE When downloading a file to your local computer ensure that the file is not
currently open on your desktop.

After the file is downloaded, the application registered as the file type's editor
with Microsoft Windows opens the file on your computer (if a document is
a redline, link, or note, it is edited within Buzzsaw). If you want to choose a
different editing application, you can make the change at this point.

See also:

Add/Update to Project - Select Drawings Wizard (page 417)

Viewers and Markups (page 241)

Update a Drawing (page 208)
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External References (Xrefs)

External References Overview

An external reference (Xref) is a method that AutoCAD uses to link drawing
files together. It is often convenient to use Xrefs because once drawing files
are linked, all updates to the Xref files are automatically reflected in the original
drawing file.

As an example of a similar process, it is often convenient to insert an existing
Excel spreadsheet into a Word document. Then, each time the spreadsheet is
updated, the changes also automatically appear in the Word document.

Ensure that Xref files are found and loaded (resolved) within your site

■ Keep the selected drawing file path(s) relative.

You can convert drawing file path(s) from an absolute path (also know as
hard path) to a relative path (also know as soft path) in AutoCAD before
adding the files to your site. When you convert absolute file paths to
relative paths, as long as the directory structure is maintained, the file can
be found more easily.

To find out if the drawing file path you want to add to your site folder is
absolute or relative.

■ Create a staging folder on your local computer to hold and work with all
the drawing files whose path(s) have been converted.

That way, the original Xref file(s) remained untouched in the original
location on your local computer. When you add the Xrefs to your site, all
you need to do is navigate to the staging folder and copy it to the target
location. As a result, the directory structure is maintained, and the Xrefs
can be easily found in your site.

Path Type Differences

Path types do look the same, but it is easy to tell the difference. Following are
examples:
■ An absolute file path is specific (usually including a drive letter) and

identifies the exact location of a file. An example of an absolute file path
is:

C:\Program Files\ACAD\SAMPLE\1st floor lighting.dwg
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■ A relative file path is a string that identifies an exact file location according
to its parent file position within a specific file structure. An example of a
relative file path is:

..\my programs\drawings\floorplan.dwg

See also:

Downloading External References (page 214)

Uploading External References (page 212)

Uploading External References

You can upload externally referenced files (Xrefs) and view each Xref as needed.
As long as a DWG file is selected, you can scan the AutoCAD drawing for
referenced file(s). You can also upload non standard fonts (such as SHX and
TTF) and choose how the referenced files are displayed (nested, flat, or list
style). To save time, create a target folder in your site for your master file before
you upload Xrefs.

To upload external references:

1 In the tree view select a target folder for your master file.

2 Click the Add toolbar button and choose Drawing (only DWG files are
available to upload) or Document (all file types are available) from the
list.

The Add to Project wizard is displayed.

3 Click Browse to locate and select the desired file.

4 Click Open.

Notice that the Include AutoCAD external references option is selected.

5 Click Next. The master file and a list of all associated referenced files is
displayed.
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6 To select references, complete the following as desired:
■ To upload nonstandard font(s) such as SHX and TTF, select the

Include fonts option.

■ To preserve the folder structure as you see it now, select the Preserve
folder structure option.

■ To clear all selected Xref file(s), click the Clear All button. If all the
Xrefs have been previously uploaded to your site and are up to date,
this saves unnecessary upload time.

7 To select display style, choose from the following:
■ To view the uploaded files in a nested style click the Refresh button

on the standard toolbar (  ).

■ If you want to view the uploaded files in a flat list, click  .

■ To view the uploaded files as they physically appear on your hard

drive click  .

NOTE A check mark indicates that the Xref has been resolved. An X indicates
that the Xref path has not been resolved or there is a problem with it. In this
case, it's a good idea to contact the publisher to resolve the problem.

8 To attach a comment or create an email click Next. To skip comments
and email and upload the drawings and Xref(s) immediately click Finish.
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Downloading External References

You can download externally referenced files (Xrefs) for AutoCAD drawings
and view each Xref as needed. You can also download non standard fonts
(such as SHX and TTF) and choose the path to which the files are downloaded.

NOTE It is not recommended that you use drag and drop to download external
references. If you drag and drop a drawing to your local file system you will not
see the external references. Use the following procedure instead.

To download external references:

1 Select a drawing in your site. Right-click and choose Download. The
Download dialog box is displayed.

2 If you are downloading multiple files, the Download Multiple Files dialog
box is displayed. This area allows you to choose the download path of
the parent drawings. Choosing the Location specified above selection
means that all of the files will be downloaded to the same place. If you
want individual files to be downloaded to different places, then select
the Working Folders option. This allows you to set the download
location for each file.

NOTE This selection only applies to the parent drawings. You can specify
the download location of external references at the bottom of the dialog
box.

3 Click the Include AutoCAD External References button. The dialog box
expands to show the master file and a list of the associated referenced
files. This button only displays if a .dwg file or a folder containing a .dwg
has been selected.
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A check mark next to a file indicates that file will be downloaded. An X
indicates that the Xref could not be found on your site. You can view
the files in three different views:

■ Tree view — shows the files in a nested style so that you can see
subfolders and files.

■

■ Detail view — shows the files and various information about
each file, such as, where the file will be downloaded to on your
hard drive, where the file is stored in your site, author, and the
date the file was last modified. Every column is re-sizable.

■ Folder view — shows how the files as they are physically stored
on your hard drive.

■ To download nonstandard font(s) such as SHX and TTF , select the
Include fonts option. The fonts display below the drawing.

■ By default all Xrefs are selected to be downloaded. You can
individually de-select files, or use the Clear All and Select All
buttons to make your selections. This can save time if there are a lot
of Xrefs selected and you only want to download one or two of them.
Then, it is easier to click the Clear All button and select the two files
you want.

■ If downloading multiple files, click the Include subfolders option
to download any folders below the parent file. If you only want files
from the root of the current folder, then do not select this option.

■ You have three options of directory structures for downloading
external references to:
■ AutoCAD folder structure — the files are downloaded

according to AutoCAD resolution rules to ensure that the external
references will be resolved by AutoCAD. Specifically, Buzzsaw
searches that same folders that AutoCAD would search when
resolving external references for a drawing. If a local copy of the
file is found anywhere on the search path, the external reference
is placed there to avoid duplicate copies. If no local copy is found,
the external reference is placed in the highest priority location in
the search path.

■ Same folder as parent — all the external reference files are
downloaded to the same location as the parent drawing.

■ Working folders — the location that the file was last uploaded
from, or downloaded to. This path is automatically remembered,
but you can change the working folder at any time. Click the
ellipses button to change the working folder.
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■ Click the OK button to start the download.

NOTE At the bottom of the Xref download box there are two sets of numbers
representing the number of the files that you are downloading. The number on
the left (included) shows the number of files that you are actually downloading.
The number on the right (total) shows the total number of files that could be
downloaded. For example, if a file has two xrefs and you only select one to
download, the number on the left will read: Included 2 files. The total number on
the right will read: Total 3 files.

See also:

External References (Xrefs) (page 211)

Uploading External References (page 212)

Working Folders Dialog Box (page 403)
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Find

Find Files

The Files tab of the Find window provides a way to easily search for files
anywhere on your site, within a specific project, folder, or subfolder. You can
limit or expand your search by including search criteria such as date, original
author, file name, or text. You can also include locked files and all text within
all files in your search. Files that match your search criteria appear in the window
display beneath the dialog box. When you click a file name in the list, the
contents of the file appear in the details view to the right of the shortcut bar.

When updating or adding files to the site, the files are scanned and their
keywords are added to a database. Thus, when you search for a keyword or
phrase, rather than scanning the actual files, the database of indexed keywords
is scanned. This results in a faster search.

NOTE When adding a large file, or a large number of files at once, there may be a
time lag between adding the file and the completion of the indexing process. Thus,
if you add a file, attempt to search on it immediately and it doesn't appear in the
search results, this does not mean that the search failed. Try your search again in a
few minutes. Files that are corrupt, or a file type that is not indexed (see Search
Basics (page 219) for a list of file types whose contents are indexed), will not be
returned in the search result.

To learn more about how to search for files, see the following sections:

Search for a file

1 In the tree view, select the site, project, or folder that you want to search.

2 In the shortcut bar, click Find. The Find tab is displayed.
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3 Use the following field options to further narrow your search:

Files named: Specify the file name(s) or type(s) for which you are
searching. In the example above, any files with a .dwg extension are
targeted in the search. This is an example of a wildcard expression.

Look in: Click the arrow to the right to browse for the site, project, or
folder to include in the search. The Search subfolders check box is selected
by default. Click to clear the check box.

Containing Text: If you want to find information in the body of a
file, enter the text you want to include in the search. For example, if you
want to search for all .dwg files in a folder containing the words "first"
and "floor," type the words "first floor" in the Containing Text field. The
search will also include the subject lines of all discussion and version
comments.

Author: From the drop-down menu, select the name of the person who
originally published the file. You can also make the search generic by
selecting "Anyone".

Date: Using the date fields, specify the file(s) you want to search for
based on the date the file was created or the date it was last modified.
For instance, you can elect to search for a file that was last modified
before 01/10/01.
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Search subfolders: Use to search all folders within a site or project.
The check box is selected by default. Click to clear the check box.

Full content search: Use if you want to find information in the body
of a file. When this option is not selected, only file names, and the subject
lines of discussion and version comments are searched.

Ignore case: When searching document titles and descriptions the
search ignores uppercase and lowercase letters. The check box is selected
by default. Full content search is always case-insensitive, even if this
option is not selected.

All versions: Searches all versions of a file, including the latest version.
This option is only used in conjunction with Full content search (all
versions of a file have the same name).

Files locked by: To search for files that you or somebody else has
locked, select the Files locked by check box and choose a name from the
adjacent drop-down menu (you can also choose "Anyone").

4 Click the Search button.

If your search does not produce any matches, make sure you have selected
the right project and then broaden your search criteria. To search for all files,
leave the File named and Containing Text fields blank and click Search (no
wildcards are needed).

Search Basics

A basic search consists of the word or phrase you want to find. The basic rules
for formulating queries are:
■ The Ignore case check box is selected by default, so you can enter your

search criteria in uppercase or lowercase characters.

■ You may search for any combination of letters (a-z) and numbers (0-9).

■ Punctuation marks (alone) can be searched but not quotation marks and
parentheses.

■ Group the elements of your search using double quotes " or parentheses
() to set apart each element. Quotation marks and parentheses must be
paired to make a valid search string.

Search Limitations

The following file types are indexed:
■ .doc — Microsoft Word Documents

■ .dwf — Autodesk Design Web Format files

■ .dwfx — Autodesk Design Web Format files
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■ .dwg — Autodesk AutoCAD Drawings

■ .dxf — Autodesk AutoCAD Drawing exchange files

■ .html, .htm — Hypertext Markup Language files

■ .pdf — Adobe Portable Document Format files

■ .ppt — Microsoft PowerPoint presentations

■ .rtf — Microsoft Rich Text Format files

■ .txt — Microsoft DOS ASCII text files

■ .xls — Microsoft Excel Workbooks

In the following situations a file will not be indexed:
■ Files that are internally password protected

■ Corrupted files

■ Compound documents (for example, an Excel table embedded in a word
doc)

■ Linked (or Xref-ed) content within a document

NOTE Files that can not be read, for whatever reason, are not scanned and
indexed.

Using Wildcard Expressions and Boolean Operator for Full Content
Search

The full content search is quite specific on its own. By default the system
searches for a phrase rather than a single word. Thus, you do not need to add
double quotation marks to your phrase as you might have to in other searches.
However boolean operators and wildcard expressions are available to help
narrow your full content searches for more precise results. When you use the
Files named field, you can search for words or phrases using wildcard
expressions. Wildcard expressions allow you to search for one or more
characters using a question mark or asterisk. Only the Files named field uses
wildcard expressions; it does not recognize the boolean operators AND, OR,
and AND NOT.

The following table shows an example of a wildcard expression search:

Search ResultsExample

Topics that contain the terms "water", "wa-
terfall", "waterproof" etc.

Use an asterisk (*) to match any number of
characters: water*
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Use Boolean operators in the Containing Text field (which does accept AND,
OR, and AND NOT operators), as well as single word and phrase expressions.
As an example, the AND operator enables you to precisely define your search
by creating a relationship between the terms. If you want to find all files that
contain the words "sail" and "water", the search string would look like this:

sail AND water

(or)

sail water (a space between words produces the same results as including
the AND operator)

The AND, OR, and AND NOT operators enable you to precisely define your
search by creating a relationship between search terms. The following table
shows how you can use each of these operators. If an operator is not specified,
then the AND operator is used. For example, the query "spacing border
printing" is equivalent to "spacing AND border AND printing."

ResultsExampleSearch For

Files con-
taining

dib AND paletteBoth terms in the same file

both the
words
"dib" and
"palette"

Files con-
taining

raster OR vectorEither term in a file

either the
word "ras-
ter" or the
word "vec-
tor" or
both

Files con-
taining the

red AND NOT blueThe first term without the second term

word "red"
but not the
word
"blue"
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ResultsExampleSearch For

Files that
contain the
word "sail"

sailA single word

Files that
contain the

"scuba dive" OR scuba diveA phrase

actual
phrase
"scuba
dive" and
all its
grammatic-
al vari-
ations.
Without
the quota-
tion marks,
the query
is equival-
ent to spe-
cifying
"scuba
AND dive",
which will
find files
containing
both of the
individual
words, not
the actual
phrase.

NOTE The |, and & characters can be used as Boolean operators.

See also:

Recycle Bin (page 237)

“ NO LABEL ”

People (page 223)
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People

Use the People tab of the Find window to search for project members within
a site. You can search for members based on partial name, project, or member
status. This is useful if you are trying to find out who is the project
administrator for a specific project.

Use one or all three of the following options to search for people:

1 Enter the member's name in the Name text box. It is not necessary to
enter the person's full name, you can enter a partial name. Note however
that only the first name is searched for.

2 Select a project to search in the Members of list.

3 Select a User Level to search for in the User Level list.

A list of members displays in the pane below the search criteria.

If you are a site or project administrator you can use the right-click menu to
add, edit, or remove a member. Select a member from the list and right-click.

See also:

Find (page 217)
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Notification Manager

Notifications Overview

The notifications feature allows you to subscribe to a notification for a file,
folder, project, or form log. By subscribing to a file (or project or folder) you
will be alerted via email when a change is made to the file. This enables you to
track changes that are made to files and projects without having to constantly
log into your site. Notifications are for two very specific actions: when a file is
updated, and if subscribing to a project, when a file is added.

You can subscribe to an individual file, folder, project, or form log. By subscribing
to one of these items, you are asking to receive a notification for when that
item is updated. There are limitations on the specific types of Automatic
Notification File Types (page 410) and items that you can subscribe to. For
example, you can not subscribe to a link. In order to use Notification Manager
you must at least have the permission of List.

Subscriptions also work for files that are updated via Web Folders. That is, if a
user modifies a file via Web Folders you will receive a notification.

There are two ways to receive a notification:
■ Immediate — An email is sent to you every time a change is made to the

item. Notifications are sent out every ten minutes. This means that if you
upload 100 files to your site and it takes ten minutes for the first 75 to upload,
then the notification that is sent out will notify you that the first 75 files
were changed. Then, in another ten minutes you will receive a second email
notifying you of the changes made to the last 25 files. This method prevents
you from being inundated with 100 single emails.

■ Daily summary — An email is sent to you once a day. This email contains
all the changes made that day to the item that you subscribed to. You can
specify the time of day that you want to receive this email. This is helpful
if for example you are only in the office between the hours of 9 and 11 am.

11
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You can ensure that you will receive the summary at a time when you will
be most likely to read it.

In general, notifications are based on items changing. Please note the following
specifics:
■ Notifications are triggered by changes to the items you subscribe to. You

will receive a notification only if the item has actually changed. If no
changes have been made, you will not receive an email.

■ Moving or copying a file into a new project triggers a notification.

■ If a file is put in the recycle bin, you will stop receiving notifications.
However, if that file is restored to the project tree, your notification is also
restored.

Subscribing to a folder or project

Subscribing to a folder or project has slightly different implications than
subscribing to a file. Subscribing to a folder or project means you will receive
emails about all the activity that happens within the project. Therefore,
depending on the size of the project you may be deluged with emails if you
have elected to receive immediate notification. It is recommended for larger
folders or projects that you select a daily summary for your notification.

When you subscribe to a folder or project you are notified when the files are
updated and when new files are added. Subscribing to a folder or project is a
good way to monitor multiple files at once. It is easier to set-up the notification
for one folder or project versus having to subscribe to hundreds of individual
files.

Subscribing to a file

When subscribing to a file you will not receive emails when markups or
discussions are added to the file. You will only receive notice when the content
of the file has been modified. Also, when a file is deleted you will not receive
a notification, but your subscription to that file will be automatically removed
from the Notification Manager.

Once a file is deleted from the site, your subscription to that file is
automatically deleted. You will not receive an email saying that this item was
deleted.

See also:

Notification Manager (page 227)

Daily Summary Time Dialog Box (page 411)
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Notification Manager

You can manage all of your subscriptions from a centralized location, the
Notification Manager. To open the Notification Manager click the toolbar
button in the main window. From here you can add, change, remove, or
disable subscriptions. Any changes you make within Notification Manager
only apply to you. You can't add, disable, or remove notifications for other
project members.

The Notification Manager window allows you to view all of your notifications
at once. You can customize the window by re-sizing it, and sorting and re-sizing
the columns.

Adding a notification

1 In the tree view select a file, right-click and choose New Notification
from the menu.

NOTE You can select multiple files at once to subscribe to. In the Details
view, hold down the Ctrl key and select the files you want.

2 In the New Notification dialog box, select the type of notification
(immediate or Daily Summary Time Dialog Box (page 411)).
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3 Click OK when you are finished. A confirmation message is displayed,
specifying which file, folder or project, you subscribed to and to which
email address the notification will be sent. If the email address is incorrect
go to Changing Your Member Information (page 17) and edit the address.

You can also add subscriptions through the Notification Manager. Using the
Notification Manager is a convenient way to add multiple notifications at one

time. Click the New Notification toolbar button,  , in the Notification
Manager to reach the New Notification dialog box.

Removing a notification

You can remove subscriptions at any time from within the Notification
Manager.

1 Click the Notification Manager toolbar button,  . The Notification
Manager screen is displayed.

2 Select a subscription and click the Remove toolbar button, 
. The subscription that you removed is no longer listed. Note that you
will not receive a confirmation notice of this removal.

NOTE Clicking Remove only removes the subscription; you are not deleting the
file (or project) from your site.

Changing the type of notification

You can edit when you receive your notification by changing the subscription
type from Daily to Immediate.

1 Click the Notification Manager toolbar button,  . The Notification
Manager screen is displayed.
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2 Select a subscription and click the Edit Subscription toolbar button,

 . The Edit Notification dialog box is displayed.

3 Select a new type from the drop-down list and click OK.

Your selection is reflected in the Notification column of Notification Manager:

Disabling a notification for a single item

You can temporarily disable the notification service for a single item. Disabling
a notification does not delete your subscriptions. It merely turns it off
temporarily for one item. That is, you will not receive an notification in the
next round of emails that are sent out until you turn the service back on.

To disable a notification:

1 Click the Notification Manager toolbar button,  . The Notification
Manager screen is displayed.

2 Select the notification you wish to disable. Right-click and choose Disable
Notification from the menu. (This is also available from the Edit menu.)

A disabled icon (  )is displayed to the left of the file name. You will not
receive any more emails until you turn the service back on for this file.

To enable a notification:

1 Select the file you want to reinstate.

2 Right-click and choose Enable Notification from the menu. As this file
is updated, you will receive emails again.
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You can disable and enable multiple files at once: hold down the Ctrl key and
select the files you want.

NOTE You can still add or remove notifications when the service is disabled.

Disabling all notifications

By setting up notifications you are subscribing to a service that manages your
notifications. You can disable this service which will temporarily turn off all
of your notifications. This does not remove the notifications. This is similar
to stopping your newspaper subscription when going on vacation. You are
not ending you subscription, just temporarily stopping the delivery of the
newspaper.

In the same manner you can stop the delivery of your notifications if you are
going to be away from your email for a time and do not want your inbox to
be inundated with emails. But since you have taken considerable time to set-up
all your notifications you do not want to delete them. Disabling the service
stops the emails from being delivered to you; it does not remove your settings.
As soon as you enable the service, you will begin receiving emails.

To disable all your notifications:

2 Click the Notification Manager toolbar button,  . The Notification
Manager screen is displayed.

3 From the File menu, choose Disable Notification Service. The Notification
Manager toolbar button in the main Buzzsaw Standard window changes

to a disabled toolbar button,  .

A check mark displays next to the menu item indicating that the notification
service has been turned off. To re-activate the service, select Disable Notification
Service from the File menu. The check mark will disappear and all of your
notifications are turned on.

See also:

Notification Manager (page 225)

Daily Summary Time Dialog Box (page 411)
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Mail

Overview of Using Mail

The Mail function, which is similar to Microsoft Outlook, allows you to manage
your email in four folders: Sent, Deleted Items, Drafts, and Outbox.

When you click the Mail icon, these folders appear in the tree view to the right
of the shortcut bar (similar to Microsoft Outlook). To view any message in any
of the folders, select a folder. Then, in the details view to the right, select the
message you want to see.

When you select a different folder in the tree view, the corresponding mail
items appear in the details view.

Right-click menu options are available at any time but change depending on
the active view and activity.

In general, messages are stored according to actions taken; draft messages reside
in the Drafts folder, messages already mailed are in the Sent folder, etc. You can
also move messages into other folders. For example, if you delete a message you
have sent and would like to keep the email after all, you might want to place
it in the Sent folder for easy reference. In addition, you can use the right-click
menu to quickly perform tasks such as opening, printing, and deleting mail
messages.

NOTE Site Administrators can view how the amount of mail being stored by
individual users through the Site Admin General Tab (page 56) and Members Tab
(page 58) tabs.

The following sections describe how to work with Mail:

12
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Mail basics

To see your mail and mail folders, click the Mail button in the shortcut bar.
Your Mail screen will look similar to this:

You can choose to view or place mail in your folders as follows:
■ Sent — Messages already mailed. Every email message you send is saved

here.

■ Deleted items — Messages that you have deleted. You can restore these
messages by dragging them into another folder. Or, select the message
name from the details view, right-click, and choose Restore from the menu.

■ Drafts — Messages you have saved but not yet sent.

■ Outbox — Messages that are ready to be sent. If you attempt to mail a
message and it does not get sent, it will appear in the Outbox. You must
then attempt to send the message again. Messages in the Outbox cannot
be edited; to do so, you must move the message to the Drafts folder.

Using the buttons in the mail toolbar

To sort your messages by a specific category, click the appropriate button on
the Mail toolbar, located above the list of mail messages in the details view.

For example, to sort your messages according to who you have sent them to,
click the To button.

The following list includes all mail-sorting options available to you:
■ Priority (assigned when you create an email)

■ Message status (such as Forward)

■ Follow-up status (assigned when you create an email)

■ File attachments included
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■ Recipient name

■ Subject line

■ Date and time sent

Viewing mail messages and attachments

In the tree view, select the folder you want to view. A list of corresponding
messages appears in the details view to the right.

To view the contents of a mail message, select it from the list. The contents
are displayed in the lower pane, as shown below:

To view a file attachment, double-click the file.

NOTE If the attachment doesn't open, you probably have not specified a viewer.
See Drawings (page 203) for information on choosing a viewer.

Moving mail messages among folders

To move mail messages from one folder view to another, drag and drop the
selected message to the target mail folder.

NOTE Messages placed in the Outbox folder cannot be edited.
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See also:

Creating and Sending an Email Message (page 234)

Creating and Sending an Email Message

Creating and sending email messages to other project members is similar to
sending email in Microsoft Outlook. There is one important difference: As
you create and send messages, you can see lists of members for only those
projects to which you are assigned.

1 Click the Send Mail toolbar button,  .

2 The New Message window is displayed. Use this window to address,
compose, and send email messages.

3 Click a recipient type from the following options:

To: Primary recipients of your message

Cc: Carbon-copy; for secondary recipients

Bcc: Blind carbon copy; for secondary recipients not identified to the
other recipients, including those in the Cc list

4 The Select Recipients window is displayed. Use this screen to select the
project and message recipients. Note that Private and Hidden Groups
(page 128) (non-expandable groups) are automatically placed in the Bcc
field. This prevents the names and email addresses of the private group
members from being exposed to other email recipients.

To select a project:

■ In the Project field of the Select Recipients window, use the
drop-down menu to select the project you want. The member list for
the selected project appears on the left.

NOTE To see the member list that includes all the members on the site,
choose the site name. Remember, you will see the member list for only
the projects you are working on.

To select recipients:

■ Select the member name(s), then click To, Cc, or Bcc.

The selected name(s) are added to the corresponding recipient list
on the right.
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Using the Find button

■ Within the Select Recipients dialog box, you can enter a string to
search the member list data, including name, company, and title.
The first item that matches the search string is selected. Groups are
expanded as needed to display found items. If a match isn't found,
a "text not found" message appears.

To search for specific member data:

2 In the Find text field, enter the search string and then click Find
Next.

3 Select the member name(s), then click To, Cc, or Bcc.

The selected name(s) are added to the corresponding recipient list
on the right.

4 When you are through selecting recipients, click OK.

You will return to the New Message window to complete the
message.

5 Enter a title in the Subject line.

6 Position the cursor in the text box and enter the message text.

7 Choose from the following message options as desired:
■ Print the message: In the New Message window menu, click the

Print icon on the standard toolbar.

■ Insert text from a file: In the New Message window menu, choose
Insert/Text from File, select the file, and then click Open.

■ Insert a link: Select text (text will become active link). From the
Insert menu choose Insert Link. In the Create Link dialog box enter
a URL address or click Browse to navigate and select the file you want
from the site. Click OK.

■ Browse: To attach a file from your site, click the Attach File toolbar
button. Click the Browse button and choose Browse local files to
select a file from your local hard drive. Click OK.

NOTE Attachments are limited to a file size of 20 MB or less. Attempting
to send a larger file will result in an error.

■ Set priority: Click the high priority button (exclamation point) or
low priority button (arrow) to inform readers of the urgency of the
message.
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■ Flag for follow-up: Clicking the flag icon marks a message as
requiring follow-up by recipients. In the Flag for Follow Up dialog
box, select a follow-up description or enter your own. After you send
an email, a red flag is displayed next to the message in the details
view. You can open the message and change the follow-up note as
necessary, as well as select the Completed check box, as a means of
tracking follow-up progress. Marking flagged mail as Completed
registers in the project Activity Log.

8 Click the Send button.

The New Message window closes, and the message is sent to all recipients. A
copy of the message is also sent to your email account for confirmation and
logging.

NOTE Internet email standards require that the lists of To, CC, and BCC recipients
be less than 512 characters. If the number of recipients on an email message
exceeds this length, the message is broken into multiple messages. So that users
do not reply to these messages and expect their replies to go to all of the original
recipients, the To field is changed to
DistributionListWithRepliesToSenderOnly@Buzzsaw.com and the
BCC field is used to deliver the message.

See also:

Mail (page 231)

Private and Hidden Groups (page 128)
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Recycle Bin

About the Recycle Bin

The Recycle Bin allows you to view folders and files that have been deleted from
a project.

When you click the Recycle Bin icon, a list appears in the details view to the
right of the shortcut bar. You can still work with any of the items in the list all
you need to do is select the folder or file you want and then use the tabbed
views beneath the list to view specific file, discussion, or version information.

By default, all users can empty the Recycle Bin (thus permanently deleting files
from the site) of items that they own or have edit permissions to. Site
Administrators can restrict who can empty the Recycle Bin. If the default is
changed so that only Administrators can empty the Recycle Bin, then project
members can only "soft" delete files. That is, deleting a file sends it to the Recycle
Bin. It can then be recovered from the Recycle Bin unless an Administrator
permanently deletes it. To change who can empty the Recycle Bin, click the
Site Administration icon, and then click the General tab.

When a locked file is put in the recycle bin, the lock is removed. If a file that
was previously locked file is restored from the recycle bin to a project, the file
is restored as unlocked.

NOTE  If you permanently delete items and then want them back, you can recover
them — as long as you do so within 30 days from the day the original item is deleted.
You must have Site or Project Administrator permission to recover permanently
deleted items. For more information, see Recovering a Folder  (page 162).

See also:

Recovering a Folder  (page 162)
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Using the Recycle Bin (page 238)

General Tab (page 56)

Using the Recycle Bin

The Recycle Bin is a temporary holding place for all project folders and files
that have been deleted from your project. After you've moved items to the
Recycle Bin, click the Recycle Bin icon, and the list of files you've identified
to be deleted appears in a list in the details view (to the right of the shortcut
bar).

NOTE If the list is empty, it means that you haven't chosen the Move to Recycle
Bin option (right-click the selected file in the tree view) or that you chose to delete
a file permanently directly from the tree view instead of moving it to the Recycle
Bin.

You can still work with any of the items in the Recycle Bin list all you need
to do is select the file you want and then use the tabbed views beneath the
list to view specific file, discussion, or version information.

To work with a file in the Recycle Bin list:

In the shortcut bar, click the Recycle Bin icon, select the file you want, and
then complete any of the following:
■ To view general information about the file, click the General tab beneath

the Recycle Bin list.

■ To view the contents of the file, click the View tab beneath the Recycle
Bin list.

■ To view discussions, click the Discussions tab beneath the Recycle Bin list
and then choose the discussion you want from the Discussions list.

■ To view a different version, click the Versions tab beneath the Recycle Bin
list and then choose the version you want from the Versions list.

■ To sort files according to a category, click a column heading. For example
you can sort files by version, date modified, and project location.

■ To restore a file, select the file you want from the Recycle Bin list,
right-click, and then choose Restore from the menu. The file is moved back
to its former location in the tree view.

■ To permanently delete a file, select the file you want from the Recycle Bin
list, right-click, and then choose Delete from the menu. Click Yes to confirm
removal of the file from the system. By default all users can permanently
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delete a file that they have permission to or have administrator permissions
to. Site Administrators can restrict who can empty the Recycle Bin. If project
members are restricted from emptying the Recycle Bin, then deleting a file
functions as a soft delete. That is, the file is sent to the Recycle Bin where
an Administrator can later delete it from the site. See General Tab (page
56) for instructions on how to change this setting.

NOTE  If you permanently delete an item and then want it back, you can
recover the deleted item if you do so within 30 days from the day the item
was originally deleted. You must have Site or Project Administrator permission
to recover permanently deleted items. For details, see Recovering a Folder
(page 162)

See also:

Recovering a Folder  (page 162)

General Tab (page 56)
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Viewers and Markups

Available Viewers

Buzzsaw is fully integrated with the Autodesk family of viewers. There are
different viewers available depending on your collaboration needs. See the
Viewers Controls website for details on how to download the viewers.
■ Autodesk Design Review (page 242) — the all-digital way to measure, mark

up, and annotate 2D and 3D designs, all without the original design creation
software.

■ Autodesk DWG TrueView (page 244) — a viewer to view, plot, and publish
authentic DWG and DXF files.

■ AutoVue Professional (page 245) — to view and redline CAD files in their
native DGN format. In addition to CAD files, AutoVue supports other file
types.

■ AutoVue (page 248) — view DGN files with this viewer for use within Buzzsaw
only. For more information go to the Viewer information website.

Supported File Types

Viewer

AutoVue
(full

AutoVue
for

DWG
TrueView

Autodesk
Design
Review

File
Type

ver-
sion)

Buzz-
saw

XDW-
Fx

14
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Viewer

XXDWF

XXDWG/DXF

RML

XXDGN

XXBit-
map
files

If you have more than one viewer installed, you can select which viewer is
the default for viewing drawing files in the Preferences dialog box to set these
options. From the Tools menu click Setting Preferences (page 19).

See also:

Autodesk Design Review (page 242)

Autodesk DWG TrueView (page 244)

AutoVue Professional (page 245)

Autodesk Design Review

Buzzsaw supports the use of Autodesk Design Review to view, markup, create,
and print DWFs. You can also use Design Review to manipulate drawing sets
and republish DWF sets. For more information about using the Design Review
refer to the Design Review Help. Position your mouse in the details view of a
DWF. Right-click and select Help. The Design Review help is displayed.

If the Design Review is installed on your computer it is automatically selected
to view and markup DWFs. To use the Design Review to view and markup
bitmaps, explicitly select it in the Preferences dialog box (page 19).

You can compare two drawings to see changes that have occured. You can
compare drawings in three ways: both drawings are within Buzzsaw, one
drawing is in Buzzsaw and the second is on your local hard drive, or compare
two versions of the same drawing.
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Using the DWF Navigator

You can use the DWF Navigator within Buzzsaw to view multiple sheets in
the DWF. You can also access bookmarks and markup items if they exist in
the DWF.

To turn the Navigator on, right-click in the drawing and choose Navigator.
The Navigator is displayed as a floating palette that you can move around the
window.

To compare two drawings:

1 Within the project tree select one or more drawings.

2 Right-click and select Compare DWFs. The Compare DWFs dialog box
is displayed.

3 The name of the file you selected in the project tree is displayed in the
field, File 1. If you want to select a different file click the Browse button
and navigate to the desired file.

4 Select the sheet to be used in the comparison.

5 Under File 2, click the Browse button and select Browse project
folders to select a second file. Alternatively you can select Browse
local files to select a file for comparison from your local hard drive.

6 Select the sheet for to be used in the comparison.

7 Click OK. The selected sheets are displayed in Autodesk Design Review
for comparison.

To compare two versions of the same drawing:

1 Within the project tree select a drawing.

2 Navigate to the Versions tab.

3 Click the Compare DWFs button. The Compare DWFs dialog box is
displayed.

4 Under Version 1 select a version.

5 Select a sheet.

6 Under Version 2 select a second version and then select a sheet.

7 Click OK. The selected sheets are displayed in Autodesk Design Review
for comparison.
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You can use the Design Review to markup DWFs and save the markup to
Buzzsaw.

1 Click the Save toolbar button,  .

2 Choose between saving the markup as an associated file (is saved in the
Markups tab), or as an unassociated file (is saved in the project tree).

Members with View permission can only save a markup to their local hard
drive.

See also:

Viewers and Markups (page 241)

Markups (Redlines) (page 248)

Setting Preferences (page 19)

Autodesk DWG TrueView

Buzzsaw supports the use of the Autodesk DWG TrueView. For more
information about using the DWG TrueView refer to the Viewer Help. Position
your mouse in the details view of a DWG. Right-click and choose Help. The
Autodesk DWG TrueView help is displayed.

With the DWG TrueView you can:
■ view DWG and DXF

■ modify the page settings for a DWG

■ plot a DWG

■ publish a DWG to the DWF format.

You cannot markup a DWG using the DWG TrueView. In order to markup
you must publish the DWG to DWF format. Buzzsaw automatically publishes
the file to DWF if you initiate a markup through the View tab. (Select a file,
click the View tab and then click Markup.) Then, using Design Review you
can markup the file.
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NOTE When using the DWG TrueView inside of Buzzsaw, the DWG tooltips display
even if you have turned them off in the DWG TrueView Options dialog box. This
is also true for the option, Use large buttons for Toolbar. Toolbar buttons
embedded in the DWG TrueView toolbar are not enlarged after selecting this
option.

See also:

Viewers and Markups (page 241)

Autodesk Design Review (page 242)

AutoVue Professional

In addition to allowing drawing-file viewing and markup through Autodesk
Design Review, Buzzsaw also supports AutoVue™ Professional from Cimmetry
Systems. AutoVue provides for viewing and markup of more than 200 different
file formats, including DGN, DWG, DWF, DXF, HPGL, CALS, TIFF, PDF, CSI,
and more.

To download AutoVue Professional, go to the Autodesk Viewers Controls.

Choosing a default drawing viewer

You can choose which viewer to use when viewing drawings. To do so, alter
your Preferences settings.

To choose a drawing viewer:

1 From the ProjectPoint menu (above the Internet Explorer toolbar), select
Preferences.

The Preferences dialog box is displayed.

2 Select Published Drawings (.dwf) in the top portion of the window.

3 From the View With drop-down list, select AutoVue as the default
drawing viewer.

4 Click OK.

NOTE If you change your preferences at the same time you are viewing a drawing,

click the Refresh toolbar button,  , on the standard toolbar in order for the
changes to take effect. Close and reopen the drawing if the viewer toolbar does
not appear in its entirety.
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Viewing files with AutoVue

To view Buzzsaw files with AutoVue, select the desired file and click the View
tab on the right-hand side of the screen. Remember: When you are viewing
drawing files, AutoVue will launch only if you have selected it as your default
drawing viewer (as described previously in this topic).

NOTE Whatever file or drawing viewer you choose, the viewer may not always
render selected files with complete accuracy. This is a function of the viewer's
ability to approximate the selected image or information as created by the file's
native application and is not related to the performance or capabilities of Buzzsaw.

Marking up drawings with AutoVue

AutoVue provides a variety of markup tools, allowing you to create a range
of shapes, lines, text notes, and links, as well as insert symbols and OLE objects.
Members with View access can use AutoVue's markup tools but cannot save
any changes to files within the site.

NOTE To view and mark up drawings with AutoVue, you first must have selected
it to be your default drawing viewer. For more information see Setting Preferences
(page 19).

To mark up a drawing:

2 Select the desired file and click the View tab on the right-hand side of
the screen. The Markup Mode button displays to the top right of the
drawing.

3 Click Markup Mode .

4 Using the AutoVue toolbars, mark up the drawing.

NOTE To exit any tool in AutoVue and restore the use of your mouse pointer
within the drawing, click the right-hand button on your mouse. For help
with AutoVue, launch the standalone application and use the Help menu.

5 To save the markup, click Save on the AutoVue toolbar.

The Save Markup File As dialog box is displayed.

NOTE If you mark up a drawing and then attempt to open a second markup
before saving the first, a message is displayed asking if you want to save your
work. Click Yes to save the markup or No to discard the changes. (The
Cancel option may be disabled).
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6 In the Markup ID field, enter the markup identification number, then
click OK.

Optionally, enter your name, department, company, location, and
telephone number along with the markup ID.

7 When you have finished your markup, click Exit Markup Mode.

To view markups associated with a drawing, select the drawing, then click the
Markups tab. Double-click a markup name to view the file in its own window.

NOTE When working with a markup in AutoVue, it is possible that the file version
to which the markup applies is deleted or is no longer available. In this event, a
message displays asking if you want to associate the markup with the next available
version of the file.

Changing AutoVue's plug-in settings

When installing AutoVue, you are prompted to choose which file types the
viewer will work with. The AutoVue Plug-ins List window allows you to activate
or deactivate plug-ins that launch the software when an associated file type
is opened in Buzzsaw. You can make such changes during and after installation
of the AutoVue software.

To change plug-in settings:

2 On the Windows taskbar, click Start  ➤ Programs from the menu.

3 In the list of programs that appears, select AutoVue  ➤ Setup
 ➤ AutoVue Plugin Setup.

The CSI Plugins Setup dialog box is displayed.

4 Click Add/Remove Components.

5 Using the check boxes provided, choose the Web browser(s) for which
the plug-ins will apply, then click Continue.

The Plug-ins List window appears.

6 The Extensions column displays the file format extensions — for example,
XLS, DOC, BMP, etc. — that each plug-in allows you to view.

7 To choose a plug-in, in the Plug-In Name column, select the appropriate
check box. You can also deselect any plug-in by clearing the check box.

Optional: Highlight the name and use the Select or DeSelect buttons
at the bottom of the dialog box to select or clear a plug-in

8 Click Continue.
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See also:

Viewers and Markups (page 241)

Markups (Redlines) (page 248)

AutoVue

AutoVue for Buzzsaw enables you to view DGN files. This viewer can only be
used within Buzzsaw and does not offer the full capabilities of a fully licensed
version of AutoVue. If both AutoVue and AutoVue for Buzzsaw are installed
then AutoVue is used for viewing drawing files.

For more information go to the viewer information website.

See also:

Viewers and Markups (page 241)

AutoVue Professional (page 245)

Markups (Redlines)

Creating a Markup File

Markups (redlines) are colored lines used together with text to mark areas of
a drawing that need discussion or revision. A markup is a layer that overlays
a drawing rather than a part of the basic drawing file. Markup data is stored
in files in DWF format in the Markups tab, the project tree, or your hard drive.
Markup files can be edited and re-saved as needed.

You can use markups to expedite a discussion or review cycle. People reviewing
the markups do not need AutoCAD to view them. For example, to provide a
DWF file to a project member for review and possible revision, copy the
drawing file to a project folder in your site and use the email notification
option to communicate the file location and that it is available for review.
The project member can review the file, add markups, and save it to the
Markups tab. You can then access and review the markup file and add
comments or make revisions as necessary.
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For instructions on how to create a markup with a specific viewer, refer to the
help for each of those viewers. Within Buzzsaw, open the file using the View
tab. In the viewer toolbar, click the Help toolbar button.

Saving a markup

1 Click the Save toolbar button for the viewer that you are using.

2 The Save Markup File wizard opens. Enter a name for the markup file.

3 Save the file to your site or to your local hard drive. Click the Choose
button to make your selection.

4 Associated markup - The markup is displayed in the Markups
tab list corresponding to the original drawing. Associating markup
files with the original drawing makes it easy to view all the markups in
one place all you have to do is look in the Markups tab list.

To associate the markup with the original drawing, enter a name without
a path in the Name field. The associated markup is included in the count
displayed on the Markup tab. Unassociated markup - The markup is
saved as a separate file (not associated with the original drawing) and
appears in the tree view hierarchy. If you often use the tree view to locate
and work with files, you may want to organize markups in folders and
position them according to the project structure in the tree view list.
That way, you can quickly spot and access the folder and drawings you
want.

To save the markup as a separate file, enter a path along with the name.
Note that saving the markup as a separate file means that it is not
included in the count that displays on the Markup tab.
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5 The Add to Project wizard prompts you through the remaining steps and
options, such as attaching a comment and sending email notification.

6 If you wish, you can click Finish at any time to save the markup file
without adding comments or email.

Depending on which option you chose, the markup is displayed in the Markups
tab or in the project tree view.

Adding a discussion thread to a markup

Discussion threads for a markup are separate from the discussion threads for
the parent drawing.

1 To add a discussion thread to a specific markup file, open the markup
by selecting it in the Markup Tabs list.

2 Right-click and choose View in Window. A new window opens and the
markup is displayed.

3 Click the Discussions tab. Right-click and choose, Add a Comment.
Complete the Add Comment wizard.

Your discussion thread is now associated with this specific markup. Other
project members will not be able to view it unless they open this markup by
right-clicking and selecting, View in Window.

Versioning of Markups

In the Markups tab, each version of the file is listed in a hierarchical view.
The markup itself does not display a version number, but is displayed one
level below the published dwf. All markups associated with a drawing are
displayed at the same level, including markups of markups. For example:
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Saving a markup as an associated file, saves the markup to the Markups tab.
The markup is listed in a hierarchical format under the associated drawing.
For example:

For a list of available viewers and the file types that can be viewed within
Buzzsaw, see Viewers and Markups (page 241).

See also:

Viewing a Markup File (page 251)

Viewing a Markup File

Markup files are managed in two different locations depending on how the
markup was saved originally: in the Markups tab or in the project tree.
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To view an associated markup file:

If you entered a file name without a path when you saved the markup, you
created an associated markup. An associated markup appears in the Markups
tab under the parent drawing.

1 In the tree view or details view, select a file. For example, if you want to
view a list of all the markup files associated with a file named
Kitchen.dwg, select the Kitchen.dwg file from the list in the tree view.

2 In the details view, click the Markups tab.

Markups are associated with a particular version of the published drawing,
and are displayed one level under that drawing.

3 Select the file you want to view from the list.

The contents are displayed in the bottom window.

NOTE If multiple versions of an associated markup file exist, only the most
recent version appears in the Markups tab list.

4 To view discussion threads for this particular markup, select the file in
the Markups tab and right-click. Choose View in Window and then click
the Discussions tab.
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To view associated markup discussions or notes:

1 Select the original drawing file in the project tree.

2 In the details view, click the Markups tab.

3 Right-click the markup and then choose View in Window from the menu.

4 Click the Discussions or Versions tab to view all the notes or discussions
that are connected with the selected markup.

To view unassociated markups:

If you entered a path along with the markup name, you created an unassociated
markup. An unassociated markup is saved as a separate file (not associated
with the original drawing) and appears in the tree view hierarchy. The
unassociated markup is not included in the count that is displayed on the
Markups tab.

1 In the tree view or details view, select the markup you want and then

double-click the markup. 

2 Or, right-click the markup and choose View in Window. The markup
opens in a separate window.

NOTE If multiple versions of a markup file exist, only the most recent version
appears in the tree view. To view a previous version, select the markup you want
in the tree or details view, click the Versions tab, and then double-click the version
you want from the list.

To view unassociated markup discussions or notes:

■ Click the Discussions or Versions tab to view all the discussions and notes
connected with the selected unassociated markup.

See also:

Viewers and Markups (page 241)
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Markups (Redlines) (page 248)
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Buzzsaw Professional
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Overview of Buzzsaw
Professional

Buzzsaw® Professional is an advanced online collaboration service to enable improved
project communication through all phases of the building lifecycle. Buzzsaw
Professional contains all the features of Buzzsaw Standard, plus added functionality
to manage RFIs, submittals, correspondence, and other documents among team
members using a centralized online database. Buzzsaw Professional allows for
customized forms, tracking of communication progress, reports and searching through
all communications to quickly find the data you need.

For an overview of your projects and the items assigned to you, use the Dashboard
Overview (page 275).

Buzzsaw Professional includes the following standard construction forms:
■ Addendum

■ Approval

■ Architect's Supplemental Instruction (ASI)

■ Bulletin

■ Change Order Request

■ Correspondence

■ Daily Reports

■ Meeting Minutes

■ Print Order

■ Request For Information (RFI)

■ Submittals

■ Submittal Package

■ Transmittal

Forms in Buzzsaw Professional are customizable by Autodesk Professional Services
team to meet your companies specific requirements.
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Buzzsaw Professional is available in the following languages: English, French,
German, Italian, Japanese, Korean, Spanish, and Simplified Chinese. You can view
forms that have been created in one of these languages. Internet Explorer
automatically prompts to install the appropriate language pack. A windows
operating system CD may be necessary to complete the installation. See the Internet
Explorer help for more information.

The above features are only available if your company has purchased the higher-tier
Buzzsaw Professional service. If you are interested in finding out more about
Buzzsaw Professional, or would like to customize your existing forms, please contact
your sales representative, or call Customer Care to discuss upgrading your account
at (800) 892 0449.
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Project Setup

Creating a Project

Only available to Buzzsaw Administrators.

A project serves as a container for storing, managing, and sharing files and
discussions. It is easy to create all projects according to your organization's
needs. You will notice that a project behaves like a windows folder holding
subfolders and files that contain team member and administrative information.
You can add new projects at any level of the hierarchy or within existing projects
or folders.

You can also convert folders to projects and vice versa at any level within the
tree view hierarchy. See Converting Project and Standard Folders (page 48) for
more information.

To create a project:

1 Select the site or a project in the tree view.

2 Right-click and choose Add, and then Project from the menu.

3 A project folder  appears in the tree view. The new project is
automatically selected so you can rename it.

4 Rename the project.

5 After renaming the project the Add Project dialog box is displayed. You
have the option of setting up your project now or later. If you select now,
then you will be prompted to complete the Project Setup wizard. If you
choose to setup the project later, you can complete the Project Setup wizard
another time. If you do not wish to see this dialog box each time you
create a new project, then change the Project Creation option in the Setting
Preferences (page 19) dialog box. You can also choose to always start the
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Project Setup wizard when adding a new project, never start it, or to
always ask first. If you turn the Add Project dialog box off you can still
access the pages of the wizard through the Project Setup menu.

NOTE To maintain optimum system performance add members and groups to
your site and projects before adding files.

Step 1: Define Project Data (page 260)

Step 2: Select Project Members (page 262)

Step 3: Assign Project Members to a Role (page 262)

Step 4: Business Processes (page 263)

Step 5: Manage Information Pages (page 269)

Deleting and restoring projects

If a project is deleted and then restored, all project setup parameters will be
restored, including information pages.

See also:

Creating a New Member (page 89)

Converting Project and Standard Folders (page 48)

Permissions (page 130)

Step 1: Define Project Data

Only available to Buzzsaw Professional Administrators.

Step 1 of setting-up a project:

Defining the data for a project is the first step in creating a project. Project
Data allow administrators to customize the data that is displayed in dashboards,
forms, form logs and reports. By using Project Data you will save project
members time when creating forms. Much of the data that is entered in the
Project Data page will be used to auto-populate fields in forms and business
processes, and are displayed in the Project Personal and Executive Dashboard
Overview (page 275).

To define project data:

1 From the Project Setup menu, choose Project Data.
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2 The Define Project Data page is displayed.

3 Fill in the fields as necessary.
■ If you do not fill in a field, it is left blank on the form.

■ You can change the name of a project to something other than that
of the Project Folder.

■ Dates are displayed according to the locale setting on the user's
system.

■ Monetary values are also formatted according to the user's locale
setting.

■ Project size limit section — only site administrators can edit these
values. Project administrators can only view the data. The information
entered here is updated in the Site Administration Limits tab; and
values previously entered in the Limits tab can be viewed here.

4 Click the Preview Notification button to view the email that is sent.

5 When finished, click the Save and Continue button to continue with
the rest of the project setup. If you are editing the data for a previously
created project, click the Apply Changes button.

Project Data can be edited at any time using the Project Setup command in
the navigational bar.

See also:

Project Setup (page 259)

Dashboard Overview (page 275)

Step 2: Select Project Members (page 262)
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Step 2: Select Project Members

Only available to Buzzsaw Professional Administrators.

Step 2 of setting-up a project:

In this step choose the members you want to be involved with this project.
If you do not add a member to the project, that person will not be able to
view any of the files or forms within the project.

1 Click the Add Member button to select a new member. A list of available
members is displayed.

2 Select a member from the list.

3 Use the drop-down list box at the bottom of the window to select a
permission for the member.

4 Click OK.

5 Click the Roles tab at the top of the window to continue to the next
step.

See also:

Permissions (page 130)

Step 3: Assign Project Members to a Role (page 262)

Step 1: Define Project Data (page 260)

Step 3:Assign Project Members to a Role

Available to Buzzsaw Professional administrators only.

Step 3 of setting-up a project:

In this step, you assign the project members selected in Step 2: Select Project
Members (page 262) to a role. Buzzsaw provides you with a set of default roles.
You can create your own Roles (page 303) if the default roles do not meet your
needs. This step is optional. Members do not have to be assigned to a role in
order to participate in the form log.

1 Select a role from the drop-down list at the top of the screen. The window
is initially blank until you add members to that role. Use the Add/Remove
Roles Dialog Box (page 444) button to edit the roles available to the
project.
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2 Click the Add member button at the bottom of the screen. From the
pop-up window select the members that you want to be assigned this
role. Use the SHIFT and CTRL keys to select multiple members. Click OK
when you are finished.

3 Repeat steps 1 and 2 to add members to a different role. Members can
belong to more than one role.

4 To remove a member select a name from the list and click the Remove
Member button.

5 Click the Finish button to complete this step or click the Save and
Continue button to move to the next step.

See also:

Step 4: Business Processes (page 263)

Step 2: Select Project Members (page 262)

Roles (page 303)

Workflow Types (page 290)

Step 4: Business Processes

Only available to Buzzsaw Professional Administrators.

Step 4 of setting-up a project:

In this step, you are creating business processes. Depending on the process
that you are adding, you will select the types of forms to be used in the project
and the workflow type to be associated with that form. You can also set form
options. There are different workflow types available for each form type.

Available workflow types

Gatekeep-
er/Interme-
diary

Gatekeep-
er/Distrib-
utor

Gatekeep-
er

Serial
Approv-
al

Send/Re-
spond/Ap-
prove

Send/Re-
spond

Post

XXAddendum

XXApproval Form
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Gatekeep-
er/Interme-
diary

Gatekeep-
er/Distrib-
utor

Gatekeep-
er

Serial
Approv-
al

Send/Re-
spond/Ap-
prove

Send/Re-
spond

Post

XXASI (Architect's
Supplemental In-
struction)

XXBulletin

XXChange Order Re-
quest

XXCorrespondence

XXDaily Report

XXMeeting Minutes

XXPrint Order

XXXXXRFI

XXXXSubmittal

XSubmittal Package

XXTransmittal

NOTE Document registers and bid management business process are not
associated with a workflow. They are simply added to the project.

Adding a Business Process

1 In step 4: Business Process of Project Setup click the Add button. The
Add Business Process window is displayed.

2 Enter a name for the Business Process. This must be a unique name.
Duplicate names cannot exist within a project. If you rename this form
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log at a later date then the log name that is displayed in the project tree
is also renamed.

3 Select a Business Process the list.

4 Select a workflow type from the available list. The workflows available
depend on the Business Process you selected in step 3. The corresponding
workflow diagram is displayed.

5 Click the Next button.

6 Depending on the workflow type selected, different tabs are available.
There is a tab for each type of participant (that is, responder, gatekeeper,
etc), as well as a single tab for configuring general form options. The
options that you specify for this form log applies to all the forms that
are created for this log. Thus, if you create a correspondence log that you
only want 4 members of the project to participate in then you will have
to create a second correspondence log if you want other members to
participate. Following is a description of the various tabs:

Creator — Selecting the project members who can create a form in this
particular log. Groups as well as individuals can create forms. You can
also select who the creator can notify or discuss the form with.

Responder — Selecting the project members who can respond to a
form in this particular log. Groups as well as individuals can respond to
a form. You can also select who the responder can notify or discuss the
form with. Select how many days the responder has to respond to the
form. If the responder does not respond in the time allotted the form is
removed from the responders dashboard and returned to the creator.

Select when reminder and overdue notices should be sent to the
responder.

Reviewer — Select the project members who can review this form and
how many days they have to respond. You also have the option of
allowing reviewers to stop the routing of the form and return it to the
creator. If selected, notifications will be sent to all reviewers when the
routing of the form is complete.

Distributor — Select which project members can be distributors and
who they can notify and discuss the form with. The Distributor tab is
only available if the Gatekeeper with Distributor workflow has been
chosen.

Intermediary — Select which project members can be intermediaries
and who they can notify and discuss the form with. The Intermediary
tab is only available if Gatekeeper with Intermediary workflow has been
chosen.
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Gatekeeper — Select which project members can be gatekeepers and
who they can notify and discuss the form with.

Consultants — Select which project members can be consultants and
who they can notify and discuss the form with.

General — Select the project members who should be able to view the
form: all project members, only project members who are directly
involved in the workflow, or select members whom you choose. You
can also specify how many days the form is available on each member's
dashboard.

7 Click the Forms tab to change the pre-populated fields in the form such
as, company name and address. The information entered in this tab is
displayed on the form. Use the TAB key to move between fields. The
following fields are available:
■ Document Numbering — When a form is submitted it receives a

number. This number can have a prefix and a suffix. Use the following
options to customize the prefix and suffix. Note that a form does not
actually receive this number until the Submit button is clicked.

■ Prefix — Enter a prefix for your forms numbering system. The prefix
can contain letters and numbers. For example, to set a numbering
system such as, RFI0001, enter RFI for the prefix.

■ Suffix — Enter a suffix for your forms numbering system. The suffix
can contain letters and numbers. For example, to set a numbering
system such as, 10001RFI, enter RFI for the suffix.

■ No of Digits — Type the maximum number of digits that you want
the form number to be. This does not include the prefix and suffix.

■ Next Document Number — Enter a number that the next form
created should start with.

■ Document Heading — Type a title for the forms.

■ Footer — Type a standard footer. The footer appears at the bottom
of each form.

■ Company Name — Type your company name, or the company
name that you want to appear on the forms.

■ Address and Phone — Type the company address and telephone
numbers that you want to appear on the forms.

■ Region — Enter a geographical region for this project. For example,
"Northwest".
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NOTE The options in the Form tab can be configured at any time. However,
only forms that are created after you configure the options will contain this
information. Existing forms are not updated with the information entered
in the options.

8 Click the OK button to save the log. This log appears in the project tree.
The log has the same name that you have given the workflow. The log
is also displayed in Project Setup ➤ Form Logs window, and in the
Form ➤ View Form Log drop-down menu.

For example:

View Form drop-down menu
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Project Setup> Form Logs and Workflows window

Closing the Add Form Log window cancels the creation of the form log and
closes the window.

Editing a log

You can change the configuration of a form log at any time for such things
as, who can participate in the form log and company address. Remember that
the changes you make apply only to this specific log and the forms within.

1 Click Project Setup ➤ Business Process in the project navigation bar.

2 Select a Business Process from the list and click the Edit Options button.
The Edit From Log window is displayed.

3 Click each tab and make the necessary changes.

4 Click OK. The information that you entered will be included on the
forms that are created or edited in the current log.
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NOTE The options in the Form tab can be configured at any time. However, only
forms that are created after you configure the options will contain the changes.
Existing forms are not updated with these changes.

Removing a Business Process

Select a Business Process from the list and click the Remove button. The form
log is removed from the project. This means that users will no longer be able
to create new forms of this type in this project.

See also:

Step 1: Define Project Data (page 260)

Step 5: Manage Information Pages (page 269)

Workflow Types (page 290)

Step 5: Manage Information Pages

Only available to Buzzsaw Professional Administrators.

Step 5 of setting-up a project:

Information pages are accessed via the Project Information menu. Information
pages refer to automatically generated pages such as dashboards and team
directories as well as user defined pages. You can edit how information pages
are displayed in Project Setup ➤  Information pages. Actions relating to project
information pages are tracked in the Activity Logs (page 143).

You can select a custom information page to display for each project. A project
administrator can control which information pages are available for a project.
Standard pages can be removed and as many custom information pages as
desired may be displayed for a project. While any type of file can be selected
as the source for an information page, web pages (HTML files) are the best
choice because no special application is required to view them. Buzzsaw comes
with default information pages. By default, projects display the automatically
generated pages until you select different pages.
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Selecting an information page

Information pages can be configured at any point during the life of the project:
during the initial project setup or anytime thereafter. An information page
can be an HTML file or other type of file (for example, gif, bmp, doc, xls).

1 If you are defining the information pages during the initial project setup
this is Step 5 of the project setup process.

At anytime, you can edit the information pages by selecting Information
Pages from the Project Setup menu.

The default pages that come with Buzzsaw are listed in the window.

2 To add a new page click the Add Page button. The Add Information
Page dialog box is displayed.

3 Enter a name for the page in the Page Name field. The name field can
contain any character including spaces. This field is required. To accept
a default name for an automatically generated page, go to step 4 and
select a source. The name field will be populated after you select the
source. If entering an external URL as the source, you must fill in the
name field.

4 Select a page by clicking the Select Source drop-down list. From this
menu you can select one of the automatically generated pages, or browse
the files in your site or on your computer for a new page. You can also
enter an URL to use an external web address as an information page.

5 Select which members can view this page: all project members or selected
individuals.

6 Click OK when you are finished, or Cancel if you do not want to add
these pages the project.
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Controlling who can view the information page

You can control which users have access to an information page, and when
they view that page. For example, when the user first logs in to the site, you
can specify that he or she sees a specific information page.

If a member is not given the ability to view an information page, then the
page is not displayed in that users Project Information menu. By default, all
project members can view all information pages. However, this does not apply
to the Site Executive Summary, Project Executive Summary, and the Portfolio
Information pages. When adding these pages the option, Viewable by Selected
Site Members, is the default. If members are not added to this list, then only
administrators can see the Site Executive, Portfolio and Project Executive pages.

NOTE Controlling access to information pages is a powerful option. You can
choose to restrict a member from seeing a dashboard. Beware that doing so may
prevent the member from viewing assigned items.

Changing the page order

As an administrator, you can control the user's experience of what he or she
sees and in what order.

If you want the information pages to display in a different order, select a page
and use the Move Up or Move Down buttons.

You can also specify which page the user sees upon login for each session. To
do this:

1 Select a page from the list.

2 Select one of the following options:

First information page the user has access to view — if selected
the member will see this view when he or she initially logs into the site.

Files view — if selected the member will see the tree view in the details
pane.

Last page viewed by the user — the last page the member viewed
will be the first page the member sees the next time he or she logs in.

These settings apply to the members specified in the Add Information Page
(page 438) dialog box. That is, either all project members or specific individuals.

Removing an information page

Select a page and click the Remove button.

Project Setup | 271



Tracking Project Information pages in the Activity Log

All actions pertaining to the management of Project Information pages are
tracked in the Activity Log. These actions include:

Site/Project Setup Information Pages
■ Add page

■ Edit page

■ Change name

■ Change file

■ Remove page

■ Change page order

■ Change access list

Site/Project Setup Initial View
■ Change initial view for site

■ Change initial view for project

Linking to images in a custom information page

If you are creating a custom html information page note that you can not
embed an image (or a DWF). You may only link to images that reside in the
same directory as the custom information page.

See also:

Dashboard Overview (page 275)

Managing Site Information Pages (page 87)

Information Pages (page 151)
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Global Collaboration

With Buzzsaw Professional it is possible to have true global collaboration within a
site. For example, users in the United States can collaborate with users in Germany,
each using English and German respectively. If you have work on a site in English
but have a German contractor, that contractor can login to your site, and view the
site in German. In the past all members of a site would have had to view the site in
the same language.

This has certain implications for how you might use forms and form logs:
■ A form will remain in the language that it was created in. For example, if the form is

created in German, it will always be in German.

■ Users within the same site can create form logs in multiple languages. That is, a German
member using the German version of Buzzsaw Professional will create logs in German.
An American user using the English version of Buzzsaw Professional will create logs in
English. The forms themselves will remain in the language that they were created in.

■ A form log can only contain one form type. Thus, if you need RFIs in English and German,
then you need to create two different form logs: one for the English RFIs and one for the
German RFIs.

■ The column headings in the log view will be taken from the form itself. Thus, a log
containing German forms will have column headings in German regardless of your system
configuration or which client language you have installed.
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Dashboard Overview

A dashboard is one type of an information page and is only available in Buzzsaw
Professional.

The Dashboard gives you a personalized view of your site and projects, and an easy
way to navigate through the information about your site or project. You can see
project data such as items that are assigned to you and their due date. From the Site
Dashboard you can jump to a Project Dashboard, the Site Details dashboard, a form
that has been assigned to you, or a to a specific form.

Site Summary Dashboards

Site dashboards offer an overview of the site and all projects that you have permission to
access. Following are the dashboards available at the site level:
■ Portfolio Dashboards— This dashboard displays the following data: total number of

projects, total number of projects by facility type (for example, store, building), and project
type (for example, new, remodel, tenant improvement).

This information comes from the Step 1: Define Project Data (page 260) that the project
administrator has defined. The data fields, Facility Type and Project Type, are categories
to use for organizing your projects. If these two fields are not filled in then the
corresponding column or field in the portfolio dashboard is marked as undefined. The
dashboard provides more meaningful data if these fields are defined.

The Facility and Project Type section displays the projects in the site that have been
organized according to these two project data fields. This table is not representative of all
the projects within the site, only those that have been given a Facility Type and a Project
Type. There may be many other projects in the site. The Site Executive Summary displays
a complete listing of all projects within a site.

In the following screen shot there is a facility type of Library. Reading across that row you
can see that there are 2 library projects, one is of the Project Type city government, and
the other is school. The total number of library projects is 2. The total number of city
government projects is 1 and the total number of school projects is 1.
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■ Site Level Executive Summary Dashboard— This dashboard displays the total
number of assigned items in the site regardless of who assigned the item, items due this
week, items due today and all overdue items.

■ Site Level Personal Summary Dashboard— This dashboard displays all items in
the site that have been assigned to you. You can see items due this week, items due today
and all overdue items.

■ Site Details Dashboard— This dashboard displays all forms in the site. You can sort
the table by form type, items assigned to you or by you, and whether the forms are open,
overdue, due today or due this week.

Project Dashboards

A project dashboard displays details about the project, such as project name, project number,
and project address and what assignments you have. Following are the dashboards available
at the project level:
■ Project Level Executive Summary Dashboard— some of the data displayed in

this dashboard are project name, address, and project number.

This information comes from the project data (page 260)defined by the project
administrator.

In this dashboard you can also see the total number of assigned items in a project
regardless of who assigned the item, items due this week, items due today and all overdue
items.
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■ Project Level Personal Summary Dashboard— This dashboard displays the total
number of items in the project that have been assigned to you. You can see items due
this week, items due today and all overdue items.

■ Details Dashboard— This dashboard displays all forms in the project. You can sort
the table by form type, items assigned to you or by you, and whether the forms are open,
overdue, due today or due this week.

Viewing the Dashboard

The Dashboard is available at the Site and Project level (folders do not have a Dashboard).
There are different dashboards available depending on whether you are at the site or project
level.
■ Executive view— This dashboard provides an overview of the site or the project. The

Executive summary displays an overview of open action items by form type and by
project (posted items are not included in this count). For example, you will see all open
assigned items for a correspondence log regardless of which project it is in, and you will
see all open assigned items for a specific project. From this view you can easily jump to
a specific project for further details.

■ Personal Summary— This dashboard displays the items that you assigned, items that
are assigned to you, drafts that you have written, and new discussion items.

The Executive Summary dashboard is different from Personal Summary dashboard. The
Personal Summary dashboard displays the number items that are assigned to you, whereas
the Executive Summary displays the number items assigned to all project members.

The Dashboard is divided into the following sections. Depending on which dashboard you
are viewing (Site Executive, Project Executive, etc.) different sections are displayed:
■ Project Information— This section displays information about the project that was

defined in project data. For example you can see the project name, address and the
project number. This section is only displayed in the Project Personal and Project
Executive dashboard. It is not displayed in the Site Executive or Site Personal dashboard.

■ Project Attributes— This section displays information about the project that was
defined in. For example, you can see the project start date, project manager and project
budget information. This section is only displayed in the Project Executive dashboard.

■ Action Items Summary— This section displays open items for each form log. In the
Executive view this section shows all the assigned items that are currently open in the
site (this does not include posted items). In the Personal Summary view, this section
shows all the assigned items that are currently open in the project (this does not include
posted items). This section is displayed in the Site Personal and Executive dashboards
as well as the Project Personal and Executive dashboards.
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■ Drafts— This section displays forms that you have begun to enter data for but have
not submitted. A draft is not numbered and has not been assigned to anyone.

■ Assigned To Me— Forms that have been assigned to you and require an action from
you. This section only displays in the Project Personal dashboard.

■ Assigned By Me— Forms that you have assigned to other project members. This section
only displays in the Project Personal dashboard.

■ Posted Items— This section displays forms in the project that have been posted but
not assigned. For example, a Meeting Minutes form is often posted for all project members
to review but is not assigned to anyone. This section is only displayed in the Project
Personal Summary and Project Executive Summary dashboards. Note that once you have
opened and viewed a posted item, then that item is removed from your Project Personal
Summary dashboard. However, the items are still displayed in the Project Executive
Summary dashboard.

■ Discussions— This summary displays unread discussion threads that you have been
added to as a participant. Once you have read the discussion it does not display on your
dashboard. This section is only displayed in the Project Personal dashboard.

■ Sub-projects— This section lists any sub-projects and the total number of items that
are open and closed in each project. In the Site and Project Executive dashboards this
section shows all the items that are currently open in the project including sub-projects.
The Site and Project Personal dashboards displays the number of items that are assigned
and issued by you. You can also see the number of items that are overdue. This section
displays in the Site and Project Personal and Executive dashboards.

The dashboard is not automatically updated when another member makes a change that
affects you, or when assigned items become past due. To ensure that you are seeing the
most current data, such as, overdue items and assigned items, you should refresh your

dashboard frequently by clicking the Refresh toolbar button,  .
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Forms Setup

Forms Setup: Site Forms Tab

Only available to Buzzsaw Professional administrators.

This tab is accessed through the title bar Site Setup.  ➤ Forms Setup. In this
tab you can enable or disable forms and workflows on the site, import forms,
or create new forms using Microsoft® InfoPath™. To see which workflows are
associated with a form, and their status, click the plus sign next to the form.

Enable a Form or Workflow

1 Select a form or workflow that has a status of Disabled.

2 Click the Enable button.

The form or workflow can now be used throughout the site.

Disable a Form or Workflow

Any form or workflow on the site can be disabled including the default forms
that come with Buzzsaw Professional, forms that have been created by the
Autodesk Custom Implementation team, and forms that you have imported or
customized.

Disabling a form disables that particular form and all associated workflows from
that point onward. Any form that is in progress on the site is not affected by
the disable.

Disabling a workflow disables all the forms are associated with that workflow,
from that point onward. For example, if you disable the Post workflow then
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the next time you add an RFI form log, Post will not be available as a workflow
choice.

1 Select a form or workflow by clicking the checkbox next to the form or
workflow.

2 Click the Disable button.

Once disabled, the form or workflow can not be used anywhere in the site
until it is enabled.

Import a New Form

Click this link if you have an existing form that you want to be available in
your Buzzsaw site. This link launches the Import Form wizard. See Importing
Forms (page 282) for instructions on how to proceed through each step.

Design a New Form

Click this link to select a form that you want to act as a template for a new
form. You will actually create and customize the form in InfoPath, and then
import the form into your site.

In step one of this wizard, select Customize from the drop-down list box, for
the form that you want to customize.

Follow the rest of the steps outlined in Importing Forms (page 282).

Customize a Form

1 Select Customize Form from the drop-down list box to modify forms
that have been imported to your site.

2 Save the .xsn file to your hard drive.

3 Modify the .xsn file using InfoPath.

4 Import the modified form to the site. See Importing Forms (page 282) for
more information.

The default Buzzsaw Professional forms, and forms created by the Autodesk
Custom Implementation team, cannot be customized.

Edit a Form

Only administrators can edit the InfoPath forms that have been imported into
Buzzsaw Professional. The default forms that come with Buzzsaw Professional,
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and forms that have been created by the Autodesk Custom Implementation
team, cannot be edited.

1 Select Edit from the drop-down list box to edit forms that have been
imported to your site.

2 Use the Edit Form wizard to change the workflow associated with the
form or the fields that are displayed on the form. See Importing Forms
(page 282) for more information about these steps.

Delete a Form

Administrators can delete the InfoPath forms that have been imported into
Buzzsaw Professional. The default forms that come with Buzzsaw Professional,
and forms that have been created by the Autodesk Custom Implementation
team, cannot be deleted.

1 Select Delete from the drop-down list box for a form that has been
imported.

2 The form is removed from the list and the form is no longer available
to use on the site. Any instance of the form that is currently in use, is
not affected by the deletion.

Print View

Click the Print button to print the forms listed in this tab. The following
elements are printed: form name, form description, status, who the form was
created by and the creation date.

If a row is expanded then that view is printed.

See also:

Form Templates Tab (page 281)

Importing Forms (page 282)

Form Templates Tab

Only available to Buzzsaw Professional administrators.

This tab is accessed through the title bar Site Setup  ➤ Forms Setup. This
tab lists the .xsn versions of the default forms that come with Buzzsaw
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Professional, and forms that have been created by the Autodesk Custom
Implementation team. You can print this list by clicking the Print button.

From this tab you can create a new custom form based on an existing form.
The actual customization of the form does not take place within Buzzsaw
Professional but rather on your hard drive. Microsoft® InfoPath™ is required
to open and modify .xsn files.

1 Next to the existing form that you want to base your new form on, select
Customize from the drop-down list box.

2 Save the .xsn file to your hard drive.

3 Modify the .xsn file using InfoPath and save it.

4 Return to Buzzsaw Professional and import the .xsn file saved in step 3.
Follow the process for Importing Forms (page 282).

See also:

Forms Setup (page 279)

Importing Forms (page 282)

Importing Forms

Only available to Buzzsaw Professional administrators.

Using the import wizard you can import forms that are an Microsoft®

InfoPath™ (.xsn) file. Access this wizard through the title bar, Site Setup
 ➤ Forms Setup. In the Site Forms tab click the Import New Form link.

Optional Step 1 if designing a new form

This step of the wizard is available if you click Design a New Form (page 280)
in the Site Forms tab. In this wizard you are selecting a form that will act as
a template for a new form. You will actually create and customize the form
in InfoPath, and then import the form into Buzzsaw.

1 To the right of the form that you want to customize, select Customize
from the drop-down list box.

2 Click Next to proceed with the next four steps.
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Step 1: Import existing form file

1 Enter a name for the form in the Form name field.

2 Click Browse to navigate to the .xsn file that you want to import.

3 Enter a description of the form in the Description field. This step is
optional.

4 Click the Import button. If the import of the file is successful a
confirmation message is displayed. If your file is not imported successfully
an error message is displayed along with the cause of the error. You
cannot continue through the wizard until you have a successful import.
If your file imports successfully, defaults are populated for all remaining
steps and the Finish button is enabled. You can click the Finish button
at this time and complete the import process provided that you are
satisfied with the defaults. Otherwise, continue with the wizard to edit
the defaults.

5 Click Next to continue.

Step 2: Select workflow

In this step you are selecting the workflows and view that you want to be used
for the form. You can accept the defaults that have been chosen for you, or
make your own selections.

1 Select the workflow that you want to be associated with this form.

2 For each workflow you select click the Advanced button. Choose a view
to be associated with each step. For example, in the Post workflow the
steps Create and View are listed. You can select the view of the form that
users should see for each step. A default view is chosen for each step.
Depending on your business needs, you may not need to take further
action.

3 Click Next when you are finished.

Step 3: Configure form fields

In this step you can change the labels for the fields that are displayed on the
form, specify whether these fields should display in the form log or log report,
and change the order in which they appear on the form log or log report.
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The field names listed have been automatically detected by Buzzsaw
Professional.

1 Select a label value from the Field Content drop-down list to the right
of the field name. Selecting a value means that the field will be
pre-populated on the form. Select Leave Blank if you do not want the
field to be pre-populated. Users can then manually enter data in the
field. The field will still be on the form even if you do not select a label.

NOTE The data that populates the fields you choose are derived from the Project
Data page and Member Information (page 17). If the Project Data has not been
defined, or members have not filled in their contact information, then the fields
will be blank on the form. For more information see Step 1: Define Project Data
(page 260).

1 Select the checkbox to the right for each field that you want to be
displayed in the form log or log report.

2 To change the order in which the fields are displayed in the log or log
report, select the checkbox to the left of the field. The order from top to
bottom that the fields are listed in this screen is the order in which the
columns are displayed in the log, and log report, from left to right. Click
the Move Up or Move Down buttons to change the order.

3 Click Next to continue.

Step 4: Confirm new form

The selections that you made in the previous steps are displayed here. Review
them and if they are correct click the Finish button. If you need to make
changes click the Back button until you reach the desired step.

Clicking Finish returns you to the Site Forms Tab and the new form is displayed
in the list.

After completing the 4 steps your imported form is ready to be used within
your site and can be added to your projects as a form log.

See also:

Form Templates Tab (page 281)

Forms Setup (page 279)
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FAQ: InfoPath Forms

This topic is for site administrators who customize Buzzsaw Professional Forms
using InfoPath.

I opened an XSN file in InfoPath but I do not see the controls to
customize it.

You have opened the file in a data entry mode. To switch to design mode
choose Design this Form from the Tools drop-down menu. Now you can
edit the form.

What type of InfoPath data field should I use for the following field
types in Buzzsaw?

■ Text Box (greater than 50 characters) — use Rich Text (XHTML)

■ Text Field (50 characters or less) — use Text String

■ Drop-down — use Text

Where can I put a default value for a field?

Open the properties dialog for the field. On the Data tab enter the default
value in the Default Value field.

Can I have more than one "edit" version of a form that has hidden
fields?

Yes, you can create as many different versions of the form as you would like
to match each stage of the workflow you intend to use it with.

For example: in the send, respond workflow you can have three views. One
view for the person creating the form, one view for the person responding to
the form, and a view for viewing the form in Buzzsaw in view mode.

How do I make different views of a form?

If you have created one view of the form:

1 Press Ctrl+A to select all elements of the form.

2 Press Ctrl+C to copy the form to the clipboard.

3 In the Design Tasks Side pane, click Views. Click Add View to add a
new view to your InfoPath form.
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4 In the newly created view press Ctrl+V to paste the form into the new
view. You may need to create a single table cell to paste the view into.

5 You can now customize this view by removing fields, adding additional
fields or changing the properties of existing fields.

How do I make a view version of my form?

1 Use the steps from the question above, "How do I make different views
of a form?" to create a new view of the form.

2 Change the properties of each form field to "Text Box".

3 Change the properties of each form field to "Read Only" in the field
properties dialog.

How many view versions of the form does Buzzsaw support?

1

How do I make a field required?

In the Field Properties dialog box, change the properties of the form field to
Cannot be blank.

NOTE This will be global to all views of the form.

Can I make a field required for a certain step of my workflow?

No.

How do I add a document number field in my InfoPath form so that
Buzzsaw will auto populate this field on my form?

Add a text field to your form called _DocumentNumber. When importing the
form Buzzsaw automatically detects this field and uses it for its document
number field.

How can I name my data fields so that they display properly in
Buzzsaw?

InfoPath does not support spaces in the Data Source names but Buzzsaw adds
spaces prior to each capital letter in the string.
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For example, a CreatedBy field in InfoPath is displayed as Created By in
Buzzsaw.

Which InfoPath form features are not supported in Buzzsaw?

■ Master/Detail Control

■ No external data validation through scripts, code, etc.

■ No support for Web Services

■ No support for Databases

■ No support for Rules/Formulas

■ No support for Required Field Validation

How do I add a field to my InfoPath form so that it will display in the
"Subject/Title" column on the standard Buzzsaw dashboards and
reports?

Add a text field to your form called "Subject". The contents of this field are
automatically displayed as Subject/Title on dashboards and reports in Buzzsaw.

Importing into Buzzsaw Professional

How can I make fields pre-populate with datawhen a new form is
created in Buzzsaw?

During Step 3 of 4 when importing or editing your form in Buzzsaw you can
use the Field Content drop-down to auto-populate data.

If the field is a date field you can choose to set the default date to Today + X
days from Project Properties.

If the field is a text field you can auto-populate it from Member Information
or Project Properties.
■ Member Information specifies who the user name of the member who

adds a new form to the form log. For example, if you have a field on your
form called Created By, you can auto-populate this field with the Name
field to display the user name of the person adding the form.

■ Project Properties specifies the project name that the form log is associated
with. For example, if you have a field on your form called Project you can
auto-populate from the Full Project Name field from the Buzzsaw Project
Data page.

Forms Setup | 287



Why did I receive an error when importing my InfoPath form into
Buzzsaw?

There are several possibilities as to why you received an error:

1 The InfoPath form is open within the InfoPath application—When
importing an InfoPath form that form cannot be open in InfoPath at
the same time. If the XSN file is open an error will occur. Close the form
in InfoPath and then try importing the form into Buzzsaw again.

2 Duplicate names—Buzzsaw requires unique form type names. Duplicate
form type names cannot be used. To update an existing form with a new
version, delete it first from Buzzsaw, and then import the new version.

3 Unsupported naming convention—If you use an unsupported naming
convention for your data source names in InfoPath, you may receive an
error. For example, only _DocumentNumber is supported. If an
underscore is placed in front of any other data field, an error will occur
during the import.

What happens if I delete or disable a form on my site and form logs
still exist?

If a form is disabled or deleted from the site, the form logs that were created
from that form type will continue to function on the site.

What happens when I disable a form type on Buzzsaw?

New versions of that form type cannot be added to the site.

What happens to existing forms/form logs when I edit the form type
properties?

Editing a form type does not affect existing form entries; only entries made
after the edits are affected.

What happens to existing form logs when I reorder columns in the
Form Designer?

Reordering fields by editing the form type will reorder the fields for all form
logs of that type on the site. Form logs that have had the fields specifically
reordered are not affected.
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Working with Form Logs,
Workflow and Roles

Overview of the Log Process

Once your administrator has configured a log you can start adding forms (if
you have been added as a participant in the log). Following is an outline of the
basic stages of adding a form and assigning it. Depending on the type of
workflow that was configured for this log, (that is, Post, Gatekeeper, Serial, etc.)
some of these steps will be more involved than others.

Step 1: Adding a form

Add a form from the Forms menu on the Project Bar.

Step 2: Filling out the form

Fill in the fields that you require using the TAB key to move between fields. In
this mode you can also add comments. At this step you can save the form as a
draft. Doing so saves the form to the log without sending it to other members.
The form is not assigned a number until the form is submitted. Routing
information is saved with the draft but notifications are not sent. The draft is
only available to the creator.

Certain fields are pre-populated if your project administrator has defined Step
1: Define Project Data (page 260) for this project. These fields are non-editable
except by project administrators and the form creator. If these fields have not
been defined then the fields will be blank.

Step 3: Assigning the form

Select the members you want to assign the form to. You can also notify other
members about this assignment. Members who are notified can view the form
but can not respond, forward or edit the form. Assigning a form results in the
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form being saved to the log, assignment notification emails being sent to
members listed in the Assign To field, and assignment notification emails
being sent to members listed in the cc field.

Step 4: Receiving an assignment

Members who have been assigned an item receive an email containing a link
to the form. The action item also displays in the member's dashboard. Once
a member has received the assignment, depending on how the log was
configured, he or she can respond or forward the assignment.

Step 5: Viewing the form

A form in view mode can not be edited. Administrators can close or re-call
the form (doing so removes all assignments).

Step 6: Responding to an Assignment

How you can respond to a form depends on the particular log that you are
working with. Who you are able to respond, or forward to, depends on how
the log was configured.

See also:

Working with Forms (page 309)

Step 4: Business Processes (page 263)

Using the Form Log (page 304)

Workflow Types

A business process is configured to use a workflow type. Workflow is a
commonly used term that describes the automation of a business process, in
whole or part, during which documents, information or tasks are passed from
one participant to another for action, according to a set of procedural rules.
By creating a business process that is configured to use a workflow type, you
can automate the process of your internal business operations.

Benefits of using Workflow:

■ Improved efficiency — automation of business processes results in the
elimination of unnecessary steps

■ Better process control — improved management of business processes
achieved through standardizing working methods and the availability of
audit trails
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■ Flexibility — you can change an existing workflow or create a new one
in order to stay in line with changing business needs

■ Business process improvement — focus on business processes leads
to their streamlining and simplification

In Buzzsaw, workflow refers to the process by which administrators define the
parameters that determine how a form is processed. That is, which members
can create, respond, view, and discuss the form. The workflow can be defined
by roles or by events.

When you configure a business process you are setting options that apply to
all the forms within that log. If you want a form with a different configuration
then you need to create a different business process. For example: you want
a correspondence log for ten members in the project but you want the
correspondence among three of those members to be private. To accomplish
this, you would have to create one log for all ten members, and a second log
for the three members.

Members can only add new form types to a log that has been created for that
form type. For example, you can not add an RFI form until an RFI log is
configured.

Available workflow types

Gatekeep-
er/Interme-
diary

Gatekeep-
er/Distrib-
utor

Gatekeep-
er

Serial
Approv-
al

Send/Re-
spond/Ap-
prove

Send/Re-
spond

Post

XXAddendum

XXApproval
Form

XXASI (Archi-
tect's Supple-
mental In-
struction)

XXBulletin

XXChange Order
Request
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Gatekeep-
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er/Distrib-
utor
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er

Serial
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Send/Re-
spond/Ap-
prove

Send/Re-
spond

Post

XXCorrespond-
ence

XXDaily Report

XXMeeting
Minutes

XXPrint Order

XXXXXRFI

XXXXSubmittal

XSubmittal
Package

XXTransmittal

Buzzsaw Professional comes with the following default workflows. These
workflow types enable you to define the parameters by which the routing of
a document is controlled:

Post

The Post workflow allows the creator to fill in a form, post it to the log and
optionally notify project members. No response is expected but the document
may be discussed.

It can be used with the following forms: Addendum, ASI, Bulletin,
Correspondence, Daily Reports, Meeting Minutes, Print Order, RFI, Submittal,
and Transmittal.
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Post workflow ooptions:

■ Creator — In this tab you are choosing who can create a form in this
particular workflow. Note that administrators can always create forms.
Choose which members can create this workflow: all members, specific
individuals, groups, or roles. You can also select who the creator can notify
or discuss the form with.

■ General — In this tab you are choosing who can view the forms associated
with this workflow: all project members, only individuals who have been
assigned or notified during the workflow, or specific individuals, groups,
or roles. The default setting allows only form participants to view the forms
that they have access to. You can change this setting to allow other
members to view forms in this log. However, once you choose a setting it
cannot be changed. The ability to change this setting is only available
when you first create the form log. You cannot change these options at a
later time. Note that administrators can always view forms regardless of
whether they are a form log participant or have been specifically given
permission to view the form log.

■ Form — In this tab enter the information that you want to include on
every form in the current log. For example, you can enter a document
heading, footer and your company information.

Send/Respond

This workflow allows the creator to assign the form to one or more responders.
The creator receives only one response. When any one of the responders
responds, re-assigns the assignment, the assignment is removed from any
other co-responders.

When an assignment is re-assigned, the initial responder, Responder A, has
this form as an issued item instead of an action item; the newly assigned
responder, Responder B, has an open action item; responses must travel back
through the participants in reverse order before the form can be closed. If an
assignment is re-assigned, responsibility is transferred to the new responder;
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the initial responder does not have this form as an action item or as an issued
item.

If an assignment is recalled by the assignor, all upstream assignments are
recalled. If an assignment is recalled by the administrator, only the last level
of the assignment is recalled; the administrator can recall multiple times.

It can be used with the following forms: Addendum, ASI, Bulletin,
Correspondence, Daily Reports, Meeting Minutes, Print Order, RFI, Submittal
and Transmittal.

Send/respond workflow options:

■ Creator — In this tab you are choosing who can create a form in this
particular workflow. Note that administrators can always create forms.
Choose which members can create this workflow: all members, specific
individuals, groups, or roles. You can also select who the creator can notify
or discuss the form with.

■ Responders — In this tab you are choosing who can respond to a form
in this particular workflow. Choose which members can respond to this
workflow: all members, specific individuals, groups, or roles. In addition,
you can select which members the responder can notify, CC or discuss
this form with.

■ General — In this tab you are choosing who can view the forms associated
with this workflow: all project members, only individuals who have been
assigned or notified during the workflow, or specific individuals, groups,
or roles.

The default setting allows only form participants to view the forms that
they have access to. You can change this setting to allow other members
to view forms in this log. However, once you choose a setting it cannot be
changed. The ability to change this setting is only available when you first
create the form log. You cannot change these options at a later time.

NOTE Administrators can always view forms regardless of whether they are a
form log participant or have been specifically given permission to view the
form log.
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■ Form — In this tab enter the information that you want to include on
every form in the current log. For example, you can enter a document
heading, footer and your company information.

Send/Respond/Approve

This workflow is for the Change Order process in which an
Owner/Architect/Engineer creates a Change Order and sends it to the General
Contractor. The General Contractor reviews and responds with the change in
cost and schedule. The Owner/Architect/Engineer reviews and approves. The
creator receives only one response and the respondent receives one approval.

It can be used with the following forms: Change Order Request.

Send/submit/approve workflow options:

■ Creator — In this tab you are choosing who can create a form in this
particular workflow. Note that administrators can always create forms.
Choose which members can create this workflow: all members, specific
individuals, groups, or roles. You can also select who the creator can notify
or discuss the form with.

■ Responders — In this tab you are choosing who can respond to a form
in this particular workflow. Choose which members can respond to this
workflow: all members, specific individuals, groups, or roles. In addition,
you can select which members the responder can notify, CC or discuss
this form with.

■ General — In this tab you are choosing who can view the forms associated
with this workflow: all project members, only individuals who have been
assigned or notified during the workflow, or specific individuals, groups,
or roles.

The default setting allows only form participants to view the forms that
they have access to. You can change this setting to allow other members
to view forms in this log. However, once you choose a setting it cannot be
changed.
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NOTE Administrators can always view forms regardless of whether they are a
form log participant or have been specifically given permission to view the
form log.

■ Form — In this tab enter the information that you want to include on
every form in the current log. For example, you can enter a document
heading, footer and your company information.

Serial Approval

This workflow is designed for a serial approval process. It is considered a rigid
flow. That is, the review path is fixed. Individual reviewers can not choose
who they will forward the item to. Reviewers can cc, notify, or discuss the
item with pre-determined members.

The number of steps is variable. This can be considered a peer approval where
the entire set of steps must be completed.

When a form is "auto-pushed" to the next step, some form data/status
communicates that this was "moved forward without approval". As the
document flows through the process, each down stream approver will see the
upstream approver's data.

This workflow can be used with the following form: Approval.

Serial approval workflow options:

■ Creator — In this tab you are choosing who can create a form in this
particular workflow. Note that administrators can always create forms.
Choose which members can create this workflow: all members, specific
individuals, groups, or roles. You can also select who the creator can notify
or discuss the form with.

■ Reviewers — In this tab you are choosing individual members who can
review a form and with whom the form can be discussed. You can also
specify how many days a member has to respond to an item and when a
reminder notice should be sent. If the reviewer does not respond in the
time allotted you can configure the workflow so that the form is
"auto-pushed" to the next reviewer. This prevents the form from getting
stuck.

You can also choose to notify all users when routing is complete.

■ General — In this tab you are choosing who can view the forms associated
with this workflow: all project members, only individuals who have been
assigned or notified during the workflow, or specific individuals, groups,
or roles.
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The default setting allows only form participants to view the forms that
they have access to. You can change this setting to allow other members
to view forms in this log. However, once you choose a setting it cannot be
changed. The ability to change this setting is only available when you first
create the form log. You cannot change these options at a later time.

NOTE Administrators can always view forms regardless of whether they are a
form log participant or have been specifically given permission to view the
form log.

■ Form — In this tab enter the information that you want to include on
every form in the current log. For example, you can enter a document
heading, footer and your company information.

Gatekeeper

In the gatekeeper workflow, the gatekeeper acts as a conduit to other parties
with whom he or she needs to communicate to collect an answer. For example,
the form creator assigns the form to the gatekeeper. The gatekeeper is then
responsible for collecting the information that the creator needs. The
gatekeeper can set individual response dates for the consultants. The due date
that the gatekeeper sets will most likely differ from the due date that the
creator has set.

The gatekeeper workflow can be used with the following forms: RFI and
Submittal.
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Gatekeeper with Distributor

The gatekeeper/distributor workflow can be used with the following forms:
RFI and Submittal. When using this workflow it is referred to as "RFI with
Distributor" in dashboards and reports.

Following is an example of how the gatekeeper with distributor workflow can
be used:

An RFI is created by the Mechanical Subcontractor (Creator) and sent to the
General Contractor (Distributor). The General Contractor reviews the RFI and
sends copies directly to the Architect (Gatekeeper) as well as the Mechanical

298 | Chapter 20   Working with Form Logs, Workflow and Roles



Consultant (Consultant 1) and the Structural Consultant (Consultant 2). The
Mechanical and Structural Consultants provide responses to the RFI and send
them to the Architect. These consultants are not allowed to provide official
direction to the General Contractor due to contractual and liability issues;
they must provide their responses to the Architect (Gatekeeper). The Architect
reviews the responses and adds additional detail as needed and sends the
Official response to the General Contractor.

Gatekeeper with distributor workflow options:

■ Creator — In this tab you are choosing who can create a form in this
particular workflow. Note that administrators can always create forms.
Choose which members can create this workflow: all members, specific
individuals, groups, or roles. You can also select who the creator can notify
or discuss the form with.

■ Distributor — Select which project members can be distributors and
who they can notify and discuss the form with. Consultants are optional.

■ Select an option to remove comments from the Gatekeeper’s response or
from all versions of the form. Selecting either of these options means none
of the comments are saved in the various versions in the Versions tab.

■ Gatekeeper — Select which project members can be gatekeepers and who
they can notify and discuss the form with.

Select the option to hide comments from the Gatekeeper’s response. If
selected all comments made by the consultants and gatekeeper are hidden
from view when the gatekeeper replies to the distributor.

Select the option to hide comments on forms when accessed through the
versions tab. If selected all comments are hidden from view when the the
form is accessed through the versions tab.

If neither of these options are selected that all comments will remain visible
to all workflow participants when the form is accessed through the versions
tab.

■ Consultant — Select which project members can be consultants and who
they can notify and discuss the form with.

■ General — In this tab you are choosing who can view the forms associated
with this workflow: all project members, only individuals who have been
assigned or notified during the workflow, or specific individuals, groups,
or roles. The default setting allows only form participants to view the forms
that they have access to. You can change this setting to allow other
members to view forms in this log. However, once you choose a setting it
cannot be changed. The ability to change this setting is only available
when you first create the form log. You cannot change these options at a
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later time. Note that administrators can always view forms regardless of
whether they are a form log participant or have been specifically given
permission to view the form log.

■ Form — In this tab enter the information that you want to include on
every form in the current log. For example, you can enter a document
heading, footer and your company information.

Gatekeeper with Distributor for submittal package

This gatekeeper/distributor workflow can be used with the following forms:
submittal package.

Gatekeeper with distributor for submittal package workflow options:

■ Package Creator — In this tab you are choosing who can create a
submittal package in this particular workflow. Note that administrators
can always create forms. Choose which members can create a submittal
package: all members, specific individuals, groups, or roles. You can also
select who the creator can notify or discuss the submittal package with.
Select whether the creator can add and edit submittal items, or revise
submittal packages. If neither of these options are selected then the package
creator can only create new packages.

■ Transmittal Creator — Select which project members can create a
submittal package transmittal and who the transmittal creator can notify
or discuss the submittal package with. Select whether the transmittal creator
can edit the details of the submittal package. Set the dates by which any
revisions of the transmittal are due.

■ Distributor — Select which project members can be distributors and
who they can notify and discuss the form with.
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Set a date by which the submittal package must be distributed and when
notification emails should be sent.

■ Gatekeeper — Select which project members can be gatekeepers and who
they can notify and discuss the form with. Set dates for when a response
is due to the distributor and when notification emails should be sent.

■ Consultant — Select which project members can be consultants and who
they can notify and discuss the form with. Set dates for when the submittal
package must be reviewed and a response sent to the gatekeeper, and when
notification emails should be sent.

■ General — In this tab you are choosing who can view the forms associated
with this workflow: all project members, only individuals who have been
assigned or notified during the workflow, or specific individuals, groups,
or roles. The default setting allows only form participants to view the forms
that they have access to. You can change this setting to allow other
members to view forms in this log. However, once you choose a setting it
cannot be changed. The ability to change this setting is only available
when you first create the form log. You cannot change these options at a
later time. Note that administrators can always view forms regardless of
whether they are a form log participant or have been specifically given
permission to view the form log.

Gatekeeper with Intermediary

Following is a diagram of the gatekeeper with intermediary workflow:
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The gatekeeper/intermediary workflow can be used with the following forms:
RFI and Submittal.

In the gatekeeper/intermediary workflow, intermediaries can respond only
after receiving a response from the gatekeeper. Gatekeepers can respond at
any time. All assignments the intermediary has made are recalled.

Gatekeeper with intermediary workflow options:

■ Creator — In this tab you are choosing who can create a form in this
particular workflow. Note that administrators can always create forms.
Choose which members can create this workflow: all members, specific
individuals, groups, or roles. You can also select who the creator can notify
or discuss the form with. Select a date by which the intermediary or
gatekeeper must respond to the creator.

■ Intermediary — Select which project members can be intermediaries
and who they can notify and discuss the form with.

■ Gatekeeper — Select which project members can be gatekeepers and who
they can notify and discuss the form with.

■ Consultant — Select which project members can be consultants and who
they can notify and discuss the form with.

■ General — In this tab you are choosing who can view the forms associated
with this workflow: all project members, only individuals who have been
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assigned or notified during the workflow, or specific individuals, groups,
or roles. The default setting allows only form participants to view the forms
that they have access to. You can change this setting to allow other
members to view forms in this log. However, once you choose a setting it
cannot be changed. The ability to change this setting is only available
when you first create the form log. You cannot change these options at a
later time. Note that administrators can always view forms regardless of
whether they are a form log participant or have been specifically given
permission to view the form log.

■ Form — In this tab enter the information that you want to include on
every form in the current log. For example, you can enter a document
heading, footer and your company information.

See also:

Step 4: Business Processes (page 263)

Roles (page 303)

Roles

The word "role" refers to a category that you place members in, and defines
the actions a group of members can perform within a form log. By grouping
members into roles you can easily control the level of access they have within
a form log. Roles only apply to form logs in Buzzsaw. The use of roles does
not affect a member's permission for other files and projects. Roles are specific
to form logs. A member can be a participant in multiple form logs and have
a different role in each form log.

A role, however, is more than just a level of permission or a group of people.
A role governs how the group participates in the form log. For example, if you
create a role for subcontractors you can configure a form log so that
subcontractors can only respond to general contractors.

A role is similar to a Buzzsaw group but because you can create a role at the
project level, it is a better choice for the purpose of form logs. Roles are stored
in a site master list. You can add and delete roles at any time, even while
configuring a form log. Roles do not have to be defined before configuring a
form log. Roles are a quick way to create groups of people that can be used
repeatedly in multiple form logs. You only have to create a role once and then
you can use it in multiple projects. Unlike a group, a role is an empty shell at
the site level (groups are created with members at the site level). Then, when
configuring a form log you add members to that role. Using roles is more
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efficient than using groups. If you were to use a group, you'd have to create
a new group for every form log, each with a unique name. This would quickly
become confusing.

Defining your form log using roles, rather than using groups and individual
members, allows you to standardize your project setups, which allows you to
have set processes for your business needs. For example, you can create a form
log for your design build. Within this design build form log you create a role
for architects, sub-contractors, general contractors and owners. Each role is
then given a privilege that defines the actions that role can perform within
the form log. That is, who can create a form, who can respond to it, etc.

See also:

Step 3: Assign Project Members to a Role (page 262)

Step 4: Business Processes (page 263)

Workflow Types (page 290)

Using the Form Log

Logs are automatically created as a result of completing the project setup
wizard. Initially logs are placed at the root level of the project. You can
however, move the log anywhere within the project after it has been created.

You could not add a form to a project without first adding a log to the project.
Once the log is created then you can add forms to the log.

In the log, you can page through the list of forms using the pagination at the
top of the window. You can also sort and rearrange the columns. Printing a
form from the log is available. To print a view of what is in the log, run the
Working with Reports (page 331) for that log. Your view of the log is "sticky".
That is, if you are viewing the second page of the form log and open an form
to view it, upon closing the form you are returned to page two of the form
log. This "sticky" behavior also applies when using the Open/Closed filter.

A right-click menu is available when a form is selected. The options available
in the right-click menu enable you to perform form actions without first
having to open the form.

Forms are color-coded to help you quickly see the state of a form.
■ Overdue forms are bold and in red.

■ Closed forms are gray and italicized.

■ Drafts of forms are blue.
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Use the toolbar buttons to perform tasks and access information.

The toolbar is located at the top of the log. Click the button on the toolbar
that corresponds to the task you want to perform.

DescriptionToolbar Button

Opens a new form.Add

Deletes the selected form by moving it to the Recycle bin. See De-
leting a Form (page 329) for more information.

Delete

Prints the selected form. You can only print one form at a time.Print

Exports (page 307) the contents of the log to a .CSV file.Export

Opens the Options window. You can change options such as, who
has access to forms in this log, routing rules, and document num-
bering. See Editing Business Process Options (page 306).

Options

Filter your view of the log according to open or close status.View

Searches the log for the criteria set in the text box next to the find
button. See Searching a Form Log (page 306) for more information.

Search

See also:

Working with Forms (page 309)

Deleting a Form Log (page 307)

Searching a Form Log (page 306)
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Editing Business Process Options

You can edit the options in a Business Process at any time. Changes you make
only affect forms that are created after the changes are applied. Existing forms
are not updated with these changes.

1 Select the log and click the Options toolbar button. The Edit Form Log
window is displayed.

2 Click the tabs to change the information. See Adding a Business Process
(page 264) for informaiton about these tabs.

3 Click OK.

See also:

Step 4: Business Processes (page 263)

Searching a Form Log (page 306)

Using the Form Log (page 304)

Searching a Form Log

You can search for text contained in the fields displayed in the Business
Process. If a field does not appear in the log itself, the contents of that field
are not searched.

1 Type the text that you want to search for in the search box,

 .

2 Click Find. The forms that contain the text you entered are listed in the
log. Forms that do not contain the text are not listed.

3 To start a new search, click clear and then enter new text in the box.

See also:

Deleting a Form Log (page 307)

Editing Business Process Options (page 306)

Viewing, Printing, Saving and Exporting Reports (page 337)
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Exporting a Form Log

You can export the contents of a form log to a CSV (comma separated value)
file. A CSV file is a file in which each piece of data is separated by a comma.
This information can then be imported into a spreadsheet, for example.

When exporting a log, the actual forms are not exported, but rather the
information that you see in the log. For example, the form names, assignment
information, and due dates.

To export a log:

2 Open a log and click the Export button,  .

3 Choose a location to save the file to.

See also:

Deleting a Form Log (page 307)

Editing Business Process Options (page 306)

Viewing, Printing, Saving and Exporting Reports (page 337)

Deleting a Form Log

Deleting a log sends the selected log and its contents to the Recycle bin. If
you change your mind about the deletion, you can go to the Recycle Bin and
restore the log.

NOTE Once the Recycle Bin is emptied, you cannot restore the log.

1 In Project Files, click on the log that you want to delete to select it.

2 Click the Delete toolbar button,  , or right-click and choose delete.
The selected log and its contents move to the Recycle Bin. You can still
restore the log, but once the Recycle Bin is emptied, you can no longer
restore the log.

See Using the Recycle Bin (page 238) for more information.

See also:

Searching a Form Log (page 306)
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Editing Business Process Options (page 306)

Viewing, Printing, Saving and Exporting Reports (page 337)
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Working with Forms

Adding a Form

Once a Business Process has been configured you can add forms.

If you have not created a Business Process see Step 4: Business Processes (page
263) for instructions.

You can create a new form if you have been given the ability to create a new
form in a specific Business Process.

1 From the Forms menu, choose New Form and then the Business Process
that you want the form to reside in. Following is an example.

You can choose to add a form to a log and not assign it to anyone. Doing
this "posts" the form to the log and allows you to notify, cc, and discuss
the form, but no assignments are made. To post a form instead of assigning
it, open a log and click Add  ➤ Without Assignment. Complete the form
as described in the following steps, skipping step 3. If you do not
specifically choose this option, it is assumed that you want to assign the
form.

21
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A blank form opens in a separate window.

If the Add form window does not display correctly, see Forms Display
Issues (page 414) for more information.

2 Fill in the fields that you require using the TAB key to move between
fields.

Certain fields are pre-populated if your project administrator has defined
project data (page 260) for this project. These fields are non-editable except
by project administrators and the form creator. If these fields have not
been defined then the fields will be blank.

Many fields such as Company Name and Address, Document Heading,
Project Name, Project Number, and the footer are not editable.
Administrators can change these fields by editing the form options (page
283).

Other fields are pre-populated based on choices you make. For instance,
in an RFI form clicking the Assign button and choosing a member causes
that members name to display in the Recipient field. These pre-populated
fields are editable. If you manually enter data into these fields, the data
will not be overwritten at a later date.

3 To assign the form to a project member or a group, click the Assign
button at the top of the form. See Assigning/Re-assigning a Form (page
324) for more information. To whom you can assign a form depends on
how the form log was configured by your project administrator. You can
only assign the form to the members listed. If you need to assign the
form to a member who is not listed, contact your project administrator
and ask him or her to add that member to the form log configuration.

It is not recommended that you re-assign a form to a private group (page
128). Doing so exposes the names and email addresses of private group
members in the Routing Tab for Forms (page 319) and in various
dashboards.

4 In a text box field, you can type multiple lines of information.

NOTE If you enter more lines than can be displayed, a scroll bar appears on
the right side of the text box. When you print the form, the entire text prints
without the scroll bar.

5 To notify other project members about this form, click CC. Select
members from the list. Notifying a member means that once this form
is submitted, the members selected will receive an email containing a
link to this form. Notified members can only view the form; they can
not forward, re-assign, respond or recall a from. They can however view
attachments and participate in discussions.
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When notifying a Private and Hidden Groups (page 128) the group name
is displayed in the cc field, but not the individual member names.

6 To attach a file to the form click Attach. See Attachments Tab for Forms
(page 320) for more information.

7 Link to a document within Buzzsaw or, upload a document from your
hard drive to link to:
■ Link to Project Files — Click this link to navigate to a document

or folder within Buzzsaw. The links to your selected documents are
added to the form. You can link to a project, folder, document,
markup or a specific version of a document. You cannot link to a
form or form log.

■ Upload & Link to Local Files— Click this link to upload a
document from your hard drive, add it to a project within Buzzsaw,
and link the form to this document. You can link to a specific version
of the file which makes the link static and links to the selected
version, not to the most recent version.

Once a link has been added to a form the attachment icon displays in
the form log attachment column. See Linking Documents to a Form
(page 317) for more information.

8 To include a comment about the form, click Add Comment at the top
of the form. See Adding a Comment to a Form (page 312) for more
information. When you have completed the form, click one of the
following:
■ Save As Draft — Saves the form to the log but the form is not

numbered, nor are email notifications sent to the selected members.
The draft is only displayed in the creator's log and dashboard. No
other members can see the draft.

■ Submit — Saves the form, adds it to the log, and numbers the form.
When the form is submitted an email, containing a link to the form,
is sent to the selected members.

9 To cancel the form, simply close the window. The form is not added to
the log and you lose any information that you entered.

When you have finished adding the form it is displayed in the log. The form
log configuration determines the type of access that other project members
have to the form.

See Step 4: Business Processes (page 263) for more information.

See also:

Assigning/Re-assigning a Form (page 324)
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Attachments Tab for Forms (page 320)

Deleting a Form (page 329)

Adding a Comment to a Form

If you make a change to a form or add an attachment to the form, entering a
comment is a good way to communicate the type of change you made to
other project members. The comment applies only to the version that you
are working with and is not added to the discussion thread. Comments are
displayed in the Versions tab in the bottom pane of the Log. Using Add
Comment, you can also add a comment to the email notification that is sent
when assigning a form to a member.

1 When editing, responding, or recalling a form, Add Comment, at the
top of the window.

2 In the Add Comment dialog box, enter a subject in the Subject field.

3 Enter a comment in the Comment box.

4 Click Save. When you save the version of the form the comment is saved
with it. The comment that you entered appears in the Versions tab. See
Versions Tab for Forms (page 323) for more information.

See also:

Working with Forms (page 309)

Assigning/Re-assigning a Form (page 324)

Deleting a Form (page 329)

Viewing a Form

You can view forms that you have access to. Your access depends on how the
site or project administrator configured the form log.

1 Select a project in the tree view.

2 From the Forms menu, select View Form Log and select a type of log.
The available form logs are displayed in the fly-out menu. Following is
an example.
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3 The form log is displayed in the details pane. Double-click a form to
open it.

The following tabs are displayed at the top of the form:
■ General Tab for Forms (page 318)

■ Routing Tab for Forms (page 319)

■ Links Tab for Forms (page 319)

■ Attachments Tab for Forms (page 320)

■ Discussions Tab for Forms (page 321)

■ Versions Tab for Forms (page 323)

■ History Tab for Forms (page 324)

See also:

Attachments Tab for Forms (page 320)

Discussions Tab for Forms (page 321)

History Tab for Forms (page 324)

Editing a Form

A form can be edited after it has been saved as a draft, assigned to another
member and submitted, and when you are responding, recalling, and reviewing
a form. Depending on the workflow type that has been configured for this
form, the Edit button may not display. However, if you click respond or
re-assign the form opens and you can edit the fields.

1 Open a form.

2 Double-click the form that you want to edit. The form is displayed.

3 Click the Edit button. Following is an example. (Or, select a form in the
log and right-click. Choose Edit from the menu.)
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Type the changes in the fields that you want to edit. Use the TAB key to
move between fields.

4 In a text box field, you can type multiple lines of information.

If you enter more lines than can be displayed, a scroll bar appears on
the right side of the text box. When you print the form, the entire text
prints without the scroll bar.

5 To add a link click Link to Project Files, or Upload & Link to Local Files.

6 To delete a link, select a link and then click Remove Links. See Linking
Documents to a Form (page 317) for more information.

7 To attach a file to the form click Attachments at the top of the form. See
Attachments Tab for Forms (page 320) for more information.

8 To include a comment about the form, click Add Comment at the top
of the form. See Adding a Comment to a Form (page 312) for more
information.

9 When you have completed the form, click one of the following:

■ CC — Click here to select project members that you would like to
notify about this form. An email that contains a link to the form is
sent to the members.

■ Submit — Saves the edits and send the form to the members selected.

■ Save as Draft — Saves the changes that you made but does not
send email notifications to the members selected.
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See also:

Adding a Comment to a Form (page 312)

Assigning/Re-assigning a Form (page 324)

Attachments Tab for Forms (page 320)

Printing a Form

A form can be printed if it has been saved as a draft, assigned to another
member and submitted, and when you are responding, recalling, and reviewing
a form.

To print a form:

2 Open a form.

3 Click the Print button. A print preview window is displayed:

4 Use the arrows to hide or show the details of different sections. For
example, if you do not want to print the information about which
documents are linked to the form then click the arrow button to collapse
that section. The heading of that section will be printed.
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Or, click the Delete button to remove a section, including the heading,
from the printed form.

5 Click the Print button. The form prints with the details displayed in
the preview.

See also:

Editing a Form (page 313)

Viewing a Form (page 312)

Adding a Form (page 309)
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Linking Documents to a Form

A form can contain links to other documents or folders. Linking to a document
is analogous to adding a link in an email. For example, within an email you
can add a link to a document that is on a central server. This link takes you
to the current, most recent version of that document. Likewise, adding a link
to a form takes members to the current version of that document within
Buzzsaw. This is different from attaching a document to a form. An attachment
is a static version of that file and may have been updated since it was attached
to the form. The advantage of linking a document to a form rather than
attaching it to the form, is that you do not have to update the file in two
places (the project tree and the Attachments tab). By default the link is to the
current version of the document unless otherwise specified. You have the
option of linking to a specific version of the document.

It is possible to link to documents that not all form users have access to. If
you assign a form to members who do not have access to the linked documents,
a warning is displayed. The members who do not have access to the linked
documents are displayed. You can cancel and reassign the form to members
who do have access to the linked documents, or continue with the members
who do not have access to the linked documents.

When printing a form the links are also printed.

Adding links to a form

A form can link to a project, folder, file, markup, or a specific version of a file,
within your site. The file that you link to can be a file within the site or a file
that is uploaded from your hard drive and added to the site. Use the following
options to select a file:
■ Link to Project Files — Click this link to navigate to a document or

folder within Buzzsaw. The links to your selected documents are added to
the form. You can link to a project, folder, document, markup or a specific
version of a document. You cannot link to a form or form log.

■ Upload & Link to Local Files— Click this link to upload a document
from your hard drive, add it to a project within Buzzsaw, and link the form
to this document. You can link to a specific version of the file which makes
the link static and links to the selected version, not to the most recent
version.

Once a link has been added to a form the attachment icon displays in the
form log attachment column.
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Removing links from a form

In draft or edit mode, select a link and click Remove Links. The ability to add
or remove links to a form is determined by the rules of the business process.
For example, if a user has the ability to reassign a form then he or she can add
or remove links.

Moving linked documents

If a document that a form is linked to is moved the link is automatically
updated. Moving a linked document may alter who can access the document
(that is, if you move the document to an project that members do not have
access to). You can check which forms are linked to a document by looking
at the Forms Links tab. Access this tab by opening the file in the project tree
and clicking the Form Link tab.

See Using the Form Links Tab (page 176) for more information.

Deleting linked documents

If a document that a form is linked to is deleted, then the link on the form
breaks. You can check which forms are linked to a document by looking at
the Forms Links tab. Access this tab by opening the file in the project tree and
clicking the Form Link tab.

See Using the Form Links Tab (page 176) for more information.

See also:

Using the Form Links Tab (page 176)

Assigning/Re-assigning a Form (page 324)

Attachments Tab for Forms (page 320)

General Tab for Forms

The general tab displays the following information about a form:
■ Author — The author of the current version of the form.

■ Version — The version number of the current version of the form.

■ Created — The date and time the first version of the form was submitted.

■ Modified — The date and time the current version of the form was
submitted.
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See also:

Discussions Tab for Forms (page 321)

Routing Tab for Forms (page 319)

Versions Tab for Forms (page 323)

Routing Tab for Forms

The routing tab displays the following information about the form in its
currently assigned state:
■ who the form is currently assigned to

■ who the form was assigned by

■ due date and time of the form

See also:

Attachments Tab for Forms (page 320)

History Tab for Forms (page 324)

Versions Tab for Forms (page 323)

Links Tab for Forms

The Links tab displays the documents or folders within Buzzsaw that are linked
to this form.

To view a linked document:

1 Open a form from the form log.

2 Click the link to the document in the Links tab. The document is
displayed.

If you do not have access to the document an error message is displayed.
Contact your project administrator to gain access to the document.

To download a linked document:

1 Select a link. Use the check boxes to select multiple documents to
download. Or, use the Select All button.
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2 Click the Download button.

3 Click the Save button.

4 Select a location on your hard drive and click the Save button.

See also:

Attachments Tab for Forms (page 320)

History Tab for Forms (page 324)

Versions Tab for Forms (page 323)

Attachments Tab for Forms

If you have another document that is related to a form, you can attach the
document to the form. You can attach a document that is stored in your site,
or one that is stored on your computer. Adding an attachment to a form causes
the attached file to be displayed in the Attachments tab associated with the
form. The attached file is available in your site. The adding and deleting of
attachments is tracked in the History tab.

To add an attachment:

1 In an open, editable, form, click the Attach button. The Attachments
dialog box is displayed.

2 Click the appropriate Browse button to select a file from your Buzzsaw
site or from your local hard drive.

3 Navigate to the file that you want to attach.

4 Select the file and click OK. In the Attachments dialog box click the
Attach button. The file name appears in the Attachments list.

5 When you are finished attaching files, click the OK button. You are
returned to the form and the file is now listed in the Attachments tab.

To view an attachment:

1 Open a form and click the Attachments tab.

2 Click the file name of the attachment to open it. You can only view a
file if you have the appropriate software. For example, to view a Microsoft
Excel spreadsheet Excel must be installed on your computer.
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See also:

Discussions Tab for Forms (page 321)

Routing Tab for Forms (page 319)

Versions Tab for Forms (page 323)

Discussions Tab for Forms

Overview

The discussions tab displays the discussions that you have access to. In this
tab you can add a new comment to the discussion or reply to an existing
comment. Discussions enable you to communicate information about the
form outside the actual form. That is, you can discuss a form (assuming you
have permission to do so) even if the form has not been assigned to you. You
can also discuss the form with members who are not active participants in
the form (again, assuming the log has been configured to allow this). That is,
a member who is not an assignee, responder, approver, gatekeeper, or reviewer.

Discussions can be public or private. Public discussions can be viewed by all
form log participants but only members who have been given the explicit
privilege to discuss the form can start or reply to a discussion. Only discussion
participants will see discussions in their dashboards and receive notification
emails.

All form log participants can start a private discussion. However, a private
discussion can only be viewed by members that the thread initiator has
expressly invited to view the discussion. Only the member who initiated the
private discussion thread can add more participants to the thread. Once a
private discussion has been started it can not be changed to a public discussion.
Administrators can not view a private discussion unless he or she has been
invited as a participant.

NOTE Discussions are saved to a project and thus can be archived. Private
discussions can be archived but only if the user doing the archiving has access to
the discussion. After a form is closed, you can not add new comments.

To view a discussion:

1 Click the Discussions tab.
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2 Select a comment and the text is displayed in the bottom half of the
discussions pane. Or, click the View button and a separate window
displays the comment.

3 Click the plus sign next to a comment to see all the replies. Select a reply
and the text is also displayed in the bottom half of the discussions pane.
Or, click the View button and a separate window displays the comment.

To add a comment:

1 Click the Discussions tab.

2 Click the Add Public Comment or Add Private Comment button. The
Add Thread window is displayed.

3 Select the members you want to send your comments to.

Public discussion — click the Add Participants button to select the
members you want to participate in the discussion. Once a discussion
has started discussion participants can not be removed. Any discussion
participant can add more participants. Once a discussion comment has
been submitted, the members added as participants to a thread cannot
be removed. Only users that are active participants in a form's workflow
(that is, Creator, Responder, etc.), can add participants to a discussion
thread.

Private discussion — click the Add Participants button to select the
members you want to participate in the discussion. As the thread initiator
you are already added to the Participants field. Once a discussion thread
has been started discussion participants can not be removed and only
the thread author can add more participants.

4 Fill in the subject and comment sections. Both sections must be filled
out in order for the comment to be saved.

5 By default the Email comment to participant option is checked. This
means that once you save this comment an email is sent to each of the
participants. This email contains the subject and comment you entered
and a link to the discussion. If you do not want an email to be sent then
clear the checkbox.

To reply to a comment:

1 Click the Discussions tab.

2 Select a thread and click the Reply button.

3 The Reply to Comment window is displayed.
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4 If this is a public discussion you can add members to the thread by
clicking the Add Participants button and selecting additional members.
If this is a private discussion the available participants are automatically
entered in the Participants field. Once a discussion has been started,
discussion participants can not be removed from the thread. This applies
to public and private discussions.

5 Fill in the subject and comment sections. Both sections must be filled
out in order for the comment to be saved.

6 By default the Email comment to participant option is checked. This
means that once you save this comment an email is sent to each of the
participants. This email contains the subject and comment you entered
and a link to the discussion. If you do not want an email to be sent then
clear the checkbox.

See also:

History Tab for Forms (page 324)

Routing Tab for Forms (page 319)

Versions Tab for Forms (page 323)

Versions Tab for Forms

The versions tab displays the existing versions of the form. For each version
you can see when the version was modified, who it was modified by, and any
comment the author entered for that version.

To view a specific version click the underlined number in the Version column.
The form is displayed in HTML format. The details of the form, the path to
linked documents, and the names of attachments are displayed.

See also:

Attachments Tab for Forms (page 320)

History Tab for Forms (page 324)

Routing Tab for Forms (page 319)
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History Tab for Forms

The form history tab enables you to track form activity. Descriptions of each
action taken within the form, associated with a specific form, are listed in the
History tab. You can view the date the action was taken and what the action
was. The columns (Date and Action) are sortable.

You can export the history log as a .txt file or save it to your hard drive as an
.html file.

Only the actions pertaining to a form are recorded in the history tab. These
actions include the following:
■ Save to log

■ Edit

■ Assign

■ Respond

■ Forward

■ Close

Some actions are performed by the Buzzsaw system. For example, when an
RFI becomes overdue it is noted in the history tab as "RFI0123 became overdue".

See also:

Attachments Tab for Forms (page 320)

Routing Tab for Forms (page 319)

Versions Tab for Forms (page 323)

Assigning/Re-assigning a Form

Assigning a form enables you to assign an action to a project member or group.
Forms can also be recalled after you have assigned it.

Assigning a form

1 Create a form (page 309) like you normally would.

2 After filling in the form, click the Assign button. The Assign To dialog
box opens.
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3 Select a member or a group from the Available members list. Use the
pagination arrows at the top right of the window to page through the
member list as necessary. Click OK.

You can select as many members or groups as you would like. Assigned
members receive an email containing the subject, the due date and a
link to the form.

It is not recommended that you assign a form to a Private and Hidden
Groups (page 128). Doing so exposes the names and email addresses of
private group members in the Routing Tab for Forms (page 319) and in
various dashboards.

4 Select a due date and time. Once selected this date will be written into
the view version of the form. Once this date has expired, the form will
become overdue. The due time will display in your log in your local time
zone. It will display in the assignee's member's log in his or her time
zone. For example: you are in California and are assigning this form to
a member in New York. You want the due time to be 10am Pacific
Standard Time. To do this, select 10:00am from the Due Time list box.
This assignment will display in the New York member's log as being due
at 1:00pm Eastern Standard Time.

5 To notify other project members about this form, click the CC button
and add the appropriate members. These members are sent an email
with a link to this form. When notifying a private group the group name
is displayed in the cc field, but not the individual member names.

6 Click Add Comment at the top of the window. See Adding a Comment
to a Form (page 312) for more information.

7 Click Submit when you are finished. Clicking Submit saves the form,
adds it to the log, numbers the form, and sends the appropriate email
notifications.

8 To cancel the assignment, simply close the window. The form is not
added to the log and you lose any information that you entered.

Re-assigning a form

Once a form has been assigned you can re-assign it. This is useful if the member
the form was originally assigned to is not responding to the form, and you
want to keep the routing of this form in motion.
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NOTE Depending on the type of form log that you are viewing and your role
within the form log, the option to re-assign may not be available to you.

1 Within a form log select a form and right-click. Choose Re-assign from
the menu.

2 The form opens. Click Re-assign and select a member or group to re-assign
the form to.

It is not recommended that you re-assign a form to a private group (page
128). Doing so exposes the names and email addresses of private group
members in the routing tab (page 319) and in various dashboards.

3 You do not have the option of changing the due date or time. You can
add comments.

4 Use the Route Back through me option if you want the form to be
automatically sent back to you. Or, if it is okay for the form to be
forwarded to someone else then do not select this option.

5 Click Submit to save and notify the assigned member. The form is
displayed in your Dashboard as both an assigned item and an issued
item.

6 To cancel the re-assignment, simply close the window. The form is not
added to the log and you lose any information that you entered.

To view items that are assigned to you, and items that are overdue, in a specific
project, view your personal summary dashboard (page 275) for that project.

NOTE You can choose to add a form to a log and not assign it to anyone. Doing
this "posts" the form to the log and allows you to notify, cc, and discuss the form,
but no assignments will be made. To post a form instead of assigning it, open a
log and click Add  ➤ Without Assignment. Then, complete the form as you normally
would except that you will not be selecting "assignees". If you do not specifically
choose this option, it is assumed that you want to assign the form.

See also:

Closing a Form (page 328)

Recalling a Form (page 328)

Responding to a Form (page 327)
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Responding to a Form

In certain form logs you have the ability to respond to an item that has been
assigned to you. If this is available to you when you open the form there is a
Respond option on the form. Following is an example:

1 Within a form log, select a form and right-click. Choose Respond from
the menu.

2 The form is automatically sent back to the person who assigned it to
you. Click the CC or Notify button to select a member to notify about
the form.

3 Edit the form and add comments as needed. Click Submit when finished.

4 To cancel the response, simply close the window. The form is not added
to the log and you lose any information that you entered.

Once you have responded to a form, the assignment is removed from your
list of action items in the Dashboard.

See also:

Viewing a Form (page 312)
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Recalling a Form

After you have assigned a form to another project member you can recall the
form. This is useful if the assigned member is unable to respond and you want
to re-assign the form to someone else.
■ Within a form log, select a form and right-click. Choose Recall from the

menu.

or

■ Double-click the form within a log. When the form opens, click Recall.

The form is removed from the assigned's dashboard. An email is sent to the
members from whom the form is being recalled stating that you have recalled
the form.

See also:

Assigning/Re-assigning a Form (page 324)

Closing a Form (page 328)

Viewing a Form (page 312)

Closing a Form

A form can be closed at any time by an administrator or the form creator.
Within a form log select a form that has been submitted (that is, not a draft)
and right-click. Choose Close from the menu. This ends the routing of that
form. All assignments are removed and members will not see the assignment
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on their dashboard. You can not close a form if it has been assigned to you
and a response is required.

After a form is closed an administrator or the original form creator can re-open
the form. When a form is re-opened previous routing (that is, assignments)
no longer exists. Other data though, such as comments, discussions,
attachments and the form history remains intact.

See also:

Assigning/Re-assigning a Form (page 324)

Viewing a Form (page 312)

Deleting a Form

Only administrators and the creator of a form can delete a form. Deleting a
form from the log sends the selected form to the Recycle bin. If you change
your mind about the deletion, you can go to the Recycle Bin and restore the
form.

NOTE Once the Recycle Bin is emptied, you cannot restore the form.

1 In the log, select the form that you want to delete.

2 Right-click and choose Delete. The selected form moves to the Recycle
Bin. You can still restore the form, but once the Recycle Bin is emptied,
you can no longer restore the from.

See Using the Recycle Bin (page 238) for more information.

NOTE Deleting a draft (that is a form that has not been submitted) permanently
deletes the form. The draft will not go to the Recycle Bin and it is not recoverable.

See also:

Working with Forms (page 309)

Recalling a Form (page 328)

Responding to a Form (page 327)
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Working with Reports

Overview

Reports provide information about the selected site, project, or form log. Reports
provide details about items that are assigned to you, issued by you, and when
these items are due. Reports are a means of creating a printable version of what
you see in the Dashboard.

Reports can be accessed though the Reports menu at the top of your dashboard.
The reports available depend on whether you are viewing a site or project and
your permission level. Reports are available at the site level, project level, and
for specific logs (that is, RFIs, Meeting Minutes). For example, if you are viewing
a project dashboard and click the reports menu, you will be able to select from
project level reports, not site level reports. Reports are not available for folders
and files.

Reports can be generated for a site, project, form log, and form type. Within
each category there are multiple reports that can be generated. Following is a
description of the three main categories:
■ Executive — Executive level reports display all the items pertaining to a

site, or project, not just items that have been assigned to you or by you. By
default, only administrators can view executive level reports. Site
Administrators can see the site level executive reports; Project Administrators
can only see project level executive reports.

■ My Items — These reports display forms that have been assigned to you,
and can be run at the site or project level.

■ Issued Items — These reports display the items that have been assigned
by you and can be run at the site or project level.
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Site level reports

The following reports can be generated for a site:

Executive
■ Overdue Items — all items for the site that are overdue.

■ Due Today — all items within the site that are due today.

■ Due This Week — all items within the site that are due this week.

■ Projects by Manager — This reports lists all the projects within a site
by status and the project manager.

■ Project by Region — This report lists all the projects within a site by
region.

■ Projects by Type — This report lists all the projects within a site by
project type.

The three reports, projects by manager, region and type are based on the
project data that has been defined for the project. If your project administrator
has not added this data to the project then these reports will not be as
meaningful.

See Step 1: Define Project Data (page 260) for more information.

My Items

■ Overdue Items — This report produces a list of overdue items, for the
entire site that are assigned to you.

■ Due Today — This report produces a list of items due today, for the entire
site that are assigned to you.

■ Due This Week — This report produces a list of items due this week, for
the entire site that are assigned to you.

Issued Items

■ Overdue Items — This report produces a list of items, for the entire site
that have been assigned by you, to other people, and are overdue.

■ Due Today — This report produces a list of items, for the entire site that
have been assigned by you, to other people, and are due today.

■ Due This Week — This report produces a list of items, for the entire site
that have been assigned by you, to other people, and are due this week.
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Project level reports

Following is a list of all the reports that can be generated for a project:

Executive
■ All Open Items — This report produces a list of every open item within

the project. Only administrators can see this report.

■ Overdue Items — All items for a project that are overdue. As a project
administrator you will see all overdue items regardless of who assigned
them or who they are assigned to.

■ Due Today — All items within the project that are due today. As a project
administrator you will see all items that are due today regardless of who
assigned them or who they are assigned to.

■ Due This Week — All items within the project that are due this week.
As a project administrator you will see all items that are due this week
regardless of who assigned them or who they are assigned to.

My Items

■ All Open Items — This report produces all items within a project that
have been assigned to you.

■ Overdue Items — This report produces a list of items, for the project,
that have been assigned to you and are overdue.

■ Due Today — This report produces a list of items, for the project, that
have been assigned to you and are due today.

■ Due This Week — This report produces a list of items, for the project,
that have been assigned to you and are due this week.

Issued Items

■ All Open Items — This report lists all forms within a project, that you
assigned to another person, that are still open. A form is no longer open
if it has been closed, or deleted.

■ Overdue Items — This report produces a list of items, for the project,
that have been assigned by you to other people, and are overdue.

■ Due Today — This report produces a list of items, for the project, that
have been assigned by you to other people, and are due today.

■ Due This Week — This report produces a list of items, for the project,
that have been assigned by you to other people, and are due this week.
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Addendum

■ All Open Items — This report produces a list of open addendum forms
within the project that you have access to.

■ My Items — This report produces a list of addendum forms that have
been assigned to you.

■ Issued Items — This report produces a list of addendum forms that you
have assigned to other people.

Approval

■ All Open Items — This report produces a list of open approval forms
within the project that you have access to.

■ My Items — This report produces a list of approval forms that have been
assigned to you.

■ Issued Items — This report produces a list of approval forms that you
have assigned to other people.

ASI (Architect's Supplemental Instruction)

■ All Open Items — This report produces a list of open ASI forms within
the project that you have access to.

■ My Items — This report produces a list of ASI forms that have been
assigned to you.

■ Issued Items — This report produces a list of ASI forms that you have
assigned to other people.

Bulletin

■ All Open Items — This report produces a list of bulletin forms within
the project that you have access to.

■ My Items — This report produces a list of bulletin forms that have been
assigned to you.

■ Issued Items — This report produces a list of bulletin forms that you
have assigned to other people.

Change Order Requests

■ All Open Items — This report produces a list of open change order
requests within the project that you have access to.

■ My Items — This report produces a list of change order requests that have
been assigned to you.

334 | Chapter 22   Working with Reports



■ Issued Items — This report produces a list of change order requests that
you have assigned to other people.

Correspondences

■ All Open Items — This report produces a list of open correspondences
within the project that you have access to.

■ My Items — This report produces a list of correspondences that have been
assigned to you.

■ Issued Items — This report produces a list of correspondences that you
have assigned to other people.

Daily Reports

■ All Open Items — This report produces a list of open daily reports within
the project that you have access to.

■ My Items — This report produces a list of daily reports that have been
assigned to you.

■ Issued Items — This report produces a list of daily reports that you have
assigned to other people.

Meeting Minutes

■ All Open Items — This report produces a list of open meeting minutes
within the project that you have access to.

■ My Items — This report produces a list of meeting minutes that have
been assigned to you.

■ Issued Items — This report produces a list of meeting minutes that you
have assigned to other people.

Print Order

■ All Open Items — This report produces a list of open print order request
forms within the project that you have access to.

■ My Items — This report produces a list of print order request forms that
have been assigned to you.

■ Issued Items — This report produces a list of print order request forms
that you have assigned to other people.
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RFI

■ All Open Items — This report produces a list of open RFIs within the
project that you have access to.

■ My Items — This report produces a list of RFIs that have been assigned
to you.

■ Issued Items — This report produces a list of RFIs that you have assigned
to other people.

RFI with Distributor

■ All Open Items — This report produces a list of open RFIs with Distributor
within the project that you have access to.

■ My Items — This report produces a list of RFIs with Distributor that have
been assigned to you.

■ Issued Items — This report produces a list of RFIs with Distributor that
you have assigned to other people.

Submittal

■ All Open Items — This report produces a list of open submittal forms
within the project that you have access to.

■ My Items — This report produces a list of submittal forms that have been
assigned to you.

■ Issued Items — This report produces a list of submittal forms that you
have assigned to other people.

Transmittal

■ All Open Items — This report produces a list of open transmittal forms
within the project that you have access to.

■ My Items — This report produces a list of transmittal forms that have
been assigned to you.

■ Issued Items — This report produces a list of transmittal forms that you
have assigned to other people.

Log reports

Form Logs have two types of reports available:
■ List view — This report displays all the information that is seen in the

log. For example, whether a form is open or closed, who it is assigned to,
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who it was assigned by and the due date and time. The list view report is
available for all form types except for Meeting Minutes. Only the detail
view is available for Meeting Minutes.

■ Details view — This report contains the most critical information about
the form. For example, the details view of an RFI contains the actual
question and answer from within the form.

Generating a report about the correspondence for a project is different from
generating a list view or details view of a correspondence log. In a
correspondence report for a project, you can see the open items and who they
are assigned to. Whereas a report about an individual correspondence log
provides you with specific details about all items within a log (open and
closed).

See also:

Dashboard Overview (page 275)

Step 1: Define Project Data (page 260)

Viewing, Printing, Saving and Exporting Reports (page 337)

Viewing, Printing, Saving and Exporting
Reports

In the report viewer you can view, print, save, and export reports.

1 You can launch a report from the Reports menu: at the top of your
dashboard, click the reports menu. Select the report that you want to
view from the drop-down menu. Following is an example:

2 The report is displayed in a separate window. If you want to view a
different report click the Select Report drop-down list at the top of the
window and choose another report.

Working with Reports | 337



3 Use the Back/Forward arrows in the toolbar to move between reports.
Clicking Back displays the last report you viewed. Clicking Forward
displays the last report you viewed before clicking the Back button.

4 To print the report, click the Print Report toolbar button,  .

5 To save the report, click the Save Report toolbar button,  .

6 To export the report to a Comma Separated Value (CSV) file, click the

Export Report toolbar button,  . The CSV file contains the data in
the report. A CSV file is a file in which each piece of data is separated by
a comma.

When you are finished, close the viewer.

See also:

Dashboard Overview (page 275)

Searching a Form Log (page 306)

Working with Reports (page 331)
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Working with Submittal
Packages

Overview of the Submittal Package Process

Submittals review is a key part of any large construction project. Submittals
review is the process by which vendors (subcontractors) submit to the general
contractor (who in turn submits to the Architect/Engineer/Owner) detailed
documents, drawings or samples of each material item they plan to use within
their part of the project (per the specification requirements). Each item submitted
needs to be approved prior to installation. Through the submittal package log
Buzzsaw provides an automated method of creating, scheduling and tracking
the status of submittals.

Overview of the submittal process

Following is an overview of the submittal process. Click the appropriate link
for detailed instructions of each step.

1 The package creator adds a submittal package form log. This is the same
process for adding other form logs. It is in this step that you define who
is the package creator, transmittal creator, distributor, consultant, and
gatekeeper.

See Step 4: Business Processes (page 263) for more information.

2 The package creator opens the submittal form log and creates the submittal
package (page 343). The package is assigned to the transmittal creator.

3 The transmittal creator adds submittal items (page 346) to the package. He
or she then creates and submits a transmittal (page 347) to the design team.

4 The distributor reviews the submittal items and distributes (page 347) to
the gatekeeper and optionally to the consultants. (It is not required that
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the package is distributed to consultants at the same time as the
gatekeeper.) It is at this point that the clock starts. In this step the
distributor can alternately choose to return the (page 347) package to the
transmittal creator instead of distributing to the design team. If the
distributor returns the package transmittal the clock does not start.

5 At this point the gatekeeper and consultants can send their responses
(page 347) to the gatekeeper.

Consultants can also forward (page 347) the package transmittal to other
members granted access in the log options. The responses from these
forwarded package transmittals can be used by the consultants in their
own responses.

6 Consultants send responses (page 347) to the gatekeeper.

7 The gatekeeper submits final response (page 347). The clock stops at this
point.

8 The distributor closes (page 343) and returns the package transmittal to
the transmittal creator. At this point the transmittal creator can revise
the package by editing the package, adding submittal items, or revising
existing submittal items.

The clock starts in the workflow when the transmittal is distributed to the
gatekeeper and consultants. The clock ends when the gatekeeper submits a
final response.

See also:

Submittal Items Tab (page 346)

Submittal Log (page 340)

Submittal Packages Tab (page 343)

Submittal Log

The submittal package log is where project members can view and access
submittal packages, package transmittals, and submittal items.

A submittal log behaves as other logs do in terms of what happens when it is
deleted (page 307) and cloned (page 42). Site and project administrators can
view form log actions in the Activity Logs (page 143).

All participants have access to the submittal form log. The actions and views
available to participants depend on the member's role in the workflow.
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Submittal packages are displayed in dashboards and reports. Submittal packages
are displayed in Executive, My Items and Issued Items reports. Submittal
packages are not tracked in project level reports. For more information about
the different levels of reports see Working with Reports (page 331). You can
access a submittal directly from a dashboard as you can with other forms. For
example, if a package is assigned to you, the package is displayed in your
Project Personal dashboard under "My Action Items". The submittal log also
has a "My Submittal Action Items" section through which submittals can be
accessed.

To add a submittal log follow the process for Step 4: Business Processes (page
263).

The following tasks are available in all three tabs of the log. Again, depending
on your role in this workflow, you many not be able to see all of these options.

Exporting:

You can export the contents of a form log to a CSV (comma separated value)
file. A CSV file is a file in which each piece of data is separated by a comma.
This information can then be imported into a spreadsheet, for example.

When exporting a log, the details of the packages are not exported, but rather
the information that you see in the log. For example, the form names,
assignment information, and due dates.

1 In any of the three tabs, Submittal Packages, Submittal Items or
Transmittals, click Export.

2 The File Download dialog box is displayed. Click Save.

3 Select a location and save the file.

Printing:

In any of the three tabs, Submittal Packages, Submittal Items or Transmittals,
you can print the different sections of that tab. For example, in the Submittal
Packages tab, you can print a summary list of the Submittal schedule. The list
that is printed is representative of what you see in the submittal log — package
details, item details and transmittal details are not printed.

In the section that you want to print, click Print. The print preview is displayed.

Viewing the submittal schedule:

You can view a schedule of all submittal packages at the bottom of each of
the three tabs: Submittal Packages, Submittal Items, and Transmittals.
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The submittal schedule shows start and due dates for the submittal package.

Sorting the log view:

In each of the submittal package log tabs you can filter your view to see a
subset of packages. Click the Display drop-down list box and select a filter.
Following is an example:

Only the submittal packages that have the specified criteria are displayed in
the log.

Setting log options:

Administrators can edit the options for this log at any time. See Workflow
Types (page 290) for details about the options that are specific to this workflow.

See also:

Working with Submittal Packages (page 339)

Submittal Packages Tab (page 343)

Transmittals Tab (page 347)
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Submittal Packages Tab

This tab is available in a submittal package log. Submittal packages can not
be deleted. Once a package is created it can only be recalled or closed out.
Submittal packages that have been sent are displayed in the assignee's
dashboard under Action Items. The item is listed as "submittal package".

In this tab you can add a submittal package. Read the following sections for
details:

Adding a package:

1 In the submittal package log, click Add Submittal Package. The Add New
Submittal Package is displayed.

2 Fill in the fields as necessary. Required fields are marked by an asterisk.

3 When you are finished you have several options for saving the package:

■ Save and Add Another — save this package and continue adding new
packages.

■ Save and Return — save this package and return to the submittal log.

■ Save and Add Items — save this package and continue to the Submittal
Items Tab (page 346).

■ Cancel — return to the submittal log without saving any data entered.

Editing a package:

Depending on your role in the submittal process you can edit a package that
has been assigned to you. Submittal packages can not be edited when they
are being reviewed.

1 Click the package link in the Submittal Package tab. The details of the
package are displayed.

2 Click Edit.

3 Enter changes as necessary and click Save and Return. You are returned
to the Submittal Package tab.

Importing a package:

You can import submittal packages instead of entering them manually. When
importing it’s important to note that the file you import must be in the
following format:
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The file must be a CSV (comma separated value) file with one header line (the
contents of which are ignored) and must be UTF-8 encoded. The columns
should be in the following order using the same column names.

All columns can be empty but they do have to be in the order outlined below:
■ name

■ description

■ division number — must exactly match division number codes (that is,
01 not 1)

■ division name — must exactly match the right division name

■ spec section number

■ spec section name

■ required start date

■ actual start date

■ required complete date

■ actual complete date

■ delivery due date

■ contract award date

All dates should be in the local time zone and may specify a time. Dates and
times should also be in the current locale's date/time format.

To import the file:

1 In the Submittal Packages tab click Import Submittal Packages.

2 The Import page is displayed.

3 Click Browse to navigate to the file you want to import. You can select
a file from your hard drive or the Buzzsaw site.

If you select a file from your Buzzsaw site a copy of the file is imported to the
package. Thus, if the file on the site changes, the imported file is not updated.

Files that are exported from Buzzsaw can not then be imported.

Closing out a package:

Once a package has been reviewed and everyone has submitted a response, a
package can be closed out by the package creator (only the package creator
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can close out a package). This option is enabled when there is no open
transmittal for that package.

1 Open a package in the Submittals Package tab.

2 The View Package page is displayed.

3 Click Close Out.

Once a package has been closed out the package can not be edited or
transmitted, and submittal items can not be added to the package. A closed
out package can be re-opened by the package creator.

Recalling a package:

Packages and transmittals can be recalled. Transmittal creators, distributors,
gatekeepers and consultants can all recall a package after it has been distributed
or forwarded.

1 In the Submittal Packages tab select Recall from the Actions drop-down
list box on the far right of the package. Following is an example:

2 Confirm your selection.

Once a package is recalled, the assignment is removed from the dashboard of
each member who had been assigned to take action on the package. An email
is sent to the members from whom the package is being recalled stating that
you have recalled the package.

See also:

Working with Submittal Packages (page 339)

Submittal Items Tab (page 346)

Submittal Log (page 340)
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Submittal Items Tab

This tab is available in a submittal package log.

In this tab you add items to the submittal package. A package can not be
transmitted until items have been added.

Adding submittal items

Before creating a transmittal you can add submittal items to the package.

1 In the Submittal Form log click the package number link. The View
Package page is displayed.

2 Scroll down to the Submittal Items area. Click Add Submittal Item.

3 The Add New Submittal Item page is displayed.

4 Enter an item name, type and quantity. You can provide further details
in the Item Description field.

5 Click Browse to navigate to the file you want to attach. You can select
a file from your hard drive or the Buzzsaw site.

If you select a file from your Buzzsaw site a copy of the file is attached
to the package. Thus, if the file on the site changes, the attached file is
not updated.

6 When you are finished click one of the Save options:

Save and add another - saves the current item and opens a new Add
Submittal Item page.

Save and Return - saves the current item and returns you to the View
Package page.

7 To cancel the item click Cancel. The item is not added to the package
and you lose any information that you entered.

Importing submittal items

You can import submittal items instead of entering them manually. When
importing it’s important to note that the file you import must be in the
following format:

The file must be a CSV (comma separated value) file with one header line,
and must be UTF-8 encoded. The columns should be in the following order
using the same column names.
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All columns can be empty but they do have to be in the order outlined below:
■ name

■ description

■ Quantity

■ Item Type

■ If the item type is other, then that value can be specified here.

Once your file is in the correct format you can import it into your submittal
package log:

1 In the Submittal Form log click the package number link. The View
Package page is displayed.

2 Scroll down to the Submittal Items area. Click Import Submittal Items.

3 The Import page is displayed.

4 Click Browse to navigate to the file you want to import. You can select
a file from your hard drive or the Buzzsaw site.

If you select a file from your Buzzsaw site a copy of the file is imported to the
package. Thus, if the file on the site changes, the imported file is not updated.

Files that are exported from Buzzsaw can not then be imported.

See also:

Working with Submittal Packages (page 339)

Submittal Log (page 340)

Submittal Packages Tab (page 343)

Transmittals Tab

This tab is available in a submittal package log.

In this tab you create a transmittal. You should have already added submittal
items (page 346) to the package (a package can not be transmitted until
submittal items have been added). Now, you will create a transmittal and send
it to the distributor.
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Creating a transmittal

1 In the Submittal Packages tab, click the package number. The View
Package page is displayed. You can review the submittal items in this
view. If you need to add more items click Add Submittal Items (page 346).

2 Click Create Transmittal. The Send Transmittal page is displayed.

3 Click the To and CC buttons to select the members you want to send
the transmittal to. Only distributors as defined in the log options (page
290) are listed.

4 Fill in the fields as necessary. Comments that you enter are saved with
the package and are viewable by workflow participants depending on
the role of the participant. For example, comments entered by the
transmittal creator are only viewable by the transmittal creator and the
distributor. You can enter comments in any language. These comments
are not translated and are displayed in the language entered.

5 Click Send.

Once a transmittal has been created it is sent to the distributor who reviews
the package. The distributor can then distribute the package to the gatekeeper
or return it to the transmittal creator.

Distributing a transmittal

Once a transmittal has been created it is sent to the distributor who reviews
the package. The package can then be distributed to the gatekeeper or returned
to the transmittal creator.

1 In the Submittal Packages tab select Distribute from the actions
drop-down list box on the far right of the package.

2 The Distribute Transmittal page is displayed.

3 There are two To fields. The first one lists gatekeepers and is a required
field. The second To field is for consultants and is not a required field.

4 Fill in the fields as necessary.

5 To view comments from other project members click View All Comments.

6 Click Send.
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Returning a transmittal

If a package is missing information or required clarification, as a distributor
you can return a transmittal that has been sent to you.

1 In the Submittal Packages tab select Return from the actions drop-down
list box on the far right of the package.

2 The Return Transmittal page is displayed.

3 The To field is automatically populated with the transmittal creator's
name. You can choose additional members to send the transmittal to
by clicking CC.

4 Add your comments in the Comments field.

5 To view comments from other project members click View All Comments.

6 Click Send.

Responding to a transmittal

After a package has been distributed gatekeepers and consultants can respond
to the package.

1 In the Submittal Packages tab select Respond from the actions drop-down
list box on the far right of the package.

2 The Respond Transmittal page is displayed.

3 Click the To and CC buttons to select the members you want to send
the response to.

4 Fill in the fields as necessary.

5 Each item requires a response. Select a response from the Final Response
drop-down list box to the right of the item listing. Your response is
displayed in the Final Response column when the package is viewed by
the distributor, transmittal creator and the package creator.

6 To view comments from other project members click View All Comments.

7 Click Send.
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Forwarding a transmittal

After a package has been distributed gatekeepers can forward the package to
consultants and consultants can forward it to other consultants. A consultant
who receives a forwarded transmittal can then respond or forward the package.

1 In the Submittal Packages tab select Forward from the actions drop-down
list box on the far right of the package.

2 The Forward Transmittal page is displayed.

3 Click the To and CC buttons to select the members you want to forward
the transmittal to.

4 Fill in the fields as necessary.

5 To view comments from other project members click View All Comments.

6 Click Send.

See also:

Submittal Items Tab (page 346)

Submittal Log (page 340)

Submittal Packages Tab (page 343)
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Bid Management

Overview

Buzzsaw enables you to electronically distribute bid invitations, manage
communications with bidders, track responses, and receive bids online. Within
Buzzsaw, bid management is a business process that is added to a project. A bid
management business process cannot exist outside of a project.

1 Bid administrator adds a bid business process to a project (page 263).

2 Bid administrator configures the Bid Management Options (page 358).

3 Bid administrator adds a vendor (page 352) to the project.

4 Bid administrator addsa new bid package (page 352).

5 Bid administrator sends out bid invitations (page 352).

6 Bidder receives and reviews invitation (page 356).

7 Bidder creates intent to bid (page 356).

8 Bidder submits intent to bid (page 356).

9 Bid administrator tracks responses (page 360) from the bidders in the Bid
Management dashboard by updating the package with a bidder's response.

10 Bidder submits (page 356) a bid. Bidders can update or remove a bid (page
356) after it has been submitted.

11 Bid administrators can send notifications (page 360) to bidders after a bid
has been submitted to alert the bidder or changes.

See also:

Bid Management Dashboard for Administrators (page 352)

Bid Management Dashboard for Bid Recipients (page 356)
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Bid Management Options (page 358)

Printing, Importing and Exporting in Bid Management (page 362)

Bid Management Dashboard for
Administrators

As a bid administrator the Bid Management dashboard is where administrators
create bid packages, create invitations to bid, and track the bidding process.

The Bid Management dashboard behaves as other business processes do in
terms of what happens when it is Deleting a Form Log (page 307) and Cloning
a Project (page 42). Site and project administrators can view form log actions
in the Activity Logs (page 143).

All participants have access to the Bid Management dashboard. However, the
tasks available to bid administrators depend on the whether the administrator
was granted permission to perform that task. For example, as a bid
administrator you may have been granted the privilege to send invitations
but not enter responses.

Adding a vendor

Before you can send out a bid invitation you have to add vendors to the
project.

1 In the Project Tree select a project. This should be the project that will
contain the bid manager business process.

2 Right-click and choose Properties.

3 Click the Companies tab.

4 Click New.

5 Enter a Name.

6 A Vendor ID is automatically created for you, however, you can enter
a new ID if necessary.

7 Enter additional Company and Contact information as needed.

8 Click the Company Members tab.

9 Select a member from the Available list and click Add. Members must
first be added to a project before they can be associated with a company.
If the member you to add is not available go to Project Properties
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 ➤ Members tab  ➤ Add to add members to the project. Then return to
the Companies tab to add members to a Company.

10 In the New Company dialog click Create. Continue creating more
companies (which will serve as your vendors) or click Close.

An alternative way to add a vendor, is to add a member who is already
associated with a company. When the member is added to the project the
associated company is automatically added to the project.

Now, when you create a bid package vendors are available. The vendors
available for selection are limited to the companies you have added to the
project. Companies created at the site level are not available as vendors until
those companies have been specifically added to a project.

Adding a bid package

1 In the Bid Management dashboard click the Add Bid Packages link.

2 Enter a package name.

3 Click the calendar to select the date that the bid is due.

4 Click the Add Trades link to add trades.

5 Select the trades you want and click Add. You are returned to Step 1 of
creating a bid package.

6 Click the link, Add Vendor for all trades. The vendors selected are
added to all of the trades in the package.

Or, for individual trades click the Add Vendors link that is to the right
of that trade. The vendors selected are only added to the selected trade.

The search excludes vendors that have previously been added to a trade.

7 When you are finished you have several options for saving the package:

Save and Continue - save this package and continue to the next step
of creating an invitation.

Finish - save this package and return to the Bid Management dashboard.
You can return to the package at a later time to send out invitations to
bid.

Finish and Add Another - save this package and continue adding
new packages.

Cancel - return to the Bid Management dashboard without saving any
data entered.

8 If you selected Save and Continue the next step is to create the
invitation to send to bidders.

Bid Management | 353



9 In the Invitation details, enter a subject for the invitation.

10 Select the date when the intent to bid is due.

11 Select the date when the bid is due.

12 Select a Project Contact and enter contact information for that person.
The people available in the drop-down list are the bid administrators
that were added to the bid management process in the Bid Management
Options.

13 Add a project description and any additional notes.

14 Click the Add Documents and Drawings link if you want to send
supplementary files to the vendors. The Add Documents and Drawings
page is displayed.

15 Select either Local Files or Project Files from the drop-down list.

NOTE If you select a file from your Buzzsaw site a copy of the file is attached
to the package. Thus, if the file on the site changes, the attached file is not
updated.

16 Click the Browse button to navigate to the files that you want to add
to the bid. The files are displayed.

17 Click Save and Continue to move to the next step to the Add New
Bid Package wizard.

18 Select recipients for the invitation.

19 Click the Send Invitation button. The invitation is sent to the vendors.
You can continue adding more bid packages or return to the Bid
Management dashboard.

Creating an invitation to bid

You can create an invitation separately from the Adding a Package wizard.
However, you cannot send an invitation until at least one vendor has been
added to the package.

1 Once a bid package has been created navigate to the Bid Management
dashboard.

2 In the column, Total Invited, click the Create Invitations link. The
Create Bid Invitation page is displayed.

NOTE This method of creating an invitation is only available if you have not
previously created an invitation for this package.
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3 Select the recipients you want to send the invitation to. You can add
more vendors by clicking the Add Recipients link.

4 In the Invitation details, enter a subject for the invitation.

5 Select the date when the intent to bid is due.

6 Select the date when the bid is due.

7 Select a Project Contact and enter contact information for that person.
The people available in the drop-down list are the bid administrators
that were added to the bid management process in the Bid Management
Options.

8 Add a project description and any additional notes.

9 Click the Add Documents and Drawings link if you want to send
supplementary files to the vendors. The Add Documents and Drawings
page is displayed.

10 Select either Local Files or Project Files from the drop-down list.

NOTE If you select a file from your Buzzsaw site a copy of the file is attached
to the package. Thus, if the file on the site changes, the attached file is not
updated.

11 Click the Browse button to navigate to the files that you want to add
to the bid. The files are displayed.

12 Click OK to return to the Create Bid Invitation page.

13 When you are finished click Send. The invitation is send to the selected
vendor. You can review the invitation details by opening the bid package
in the Bid Management dashboard. You can track the responses from
the vendors in the Bid Packages (page 360) tab of the bid package details.

After an invitation has been sent to the vendors you can update the package
and send additional invitations. See Bid Packages (page 360) for details.

Viewing a bid package

In the Bid Management dashboard click the name of a package. For more
information about the four tabs and the various tasks available, see Bid
Packages (page 360).

Deleting a bid package

1 In the Bid Management dashboard select the check-box next to the
package that you want to delete. You can select more than one package.

2 Click Delete Packages.
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Finding vendors

1 Click the Find Vendors link.

2 Enter the search criteria and click Search.

3 The results are displayed. You can print, import or export this list.

See Printing, Importing and Exporting in Bid Management (page 362) for more
information about these common tasks.

See also:

Bid Management Options (page 358)

Bid Packages (page 360)

Printing, Importing and Exporting in Bid Management (page 362)

Bid Management Dashboard for Bid
Recipients

As a bidder the Bid Management dashboard is where you view your invitations
to bid, submit bids, and review bids that you have posted. As a bid recipient
you have a different view of the dashboard than administrators.

Viewing an invitation

When a bid administrator sends you a bid you will receive an email notification
which contains a link to the bid invitation. Click this link to view the
invitation.

Alternately, login to your site and navigate to the Bid Management dashboard.
Your invitation to bid is listed in the window. Click the name of the bid
invitation to review the invitation details.

See Bid Packages (page 360) for more details about viewing a package.

Creating an intent to bid

1 Navigate to the Bid Management dashboard.

2 Click the name of the bid invitation to review the invitation details.

3 Click the Respond to Invitation button.

4 For each available trade, select the option, "Will Bid", "Will Not Bid", or
"May Bid".
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5 Add any additional comments if desired.

6 Click Send.

The bidder is notified that you have sent an intent to bid. You can now submit
your bid. Follow the steps in the next section of this topic.

Submitting a bid

1 Navigate to the Bid Management dashboard.

2 Click the name of the bid invitation to review the invitation details.

3 Click the Submit Bid Now button. The Add Bid window is displayed.

4 Select either Local Files or Project Files from the drop-down list.

You can upload single or multiple files.

NOTE  If you select a file from your Buzzsaw site a copy of the file is attached
to the package. Thus, if the file on the site changes, the attached file is not
updated.

5 Click the Browse button to navigate to the files that you want to add
to the bid. The files are displayed.

6 Click Submit when you are finished. The bid is submitted to the bid
administrator.

Once a bid is submitted you can view your submitted bit in the Bid
Management dashboard in the Submitted Bids tab. From the dashboard you
can update or remove the bid.

Removing a bid

Once you have submitted a bid you can remove it.

1 Navigate to the Bid Management dashboard.

2 Click the name of the bid invitation. The bid package details are
displayed.

3 Click the Bid Packages (page 360).

4 Select Remove Bid from the drop-down list. Your bid is removed from
the bid package.
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Updating a bid

Once you have submitted a bid you can update it.

1 Navigate to the Bid Management dashboard.

2 Click the name of the bid invitation. The bid package details are
displayed.

3 Click the Bid Packages (page 360).

4 Select Update Bid from the drop-down list. The Upload Bid page is
displayed.

5 Select either Local Files or Project Files from the drop-down list.

NOTE If you select a file from your Buzzsaw site a copy of the file is attached
to the package. Thus, if the file on the site changes, the attached file is not
updated.

6 Click the Browse button to navigate to the files that you want to add
to the bid. The files are displayed.

7 Click OK when you are finished. The bid is updated.

See also:

Bid Packages (page 360)

Bid Management (page 351)

Printing, Importing and Exporting in Bid Management (page 362)

Bid Management Options

Bid administrators can edit the details of the bid project. To access the Bid
Management Options click the link on the Bid Management Dashboard. The
following tabs are available:

Package Details tab

In this tab you can select a start and end date for your project.

The address details cannot be edited in this tab. This data comes from Project
Setup  ➤ Data. To edit the address go to Project Setup  ➤ Data and enter the
correct information. All bid business processes in this project are updated with
the current information.
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Configure Vendor Search tab

This tab enables you to select the criteria by which bid administrators can
search for a vendor. You can also rearrange the order in which the search
criteria are listed.

1 Select the attribute that you want to include in the search criteria.

2 Select the attribute that you want to move and use the Move Up and
Move Down buttons to change the attribute's position in the list.

3 For each attribute that you have selected you can choose to include that
attribute as a field when searching for vendors, and as a column in the
search results. If you do not select the Use as Search Field option, that
field will not be displayed on the Vendor Search page.

4 Click Save.

Set Up Reminders tab

In this tab you can set up when reminders are sent to bid participants.

1 From within the Set Up Reminders tab select the check box next to the
reminder that you want to be sent.

2 Select who should receive the reminder, either all participants or only
the people who have not responded.

3 Select when the reminder should be sent. For example, two days after
the bid due date.

4 Select whether a copy of each reminder should be sent to the bid
administrators.

5 Click Save.

Manage Bid Administrators tab

In this tab you can add bid administrators and choose which tasks each
administrator can perform. In order for a member to be a bid administrator,
he or she must already be an administrator within Buzzsaw.

1 In the Manage Bid Administrators tab click the Add Administrators
link.

2 Select a member from the displayed list and click OK.

3 Select the tasks that this member can perform.

4 Click Save.
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See also:

Bid Management Dashboard for Administrators (page 352)

Bid Management Dashboard for Bid Recipients (page 356)

Bid Packages (page 360)

Bid Packages

To access a bid package navigate to the Bid Management Dashboard and click
the name of a package that you want to view. The following tabs are available
depending on your role:

Invitation and Package Details tab

Following are the tasks that bid administrators and bidders can complete in
this tab:

Bid administrators:
■ Edit the details of the package and notify the bidders of the changes by

clicking the Send Notification button.

■ View, add or remove documents from the package.

■ View multiple bids from one bidder.

■ Send the invitation to additional bidders by clicking the Send Invitation
button.

Bidders:
■ View the date you responded to this invitation.

■ View the details of the invitation. To make changes to your submitted bid
click the Submitted Bids tab.

■ View documents.

Vendor List tab (only available to bid administrators)

The following tasks can be completed in this tab:
■ Review the vendors that have been added to the package and their

associated trade.

■ Add vendors to a trade.

■ Remove trades and vendors from the package.

■ Create or send additional invitations to bidders.
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■ Send notifications to bidders if you make any changes.

Response Tracking tab (only available to bid administrators)

Once you receive a response from a bidder you can update the bid package
with that response.

1 Navigate to the Bid Management dashboard.

2 Click the name of the bid package that you want to update.

3 Click the Response Tracking tab.

4 For each recipient select from the Response drop-down list "Will Bid",
"Won't Bid", or "May Bid".

5 In the Received Via column select the method by which you received
the bidders response.

When you have entered all the responses the totals of who has responded and
who will bid are updated at the top of the screen.

Submitted Bids tab

Following are the tasks that bid administrators and bidders can complete in
this tab:

Bid administrators:
■ Review submitted bids.

■ Update or remove bids.

■ Add bids for the vendor. Click the Add Bid for Vendor link to upload
the vendor's document.

Bidders:
■ View the date you responded to this invitation and the date you submitted

a bid.

■ Review the bid you submitted.

■ Update or remove the bid you submitted.

See also:

Bid Management Dashboard for Administrators (page 352)

Bid Management Dashboard for Bid Recipients (page 356)

Printing, Importing and Exporting in Bid Management (page 362)
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Printing, Importing and Exporting in Bid
Management

Throughout Bid Manager you can print, import and export. The process for
each task is the same regardless of what you are actually printing, importing
or exporting.

Printing

Bid administrators and bid recipients can print sections of the Bid Management
dashboard. For example, Bid Administrators can print the details of a bid
package after it has been created. Bid recipients can print the details of their
submitted intent to bid. Not all bid management windows have the print
functionality.

On pages where you can expand lists (that is, where there is a plus sign next
to an item) if you expand the list before printing those details will also print.

In the section that you want to print, click Print. The print preview is
displayed.

Importing

The ability to import is available throughout bid management. For example,
bid administrators can import bid packages. Project files can be imported to
add to a bid submittal. Not all bid management windows have the import
task.

To import the file:

1 In a bid management window click the Import link.

2 The Import page is displayed.

3 Click Browse to navigate to the file you want to import. You can select
a file from your hard drive or the Buzzsaw site.

NOTE If you select a file from your Buzzsaw site a copy of the file is imported to
the package. Thus, if the file on the site changes, the imported file is not updated.

Files that are exported from Buzzsaw can not then be imported.
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Exporting

The ability to export is available throughout bid management. For example,
bid administrators can export the bid packages, or the results of a vendor
search. Bid recipients can export the details of a submitted bid. Not all bid
management windows have the export task.

When exporting, the details of the packages are not exported, but rather the
information that you see in the log. For example, the bid package names and
due dates.

1 In a bid management window click Export.

2 The File Download dialog box is displayed. Click Save.

3 Select a location and save the file.

See also:

Bid Management Dashboard for Administrators (page 352)

Bid Management Dashboard for Bid Recipients (page 356)

Bid Management (page 351)
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Document Register

Document Register Overview

A document register enables you to track the following: the most recent revision
(a specific Buzzsaw version) of contract documents, the revision history for
those documents. You can also document who received a specific revision of a
document in a distribution from the document register. A document register is
a business process that is added to a project. Document registers cannot exist
outside of a project. Multiple registers can exist in one project.

You can subscribe to a document register through the Notification Manager
(page 227).

Overview of the document register process

1 Create a document register  (page 263)(administrators only). Document
registers are slightly different from other business processes in that you
do not have to associate a workflow with the document register. You
simply add the process to the project.

The project data displayed at the top of the log comes from the data entered
by the project administrator in Step 1: Define Project Data (page 260).

The document register is where project members can view and access the
most recent revisions of contract documents. All participants have access
to the document register. The actions and views available to participants
depend on the member's permission level. Permissions apply to the
document register as they do to projects. See Permissions (page 130) for
more information.

Site and project administrators can view document register actions in the
Activity Logs (page 143).

2 Configure the register options  (page 371)(administrators only).
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3 Add entries (page 366) to the document register.

4 Distribute files. (page 369)

5 Receive distribution. (page 369)

6 Review sent distributions. (page 369)

Sorting the document register view

In each of the document register tabs, you can filter your view. Click the
Display drop-down list box and select a filter.

See also:

Document Register Distributions Tab (page 369)

Document Register Documents Tab (page 366)

Document Register Options (page 371)

Printing, Importing, and Exporting in a Document Register (page 376)

Document Register Documents Tab

This tab is available in a document register log. Here you can add, delete, edit,
distribute entries, and view the revision history and distribution history of a
document.

Administrators can configure which columns are displayed in this tab and
their order in the Document Register Options (page 371).

In this tab, you can add entries and create a distribution. Read the following
sections for details on specific tasks:

Adding entries

Adding an entry to a document register creates an entry in the document
register; and that entry can be linked to a document. By linking an entry to
a document, you are linking your entry to the document that is stored
elsewhere within Buzzsaw. You are not copying the document into the
document register.

1 Click the Add Entries link.

2 Select whether to add entries from a location within Buzzsaw or to add
placeholders.

366 | Chapter 25   Document Register



Adding a placeholder enables you to add an entry without linking to
the actual file. At a later time the corresponding document can be added
to the site and the document register entry can be edited to link to that
newly added document.

3 If you are adding an entry with a file on your site click the Browse
button. The Project File Browser is displayed.

4 Navigate to the desired file and click OK. You can add multiple files by
using the SHIFT and CTRL keys.

5 Enter the information that you want associated with this entry. If adding
multiple files click the Next button to advance to the next entry.

6 Click Finish. The entry is displayed in the Documents tab of the
Document Register. You can now distribute this document.

You can also add entires to the Document Register via the
Add/Update to Project - Select Drawings Wizard (page 417).

Editing entries

1 From the drop-down filter for a specific document select Edit Revision.

2 Edit the details of the entry.

3 Click the Browse button to edit the link to the document if needed.

4 Click Save & Return.

Administrators can delete entries in this window. Click the Delete button. If
the revision is the original then the revision and the entry are deleted from
the document register. If the Deleted option from the Display drop-down is
selected, then an administrator can view the deleted entry in the Document
tabs. Deleting the revision or entry does not delete the file version from its
location in Buzzsaw.

Importing entries

If you have the data in a CSV file you can import multiple entries at once.

1 In the Documents tab click the Import Entries link.

2 Choose to add the file from your local hard drive or from a Buzzsaw
project.

3 Click Browse to navigate to the file.

4 Click Import. The entries you imported are displayed in the Documents
tab.
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Distributing documents

Once documents are in the register you can distribute them to project
members.

1 In the Documents tab select the documents that you want to distribute.
A document does not need to be associated with an entry in order to
create a distribution.

2 Click the Distribute button. The New Distribution window is displayed.

3 Select electronic or manual for the distribution type. If you select manual,
Buzzsaw only records the distribution without sending it electronically.
To, CC, Additional Names, and Documents for Distribution are included
in a manual distribution.

4 Click the To and CC buttons to select the members you want to distribute
the files to.

5 Select a Purpose of Issue for the distribution.

6 Add names in the Additional Names field. Email addresses are not
allowed. People listed in the Additional Names field do not receive this
distribution electronically.

7 Click Submit to send the distribution. A confirmation email is sent to
you, the sender. Members on the distribution list receive an email
containing a link to the distribution.

Viewing the distribution history of a document

You can view the distribution history of a document through the Documents
tab. The history shows the distribution date of the document, the purpose
and the distribution number.

Adding revisions

New revisions for a document in the register can be added at any time.

1 From the drop-down filter for a specific document select Add Revision.

2 Click the Browse button and select a file.

3 Edit other details as appropriate.

4 Click Save & Return. You are returned to the Documents tab.
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Viewing the revision history of a document

Through the Documents tab, you can view the revision history for a document.

1 From the drop-down filter for a specific document select View Revision
History. The Revision History window is displayed.

2 Depending on how many revisions there are for the document, you have
the option of viewing the latest revision, the original details, or any
revisions in-between. Click the revision that you want to view.

3 Click Close.

Deleting entries

Only administrators in the document register can delete entries or view deleted
entries.

To delete an entry:

2 Select Delete from the drop-down list box for a specific entry.

Deleting an entry only removes the entry from the document register. If the
revision of the entry is linked to a document within Buzzsaw, the document
from in Buzzsaw is not deleted.

To view deleted entries:

2 Select Deleted from the Filter drop-down.

See also:

Document Register Distributions Tab (page 369)

Document Register Options (page 371)

Document Register (page 365)

Document Register Distributions Tab

This tab is available in the document register. From this tab you can create a
distribution to send to project members.

Distributions are created through the Documents tab  ➤ Distribute button.
In the By Distributions tab, administrators can configure the display of
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columns in the Distributions Received and All Distributions sections.
For more information see, Document Register Options (page 371).

Creating a distribution

1 In the Document Register click the Distributions tab.

2 Select electronic or manual for the distribution type. If you select manual,
Buzzsaw records the distribution but does not send it electronically. The
To, CC, Additional Names, and Documents for Distribution fields are
included in a manual distribution.

3 Click the To and CC buttons to select the members you want to distribute
the files to.

4 Add names in the Additional Names field. Email addresses are not
allowed. People listed in the Additional Names field do not receive this
distribution electronically.

5 Select a Purpose of Issue for the distribution.

6 Click the Add Documents link to add files to the distribution. The Add
Documents window is displayed.

7 Select the documents and their revision that you want and click Save
& Return. You are returned to the New Distribution window.

8 Click Submit when you are ready to send the distribution. A
confirmation email is sent to you, the sender. Members on the
distribution list receive an email containing a link to the distribution.

Redistributing

Redistribute is a quick way to resend a distribution to a new group of people
without having to create a new distribution.

In the Distributions tab, select Redistribute from the drop-down list for
the distribution that you want to redistribute.

Viewing distributions

Viewing Distributions You Have Received

Distributions sent explicitly to you are displayed in the Distributions tab.
You can also view a distribution using the link in the email notification that
you received. That link takes you directly to the distribution.

Received distributions are also displayed in the Distributions tab of the
Document Register. To view all distributions that you have received, navigate
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to the document register and click the Distributions tab. Your issued
distributions are listed in the top pane under Distributions Received.

Click the distribution number or select View Detail from the Select drop-down
to view the details of the distribution.

Viewing Distributions You Have Sent

If you have permission to create and send distributions you can view these
distributions in the All Distributions area. Use the tabs, By Distributions,
By Documents, and By Recipients to filter your view. Each tab provides
a different view of the distribution.

You can filter your view to see only the distributions that you have created,
or deleted distributions.

Deleting distributions

Only administrators in the document register can delete or see the Deleted
option in the Display filter for the All Distributions area.

Select Delete from the Filter drop-down list for a specific distribution.

Project members with any permission can delete a received distribution in
the Distributions tab  ➤ Distributions Received area. Administrators
can delete a distribution in the Distributions tab  ➤ All Distributions
 ➤ By Distributions area. An administrator can view the deleted entry by
selecting Deleted from the Filter drop-down.

See also:

Document Register Documents Tab (page 366)

Document Register Options (page 371)

Document Register (page 365)

Document Register Options

Administrators can edit the details of the document register. To access the
document register options click the Options link in the document register.
The following tabs are available:
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Documents Display Tab

The options selected in this tab are reflected in the Document Register
Documents Tab (page 366) in the document register dashboard.

Use this tab to:

■ customize the prefix and suffix numbering.

■ specify whether an attribute is required.

■ specify whether an attribute will display in other areas such as, searching
in the Documents tab, or importing and exporting entries.

■ rearrange the order in which the columns are displayed in the Documents
tab.

■ define the default sort order of columns.

■ specify the file attributes to display as a column.

■ create a template for importing the text for multiple rows of the Documents
tab.

To customize the prefix and suffix numbering:
■ Enter a prefix or suffix for the Document Register Entries. The prefix and

suffix can contain letters and numbers. Enter the maximum number of
digits that you want the number to be. This number does not include the
prefix and suffix.

To display or require a column:

You have the option of requiring members to enter values for specific
attributes. Select the checkbox in the Required column for an attribute.

Selecting the Display option makes the attribute viewable throughout the
Document Register but project members are not required to enter a value. If
not selected the attribute is not displayed in screens such as Editing Attributes,
Documents tab, import entries, export entries.

To rearrange the column order:

Select a column and use the Move Up and Move Down buttons to rearrange
the display order. The order in which the columns are listed in this screen
(from top to bottom) is the order in which the columns are displayed in the
Documents tab (from left to right).

To allow users to edit the revision date:

Select the Allow users to edit option next to Revision Date.
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To change the default order:

1 Select an attribute from the Sort by drop-down list.

2 Select the option to sort the columns in ascending or descending order.

To add custom fields to the document register:

You can add up to ten custom fields on your document register. Note that
custom fields cannot be longer than 175 characters.

1 In the blank entry field enter a name for the custom field.

2 Select the option to display the field in the Documents tab, or to require
that it be completed by members.

Create Import Template:

Use this option to create a template for importing the text for multiple rows
to the document register. By creating a template, you are ensuring that
document register entries are imported in the correct format.

Click the Create Import Template button to create a CSV file with the columns
displayed in this screen. You can then use this template to import document
register entries.

Distributions Display Tab

The options selected in this tab are reflected in the Document Register
Distributions Tab (page 369) in the document register.

Use this tab to add or remove the columns that are displayed in the
Distributions Received and All Distributions sections. You can also
rearrange the order of the columns.

To add a new column:

2 Click the Add Column link.

3 Select a column name from the drop-down list box.

To Remove a column:

Select a column and click the red X to the right of the column name. You
cannot delete the three columns: Distribution Type, Distribution Number,
and Distribution Date.

To rearrange the column order:
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Select a column and use the Move Up and Move Down buttons to rearrange
the display order. The order in which the columns are listed in this screen
(from top to bottom) is the order in which the columns are displayed in the
Documents tab (from left to right).

Administration Options

Use this tab to:

■ manage the project members who have access to this Document Register.

■ manage how files are added to this Document Register. You can require
project members to add a file to this Document Register when adding files
to a specific project.

■ enable project members to add entries to this document register through
the Add/Update to Project - Select Drawings Wizard (page 417).

To manage Document Register project members permissions:

2 Click the Edit button.

3 Click the Edit Permissions tab.

4 To remove a member from the document register, select a member and
click the Remove toolbar button.

5 To add a member to the document register click the Add toolbar button.
The Select member dialog box is displayed.

6 To change a member’s permission level, select a member and select a
new permission from the permission drop-down list.

7 To add a member, click the Add toolbar button. In the Add Project
Members dialog box, select a member from the Available list and click
the Add button.

8 Click OK.

9 Click OK in the Members tab.

In this section you can require that files uploaded to a specific project are also
added to this Document Register. A project can only be associated with one
Document Register. You can further require that all members, or only specific
members, add documents to this Document Register.

To associate projects with this Document Register:

2 Click the Add or Remove Projects button to add a project.

3 Select a project and click the Add Project button.

374 | Chapter 25   Document Register



4 Click the OK button to return to the Administration Options tab.

5 Select the option, Only display this document register in the File
Upload Wizard for the projects listed below. Only members with
administrator, edit, or update permissions can add entries to this
Document Register using the FIle Upload wizard.

You can specify which project members have permission to add documents
to this Document Register, when uploading files to the projects.

This option is enabled if the option, Only display this document register
in the File Upload Wizard for the projects listed below, is selected.

To allow members to add files to this Document Register:

2 Select whether project members are required to add documents to this
document register.
■ Optional -- select this option to allow all project members to add

documents to this document register.
■ All project members allowed-- select this option to allow all project

members to add documents to this document register. If this
option is selected, project members have the option to add files
to the document register, but are not required.

■ Only specific project members allowed -- select this option to
allow only specific members to add documents to this document
register.

1 Click the Select button.

2 Select a member and click Add.

3 Click OK.

■ Required -- select this option to require project members to add
documents to this document register.
■ All project members allowed -- select this option to allow all

project members to add documents to this document register

■ Only specific project members allowed -- select this option to
specifiy that only specific members are allowed to add documents
to this document register. Additionally, you can enable the option
that allows all project members to add files, but only the members
that you have selected are required to add files.

1 Click the Select button.

2 Select a member and click Add.
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3 Click OK.

3 Click Save and Return.

See also:

Document Register Distributions Tab (page 369)

Document Register Documents Tab (page 366)

Document Register (page 365)

Printing, Importing, and Exporting in a
Document Register

Throughout a drawing register you can print, import and export. The process
for each task is the same regardless of what you are actually printing, importing,
or exporting.

Printing

In any of the three tabs, Documents, Distributions, or General, you can print
the different sections of that tab.

On pages where you can expand lists (that is, where there is a plus sign next
to an item) if you expand the list before printing, those details will also print.

In the section that you want to print, click Print. The print preview is
displayed.

Importing

Document Register file attributes and placeholders can be imported into a
Document Register using a .CSV file that is edited in Excel. Click the Import
Entries link on the Documents tab.

Import Template Columns

Using the Create Import Template utility ensures that the .CSV file contains
the correct columns displayed in the correct order. If you are editing attributes
from within the Document Register, the column names in the import template
are the same as the columns that are displayed in the Document Register.
Anytime the column order or display settings are changed by an administrator,
you need to create a new import template. If you are editing attributes during
file upload using the Upload Wizard, the import template includes columns
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for all applicable attributes. If a column is not selected in the Documents tab
it will not be displayed in the .CSV file that is created when you click the
Create Import Template button. The column, Revision, is never displayed
in the import template.

Causes of Import Failure
■ Entering attribute values if they do not apply to the file type. For example,

if one entry is for a web file and you enter data in the column Phase, then
the import fails. The import fails because Phase is not a valid field for the
Web Files category.

■ Changing Import Template columns (adding columns, removing columns,
reordering columns).

■ Incorrect attribute value formatting.

Column by Column Values

Link to a file in Buzzsaw (optional, unless you are editing attributes from
within the Document Register for files that have already been uploaded). To
enter the correct file path when editing attributes for files that are in Buzzsaw:

1 Locate the file in Buzzsaw.

2 Right-click and choose Copy URL.

3 Paste the URL into the Link to file in Buzzsaw cell.

4 Delete the information, https://projectpoint.buzzsaw.com/client,
that appears before the site name.

5 Ensure that the site name is preceded by a backslash (/). For example:
https://projectpoint.buzzsaw.com/client/SiteName/ProjectName/FH--b1lcf.pdf
is entered as, /SiteName/ProjectName/FH--b1lcf.pdf.

File Category: Optional. File types: all

The File Category field must match the file type of the linked Buzzsaw file.
Enter one of the following values exactly as shown:
■ CAD Files

■ Image & Multimedia Files

■ Office & Productivity Files

■ Web Files

■ Miscellaneous

Document Number: Optional. File types: all.

No formatting requirements, but limited to 256 characters maximum.
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Title: Required. File types: all. This is also referred to as the Document Registry
Entry Title.

No formatting requirements, but limited to 256 characters maximum.

Discipline: Optional. File types: all.

The Discipline category must match one of the Buzzsaw defined options. Enter
one of the following values exactly as shown:
■ Architectural

■ Civil

■ Structural

■ Electrical

■ Mechanical

■ Plumbing

■ Landscape

Author: Optional. File types: all.

The Author category must match the name of a user in the project directory.

Creation Date: Optional. File types: all.

The date format must be the same as in the Windows Local Date Format. For
example: in the United States it is 10/26/2006. In the United Kingdom it is
26/10/2006.

Division: Optional. File types: enter for CAD files only.

The Division category must match one of the Buzzsaw defined options. Enter
one of the following values exactly as shown:
■ 01-General Requirements

■ 02-Site Construction

■ 03-Concrete

■ 04-Masonry

■ 05-Metals

■ 06-Woods and Plastics

■ 07-Thermal and Moisture Protection

■ 08-Doors and Windows

■ 09-Finishes

■ 10-Specialties
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■ 11-Equipment

■ 12-Furnishings

■ 13-Special Construction

■ 14-Conveying Systems

■ 15-Mechanical

■ 16-Electrical

Document Status: Optional. File types: enter for CAD and Office &
Productivity (for example, .pdf, .xls, .doc) file types only.

The Document Status category must match one of the Buzzsaw defined options.
Enter one of the following values exactly as shown:
■ In Progress

■ Draft

■ Under Review

■ Complete

■ Approved

■ Final

Drawing Format: Optional. File types: enter for CAD files only.

No formatting requirements, but limited to 256 characters maximum.

Drawing Name: Optional. File types: enter for CAD files only.

No formatting requirements, but limited to 256 characters maximum.

Drawing Reference: Optional. File types: enter for CAD files only.

No formatting requirements, but limited to 256 characters maximum.

Drawing Series: Optional. File types: enter for CAD files only.

No formatting requirements, but limited to 256 characters maximum.

Drawing Size: Optional. File types: enter for CAD files only.

The Drawing Size category must be match one of the Buzzsaw defined options.
Enter one of the following values exactly as shown:
■ 8.5 x 11

■ 8.5 x 14

■ 11 x 17

■ 24 x 36
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■ 30 x 42

■ 36 x 48

■ A0

■ A1

■ A1

■ A2

■ A3

■ A4

■ B1

■ B2

■ B3

■ B4

■ B5

■ C5

■ Other

File Name: Optional. File types: all.

No formatting requirements, but limited to 256 characters maximum.

Phase: Optional. File types: enter for CAD and Office & Productivity (for
example, .pdf, .xls, .doc) file types only.

No formatting requirements, but limited to 256 characters maximum.

Project ID: Optional. File types: enter for CAD and Office & Productivity
(for example, .pdf, .xls, .doc) file types only.

No formatting requirements, but limited to 256 characters maximum.

Revision Date: Optional. File types: all.

The date format must be the same as in the Windows Local Date Format For
example: in the United States it is 10/26/2006. In the United Kingdom it is
26/10/2006.

This column is included only if the administrator has enabled members to
edit the revision date through the Allow users to edit option in the
Document Register Options (page 371).
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Exporting

The ability to export is available throughout the drawing register. For example,
administrators can export a document list.

1 In a drawing register window click the Export button. The content
exported reflects how you have filtered the window.

NOTE If you are an administrator the Export link changes to Export List for
Edits. Clicking this link enables you to edit the file attributes before they are
exported.

2 The File Download dialog box is displayed. Click Save.

3 Select a location and save the file.

See also:

Document Register Distributions Tab (page 369)

Document Register Documents Tab (page 366)

Document Register (page 365)
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Support Options

As a Buzzsaw user, you have many forms of help available to you. In addition to the
online help you can contact Customer Care through the Autodesk Support website.

This help system contains all the conceptual, procedural, and reference information
for Buzzsaw. You can access this help system in one of two ways:

■ In the toolbar, click  .

■ You can also use the context-sensitive help, which provides help specific to the feature or
function you are using at the time. Context-sensitive help is available for most of the
windows and dialog boxes by clicking the Help button on the standard toolbar, choosing
the Help drop-down menu, or pressing F1 on your keyboard.

Read Me

The Read Me (page 7) file contains supplemental information about Buzzsaw, including
information about features that have limitations or are not fully implemented in the current
release of Buzzsaw. Workaround steps are included whenever possible.
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Glossary

Absolute file path

A specific string, usually including a drive letter, that identifies the exact
location of a file.

Example: C:\Program Files\ACAD2000\SAMPLE\1st floorlighting.dwg.

Action Item

A form that has been assigned to you and requires you take an action.

Add

The act of creating or uploading a file to a project. Because multiple versions
of files are stored, adding a file to a folder that contains a file of the same
name will save the file you are adding as the latest version.

Associated Markup

An associated markup appears in the tab list for the original drawing. If you
want the markup to be associated with the original drawing, enter a name
without a path.

See: Markups (Redlines) (page 248).

Client

The Buzzsaw software that is installed on your computer and runs within your
Web browser. The software interface that project members use to collaborate
on design projects using the Buzzsaw technology.

Comment

A text file that is created using Buzzsaw. A comment is added to a discussion
and a discussion thread is attached to a specific file.

Discussion

A collection of threaded comments. These comments are linked to a specific
file on the site.
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Download

To copy a file from the project site file to your local machine.

Drawing (Drawing File)

An AutoCAD drawing in DWG or DWF format. The DWG format is AutoCAD's
native file format.

The Design Web Format (DWF) is Autodesk's open format for storing and
transmitting AutoCAD drawings on the Web. See Viewers and Markups (page
241).

External Reference (Xref)

An external reference (Xref) is a method that AutoCAD uses to link drawing
files together.

File

A file of any type that can be stored with the project. The file may or may not
have an in-browser viewer, but it always has some associated editor (although
it may not be installed on a member's machine).

Flattened file path

All path information is removed and the file is re-saved with only the directory
and file name. If you want to use the drawing file for distribution purposes
(and do not expect to get it back) it's often convenient to flatten the selected
drawing file paths.

Folder

A container for organizing project files and other folders.

Form Link

A link from a form to a document within Buzzsaw. See Linking Documents
to a Form (page 317) for more information.

Group(s)

The individuals assigned to a defined group and working on a given project.
A group may be assigned to more than one project. Groups are often used to
simplify user access administration to projects. Private groups, or groups that
do not expand, are groups in which the members can only be seen by members
who have the privilege to create groups. For more information see Groups
Tab (page 61).
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Issued Item

Form that you have assigned to another member.

Link

An address or shortcut to a file on your site, an Internet address such as a Web
page, or an email address.

Locked File

Temporary state of restriction placed on a document while it is being edited.
When you have locked a document, other project members can view it but
they cannot edit it.

Locked Permissions

Temporary or permanent state of "freezing" the entries in a permission list.
The list may include a combination of individual members and groups.
Permissions are normally propagated downward through the project hierarchy.
If the permissions contained in the permission list of a folder are changed,
then all the permissions at subordinate levels from that point downward are
also changed.

See: Permission Levels (page 112).

Markup(s)

Markups (redlines) are colored lines used together with text to mark areas of
a drawing that need discussion or revision. Think of a markup as a layer that
overlays a drawing rather than a part of the basic drawing file.

Markup data is stored in files in DWF format, either with the original drawing
file or in a separate location from the original drawing in a location of your
choice on the site or on your local computer. Markup files can be edited and
re-saved as needed. You must have Admin, Edit, or Review permission to create
markups.

See: Save Markup Wizard (page 416).

Note

An independent text-only document that can be created and edited within
the Buzzsaw client.

Permission Levels

Each project member is assigned a permission level which can vary from
project to project (permissions can also be controlled at individual Folder and
File levels in a Project). Permission levels are assigned by the project
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administrator. Depending on your permission level, you have access to the
files in a project in the following ways:
■ Administrative, Site Administrator

Able to create new member accounts, new project folders, change
permissions, and access all projects and folders in the site. Also able to add,
edit, or delete all project files.

■ Administrative, Project Administrator

Able to add members or groups (already defined by the Site Administrator)
to project folders or files, as well change member permissions within a
project. Project Administrators with New Member privileges can create
new site members and site level groups.

■ Edit, Editor

Able to add, edit, or delete all project files (unless a document or folder is
restricted by another Editor or Administrator).

■ Review, Reviewer

Able to view all project files (unless a document or folder has special access
settings). Cannot edit, add, or delete files. Able to add and edit project files
limited to: notes, comments, redlines, and links.

■ View, Viewer

Able to view all project files in a project (unless a document or folder has
special access settings).

■ List

Able to see all project folders (unless a folder has special access settings).

Permission Set

The entries you see in any permission list. The list may include a combination
of individual members and groups.

Private Group

See Private and Hidden Groups (page 128).

Project

A project is the collection of all project files, people, and administrative
information.

Project Administrator

Ability to add members or groups to project folders or files, as well as change
member permissions within a project. Project Administrators cannot edit
member properties or add/edit groups. Project Administrators can only create
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new members if the "Can create member" option was selected when the admin
was created. Otherwise Project Administrators cannot create new members.
For details about creating a Project Administrator, see Creating a New Member
(page 89).

Project File

Any project document. These files can be in the format of Autodesk drawing,
Microsoft Office, or any other file type.

Project File List

Each project has project files associated with it. When you click the Projects
icon on the Buzzsaw bar, all the project files are shown in a tree view first and
then in a details view. Both views display to the right of the shortcut bar.

Project Member

An individual working on a given project. A project member may be assigned
to more than one project.

Relative File Path

A file path that identifies an exact file location according to the file's position
within a specific file structure.

Resolved

A specified external reference (Xref) has been located and loaded.

Reviewed, Read

State of a document that has been viewed by a project member. When new
files are uploaded to a site, they are flagged as "unread" until you view the file.

Role

A collection of users. This collection organized by the commonality of the
actions they can perform on an active form. All users in the same role can
perform the same actions on an active form.

Assigning a member a role only affects his or her permissions in that particular
form log. The member's permission in the rest of the project and the site is
not affected by being in a role.

The use of roles is only used in Buzzsaw Professional.

See Roles (page 303), Workflow Types (page 290).
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Separate Markup

A separate markup is saved as a separate file (not associated with the original
drawing) and appears in the tree view hierarchy. If you want the markup to
be saved as a separate file, enter a path along with the name.

Server

The remote computer that hosts your site. This remote computer, database,
and file storage system stores project information and enables access to it over
the Web. The server manages this access using requests from a client.

Site

An Internet-accessible storage and collaboration point for a team of people
managing building design and construction projects. A single site may house
one or more projects. All projects must exist within a site.

Site Administrator

The person (or persons) granted administrative rights over a site. A Site
Administrator creates new member accounts, new project folders, and sets
user permissions (access) to all projects in a site. Note that Site Administrators
can not delete the email of an individual user.

Unlocked

State in which a document is free to be edited.

Unread, Not Reviewed

State of a file that is new and/or has not yet been viewed by a project member.

Update

To choose a local document and add it to the project site as a new version of
the currently selected document. The local document does not have to have
the same name as the document it is updating, but it's a good idea for the
local file to have the same name if you are truly updating and creating a new
version.

Upload

To copy a file from your local machine to the project site. This is the same as
adding a local file to the project site, so the term Add will be used generically
to cover this.

Workflow

Workflow refers to the process that administrators can define for the routing
of forms. That is, who can create a form, who can view the form, who can
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respond to a form, who can close a form, etc. Form logs are configured to use
a workflow type. Workflow is only available in Buzzsaw Professional.

See Workflow Types (page 290).
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Using Accessibility Shortcuts

The keyboard shortcuts in the table below can be used for navigation in the
HTML Help Viewer.

For more information about accessibility features and services, visit the Microsoft
Accessibility and Disabilities Web site.

Keys to pressNavigation function

ALT+F4Close the Help Viewer

ALT+TABSwitch between the Help Viewer and other
open windows

ALT+ODisplay the Options menu

ALT+O, then press IChange Microsoft Internet Explorer settings

ALT+O, then press THide or show the Navigation pane

ALT+O and then press P, or right-click in the
Topic pane and choose Print from the menu

Print a topic

ALT+LEFT ARROW or ALT+O, then press BMove back to the previous topic
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Keys to pressNavigation function

ALT+RIGHT ARROW or ALT+O, then press
F

Move forward to the next topic (provided
you have viewed it previously)

ALT+O, then press OTurn on or off search highlighting

F5 or ALT+O, then press RRefresh the topic that appears in the Topic
pane (this is useful if you have linked to a
Web page)

ALT+O, then press HReturn to the homepage (help authors can
specify a homepage for a help system)

ALT+O, then press SStop the viewer from opening a page (this
is also useful if you are linking to the Web
and want to stop a page from download-
ing)

ALT+O, then press 1 or 2Jump to a predetermined topic or Web
page. The help author who builds a com-
piled help (.chm) file can add two links,
found on the Options menu, to important
topics or Web pages. When you select a
Jump command you go to one of those
topics or Web pages

F6Switch between the Navigation pane and
the Topic pane

UP ARROW and DOWN ARROW or PAGE
UP and PAGE DOWN

Scroll through a topic

TABScroll through all the links in a topic or
through all the options on a Navigation
pane tab
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In the Contents tab:

Keys to pressNavigation function

ALT+CDisplay the Contents tab

PLUS SIGN and MINUS SIGN or LEFT AR-
ROW and RIGHT ARROW

Open and close a book or folder

DOWN ARROW and UP ARROWSelect a topic

ENTERDisplay the selected topic

For the Index tab:

Keys to pressNavigation function

ALT+NDisplay the Index tab

ALT+W, and then type the wordType a keyword to search for

UP ARROW and DOWN ARROWSelect a keyword in the list

ALT+DDisplay the associated topic

For the Search tab:

Keys to pressNavigation function

ALT+SDisplay the Search tab

ALT+W, then type the wordType a keyword to search for

ALT+LStart a search

ALT+T, then UP ARROW and DOWN AR-
ROW

Select a topic in the results list
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Keys to pressNavigation function

ALT+DDisplay the selected topic

The following options are only available if full-text search is
enabled:

Keys to pressNavigation function

ALT+USearch for a keyword in the result list of a
prior search

ALT+MSearch for words similar to the keyword.
For example, to find words like "running"
and "runs" for the keyword "run"

ALT+ROnly search through topic titles

Notes:
■ There are also shortcut menu commands that can be accessed through the

keyboard.

■ Every time you use a shortcut key in the Navigation pane, you lose focus
in the Topic pane. To return to the Topic pane, press F6.

■ The Match similar words check box on the Search tab, will be selected if
you used it for your last search.

Logging In and Password Dialog Boxes

Log In Dialog Box

Logging In

1 Enter the username and password supplied to you. If your password has
expired, you are required to create a new password. Your site
administrator may require you to create a strong password. The criteria
your password needs to meet are listed in the dialog box.

398 | Chapter 27   Reference



If your site administrator does not require you to create a strong password
then your new password must start with a letter, be at least 8 characters
long, and contain at least one capital letter and one number. For example,
Changeme1.

2 To save a step for future logins, select the Remember this password
check box. Each time you log in, your password automatically appears.
No one else knows this password. If you forget it you will have to request
a new password from your site administrator. If you have forgotten your
password click the I forgot my password button if it is available and
follow the instructions. If this button is not available then you must ask
your site administrator to reset your password.

3 Click OK.

Password Expiration

Depending on how the site administrator has configured the Security Tab
(page 79), your password may be set to expire after a specified amount of time.

If you attempt to login and your password has expired you are required to
create a new password. Your new password must meet the criteria listed in
the Password Expired dialog box.

See also:

Logging In, Logging Out (page 15)

Password Requirements (page 443)

Security Tab (page 79)

Password Assistance Dialog Box

Use this dialog box to reset your password. You must provide the following
information in order to receive a new password.

1 Enter the name of the site that you are trying to enter.

2 Enter the email address that is associated with your member profile on
this site.

Or, Enter your user name.

If the email address that you enter is not associated with your member profile,
then you have to enter your user name. Contact your project or site
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administrator if you can not remember you user name, or if your email address
is associated with more than one member profile.

If you do not have a security question set-up then you can create a question
and answer in the Changing Your Member Information (page 17).

Once you have entered the identifying information correctly an email will be
sent to you. Click on the link in the email to reset your password.

See also:

Changing Your Member Information (page 17)

Password Assistance - Security Question (page 400)

Password Assistance - Security Question

Use this dialog box to create a security question and answer. Select one of the
default questions, or type in your own question and answer.

Doing so enables you to use the I forgot my password button in the Login
dialog box. You will be asked this security question as part of the process of
resetting your password. Using password assistance enables you to reset your
password without having to ask your site administrator for help.

You are not required to create a security question and answer. However, if
you do not, you will not be able to reset your password by yourself. You will
have to ask your site administrator to send you a new password.

Your security question and answer can be updated in the Changing Your
Member Information (page 17) dialog box.

See also:

Changing Your Member Information (page 17)

Logging In, Logging Out (page 15)

Verify Identity Dialog Box

Enter the answer to your security question here so that you can reset your
password. If you want to change your security question and answer, go to the
Changing Your Member Information (page 17) page.
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You are given five attempts to answer the question. If you can not answer the
question correctly then you have to ask your site administrator to reset your
password. To see who your site administrator is, click the Member List toolbar

button,  . Click the Filter By drop-down list box and select Site
Administrators. Double-click the person's name to view their contact
information. You can then phone or email the administrator for assistance.

See also:

Editing Members of a Project (page 126)

Using the Member List (page 18)

File and Folder Dialog Boxes

Using the Folder Properties General Tab

The General tab displays vital information about your folder:
■ Type — folder, text, drawing, or note.

■ Location — where in the site the item resides.

■ Created — date the item was created, not modified.

■ Ownership — click this button to change which member owns the folder.
See Ownership of a Project, Folder, or File (page 51).

■ Permission Lock — click this button to lock or unlock the permission
set. For more details see Locking and Unlocking Permission Sets (page 138).

■ Storage — displays the current size of the folder.

■ Content — displays the type and quantity of items in the folder including
edit and permission lock counts.

See also:

Locking and Unlocking a File (page 187)

Locking and Unlocking Permission Sets (page 138)

Ownership of a Project, Folder, or File (page 51)
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Project Folders

Project folders are automatically generated when you create a project and it
appears in the tree view. You must have Administrator permission to create
project folders. The project folder is used to store all additional folders and
subfolders, project files, drawings, links, and notes that are associated with
the project. Projects are always orange folders.

Converting Project and Standard Folders

If you have Administrator permission, you can convert standard folders to
project folders and vice versa at any level of the tree view hierarchy.
■ For examples and detailed instructions, see Converting Project and Standard

Folders (page 48).

TIP It's a good idea to confirm the permission list for a converted folder to
make sure that the list contains the correct individuals and groups, given the
new position of the converted folder in the hierarchical tree view.

■ For details about assigning permission at the project level, see Permission
Levels (page 130).

■ For details about assigning permission at the folder level, see Setting
permissions at the project level (page 137).

See also:

Adding a New Folder (page 159)

Converting Project and Standard Folders (page 48)

Deleting a Folder (page 160)

Standard Folders

You create and use standard folders and subfolders to organize and store project
information (text files, drawings, links, and notes) to best advantage for your
work environment. You must have Administrator or Edit permission to create
standard folders. Standard and subfolders are yellow folders, so it's easy to
distinguish them from project folders.

If you have Administrator or Edit permission, you can move folders from
project to project. You can also drag files into a folder, create notes, or add
links within a folder. For instructions, see Adding a File (page 176).
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NOTE You cannot move folders or project files from one site to another. For
example, you cannot open two separate sites and drag files between the two sites.

Converting Standard Folders to Project Folders

If you have Administrator permission, you can convert standard folders to
project folders and vice versa at any level of the tree view hierarchy. A project
has different implications than a folder. For example, members can only be
administrators of a project not a folder. Also, site member visibility is different
for folders and projects.

For examples and detailed instructions, see Converting Project and Standard
Folders (page 48).

NOTE  It's a good idea to confirm the permission list for a converted folder to
make sure that the list contains the correct individuals and groups, given the new
position of the converted folder in the hierarchical tree view.

See also:

Adding a New Folder (page 159)

Setting permissions at the project level (page 137)

Deleting a Folder (page 160)

Working Folders Dialog Box

A working folder is the location from which you last downloaded or uploaded
a file. Every time you download or upload a file, the location from your hard
drive is remembered. You can change the working folder at any time.

1 From within the Download Dialog box, click the Working Folders
button.

2 Select a file from the list.

3 Click the Browse button to select a new location.

4 If changing more than one file, click the Apply button. Then change
the working folder location for another file.

5 Click the OK button when finished.

See also:

Downloading a Folder or File (page 186)
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Updating a File (page 192)

Working Folders (page 160)

Recover Folder

Folder Recovery is for recovering files within 30 days of being deleted from
the Recycle Bin.

1 In the Destination Path field, confirm the destination path of the
recovered folder.

By default, the name of the deleted file(s) appears. If the file's parent
doesn't exist, a Recovered Files folder is created for you which you can
rename at any time.

2 Select the item(s) you want to recover from the list.

3 To select or clear, click the item. A check mark appears (or disappears).

TIP To save time, click Clear All if you want to clear all the files in the list.
If you want to select all the files, click Select All.

4 If you want the system to prompt you before recovering each file, click
the Prompt for Each File button. If you want to define the recovery
rules, click the Don't prompt, use Recovery Rules button.

Recovery Rules

If the file already exists, you can:

Skip Recovery - A large S appears to the left of the file name in the list.

Replace Existing File - Replaces the existing file.

Add Recovered Version - This adds the recovered version(s) as new
version(s) to the existing file.

5 Make a version restoration choice by clicking the Restore All Versions
or Restore most recent version button.

NOTE If you want to restore the original file(s) comments, select the Restore
Comments check box. If you want to restore the original file(s) markups,
select the Restore Markups check box.

6 When you're through, click OK.

See also:

Recovering a Folder  (page 162)
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Using the Activity Log (page 145)

Using the File Properties General Tab

The General tab displays vital information about your project file:
■ File name

■ Author

■ Version

■ File type (text, drawing, or note)

■ Project Location

■ File size

■ Date the file was created, last modified, and accessed

■ Ownership — click this button to change which member owns the file.
See Ownership of a Project, Folder, or File (page 51).

■ Permission Lock — click this button to lock or unlock the permission set.
For more details see Locking and Unlocking Permission Sets (page 138).

■ Edit Lock — Click this button to lock or unlock the file for editing. See
Locking and Unlocking a File (page 187).

See also:

Using the Versions Tab (page 173)

Using the View Tab (page 172)

Using the Discussions Tab (page 172)

Download Folder Dialog box

1 In the To: field, enter the destination path for the downloaded item on
your local computer. Or, click Browse to navigate to a location on your
local computer.

2 In the Download files to section, select from the following options:

■ Location specified above - This option downloads the folder to
the path in the To field. If you are downloading a folder with
subfolders the relative folder structure remains intact.
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■ Working folders - This option downloads the folder to the location
specified as the working folder. The working folder is merely the last
place the file or folder was downloaded to. Click the Working Folder
button to change the working folder location. Separate locations can
be specified for each file or folder.

3 Select the Include subfolders option to include all the subfolders within
the selected folder.

4 Click the OK button to download the file.

See also:

Working Folders (page 160)

Downloading a Folder or File (page 186)

Working Folders (page 160)

Recover File

File Recovery is for recovering files within 30 days of being deleted from the
Recycle Bin.

1 In the Destination Path field, confirm the destination path of the
recovered file. Click the Choose button to navigate and select a different
destination path.

By default, the name of the deleted file appears. If the file's parent doesn't
exist, a Recovered Files folder is created for you which you can rename
at any time.

2 Select the file(s), comment(s), and markup(s) you want to recover from
the list.

3 To select or clear, click the item. A check mark appears (or disappears).
If a destination file already exists, the recovered version will be added
as the most recent version to the selected file. You can also restore
comments or markups that were deleted with the original file.

4 If you want to view the restored file in a separate window, select the
View in Window check box. If you want to view the file in the View
tab and see where the recovered file is in the hierarchical tree view at
the same time, select the Go to check box.

5 When you're through, click OK.
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See also:

Recovering a Folder  (page 162)

Using the Activity Log (page 145)

Ownership Dialog Box

Use this dialog box to change the owner of a group. Access this dialog box
through the Site Administration tab  ➤ Groups tab  ➤  Edit Group
 ➤ Ownership button. This dialog box is also accessed through step 1 of the
New Group Wizard (page 126).

1 Use the Show drop-down list box to filter the list of members that are
displayed.

2 Select a member and click OK. The member selected is now the owner
of the group.

NOTE Owners that are site or project administrators can edit the group members
and delete the group from the site. Owners that are non-administrators can only
edit the group members.

See also:

Filtering Options (page 424)

Manage Columns Dialog Box (page 423)

Ownership of a Project, Folder, or File (page 51)

New Notification Dialog Box

1 To set up a new notification for a project, folder, file, or form log, select
the item in the tree view.

2 Right-click and choose New Notification.

3 In the New Notification dialog box, select the type of notification that
you wish to receive. That is, immediately (an email is sent to you every
time a file changes) or daily (an email is sent to you once a day
containing all the changes made that day).

4 Click OK when you are finished.
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You can manage all your subscriptions using the Notification Manager (page
227).

See also:

Notification Manager (page 227)

Notification Manager (page 225)

New Notification Dialog Box

The New Notification dialog box is entered through the Notification Manager.

Click the New Notification toolbar button,  , to open the dialog
box. In this dialog box you can add multiple subscriptions at one time.
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1 Browse to a project or folder using the drop-down list box at the top of
the window. To further filter the list that you see, change the file type
in the Files of Type drop-down list box.

2 Select the project or file that you want. You can select multiple files (or
projects) by holding the Ctrl key and clicking the items.

3 Select the type of notification that you want to receive — either
Notification Manager (page 225).

4 Click Add. The notification is listed in the New Notification box.
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5 Click OK.

To change the subscription type, use the Edit toolbar button in the main
Notification Manager window.

See also:

Notifications Overview (page 225)

Notification Manager (page 227)

Automatic Notification File Types

Following is a list of file types that you can receive update notifications about
via the Notification Manager (page 227).
■ File - misc file

■ Drawing - AutoCAD

■ DWG file

■ DWF - Autodesk Design Web Format files

■ DWFx- Autodesk Design Web Format files

■ Redline - AutoCAD markup file

■ Cimmetry Markup

■ Buzzsaw Professional Form

■ Streamline Assembly Package

■ Streamline Part Package

■ Streamline Drawing Package

■ Streamline Presentation Package

■ Streamline Markup File

■ Streamline Model File

See also:

Notifications Overview (page 225)

Notification Manager (page 227)
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Daily Summary Time Dialog Box

When subscribing to a notification you have the option of receiving the email
notification immediately or once a day. You further have the option to choose
the time of day that you want to receive the notification. The default time is
set for 7am. To change the time, follow these steps:

1 Open the Notification Manager.

2 From the File menu, choose Daily Summary Time.

3 Select the time you want to receive your email and click OK.

See also:

Notification Manager (page 227)

Notification Manager (page 225)

Updating Your Time Zone

You can update your time zone so that you will continue to receive your daily
summary notifications at the same time regardless of whether you are
travelling.

1 From within Notification Manager, choose update Time Zone from
the File menu.

2 Select the My timezone uses Daylight Savings Time if appropriate.

3 Click OK.

Your Daily Summary notifications are automatically updated to synchronize
with the time zone on the computer that you are using.

NOTE You must log out of your site before setting the local time zone on your
PC. Otherwise the time zone you selected in the steps above will not synchronize
correctly with your PC.

See also:

Notification Manager (page 227)

Notification Manager (page 225)

Reference | 411



File Types that are Indexed

.bat - Microsoft DOS batch files

.cmd - Microsoft DOS batch files

.csv - Microsoft Excel Workbooks

.dic - Dictionary file

.doc - Microsoft Word Documents

.dot - Microsoft Word Document Templates

.dwf - Autodesk Design Web Format files

.dwfx - Autodesk Design Web Format files

.dwg - Autodesk AutoCAD Drawings

.dxf - Autodesk AutoCAD Drawing eXchange files

.eml - Microsoft Outlook Express email file

.idq - Internet data query file

.inf - Microsoft Windows OS files

.ini - Microsoft Windows OS initialization files

.inx - Foxbase Index file

.mpp - Microsoft Project files

.obd - Microsoft Office Binder document

.obt - Microsoft Office Binder template

.pdf - Adobe Portable Document Format files

.pot - Microsoft Office PowerPoint template

.pps - Microsoft Office PowerPoint slide

.ppt - Microsoft PowerPoint presentations

.reg - Microsoft Windows Registry settings files

.rtf - Microsoft Rich Text Format files

.txt - Microsoft DOS ASCII text files

.VBS - Microsoft Visual Basic Script files

.vcf - Vcard file
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.wtx - ASCII text file

.xlb - Microsoft Office Excel customization file

.xlc - Microsoft Excel Charts

.xls - Microsoft Excel Workbooks

.xlt - Microsoft Office Excel template

See also:

Find Files (page 217)

Supported Bitmap Files

The following bitmap file types can be viewed and marked up using the Viewer
Controls.

NOTE If a viewer is unable to view a bitmap then Internet Explorer will be used
to open the file.

■ .bmp

■ .gp4, .mil, .rst, cg4, or .cal

■ .flc, .fli

■ .bil

■ .ig4

■ .igs

■ .jpg or .jpeg

■ .pcx

■ .pct

■ .png

■ .rlc

■ .tga

■ .tif or .tiff

See also:

Viewers and Markups (page 241)

Markups (Redlines) (page 248)
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Setting Preferences (page 19)

Forms Display Issues

The following issues affect the display of the Add Forms window:
■ If the form is displayed as HTML code, you do not have Western European

or Autoselect selected in the Encoding setting of your browser. To fix this,
exit your site and open your browser. From the View menu, select Encoding
and select Western European or Autoselect from the cascading menu.
It is recommended that you select both Autoselect and Western European.

■ If you use Cimmetry Systems AutoVue to view drawing files and then add
forms, the Add Form window does not display button icons correctly. Also,
the window title is not displayed at all. Regardless of this, the Add Form
window functions correctly.

See also:

Viewing a Form (page 312)

Adding a Form (page 309)

Enter URL Address

1 In the Address field, type the entire URL for the Web page; for example,
http://www.autodesk.com. Or click Browse to select a folder or file from
another location on your site.

2 Click OK.

Remember, the folders and files available to you are only those that you have
been given permission to work on.

Go to the page you want to link to and copy its URL out of the Address or
Location box at the top of your browser. Then paste the URL in the Address
field.

You can also add a link to a folder or file, but the method for adding the link
is different than the procedure described here.

See also:

Adding a Link to a Folder or File (page 165)
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Drawings and Viewers Dialog Boxes

Scan AutoCAD Drawings for External References

The Scan AutoCAD Drawings for External References dialog box is displayed
when attempting to download Xrefs, but a list of external references cannot
be found. Click Yes to include the Xrefs. The drawing and its Xrefs and nested
Xrefs are downloaded and scanned. Any information about the Xrefs are
displayed in the Download file dialog box.

NOTE Scanning can be time-consuming if the drawings are large.

You can set the preferences to determine if your drawings are always scanned,
never scanned, or asks you first before a drawing is scanned for Xrefs. See
Setting Preferences (page 19) for details.

See also:

Setting Preferences (page 19)

Downloading External References (page 214)

Uploading External References (page 212)

External References not Found

When downloading an AutoCAD drawing and its Xrefs, your site is first
scanned for Xrefs. If they can not be found, you have the option of using a
copy of the Xref from your local machine if one is available.

To use a local copy if available, ensure that the check box next to the file name
is checked. By default it should be checked. If you do not want to use a local
copy, de-select the box. If no local copy was found, a red X displays next to
the file name.

You can choose whether this same search is performed in future downloads.
If you always want a local copy to be used, select the Do not show this dialog
option, and then click the Always use local copies of missing external
references.

If you always want to be able to choose whether a local copy is used, then do
not select the Do not show this dialog option.
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See also:

Uploading External References (page 212)

Downloading External References (page 214)

Save Markup Wizard

Use this wizard to save a markup to the project.

1 Enter a name for the markup file. You can choose to save the file to your
site or to your local hard drive. Click the Choose button to make your
selection.

Associated markup - appears in the Markups tab list corresponding
to the original drawing. Associating markup files with the original
drawing makes it easy to view all the markups in one place all you have
to do is look in the Markups tab list. To associate the markup with the
original drawing, enter a name without a path in the Name field.

Separate markup - is saved as a separate file (not associated with the
original drawing) and appears in the tree view hierarchy. If you often
use the tree view to locate and work with files, you may want to organize
markups in folders and position them according to the project structure
in the tree view list. That way, you can quickly spot and access the folder
and drawings you want. To save the markup as a separate file, enter a
path along with the name.

2 The Save Markup File wizard will prompt you through the remaining
steps and options, such as attaching a comment and sending an email
notification to other project members.

3 If you wish, you can click Finish at any time to save the markup file
without adding comments or email.

See also:

Viewers and Markups (page 241)

Markups (Redlines) (page 248)

Viewing a Markup File (page 251)

Publishing in Progress Dialog Box

The Publishing in Progress dialog box shows the progress of your markup.
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Clicking the Cancel Job button stops the publish and returns you to either
the View tab or the Markup tab.

If you selected the Always option in the Confirm Markup dialog box or the
Confirm Version dialog box, then the publish always occurs when a published
or new published version of the DWG is needed. You can stop the automatic
publishing by clicking the Cancel Job button.

See also:

Available Viewers (page 241)

Creating a Markup File (page 248)

Project Dialog Boxes

Add/Update to Project - Select Drawings Wizard

1 In the first screen of the Add Drawing wizard, click Browse to add files
to the project. The File Open dialog box is displayed.

2 Select a file and click Open.

3 Select the Add to a Document Register option if you want these files to
be automatically added to an existing Document Register.

4 Select a Document Register from the drop-down list box (optional). If the
Document Register you want is not listed, select More Document Registers
to view all the Document Registers that you have access to.

5 If the Document Register option is selected then select one of these
options:

Add attributes to the uploaded files in the upload wizard —
select this option to edit the file attributes in the next step of the wizard.

6 Continue without adding attributes — select this option to skip
the Edit Attibutes step of the wizard and continue directly to the Attach
Comments step. You can edit the attributes at a later time within the
Document Register.

7 Click the Next button to continue with the step, Editing Attibutes (if
selected), or Attach Comment.

8 You can add a subject line and a comment, which becomes the first
discussion item for this file. Then click Next.
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9 You can send an email notification about this drawing. To copy the
subject line and comment from the previous screen into the email, click
Copy comment. To select an email recipient from the list of project
members, click To.

10 To add the drawing, click Finish. This also adds the comment and sends
the email notification if you completed those options.

NOTE You can click Finish at any time to add the drawing to your site without
adding comments or email.

See also:

Add/Update Project Documents Wizard - Send Email Notification (page
420)

Add/Update Project Documents Wizard - Attach Comment (page 419)

Add/Update to Project - Edit Attributes Wizard (page 418)

Add/Update to Project - Edit Attributes Wizard

In this step of the Add to Project wizard you can edit the attributes for each
document that you add to the register. These attributes are stored in the
document register.

Editing the attributes in this step is optional. You can edit the attributes at a
later time in the Document Register Documents Tab (page 366) of the Document
Register.

1 Select a file and click the Edit Attributes button. The Edit Attributes
window is displayed. If you select more than one file the edits are applied
to all of the files selected.

Or, select a file and right-click. Select the attribute you want to edit. The
Edit a Single Attribute window is displayed.

2 Click the Apply Attributes button. You are returned to the Edit
Attributes window.

3 Click the Next button to continue to Step 3 of the wizard.

See also:

Document Register Distributions Tab (page 369)

Document Register Documents Tab (page 366)

Document Register (page 365)
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Add/Update to Project - Import Attribute
Template Wizard

In this step of the Add to Project wizard you can create an import template.
The attributes imported in this step are stored in the document register. By
creating a template you are ensuring that the correct format is being used.
And, this template can be used for future uploads.

1 Click the Create Import Template button. A pre-formatted .csv file
is displayed. Edit the file using Microsoft Excel.

2 After editing the file save it to your hard drive.

3 In the Import Atrribute Template window click the Browse button.

4 Navigate to the file on your hard drive and select the file you edited.

5 Click the Next button to continue to Step 3 of the wizard. Clicking Next
applies the attributes to the files.

See also:

Printing, Importing, and Exporting in a Document Register (page 376)

Document Register Documents Tab (page 366)

Document Register (page 365)

Add/Update Project Documents Wizard - Attach
Comment

Add a comment that is attached to the file. If you are adding multiple files
then the comment is applied to all of the files.

1 Select the Add comment to new discussion check box if you want this
comment to become a new discussion item for this file.

2 Add a title in the Subject line.

3 Add text to the body of the comment.

4 Click the Next button.

NOTE You can click Finish at any time to copy the file to your site without adding
comments or email.
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See also:

Add/Update Project Documents Wizard - Send Email Notification (page
420)

Add/Update to Project - Select Drawings Wizard (page 417)

Updating a File (page 192)

Add/Update Project Documents Wizard - Send
Email Notification

In this step of the wizard you can elect to send an email to notify project
members that the file has been uploaded to the project.

1 If you entered a comment in the previous step, Attach Comment, click
the Paste comment button to add that comment to this email.

2 To select an email recipient from the list of project members, click To.

3 To add the file, click Finish. This also adds the comment and sends the
email notification.

NOTE You can click Finish at any time to copy the file to your site without adding
comments or email.

See also:

Add/Update Project Documents Wizard - Attach Comment (page 419)

Add/Update to Project - Select Drawings Wizard (page 417)

Updating a File (page 192)

Add to Project - Create Note Wizard

1 Enter your note and format it as desired.

There are simple formatting options (font, point size, etc.) available,
similar to the editing options in Microsoft Word.

2 Click Next.
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To create a hyperlink within your note:

You can also create a hyperlink within the body of your note to connect
members instantly to specific information on the Internet.

1 Within the note, highlight the test that will become the hyperlink.

2 Click the Globe icon (located in the upper right corner) and enter the
desired destination URL in the Address field.

Or, click Browse to select a folder or file from another location on your
site.

3 Click OK.

NOTE Remember, the folders and files available to you are only those that you
have been given permission to view.

See also:

Adding a Note (page 181)

Adding a Link to a Note (page 185)

Add to Project - Create Link Wizard

Use this wizard to add a link to a project, folder, file or website.

1 In the Title field, enter the name of the link. This is the name that appears
in the tree view.

2 In the Address field, type the entire URL for the Web page; for example,
http://www.autodesk.com.

Or, click the Browse button (  ) to select a file or form from another
location on the site. Then click OK. Remember, only the items that you
have permission to are available for selection.

NOTE You can only link to a project, folder, or form log by typing the path
to the item in the Address field in the Create link window. You can not select
a project, folder, or form log using the browse window.
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3 Click Finish to add the link or click Next to add a comment or send an
email notification.

NOTE You can also add a link to a note, but the method for adding the link is
different than the procedure described here. To learn how to add a link to a note,
see Adding a Link to a Note (page 185).

See also:

Adding a Link to a Note (page 185)

Adding a Link to a Folder or File (page 165)

Preferences and Settings Dialog Boxes

Language Options Dialog Box

Only available to site administrators and project administrators who can create
new members.

Use this dialog box to select the language and encoding options that should
be applied to welcome emails and reset password emails. This dialog box is
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displayed when multiple members are selected in the Site Administrators
Members tab, and the Send Welcome Email or Reset Password button is clicked.
■ From the Language Preference drop-down list, select a language for the

email. By default, this option is the same as defined in the Preferences
dialog box.

■ From the Encoding drop-down list, select an encoding format for the email.
You can choose between Unicode or Native Encoding (MBCS). Unicode
enables text to be displayed correctly regardless of the language the text
was written in. However if the recipients email client does not support
UTF-8 encoding then the text is not displayed correctly. By default, the
email is sent in Native Encoding which means that the subject and body
can only be in one character set (that is, you can not mix Japanese content
with Korean content). If you send the welcome email in Unicode, the
subject and body can have mixed content (that is, you can mix Japanese
content with Korean content, Chinese content, German content, etc.).

If you do not want to see this dialog box every time you send a welcome email
or reset a password, then select the Do not show send option. You can also
control whether this dialog is displayed by changing the settings in the Setting
Preferences (page 19) dialog box.

See also:

Setting Preferences (page 19)

Welcome Email Options (page 85)

Manage Columns Dialog Box

In this dialog box you can select which column you want to display in the
member management windows such as the Using the Member List (page 18),
and the Members Tab (page 58) and Members Tab (page 106) administrator
member list tabs. You can also change the order in which the columns are
displayed.

Select the columns that you want to see by checking the box next to the
display name. You can select all columns at once by selecting the checkbox
in the column header next to "Field Display Name".

To change the display order, select a field name in the list and click the Move
Up or Move Down button.
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Some columns are always displayed and you cannot remove them. These
columns have a selected, disabled checkbox in the Manage Columns dialog
box.

See also:

Members Tab (page 58)

Using the Member List (page 18)

Using the Discussions Tab (page 172)

Filtering Options

The Filter option enables you to customize your view in member management
windows such as, the Member List, and the Members and Groups tabs in site
and project administration.

1 From within the toolbar of a member management window, click the
Filter toolbar button. The filter drop-down is displayed.

2 Select a value to filter the list by. A check is added to the selected value
indicating that the list is being filtered by that value, and applies the
filter to the list box. You can select multiple filters. For example, you
could select Show Only Site Administrators and the list displays
only site administrators. Then, you could add Show Only Enabled
Members and the list displays only enabled site administrators. Finally,
you could add Filter by Company and select ACME Company. Only
enabled ACME Company site administrators would be displayed.

Any filtering that you choose remains in effect, for this specific window,
throughout your session. That is, a filter applied in the Project
Administration Members tab, will be applied the next time you return
to the Project Members tab, but not to the Members List.

3 To clear the filtering select Remove all Filters, or de-select an individual
filter.

Following is a description of the filtering options:

Remove all Filters — This option is available once a filter has been
applied. Select it to remove the filters that are being used.

Show Only Site Administrators — Displays only site administrators.

Show Only Project Administrators — Displays only project
administrators.

Show Only Non-Administrators — Displays all members except site
and project administrators.
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Show Only Enabled Members — Displays only enabled members.

Show Only Disabled Members — Displays only disabled members.

Filter by Company — Select this option to open the Filter by Company
Dialog Box (page 443). Select a company and only the members of that
company are displayed.

Edit Company Filter — This option is available after the Filter by
Company option has been selected. It opens the Filter by Company
dialog box so that you can change the company.

Users are differentiated by their icon.

See also:

Using the Member List (page 18)

Members Tab (page 58)

Email Dialog Boxes

Creating a New Message

1 Click a recipient type from the following options:

To: Primary recipients of your message

Cc: Carbon-copy; for secondary recipients

Bcc: Blind carbon copy; for secondary recipients not identified to the
other recipients, including those in the Cc list. Note that private groups
(non-expandable groups) are automatically placed in the Bcc field. This
prevents the names and email addresses of the private group members
from being exposed to other email recipients.

2 After selecting recipients, do the following:
■ Enter a title in the Subject line.

■ Position the cursor in the text box located directly beneath the Subject
line and then enter the message text.

■ Choose from the following options:
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Insert text from a file — In the New Message window menu,
choose Insert/Text from File, select the file, and then click Open.

Insert a file attachment — In the toolbar, click the Attach File
icon (or, in the New Message window menu, select Insert/File
Attachment). Note that you can not send an attachment larger than
20MB.

■ In the Attach File dialog box, click Browse and then navigate and
select the file you want. When you're through, click OK.

3 When you are finished click the Send toolbar button,  .

See also:

Overview of Using Mail (page 231)

Creating and Sending an Email Message (page 234)

Select Recipients

1 Use the drop-down list to select a project. The Member List for that
project is displayed below.

2 Select the member name and then click the To, Cc, or Bcc buttons.

The selected name is added to the corresponding recipient list on the
right. When selecting a Private and Hidden Groups (page 128) the group
name is automatically placed in the Bcc field even if you have clicked
the To button. This prevents the names and email addresses of the private
group members from being exposed to other email recipients.

To view a selected project member's personal contact information, click
the Member Information button at the bottom of the window.

You can enter a string to search the member list data, including Name,
Company, Title, or a fragment of the search criteria just mentioned. The
first item that matches the search string is selected. Groups are expanded
as needed to display found items. If a match isn't found, a "text not
found" message appears.

To search for specific member data, click Find, enter the search string
in the Find text field, and then click Find Next.

3 When you are through selecting recipients, click OK.
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See also:

Creating and Sending an Email Message (page 234)

Private and Hidden Groups (page 128)

Send Options Dialog Box

Only available to site administrators and project administrators who have the
ability to create new members.

Send Options for new members

Use the following options to determine when a welcome email should be sent
to a site member:
■ Edit email before sending — if selected an editable email is displayed

in which you can enter your own text before sending the welcome email
to the member.

■ Send email now — if selected, the email is sent immediately with the
options that you have defined in the Welcome Email Options (page 85).
You can not edit the email before sending if you select this option.

■ Do not send email at this time — this option applies to sending a
Welcome email. If selected, no welcome email is sent to the member.
Remember that users can not log in to the site until they receive a welcome
email. To send the member a welcome email at a later time, go to the Site
or Project Administration Members tab. Select the member in the list and
click the Send Welcome Email button. This same dialog is displayed and
you again, have the option of editing the welcome email. This option is
not displayed when you send a welcome email, or a reset password email,
to an existing member. It is only displayed when you create a new member.

■ Send Confirmation Email — if selected an email is sent to you
confirming that a welcome email was sent to the new user.

■ Language Preference — Select the language that the email should be
sent in.

■ Encoding — use this option to select the encoding format that is applied
to all welcome emails and reset password notification emails. Your can
choose between Unicode or Native Encoding (MBCS).

Unicode enables text to be displayed correctly regardless of the language the
text was written in. However if the recipients email client does not support
UTF-8 encoding then the text is not displayed correctly.
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Send Options for group or project membership change

Use the following options to determine when an email should be sent to a
member if his or her project or group membership changes.
■ Notify Member of Change — if selected an email sent to the member

describing the membership change.

■ Send Confirmation Email — if selected an email is sent to you
confirming that an email was sent to the new user.

To prevent this dialog box from being displayed every time you create a
member, select the, In the future, do not show send options option. To
turn this dialog box back on, go to the Setting Preferences (page 19) Email tab
and select the Display Send Options and Display Language Options
for the Welcome Email and Reset Password emails.

NOTE If you select the Do not show... option, and the Do not send email
at this time option, you will not be able to send a welcome email in the future
unless you turn this dialog box back in the Setting Preferences (page 19) Email
tab.

See also:

Setting Preferences (page 19)

Members Tab (page 58)

Welcome Email Options (page 85)

Send email

To send a message

1 Select the name of the member who will receive the message.

2 Enter your message and then click Send Email.

See also:

Creating and Sending an Email Message (page 234)

Using the Activity Log (page 145)
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Site and Project Administrator Dialog Boxes

Site Administrator's Minimum Required Version
Dialog Box

Only available to site administrators.

This dialog box is accessed through the Site Administrator General tab  ➤ Edit
Site Minimum Required Version... button. In this dialog box you can change
the minimum version of the Buzzsaw client that all site members are required
to use. For more information about managing client upgrades see General Tab
(page 56).

1 To change the required client version, click the drop-down list box. The
versions available for you to choose from are listed. The version that you
are currently using is displayed in italics.

2 Select a new version.

3 Click OK.

Once you have clicked OK any user that attempts to log in with a version that
is older than the minimum required version will be required to download the
most recent version before he or she can log in.

See also:

General Tab (page 56)

Member Information Contact Tab

Enter any contact information you want other project members to see.
Administrators have the ability to edit this information. Non-administrators
can only enter information for his or herself.

1 Enter your telephone, address, and other information as desired.

2 Click OK. If you are an administrator creating a new member, click
Create.

The information you enter here is seen in other parts of Buzzsaw, such as the
Member List, selecting recipients when creating an email, the People tab in

Reference | 429



Find, etc. It is helpful to enter as much information about yourself as possible.
Then, when other members are looking at a list of members they can easily
see your contact information. If you do not enter any contact information
then other members will only be able to contact you through email.

See also:

Using the Member List (page 18)

Changing Your Member Information (page 17)

Using the Member List (page 18)

Active Members Dialog Box

Access the dialog through Site Administration  ➤ Activity Log tab  ➤ Active
Members button.

The Active Members dialog box displays a list of everyone who is currently
logged in to the site, along with site name, login time, and timed-out
information. To close the dialog box, click OK.

See also:

Overview (page 143)

Using the Activity Log (page 145)

Remove a Member

1 In the Membership section, select the project or group name from the
list and then click Remove.

2 Click Yes to confirm. The project or group name is no longer in the
Membership list.

Optional: To automatically notify project members that a change in
membership has taken place, select the Email Added Members check box.

TIP You can select more than one name by using the SHIFT and CTRL keys. When
you hold down the SHIFT key and click another name, all the names between the
two names are selected. When you hold down the CTRL key and select another
name, only that name is added to the select list.
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See also:

Adding a Member to a Project (page 123)

Editing Members of a Project (page 126)

Confirm Member Delete

When deleting a member you have the option to remove a member from a
project, or delete the member from the site. The two actions have different
consequences.
■ Remove from project -- removing a member from a project prevents

that member from accessing the information within that project. The
member continues to have access to other projects that he or she is a
member of. The member’s name and contact information continues to be
displayed in the Member List. This member is still availale to be added to
other projects.

■ Delete from site -- deleting a member from the site prevents the member
from logging into the site and accessing projects. Deleting a member from
the site also deletes the member’s name and contact information from the
Member List.

See also:

Editing Members of a Project (page 126)

Editing a Member (page 94)

Export Permissions As Dialog Box

The permissions matrix can be saved to your hard drive as a text file.

1 In the Permissions Matrix window click the Export button.

2 The Export Permissions dialog box is displayed. Enter a name for the file
in the Save File Name field. Or click the Browse button to select a
location and name.

3 In the Field Delimiter drop-down list, select how you want the
information separated. For example, if you choose comma, the
information displays as: heisenman, 2/28/02 11:09:07 AM, logout, Site
member, heisenman.
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4 Selecting Use Quoted Strings inserts quotes between each of the values.
For example, "heisenman ","2/28/02 11:09:07 AM","logout ","Site
member","heisenman".

5 Click OK when you are finished.

See also:

Permissions Matrix (page 140)

Permission Levels (page 130)

Add to Group Dialog Box

Use this dialog box add a member to a group when editing or creating a new
member. This dialog box is accessed through New Member (or Edit Member)
 ➤ Group Memberships tab  ➤ Add.

1 Select the group you want to add the member to, from the list.

Alternatively, click the New Group toolbar button to create a new
group.

2 Click the Add button.

3 Click the OK button. The Group name is displayed in the Group
Memberships tab meaning that the member now belongs to that group.

See also:

Creating a Group (page 102)

Groups Tab (page 61)

Members Tab (page 58)

New Group Wizard: Step 2 Select Members

Only available to site administrators and project administrators who can create
new members.
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This is step 2 of the New Group wizard. To start the wizard go to: Site
Administration  ➤ Groups tab  ➤ New, or Project Administration  ➤ Groups
tab  ➤ New.

1 From the Show drop-down list select the project that you want to select
members from. You can select more than one name by using the SHIFT
and CTRL keys. When you hold down the SHIFT key and click another
name, all the names between the two names are selected. When you
hold down the CTRL key and select another name, that name is added
to the select list. The group member appears in the bottom pane.

2 Select a site member from the Site Members list and click the Add button.
The member is now listed in the bottom pane as a group member. If the
member you want to add is not listed, select All site members from
the Show drop-down list box at the top of the window. If the member
is still not available, ask the site administrator to create the member.
You can select an existing group. Doing so adds the members to the
selected box when you click Add.

3 To remove a member from a group, select the name in the Selected list
and click the Remove button.

4 Click Next to go to step 3 of the wizard (page 433).

See also:

Creating a Group (page 102)

New Group Wizard: Step 3 Project Memberships (page 433)

Private and Hidden Groups (page 128)

New Group Wizard: Step 3 Project Memberships

Only available to site administrators and project administrators who can create
new members.

This is step 3 of the New Group wizard. To start the wizard go to: Site
Administration  ➤ Groups tab  ➤ New, or Project Administration  ➤ Groups
tab  ➤ New.

In this step you can view and edit the permission level of the group for each
sub-project and sub-folder. The permission level selected applies to all members
in the group.

1 Select a project or folder.
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2 Select a permission level from the Permission drop-down list.

3 Click Finish to complete the wizard.

See also:

Creating a Group (page 102)

New Group Wizard: Step 2 Select Members (page 432)

Private and Hidden Groups (page 128)

Select Group Dialog Box

Use this dialog box to add a group to a project. Access this dialog box through
Site Administration  ➤ Groups tab, or Project Administration  ➤ Groups tab.

1 Select a group in the Available list. Or, use the project filter if to find a
group in a different project.

2 Click the Add button. Once added the member appears in the Selected
list in the lower half of the dialog box.

3 To create a new group click the New Group toolbar button. The Creating
a Group: New Group Wizard Step 1 Group Properties (page 126) starts.

4 To remove a group, select the group in the Selected list and click the
Remove button.

5 Click OK to add the group to the Members tab.

See also:

Editing a Group (page 128)

Creating a Group (page 102)

Groups Tab (page 61)

Add Project Members Dialog Box

Use this dialog box to add a member or group to a project, or to select a
member. If you have the privilege to create new members you can also create
a new member or group in this dialog box.

Access this dialog box through Project Administration  ➤ Members tab  ➤ Add.
Or, through folder properties  ➤ Members tab  ➤ Add. This dialog box can
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also be accessed through Site Administration  ➤ Limits tab  ➤ Edit Defaults
 ➤ Select Site Members.

1 In the Site Members list at the top of the dialog box, select a member or
group name and click the Add button.

2 If the member you want to add is not listed, select All site members
from the Show drop-down list box at the top of the window. If the
member is still not available, you will have to ask the site administrator
to create the member. Or, if you have the ability to create new members
or groups, the New Site Group and New Site Member toolbar buttons
are enabled. Click either button to add a member or a group. The member
appears in the Selected list in the lower half of the dialog box.

3 From the Permission list, choose a permission level for the user or group.
(The ability to select a permission level is not available when selecting
members in the Site Administration Limits tab.)

NOTE If you are adding multiple members or groups to the project then
the permission that you choose here applies to all members or groups being
added. If you want each member to have a separate permission level you
have to specify that in the Members tab.

4 Click OK to add the members and groups to the Project Members list.
All newly added members and groups appear in the Members tab.

See also:

Creating a New Member (page 89)

Permissions (page 130)

Private and Hidden Groups (page 128)

Add to Project Dialog Box

Use this dialog to select a project to add a member to.

1 Select a project from the list.

2 From the Permission list, choose a permission level for the member. See
Permissions (page 130) for more information.

3 Click OK. The project is displayed in the Membership list.

You can select more than one name by using the SHIFT and CTRL keys. When
you hold down the SHIFT key and click another name, all the names between
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the two names are selected. When you hold down the CTRL key and select
another name, only that name is added to the select list.

See also:

Adding a Member to a Project (page 123)

Members Tab (page 106)

Activity Log List Options Dialog Box

Use this dialog box to select the users and actions that you want to view in
the activity log.

Click the box next to the type of event you wish to view.

Log

■ Choose Users to specify the members to be included in your Activity Log
view.

■ Choose Actions to specify site member actions (such as change password,
update a group, remove a user, and so on) to be included in your Activity
Log view.

Project Administration Activity Log

■ Choose Users to specify the members to be included in your Activity Log
view.

■ Choose Actions to specify the project specific task(s) or activities (such as
delete, download, change permission, and so on) to be included in your
Activity Log view.

■ Choose Item Types to specify the type of file or activity (such as comments,
folders, link, project, and so on) to be included in your Activity Log view.
The types of files and activities that are available vary, depending on
whether you are using the Site or Project Administration Activity Log.

NOTE If you want to clear all the options in a list, choose Clear. If you want to
select each item in a list, choose Select All.

See also:

Activity Logs (page 143)
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Using the Activity Log (page 145)

Print Activity Log

1 Enter the file name you wish to save records to or click Browse and
navigate to the desired destination file.

2 Use the Field Delimiter field to indicate what separator you want to
appear between exported fields of information in the exported Activity
Log file. Separator choices include comma, tab, or vertical bar.

3 Check the Use Quoted Strings check box if you want to place quotes
around exported field information.

NOTE Quotes appear around each exported field of information.

Here's an example of exported information fields using a comma field
delimiter and quote strings:

"John Doe","jdoe@kalamazooinc.com","Project Manager","415 555-1234"

If field delimiters and quote strings are not used, the exported fields of
information might look like this:

John Doe,jdoe@kalamazooinc.com,Project Manager,415 555-1234

4 Click OK.

See also:

Printing Activity Log Information (page 148)

Using the Activity Log (page 145)

Save Activity Log

Activity logs can be saved at any time to your hard drive. The files are saved
as text files. This can be useful if you are viewing the activity for a particular
project, or a specific action.

To save an activity log:

1 Enter a name for the log in the Save File Name field. Or click the Browse
button to select a location and name.

2 In the Field Delimiter drop-down list, select how you want the
information separated. For example, if you choose comma, the
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information displays as: heisenman , 2/28/02 11:09:07 AM, logout , Site
member, heisenman

3 Selecting Use Quoted Strings inserts quotes between each of the values.
For example, "heisenman ","2/28/02 11:09:07 AM","logout ","Site
member","heisenman ".

4 Select Size in Bytes to display the data output in bytes (rather than MB,
KB or GB). This enables you to sort the Current Size column in the saved
.txt file.

5 Click OK when you are finished.

See also:

Overview (page 143)

Using the Activity Log (page 145)

Add Information Page Dialog Box

Available only to Site and Project Administrators.

Access this dialog box through the Project Setup menu  ➤ Information Pages.
The Manage Information Pages screen is displayed. Click the Add Page
Button.

1 Enter a name for the information page in the Page Name field. If selecting
one of the default pages that come with Buzzsaw, you can accept the
default name or create a new name. If you are selecting a custom page,
you must enter a name.

2 Using the Select Source drop-down list, select a default page or browse
your site or local computer to choose a page.

3 Select which members can view this page:

Select the All project members option to allow everyone in the project
to see this page.

Select the Selected Members option to restrict who can see this page.
Click the Select button to choose the members. In the Select Members
dialog box, select a member in the top half of the box (use the SHIFT or
CTRL key to make multiple selections), and click the Add button to
move the member to the Selected Members list. The people in this list
are the only members who can see this informaiton page (except for
administrators who can see all information pages). Click OK to close
this dialog box.
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4 Click OK to close the Add Information Page dialog box.

See also:

Step 5: Manage Information Pages (page 269)

Information Pages (page 151)

Import/Export — Select Fields

1 Use the Select Fields list to select the fields to be included in the exported
file.

Or, click the Use Standard fields button and then use the drop-down
menu to choose the type you want.

NOTE If you are using Microsoft Outlook choose the Microsoft Outlook
comma separated value type. By making this choice, column headings are
selected and organized so Microsoft Outlook recognizes them. When you
choose comma separated value, fewer column headings are selected (30 or
so) and they include headings that are unique to Buzzsaw (such as 'Remember
this Password' and 'Notify by Email').

2 Click Next.

See also:

Import/Export - Select Members Step (page 440)

Import/Export Members Wizard (page 441)

Import/Export Members - Import Field Mapping
Step

Use this window to map the fields that you are importing to the fields in
Buzzsaw. Once imported, the fields in the Contact tab of Member Information
will be populated with this information. Buzzsaw automatically maps the
source fields to the appropriate Buzzsaw field. To change these mappings, do
the following:

1 Select a field in the Source File Field list.

2 Select the field you want it to map to from the Maps to drop-down list.
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In the following example the field Business Phone is being mapped to
the Buzzsaw field, Work Phone.

NOTE Each Buzzsaw field can be used only once.

1 To preview your mappings as they will appear after they are imported
click the Preview button.

2 Click the Next button to finish.

See also:

Import/Export Members Wizard (page 441)

Import/Export - Select Members Step (page 440)

Importing and Exporting Members (page 100)

Import/Export - Select Members Step

1 In the Select Members list, select the members you want to add or include
in the imported or exported information file.
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To add all members to the Select Members list click Select All. To remove
all the members from the Select Members list, click Clear All.

NOTE When importing user information, members names are not added if
a duplicate name already exists or if a new name does not have an email
address attached to it. Member Name and Email Address are required
columns. Member names that are not added will remain in the Select
Members list with a highlighted user icon.

2 Click the Finish button.

See also:

Import/Export Members Wizard (page 441)

Import/Export Members - Import Field Mapping Step (page 439)

Importing and Exporting Members (page 100)

Import/Export Members Wizard

1 If you want to import user information, click Import. If you want to
export user information, choose Export.

NOTE If you choose Export, the wizard procedures vary.

2 Select the desired file or click Browse and navigate to the file you want.

3 Use the Delimiter field to indicate what separator appears between
imported or exported fields of information. Choices include Comma,
Tab, or Other.

NOTE When you choose Other, an additional Edit field appears. Use the
Edit field to enter the delimiter character or string you want to use.

4 Click Next.

See also:

Import/Export - Select Members Step (page 440)

Import/Export Members - Import Field Mapping Step (page 439)

Importing and Exporting Members (page 100)
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Import/Export - Send Email Step

In this dialog of the Import wizard, you are selecting when to send the welcome
email to the newly imported members and choosing the format for the
welcome email.

1 To send the welcome email now, select the Send email now option.
If multiple users are selected your options are: Send email now and Do
not send welcome emails at this time. If a single user is selected your
options are: Edit email before sending, Send email now, or Do not send
welcome emails at this time. The "Edit email..." option allows you to edit
the welcome email before sending it. This option is only available when
importing a single member.

2 Select the language that you want the text in the Welcome email to
display in.

3 Select an encoding type for the email.

4 Click the Welcome Email Options button to edit the welcome email.

See also:

Welcome Email Options (page 85)

Language Options Dialog Box (page 422)

Importing and Exporting Members (page 100)

Select Company Dialog Box

This dialog box is displayed when choosing a company to associate with a
member. Access this dialog box through the Site Administration  ➤  Members
tab  ➤ New Member dialog box. It can also be accessed by project
administrator's who have New Member privileges.

1 Select a company to associate with the member.

or

2 Click the Add New Company button to create a company. Follow the
instructions in the Companies Tab (page 64).

3 Click OK.
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See also:

Members Tab (page 58)

Companies Tab (page 64)

Filter by Company Dialog Box

This dialog is accessed through the Filter drop-down in the Members tab of
Site and Project Administration and the Members List. Use this dialog box to
filter the members list by a specific company.

1 In the Filter drop-down list, click the arrow to the right. Select Filter
by Company from the list.

2 The Filter by Company dialog box is displayed.

3 Select a company and click OK. Only the members that belong to the
company selected are displayed.

4 To clear the filtering, select No Company and click OK.

See also:

Filtering Options (page 424)

Using the Member List (page 18)

Members Tab (page 106)

Members Tab (page 58)

Password Requirements

Enable Strong Passwords

When the "Enable Strong Passwords" option is selected in the Password
Requirements section of the Site Administration Security Tab (page 79),
members are required to create a password that meets the following criteria:
■ must start with a letter

■ must be at least 8 characters long

■ must contain at least one capital letter

■ must contain at least one number

■ must be different from the previous ten passwords
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■ must be different from any password used in the previous six months.

New Passwords Must Differ Significantly

The Site Administration Security Tab (page 79) has two options to further
increase password security.

If selected these options require that a password cannot contain a previously
used password.

See also:

Security Tab (page 79)

Add/Remove Roles Dialog Box

Access this dialog box through Project Setup  ➤ Roles  ➤ Add/Remove Roles.

In this dialog box you can create and delete roles. The actions made apply to
the entire site. Thus, deleting a role makes it unavailable for all projects not
just the project you are currently working on.

To add a role to the site:

1 Click Create in the top right of the window.

2 In the Add Role dialog box select a category and then enter a name for
the Role.

3 Click OK.

To add role to a project:

1 Select the role from the list and click the Add to Project button.

2 Click OK.

To remove a role from a project:

1 Select a role from the Project Roles list.

2 Click the Remove button.

This role is no longer be available in the project, but is available in the Site
Master list.

444 | Chapter 27   Reference



To remove a role from the site:

1 Select a role from the Site Master list.

2 Click the Remove link in the top right corner.

The role is removed from the site and is not available to use in a form log.

See also:

Step 3: Assign Project Members to a Role (page 262)

Roles (page 303)

Workflow Types (page 290)
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